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d for either printing or viewing within Acrobat 
ewer. If the images do not show properly, please 
er 6 or later, as we use JPEG2000 compression to 
easonable..

eader, choose 

 

show bookmarks

 

 from the window 
y navigate through the sections and chapters by 
ou can also use the 

 

find

 

 command to find words 
 you.

  

 established in 2001 with the primary aim of supply-
ply software in developing countries. We are com-
are that enables excellence in health care delivery. 

after people who choose to use our services.

 

mandu, Nepal

  

y.org.nz> or <info@sussol.net>

21, fax: 1 (815)572-9431 

post: PO Box 8975, EPC 355, Kathmandu, Nepal

Please feel free to request more information.

  

couraging and more, and has put up with me think-
 I shouldn't have been.

f necessity at the Medical Supply Department, Kath-
 a lot from Jaap Zijp's software "Bhandari", and 
ere 

 

mSupply

 

 was originally developed and tested.
I

Th

B
th

Pl

m

• Customers are able to order on-line via the internet, and can view stock 
status and the status of their orders.

• Exporting purchase and invoice data for import into an accounting pro-
gram.

• Reporting on transactions and other data in almost any manner you 
want!

• If you need help with installing mSupply please feel free to email us at 
<info@msupply.org.nz>

Thanks
Juliet has always been en
ing about mSupply when

This software grew out o
mandu, Nepal. We learnt
from the staff at MSD wh
ntroduction

ank you for choosing mSupply.

fore you launch in (if you haven't already!), we suggest you plan to take 
e following steps. 

• Read the rest of this introduction.

• Read the setup, tutorial and licence chapters in this manual.

ease note that installation requires basic computer skills

• You need to be able to locate a file using the "open" and "save" win-
dows.

• If you are not sure, why not try, and email us if you get stuck.

Supply is designed to handle the following tasks

• Recording quotations received from various suppliers in a way that 
makes for easy comparison of true cost prices.

• Create tenders for suppliers to respond to.

• Ordering (Purchasing) of items from a particular supplier, using actual 
usage figures to calculate the required quantities.

• Entering of incoming goods into inventory.

• Manufacturing items. That is, building new items from raw materials in 
your stock.

• Tracking Accounts Payable and Accounts Receivable

• Issuing of invoices for customers, and recording the transaction against 

About this user gu
This user guide is designe
Reader or another PDF vi
upgrade to Acrobat Read
keep the download size r

If you are using Acrobat R
menu. You can then easil
clicking on a bookmark. Y
and topics which interest

About us
Sustainable Solutions was
ing and supporting mSup
mitted to producing softw
We take pride in looking 

We are based in Kath

We can be contacted at:

email:<info@msupp

phone: 977 1 5548 0



 

Introduction

 

Ujwal Khatry has stuck with Sustainable Solutions for five years, including the 
startup period where our company name could well have been a misnomer.

Jim Staples of 4D inc. http://www.4D.com kindly arranged an initial donation 

      

shall be the sole arbiter of those qualifying for this offer.

  
6

• Users who have obtained a free licence number are not eligible for free 
support.

Please contact us for quotes regarding customised versions and installation 
and training packages.
of the superb development environment we use.

Thanks to those people in the 4D tech mailing list who have helped for no 
benefit to themselves.

John Ross of Patan Hospital, Kathmandu, believed in the quality of mSupply 
enough to use it long before it was fully ready.

David Adams kindly donated his superb texts on 4D.

The moderators of the E-Drug mailing list have been gracious in letting us use 
that list for occasional announcements.

Copyright
mSupply software is copyright Sustainable Solutions, 2006, UMN/INF/Inters-
erve 1996 to 1999. You may only use the software in accordance with the 
accompanying licence agreement.

Licence Agreement and Costs
Commercial users or any user wanting multi-user functionality enabled must 
obtain a licence from Sustainable Solutions.

Please view our web site http://www.msupply.org.nz for up-to-date pricing.

Non-commercial use

• You may use mSupply software in single user mode for free as long as it 
is used in an approved not-for-profit organization in a developing 
country. All users must register with Sustainable Solutions to obtain a 
registration code. Information supplied will not be used for any pur-
pose other than generation of registration code. Sustainable Solutions 
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recommend you don't use it) 

 

• 

 

New section on ‘Non-stock’ items

    

u

        

xes

 

008)

   

nding purchase order lines

  

r Stock on Date report that allows easy display on 

  

be specified as a mandatory field

  

eckbox can be turned off by mSupply when quote 
hed.

  

le for item list view 

   

ed were sometimes wrong

  

 on invoice confirmation were not being assigned to 

  

 showing total backorder quantity for all Ad Hoc 

 

v 2b1 (1st Feb 2008)

   

agement. When you log into mSupply you can 
il you log into a different store mSupply will only 
actions, stock and report results related to the cur-
 also log in as "supervisor mode" and report on stock 
ross all stores.
C

v

M
C

Fe

B

• Logging of user log-in and log-out (can be turned on/off in the prefer-
ences)

• 

g fixes

• Checking for duplicate item codes now working

• Volumes now show m3 by default before a value is entered.

• Viewing goods received lines on a purchase order fixed.

New Features

• Multiple store man
choose a store. Unt
show you the trans
rent store. You can
and transactions ac
hanges in recent versions

2 (very soon .... towards the end of May)

ost of the major changes in version 2 are listed under earlier beta versions.  
anges between v2b2 and v2 final include:

atures

• Inter-user messaging system - a simple system to see which other users 
are logged in, and to send them messages.

• Security much improved for web itnerface- can't execute arbitary URLs 
any more.

• Can now include Purchase Order lines with zero suggested quantity 
when creating a purchase order (allows you to investigate lines that 
mSupply considers have sufficient stock)

• Shipping labels (or "box/carton labels") from customer invoices (EPL 
printing to Zebra printers only)

• Item labels for items manufactured from builds

• Order lines history now shows the goods received ID

• Change of nomenclature - items previously known as ‘Non-stock’ items 
are now called ‘Ad Hoc’ items to diferentiate from re-defined Non-
stock items.

• New, simplified Ad Hoc item handling (old system still in place, but we 

• Other minor bug fi

v2b2 (18th April 2

New Features

• New report: outsta

• New report type fo
spreadsheets

• Quote validity can 

• Quote preferred ch
validity date is reac

• Extra fields availab

Bug fixes

• Stock totals display

• Backorders created
the correct store

• Ad Hoc items were
items.



 

Changes in recent versions

 

• 

 

 Patient information recording: you can now specify tests and values 
and then keep a record of results of these values for each patient. This 
enables mSupply to be used in simple clinic situations.

                                     

• 

 

Import default location key of an item, now we search for location 
code, if does not exist create location and assign location code for the 
item

  

sible from the quick report editor: 
process that allows using an item's shelf 

  

eck is only carried out if the item code is 

  

provements.

    

ing details for a stock line

  

repa ck if not finalized.

  

d

    

s Received lines and Supplier invoice lines: 
nges the volume based on the previous ratio.

  

n to show volume availability at chosen loca-
/orange/green to indicate no space/tight 

  

d to purchase orders on the location tab to 
rchase order

  

own when double-clicking a goods receipt 

 

Bug Fixes

  

own when double-clicking a goods receipt 

  

osing an item to issue with a long supplier 

  

a repack with status “sg” fixed (critical)
8

v 1.96r4 (31st Aug 2007) 
New Features

• Allow new users to logged as store by default

• Set store as default mode if new database is created

• Checks for unique item code

• Available volume is now sh
line

• Occasional error when cho
code fixed (non-critical)

• Repacks: bug when saving 
•  Inter store transfers

•  Handy calculator for days stock required.

•  Duplication of multiple customer or supplier invoices

•  French version completed (almost!)

•  Purchase orders can now have split deliveries of a line or lines

•  Automatic order calculations take into account forward commitments 
due to existing split delivery requests

•  Ad Hoc items can now be excluded from most reports

•  Start of year stock can now be set retrospectively

Bug fixes

• Close box now works for item and invoice windows! 

v 196r6 (24th Jan 2008)

New Features

• Prescriber report now includes prescription count as well as item count.

Bug Fixes

• Transaction report: “not equals to” filter for transaction categories. 
now works correctly.

• Repeats can no longer be issued when the transaction type is “cc” (Cus-
tomer credit)

• Added a new method acce
qr_get_loc_from_key_new_
location in custom reports

• The duplicate item code ch
changed.

• Internet version checking im

v 196r3 (5th June 2007)

New Features

• Pack size shows when view

• Repacks: can now delete a 

• Repacks: now record user i

• Location management

• Purchase order lines, Good
changing the pack size cha

• Goods Receipts: new butto
tions (lines are coloured red
space/ enough space)

• Same line colouring applie
show effect of receiving pu

• Available volume is now sh
line



 

v 196 (24th April 2007)
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• 

 

In Preferences > Invoices 1, there is a new option “Activate budget 

        

ption to determine if invoices are printed with items 
er or line number order

  

ceipt input form has two 

 

new line

 

 buttons, allowing 
 the purchase order, or entry of a line not on the 

  

eceived form has a “Find” button in the lower left 
apid search for a particular line

   

tion has had many errors fixed.

  

e option for items is now respected when converting 
a supplier invoice.

apter for changes in earlier versions.
module”

• A budget period can now be set for both Customer and Supplier 
invoices

• In Preferences > Printing, the option “Don’t print placeholder lines on 
pick slips” may be toggled on or off

• Customer invoices: the $ icon at lower left has a new option to print a 
Proforma invoice in place of a pick slip.
• Purchase Orders now correctly ignore the current purchase orders’ stock 
volumes when calculating volume on order.

• Purchase Orders: volume for this order now excludes lines already 
received.

• Labels on the item usage tab were wrong.

• Negative numbers in location management windows (indication over-
full locations) now display their units correctly

v 196 (24th April 2007)

New Features

• Now certified with Windows Vista

• If editing a supplier invoice line where stock has already been issued, 
you have the option to view which customer invoices the stock was 
issued on.

• Many new options for printing dispensary labels

• Mini invoiices can be printed on dispensary labels

• Location management now handles item volumes, including the ability 
to determine whether a purchase order will result in more stock being 
delivered than there is available volume. This is especially relevant for 
cold chain items.

• New form of transaction report

• Backorders button on Customer invoice now has “New” and “Modify” 
buttons

• Each name has an o
in alphabetical ord

• The New Goods Re
entry of a line from
purchase order

• The Show Goods R
corner, allowing a r

Bug fixes

• The French localiza

• Convert pack to on
a goods receipt to 

See the technical notes ch
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f

 

h

ick
. of Names or of Items), double click the left mouse button on a 

i

u

y pressing the "Enter" key,.

ed by holding down "CONTROL" ("COM-
e period key (full stop).

scribing where a document is stored on your 
k:folder 1: folder 2:document", which is the 
ment". 

t modifier keys. We've tried to list both in 
ight slip through, so

es the same as the "COMMAND" (cmd) key 

 same as the "OPTION" (opt) key on Macs.

the list by that item. Columns that can be 
 (In future this will be true of all columns).

in mSupply that represents physical stock 

lar product. An item may or may not have 
stock lines at any given time. For example: In the example data file provided 

g tab/cap" is an item. When you first start 
 2 stock lines. (You can view them under the 
ndow (more on that later!).

nt batches of a particular item in your 
10

If you are
also work

Menus
Choose ne
Items ) Ne
choose ne

Field
An area w
white colo

Check box
is a box th
click in it. 
there is no
ing what 

Tab & Shi
You can m
SHIFT key
reverse or
ble"- that
button. Pr

Highlight 
Pressing t
which is u

Double-cl
In lists (e.g
line to ed

Insertion 
is the blin
typed inp
t or view more details.

point
king line in a field that indicates which field is currently accepting 
t.

with mSupply, "Amoxycillin 250m
to use the example data file it has
"stock" tab of the item details wi

Item lines
(or "stock lines") represent differe
store.
't familiar with using a computer, you should read this chapter, and 
 through the tutorial.

w item from the item menu (sometime also written as Choose 
w item  means.... Click on the word item in the menu bar, then 
w item from the menu that drops down.

here you can make an entry, either text or numbers - usually a 
ured box.

at changes from having an "X" in it to being blank each time you 
To "check" a check box means to click it so that an "X" appears (if 
t one already present). Check boxes have text beside them explain-
he box is for.

t
ove from field to field by using the TAB key. Holding down the 
while pressing the TAB key will move you from field to field in the 
der to normal. (Note that on Windows, some buttons are "taba-
 is, pressing the tab key moves the "focus" (the active area) to a 
essing the "return" key then activates that button.)

button
e ENTER key will operate the highlighted button in a window, 

sually the OK button.

OK button
The OK button can be operated b

Cancel button
The cancel button can be controll
MAND" on Macs), and pressing th

Path to a file
(Or to a document) is a way of de
hard disk. It is written as "hard dis
same as "C:\folder 1\folder 2\docu

Modifier keys
Windows and Macs have differen
the manual, but sometimes one m

The Windows "CONTROL" key do
on Macs

The Windows "ALT" key does the

Column headings
in mSupply can be clicked to sort 
clicked for sorting have blue text.

Stock
Also called "inventory"- an entry 
(inventory) in your store.

Item
An "item" in mSupply is a particu
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Negative values
In general, there is no need to enter negative values in mSupply. Even when 
you are entering returned goods from customers, or returned goods to sup-
pliers, you must enter positive values. mSupply automatically converts the 
invoice total to a negative amount when it is a credit to a supplier or from a 
customer.

Supplier invoice
A supplier invoice is the same as a "bill" or a "purchase"

Build
A transaction that records the manufacturing of an item by turning raw 
materials into a finished product.
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a

 

stem
 

t

up program for Macintosh.

rogram available for Windows.

ustrial strength backup solution, you should 
r Mac & Windows), and a tape backup 

e backed up data off-site to prevent the risk 

s will not be able to help you if you have 
do not have a backup.

tions:

absolutely necessary in every situation, but 
quirement. A dot-matrix printer may be 
 is preferable.

u are able to obtain good support.

on for quality (even if it means buying a 

upply on a wide range of hardware. We are 
options further via email or phone.

s versions
If you open a data file that was created with a previous version, it will auto-
matically be updated to the new format. Please note that this process may 

up of your data file before upgrading. We 
 event of some unexpected disaster if you 

C
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Hardw

Windows
Hardware
mSupply f

Here’s a ro

If you hav
mSupply t

Macintosh
Mac OS X

50Mb har

Backup sy
Once you
method o
files that r
have a hig
use of an 
tate off-si

Ab

Su
or 
use

Su
start using mSupply, it is of crucial importance that you have a 
f backing up your data. mSupply stores all it's data in a couple of 
apidly become too large to fit on diskettes. You need, therefore, to 
h capacity removable storage device. We strongly recommend the 
external hard disk using either firewire (IEEE 1394) or USB2 to facili-
e storage of backups.

take some time.

IMPORTANT! Always make a back
will not be able to help you in the
haven't followed this advice.
re requirements:

 requirements vary widely depending on what you want to use 
or 

ugh guide.

e an older operating system, please contact us for an old version of 
hat runs on Windows 98 or later.

10.3 or later.

d disk space.

• Synchronize is a good back

• Backup Magic is a similar p

• If you are looking for an ind
use Retrospect (Available fo
device.

• You need to be able to stor
of loss by fire, theft, etc.

• Note! Sustainable Solution
hardware failures and you 

Hardware recommenda

• A connected printer is not 
for most situations it is a re
used, but an ink-jet or laser

• Buy hardware for which yo

• Buy brands with a reputati
slower/older machine).

• We have clients running mS
happy to discuss hardware 

Upgrading from previou

solute minimum Windows 2000 or XP computer with 
a 500 Mhz Pentium processor or 
equivalent.

ggested single user 
lient machine for 
 with server.

Win 2000 or later, 800 Mhz or faster 
Pentium processor or equivalent, 
256Mb RAM

ggested server Win 2000 or later, 1.4Ghz Pentium 4 
or equivalent, 512Mb or more RAM. 
2 Hard disks. Attached to Uniterrupt-
ible power supply with software to 
shut down server if battery power is 
about to run out.
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• Create a "mSupply folder" entry in the "programs" section of your 
"start" menu.

oned below :

 using the Windows menu Start > Program Files > 
ll mSupply . This will remove all installed files of 
uldes the example data files. Re-installing mSupply 
esh copy of the example data file.

elete the example data file and re-install mSupply. 
ler will install a fresh copy of the example database 
 does not exist.

simply replace the example folder from the mSupply 

sers
ings in control panel, make sure the short date for-
y only 2 digits for the year (YY, not YYYY). mSupply 
llow only enough space for 2 digits. Having the 
will only affect display, not the actual data. It does 
se DD/MM/YY or MM/DD/YY or YY/MM/DD

s in mSupply overlaps the separator lines, turn off 
splay control panel. 

for the first time

rt mSupply icon on your desktop, or 

upply item from the mSupply menu in the programs 
 menu (on Windows). If this is the first time mSupply 

has been started after installation, then an example data file will be 
ou to follow the mSupply tutorial. mSupply will 
 log in window.

emember” the last data file used, and automatically 
 for that file unless you move or rename your data 

ly will show you a standard open/save window for 
me/location of your data.

e a new data file now, then log in to the example 
upply menu do the following.
 Now you are ready to begin! Proceed to the section below on starting the 
example database.

Example Data file
The mSupply installer treats example data files in a special way. Re-installing 
mSupply on a previous installation will replace all the files except the exam-
ple data file. This is to prevent valuable data from being deleted as users may 
have started entering actual stock into the example data file. 

To install a fresh copy of the example data file on windows you can carry out 

opened allowing y
present you with a

Note that mSupply will “r
present the log-in window
file. If you do this, mSupp
you to choose the new na

Creating a new data file
If you would like to creat
data file and from the mS
Installation
We are assuming you have obtained mSupply either via the Internet or on a 
CD.

If you have downloaded the file you need, and you have saved it to your 
desktop, it is important that you saved the file with an ".exe" extension or it 
will not run (You can rename a file by right-clicking on it). The default name 
for the file is "mSupply_installer.exe"

If you are using the CD, it should automatically run when inserted. Otherwise, 
locate the file "mSupply.....exe" on the CD using Windows Explorer.

It is strongly recommended that users who are not familiar with program 
installation adhere to these directions.

• Double-click "mSupply_installer..exe", and it will automatically run the 
mSupply installer. 

• The installer will do the following:
• Create a folder on your chosen drive called "mSupply" 
• Create in the mSupply folder a sub folder called "example folder" 

containing an example data file. You can use this data file for prac-
tice. (Or use the tutorial at the start of the manual to learn the 
basics quickly) 

• Install the "mSupply.exe" application and associated files. Double-
clicking this file will do the same as double-clicking the "start mSup-
ply" icon on your desktop.

• Install "readme.txt" - information on licensing and using mSupply.
• Install "mSupply manual....pdf" -this document.
• Create two shortcuts on your desktop: "start mSupply" and 

"mSupply manual"

one of the options menti

• Un-install mSupply
mSupply > Uninsta
mSupply which inc
now will install a fr

• You can manually d
The mSupply instal
as the previous file

On Macintosh machines, 
installer image.

Notes for Windows u
• In the regional sett

mat is set to displa
lists are set up to a
wrong seting here 
not matter if you u

• If the display of list
large font in the di

Starting mSupply 
To start mSupply, either 

• double-click the sta

• choose the start mS
section of the Start



Setting up mSupply

• File > New Data File...Navigate to a convenient location. Assign a name 
to your data file and click the save button. mSupply will now start creat-
ing a new data file.

 in the bottom right coner of the window. 
 where you can choose the location and 

articular data file, that file becomes the 
matically on restarting mSupply. To use a dif-
escribed later. If the default data file is 
 location, it must be openedusing its new 

u will be presented with the log-in window 
14
• You will be presented with a login window. See next page for instru-
cions

• Start entering your data.

Alternative method for creating a new date file
Here is an another way to create a new data file.

• Quit mSupply if it is running.

• Start mSupply and then immediately hold down the “alt” key (You will 
now be shown the window to choose a data file. This window has a 
“New” button allowing you to create a new data file if you wish. 

• Click on the “New” button
Another window will open
name of your new data.

Once mSupply has opened up a p
default file which is opened auto
ferent file, it must be chosen, as d
renamed or moved to a different
name or location. 

Log-in to mSupply

The first time you use mSupply, yo
like this:



Preparing mSupply for actual use
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Supervisors and other Level 1 users will have an additional menu item, Super-
visor mode. In this mode, all stores are accessible, and you would use this 

y for actual use
 necessary to start mSupply for the first time.

ata file
w data file for use

 file

ata file, see Starting mSupply for the first time on 

ation that you can easily find for doing backups. We 
er called "mSupply data" inside the “My Docu-
 store your data file. The documents folder on a 

imiliar manner.

ata file for use

our home currency. After you save the file, mSupply
rrency with a rate of “one” and a name of “Hom”.

 Currencies and double click the one line in the win-
 or three letter code to represent the currency you

ate your database (eg "ICr" for Indian Rupees, or
, or "USD" for US dollars). This currency will have a
rrencies are used when you are calculating cost prices
er currencies, and when you are comparing quota-
ers.
ences. Choose Special > Preferences to do this. Read
e manual on the File Menu - Preferences to learn-
t Preference settings do.
ers and Customers (If you like you can also do this as
simply entering a customer or supplier the first time

you create an invoice or order from them)
ou keep in stock. There are a number of ways you

is step if you want to just enter items as you enter 
ck in the next step by clicking the "new item" button 
e to enter a stock line for which there is no item.
t a file of tab-delimited item data, which you can cre-
le, in MS Excel. See the Import... command in the 
apter. A file containing the WHO essential drug list is 
 the download page of the mSupply web site. We 
u use this file.
mode, for instance, when placing an order for supplies which will be distrib-
uted to a number of stores.

For further information see Show stores on page 225.

Mode
At 4. “Choose login mode ....”, you have the option to select Store mode or 
Dispensary mode; the default can be set in your Preferences

Finally, click “OK” to login

4. Enter the items y
can do this:
• You can skip th

your actual sto
when you com

• You can impor
ate, for examp
"File menu" ch
available from
recommend yo
User name
You should select “user 1(pass=user1)”from the list 

Password
At 2., enter the password “user1” (without the quotes). When different users 
with their own level of access have been set up, you will then log-in by selecti-
ing your user name and typing your own password.

Store
At 3. select from the drop down list the store with which you are working. 
Most mSupply users will be operating with a single store, but for users oper-
ating with more than one store, the login screen allows you to select any of 
the stores to which you have access. After selecting the desired store, all 
transactions will relate to that store until you return to the login screen and 
select a different store from the drop down menu. 

Preparing mSuppl
The following 2 steps are

• Create a new d
• Prepare the ne

1. Create a new data

In order to create a new d
page 13

Save the data file in a loc
suggest you create a fold
ments” on windows PC to
MAC could be used in a s

2. Prepare the new d

1. Give a name to y
will create one cu
Choose Special >
dow. Enter a two
will use to oper
"Rnd" for Rands
"rate" of "1". Cu
for orders in oth
tions from suppli

2. Enter your prefer
the chapter of th
what the differen

3. Enter your Suppli
you go along by 



Setting up mSupply

• You can enter each item using the New item Command from the 
item menu.

5. If you intend to record the location of each item, you should define
16
the locations that your store contains.For further information see
Location - Defining locations on page 73.

6. About Dispensary Mode

mSupply allows you to log in in two different modes, Store or Dispensary. 
Each user can have his/her permissions set to allow or disallow each mode.

The modes present the user with a different menu bar and different win-
dows, depending on whether you are issuing stock to an organisation or an 
individual

For further information see Dispensary Mode on page 103.
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efore starting the tutorial, you will need to have installed mSupply, and 
pened the example database. If you haven't done so, read the setup chap-
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st
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B
o
te

N
yo
th
rs in the manual to do this

ote - mSupply runs best with a screen resolution of 1024 or 768 or greater. If 
u have your screen set to 800 x 600 or lower, some windows will not fit on 
e screen. To change screen resolution:

• Windows: Right click anywhere on the desktop, select Properties, then 
Settings, and make the necessary changes.

• Macintosh: Choose Apple > System Preferences... then click on the “Dis-
plays” icon and set a new resolution
utorial

some of the terms used below are not clear, please read the Conventions 
apter earlier in this manual.

nly mSupply’s basic features are covered in the Tutorial; its many enhanced 
atures are covered in depth in appropriate chapters in the User Guide.

Supply Explained
e chart (right) shows the common steps in most pharmaceutical supply 
ocesses.  (Of course, the manufacturing step only applies to manufacturers!)

Supply work flow diagram
e two most common transaction types in mSupply are the supplier invoice 
) and the customer invoice (ci). These transactions record stock purchases 
om suppliers, and stock supply to customers. mSupply records a full audit 
ail by only allowing stock adjustments by way of a transaction. Therefore, 
ven an opening balance of stock for the year, mSupply can show a series of 
ansactions that result in the recorded closing stock.

f course, there is much more to it than that, but these two transactions are 
e core of the system.

ote that mSupply has dozens of preference settings which change the 
haviour of many aspects of the software. If you have customized prefer-
ces from their default settings, some aspects of this tutorial may not be as 

ated below. We recommend you start with a fresh copy of the example 
ta to ensure the preferences are set correctly.
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Opening the example data file

y should be highlighted, but if it is not, it 
 (without the quotes) in the password area 

 list will display ‘General’, and the ‘Choose 
ll display “store”- these should not be 
ter you have logged on, the Navigator 
18
You will have two icons on your desktop- double-click the start mSupply icon.

If you are opening mSupply for the first time, the the program should auto-
matically open the example data file.

If you have already been using mSupply and have another data file open, but 
would like to open the example data file for use with this tutorial, then you 
can use the mSupply menu File > Open data File... to open the example data 
file.. By default the example data folder is stored inside “c:/program files/
mSupply/example folder/”; navigate to the location and open the data file. 

Note: If you have chosen a different location from the one suggested by the 
installer, the example folder will be in your chosen location.

A password entry window is presented as mSupply opens up a data file. The 
message panel informs the user that the example data base is in use.

The "User 1” (pass= "user1") entr
should be selected. Enter "user1"
(2.).

The ‘Choose store .....’ drop-down
login mode ....’ drop-down list wi
changed. Click the OK button. Af
screen appears:



The Navigator
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the shortcuts.

oice with the mouse, or by advancing through the 
t arrow keys and pressing the Enter key. You will be 
he Navigator in the next step in the tutorial, and as 
common to all panels, you will quickly become 

 the Navigator screen is available for displaying your 
cme Medical Supplies” is displayed in our example. 

is performed by choosing File > Preferences > Logo.

ng items 

 database
orial, we are going to add two new items to our 

ning screen, click on “Items”, the 3rd of the large 
screen

appears:
The Navigator always opens at the Customers screen, shown above.

Displayed along the top of the screen are four items of information: [1.]the 
mode selected at logon (store or dispensary), [2.]the store in which you are 
working - for most users this will be ‘General”, [3.] active data file, and [3.]the 
user currently logged on. Keep the pointer on the datafile name, and after a 
few seconds the full path to the data file will be displayed.

Immediately below this, there are six large icons, “Customers, Suppliers ....... 
Admin.” Click on the icon appropriate to the task you are performing, and 
you will be presented with a panel displaying annotated icons listing the 
available functions and procedures; these are in turn selected either by click-
The Navigator

Overview
The mSupply Navigator provides access to most of the functions you will be 
using regularly in mSupply. You will learn that many of these functions may 
also be opened with shortcut key sequences from the various Menu items, 
and once you have gained some experience, you may find it quicker to use 

ing on the icon of your ch
icons with the right or lef
using the Items panel of t
the same procedures are 
familiar with using them.

The bottom right area of
own logo - the logo of “A
The placing of your logo 

Adding and viewi

Adding a new item to the
For this section of the tut
mSupply database.

From the Navigator’s ope
icons near the top of the 

and the following screen 
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Type
The default entry “normal” appears, and should not be changed.

ey to advance to the next field.

". Press the Tab key to advance to the next 

 for the rest of the tutorial when you need 

e alternative is "ea" for "each".

ears in it. This means that when we export 
will be included.

n shelf 3 in the "a" section of our imagi-
preted differently from "a", so it is good to 
er case letters for entering shelf locations.

 a 100 unit pack to be our standard for com-

ned, this field allows the item which is 
propriate category.

rug
For this tutorial, ignore these fields and leave them blank.

dd this item to mSupply. The window will 
d a further item. 

 add, you could click the OK button to add 
en to exit. If you accidentally click "OK & 
click the cancel button. The Amoxycillin 
red, as it was saved when you pressed the 
20

Below is a list of fields and the text to be entered into each field. Use the tab 
key to advance from field to field or click on the field you want to edit with 
the mouse.

Click the "OK & next" button to a
now go blank allowing you to ad

Note: If you had no more items to
only the item you wanted, and th
next" and then want to exit, just 
500mg tab/cap would still be ente
• Click on the “New item” icon

• You are presented with a window with a number of fields to enter:

Item code
Enter "amo500c". Press the Tab k

Item name
Enter "Amoxycillin 500mg tab/cap
field 

Note: Continue to use the Tab key
to advance to the next field.

Units
“None” is displayed by default. Th

Price list
Click on the square so a check app
a price list, the price for this item 

Shelf location
Enter "a3". Amoxycillin is stored o
nary store. Note that  "A" is inter
use either all upper case or all low

Preferred pack size
Enter "100". This means we want
paring prices of this item.

Category
If a list of categories has been defi
being added to be placed in its ap

ATC code, DDD factor, Essential d



Adding and viewing items
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text entry area, then click the Find button.

ted with a list of all the items whose name or code 

 Amoxycillin 250mg tabs/caps - an item that was 
ple data file. To choose the item, double-click any-

 the window.

esented with a window that displays a lot of infor-
oxycillin 250mg tab/caps". From this window you 
nd, view and edit supplier quotations, view usage 
 last 24 months, view backorders, view, add and edit 
 Phew!
You will be presented with a window to find items:

•  We will choose the
already in the exam
where on its line in

• You will now be pr
mation about "Am
can see stock on ha
for this item for the
notes for this item.
"OK & next" button.

Proceed to add a further item with the following details:

Note that if you make a mistake, you can click in a field and edit the value. 

Click OK now that you have added the item, then click cancel to exit the win-
dow.

Congratulations! You have now added 2 items to our example data file. Let's 
go and see how to find them.

Viewing or Editing item details
 Click on"Show items" from the Navigator ‘s Item screen.

•  Type "a" into the 

•  You will be presen
starts with "a"

Item code "amo125s"

Item name "Amoxycillin 125mg/
5ml syrup".

Units "mL" (double-click the 
entry in the window 
that appears to 
choose it.

Price list check the check box.

Shelf location enter "a7".

Preferred pack size  enter "60".
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For this tutorial example, we will first add a new supplier, then add a new 
customer.

 your new Supplier.

mep" to identify the Supplier (Acme 
euticals). You need to choose a unique 
ach name. Try to choose a logical sys-
e code is used to look up the Supplier 

mer) when you are entering invoice 
 example, try to start the code with at 
first three letters of the Supplier name)

mep" again. This field is only used when 
 data to an accounting program - this 
t match the code you use for the sup-
ur accounting program.

me Pharmaceuticals" - the name of our 
supplier.

s box unchecked, as we are entering a 
lier.

ose "new supplier" this box will already 
ed.
22

Adding a Supplier

From the Navigator’s opening screen, click on the 2nd of the large icons, Sup-
pliers, near the top of the screen, and then click on "New Supplier" from the 
Navigator screen that appears. You will be presented with this window to 
enter the details: 

Customer check 
box

Leave thi
new Supp

Supplier check 
box

As you ch
be check
• At this stage, we only want to know how to view the information. For 
an explanation of all the information displayed, and for further infor-
mation see Item Edit - General options on page 45.

• When you are finished viewing the information, click the OK button to 
return to the list of items.

• If you want to view a different item, you can double-click it's line. Oth-
erwise click the OK button to exit to the mSupply start up screen.

Customers, Suppliers, and Contacts 

Adding a Customer or Supplier

You can now enter the details for

Code Enter "Ac
Pharmac
code for e
tem, as th
(or Custo
data. (for
least the 

Charge to Enter "Ac
exporting
code mus
plier in yo

Name Enter "Ac



Customers, Suppliers, and Contacts
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ply startup screen.

ve the details and exit the window.

r Supplier
 Pharmaceuticals" 

liers…" from the Navigator’s "Supplier" screen. You 
 a window to enter as much of the Supplier name or 
w. For this tutorial, just click the OK button- you will 

suppliers.

Enter "bluec" 

Enter "Blue Cross Hospital" - the 
name of our customer.

x Leave this box unchecked, as we are 
entering a new customer.

ox As you chose "new customer" this 
box will already be checked.

tact You can fill these in with appro-
proiate values

fac-
lds

These fields will not be visible, as 
they only apply to suppliers.

sis Ignore these for the time being

If applicable, a note or comment may 
be entered.
Enter a new customer.

From the Navigator’s opening screen, click on the 1st of the large icons, Cus-
tomers, near the top of the screen, and then click on "New Customer" from 
the Navigator screen that appears. You will be presented with a window simi-
lar to the New Supplier one above to enter the details:

Fill in the fields as follows:

Code Enter "bluec" 
If you are happy with the details, click OK. You will be returned to the mSup-

Click the OK button to sa

Editing a Customer o
Let's now look up "Acme

• Choose "Show supp
are presented with
the code as you kno
get a full list of all 

Hold checkbox If this box is checked for supplier or customer, 
that particular supplier or customer cannot supply 
or be supplied with items.

Price Category This applies to customers. It is possible to assign 
multiple sell prices to customers. Leave it set to 
“A”.

Print invoices 
alphabetically

This is only for customer invoices at the moment.

Address, Postal 
address, Con-
tact.

You can complete these with appropriate values.

Currency The field is automatically filled in with "Nrs" (which 
stands for Nepali rupees - the default currency in 
our example data). This is the currency that this 
supplier will use to bill us.

Margin Enter "10". Items purchased from this supplier will 
have a 10% margin added to them to calculate 
the selling price.

Freight factor Enter "0". Acme pharmaceuticals does not 
charge any freight to us - their prices are "CIF". 
This field is only used for comparing quotations 
from suppliers - it is not used for actual invoices.

Category & 
Analysis

Ignore these for now

Comment You can enter a brief note here (Ignore it for now)

Charge to

Name

Supplier check bo

Customer check b

Address and Con
fields

Currency, Freight 
tor, and Margin fie

Category & Analy
Fields

Comment field
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• Note the window has "Tabs" along the top edge , “Gen-
eral”,"Invoices", "Backorders", "Quotes" and "Notes", etc. Let's add a 
note for Acme pharmaceuticals:

utton. Today's date is entered automatically 
e Note Entry field.

hen click the OK button.

ext will appear in the list of notes.

iting the supplier, then click OK again to exit 

a supplier invoice) 
coming goods is referred to as a "bill"- we 
e same thing.

d a shipment containing two items from 
ant to enter these goods into stock. The 

Supplier" menu.

me pharmaceuticals 
ill no.:A939

ack Batch Expiry Price Extension

00 b93333 31/12/
2010

344 344,000.0
0

0 bb23d 31/12/
2009

21 1,365.00

0 bb22d 15/12/
2010

21 2,100.00 

Total: 347465.00
24

Choose  new invoice... from the "
• Double-click the "Acme pharmaceuticals" entry in the list. You will be 
shown a window the same as you used to enter "Acme pharmaceuti-
cals" as a new supplier.

• Click on the "Notes" tab.

• Click on the "New Note" b
and highlighted. Click on th

• Enter "This is a test note" t

• The first line of your note t

• Click OK to exit viewing/ed
the list of suppliers.

Enter incoming goods (
In some countries an invoice for in
use "supplier invoice" to mean th

Let's suppose we have just receive
Acme Pharmaceuticals, and we w
invoice looks like this:

From: Ac
B

 Item Quan P

 Amoxycillin Caps 
250mg 

1000 1

 Amoxycillin syrup 
125mg/5ml 

65 6

 Amoxycillin syrup 
125mg/5ml 

100 6



Enter incoming goods (a supplier invoice)
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In the Comment field you can type a comment or information to identify the 
invoice.

ositioned in the "Item" field. Type "a", then press 
ill be presented with a window listing all items 
 with "a". Double-click the "Amoxycillin 250mg tab/
se it. The cursor will now be positioned in the "Quan-

f units received: "1000" (Note that this is the num-
e total quantity of capsules). Press tab to advance to 

: "100." Press tab to advance to the next field.

mber: "b93333." Press tab to advance to the next 

te: "31/12/2010" (Presuming you have dates set up to 
enter as dd/mm/yy. If your dates are set to the USA's mm/dd/yy format, 
enter "12/31/10"). You only have to enter 2 digits for the year, as long as 

nge 1961 to 2060. Dates outside this range must 
red as four digits. Press tab to advance to the next 

 cost” field enter the cost price: "344"

o add, click the OK and Next button. The entry is 
 is now blank to accept your second invoice line.
Note that the margin is showing as 10 percent (the percentage that will be 
added to your cost price to obtain the selling price).

Click the new line button to add the first invoice line. You will be presented 
with the window for adding invoice lines.

the year is in the ra
have the year ente
field.

• In the “Invoice line

As we have another line t
recorded, and the window
The cursor will be positioned in the "name" field. Type in "a" and then press 
the tab key. If there is only one supplier whose name starts with "a", the 
details will automatically be filled in. In our case the supplier "Arbuckle distri-
bution" was already present, so you are presented with a window listing the 
suppliers starting with "a". Double-click the line containing "Acme Pharma-
ceuticals" to choose them for this invoice. The insertion point will jump to the 
"bill no." field.

Type "A939" into the  “bill no.” field. Press the tab key to advance to the 
“Comment” field.

• The cursor will be p
the Tab key. You w
whose name starts
cap" entry to choo
tity" field.

• Enter the number o
ber of packs, not th
the next field.

• Enter the pack size

• Enter the batch nu
field.

• Enter the expiry da

Re-numbering line

Transaction note

Copy to clipboard
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• Enter "a" into the item name field and press tab. In the list of items 
showing, you will find "Amoxycillin syrup 125mg/5ml". Double-click the 
entry.

 
on the line you wish to edit, which will now 
n it allows you to edit it. You will be shown 
 then make corrections and click the OK 

 as you have left the "print" check box 
want to print the invoice (you may do so). 
e shown two windows. The first window is 
e second window allows you to specify 
e second window also has "preview" check 
rint job)

e" it has been "confirmed" when you 
ice entry window. You can still view and edit 

the invoice details until the invoice is finalized. Note that if you issue some of 
the stock you have just entered to a customer, some fields relating to that 

re precise alternative for logging received 
 further information see Viewing and edit-
oods Receipts on page 138.
26

stock will no longer be edit-able.

NOTE - As of mSupply v190, a mo
goods has been implemented. for
ing supplier invoices created via G
• Enter the remaining invoice details for "Amoxycillin syrup 125mg/5ml":

• num units: "65"

• pack size: "60" (Note that it is better to record the actual volume of 
most packs, unless the volume is not important- for example with an 
eye-drop, where you could record the pack as "1")

• batch: "bb23d"

• expiry: "31/10/2010"

• price: "21.00" (You can just enter "21")

 Click the "OK & next" button to save the details and start to enter another 
item.

Now enter the third item on the supplier invoice from the example invoice 
from Acme Pharmaceuticals example invoice above.

When you have finished, click the OK button to take you back to the main list 
of invoices.

Our invoice will now have 3 items added to it. The invoice total should read 
"347,465"

If you have made a mistake, click 
be highlighted; double-clicking o
the line details again, and you can
button to save your changes.

Now click the OK button. As long
checked, you will be asked if you 
Note that when you print, you ar
the page setup for your printer, th
how many copies to print, etc. (Th
box, where you can preview the p

As this invoice is a "supplier invoic
clicked the OK button in the invo



Enter outgoing goods (a customer invoice)
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er "This afternoon by courier"

n to add a line to the invoice. You are presented 
e" window. 

ls:

name" field then press the tab key. In the list you are 
uble-click the "Amoxycillin 250mg tab/cap" entry.

list of available stock has appeared in the window, 
moved to the "line number" field. Enter "2" to 
 list is sorted so batches with the shortest expiry date 
ally you would choose the shortest expiry batch, but 
different!).
Type "b" into the "Name" field, and press the tab key. You will be presented 
with a list of customers whose name starts with "b". Double-click the "Blue 
Cross Hospital" entry to select it.

In the "Their ref" field enter "PO882". 

• You will see that a 
and the cursor has 
choose line 2. (The
are at the top - usu
today we're being 
Enter outgoing goods (a customer invoice)
Now let's suppose we have just received an order as follows:

Choose New Invoice from the Customer menu, and the following window 
appears:

In the comment field ent

click the "New line" butto
with the "new invoice lin

Enter the following detai

• Type "a" into the "
presented with, do

From: Blue Cross Hospital

Order number: PO882

Delivery: Express courier please

Item Quan

Amoxycillin 250mg tab/caps 10000

amoxycillin 125mg/5ml syrup 120
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field, and the following message will appear:

te” (which is likely to be your normal 
 complete the order will be drawn from 

ting with the batch which will be the first to 
wever, when you wish to override this auto-

in this event you would select “Try Again” 
rom which you wish to meet the order.

 confirmed, the "available" amount for the 
otal stc" (total stock) is still showing as 
es in the list so you can see stock that has 
as not yet left your store. You can then edit 

tly needed on the current invoice.

ng lines. You will be returned to the main 

gnore the Period and Category fields.
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Note that in the list of available stock, the second line we entered from 
"Acme pharmaceuticals" is now at the top of the list - this is because the list is 
sorted so that the item with the shortest expiry date comes to the top of the 
list.

Line 1 is selected, despite the fact that there is insufficient stock of line 1 to 
meet the order of 120. Nevertheless, you should enter “120” in the Quantity 
• Quantity field - the line we have chosen has a pack size of "100", so we 
need to enter a quantity of "100" to make a total of 10,000

Click the OK & next button to add the second line of the order.

Once again enter "a" and press the tab key. Double-click the "Amoxycillin 
125mg/5ml syrup" entry. The window will close and the list of available Avail-
able batches will be filled out. 

For this tutorial, choose “Distribu
choice), and the necessary stock to
another batch/other batches, star
expire. There will be occasions, ho
matic means of distribution, and 
and manually select the batches f

Click the OK & next button

Because the invoice has not been
line has been reduced, but the "t
"100". mSupply includes these lin
been allocated to an invoice but h
the other invoice if stock is urgen

Click OK as we are finished enteri
supplier invoice window.

For the purposes of the tutorial, i



Enter outgoing goods (a customer invoice)
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Now we are ready to print a packing slip. Click OK (make sure that "print" is 
checked). Print out your packing slip. You will notice the packing slip has a 

s.. from the customer menu.

oice number (printed on the packing slip) you can 
 list of the most recent invoices, you enter the num-
iew. As we know the invoice we want is the last one 
ust type "1" and click OK - you will be taken straight 

 icon. Click OK to confirm you want to proceed.

and you are given the opportunity to print an 

ep a record of prices that suppliers have quoted to 
 have just received 2 quotations for Amoxycillin 
e companies has used US dollars for their quota-
ed British pounds, so before entering the details of 
sary that both of these currencies are recognised. To 
enu item Special > Currencies , and this window 

Click on the New button, and a window appears which allows you to enter 

ncy field; in the Rate field you should enter the 
fault currency - in this case Nepali rupees - equiva-
column where you can write down the actual quantity packed.

Confirming the invoice:
Let's suppose the order was successfully packed according to the packing slip, 
and you now want to confirm the order and print an invoice to pack with the 
goods. (We're in a hurry - the express courier is on her way!)

Firstly, we need to look up the invoice. Here's an easy way to look up the last 
invoice you have entered: 

another currency:

Enter “USD” in the Curre
number of units of the de
At the bottom right of the invoice you will see the invoice total.

• As the customer has requested an express courier, we will charge them 
Rs200 for the service (Rs = "rupees" the currency in our tutorial). At the 
bottom of the window you will see the Other charges field:

• There, enter "Courier charge" and press the Tab key

• In the "amount" field enter "200" and press the Tab key. The new total 
should be "40,675.00"

• Chose show invoice

• If you know the inv
enter it. To bring a
ber of invoices to v
to be entered, we j
to the invoice.

Click the "confirm" truck

The invoice is confirmed, 
invoice.

Entering Quotations
mSupply allows you to ke
you. Let’s assume that you
250mg capsules; one of th
tion, and the other has us
the quotations, it is neces
achieve this, choose the m
appears:



Tutorial

lent to 1 US dollar; at the time of compiling this tutorial, the rate was 66 N Rs 
to US $1, so 71 is entered in the Rate field. Click on the OK button, and 
repeat the exercise for British pounds, the rate presently being 133.

9. Click “OK” to save the entry
10. Now click “new quote” again and enter the following details:

11. Click “OK” when you are done.

Now we can see the list of quotes. If you have done it correctly, it should look 
like this:

es into account differences in pack size and 
re suppliers.

 hope you learnt something useful.

 started" chapters in the User Guide..

to experiment with different commands as 
you read about them in the manual.

rting a new data file and using it.
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• Have a "dummy run" at sta

Supplier Gold Medical Supplies.

Currency Sterling [GBP]

Price £20.00

Pack size 1000
Once you have performed this, the Currencies window should look like this:

We’re now ready to proceed.

To enter the quotations:

1. Choose Items > Show items...
2. Type “Amox” then press enter.
3. Double-click the “Amoxycillin 250mg caps” entry from the list.
4. The item view window, on the left, has vertical content list (General,

Usage, Quotes). Click the “Quotes” line.
5. Click the “New Quote” button.
6. Note that the item is entered for us. We need to choose a supplier and

enter their price details.
7. Enter “Arb” in the supplier field and press tab. Arbuckle distribution is

automatically chosen. They have quoted in US dollars, so choose
“USD” from the currency menu.

8. Their price is US $3.50 per 100 capsules, so enter “3.5” in the price
field and “100” in the pack size field.

Notice how the adjusted price tak
currency, so you can easily compa

Thanks for doing the tutorial. We

Where to now?
• Continue with the "getting

• Use the example database 
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a
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lumns you are using.

lable columns you are not using. To add a column to 
 in the left-hand list, then click the right--pointing 

ts. You can control-click to add multiple columns at 

t the column(s) to remove from the right-hand list, 
and click the left-pointing button to move the columns back to the available 

he first column in chosen list, as it is a hidden key 
ify each row.

d name in the right hand list you can change the 

umn widths is to drag the dividers between the col-
W

W
w
an

m
w
st
h
n
n
m

W
to

C
C

stomising the columns viewed
ick the customise list button in the toolbar will display a window like this:

list. You can not remove t
column to uniquely ident

Rennaming columns
By clicking twice on a fiel
column title.

Column widths
The easiest way to set col
umns in the list view..
orking with lists

henever you do a search in mSupply that finds more than one item, you 
ill be presented with a list of records (be they items, names, contacts or 
other list) that matches the criteria you entered.

Supply uses two types of list display. Shorter lists, such as those you see 
hen you view an invoice, or view the stock for an item use a list with a 
riped background. These lists have resizable and movebale columns, and 
ve an indicator to show the sorted column. Their use is discussed in the 
xt chapter. In this chapter we are concerned with tools for handling lists of 
mes and items and transactions, which run into hundred of thousands or 
illions of records.

hen these lists are displayed, a series of buttons are present along the bot-
m of the window. The following graphic shows the item list window

On the right is a list of co

On the left is a list of avai
the view, click on the item
button in between the lis
the same time.

To remove a column selec



Working with lists

Note that if the total column width is too wide for the window, a horizontal 
scroll bar is added to the list allowing you to view columns to the right of 
those displayed.

e depending on which type of records you 
items. To order by a particular field, double-

n_hand” field the window will look like 

ht, or click the right-pointing arrow after 

y adding further fields to the right-hand 
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(You can also drag fields to the rig
highlighting the field on the left)

You can order by multiple fields b
list.
Choosing the column order
To change the order of column in a list, drag the column header to a new 
location. (This is done when viewing the list, not in the customise list view 
window.

Viewing or editing a particular record
To view or edit a record, double-click the row in the list you wish to view. A 
new window will open showing the details of the record you clicked.

Ordering (Sorting) lists
Ordering a list is the same as sorting it. We will use “ordering” from now on.

Any column that has a blue heading can be ordered by clicking on the blue 
column heading. The column will be sorted in ascending order. Ascending 
means:

• A > Z (upper and lowercase are not considered different)

• 1 > 2 > 3 for numbers

• earlier dates to later dates

Descending means the opposite of Ascending.

Note that ordering a list does not add or remove any records from the list. It 
only changes the order in which the records are displayed.

Clicking the Order by button shows the order by window:

The Available Fields list will chang
are viewing. The list shown is for 
click it in the left-hand list.

If we double-click on the “stock_o
this:
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33

Using this formula would allow you to identify items whose item code is 

ve there is a Find button.

le find window where you can enter the start of the 

e has a Complex find button. This allows you to per-
e criteria. Clicking this button shows the query edi-

 are three areas from which you have to choose or 
f a query.

to find all items whose default pack size is greater 
 starts with “A” we would undertake the following 
shorter than your organisational specifications.

Click the OK button to close the window.

Once the details are entered, click the Order by button to order the list.

Finding records
In this user guide the terms find and query are used interchangeably

Within this window there
set a value for each line o

1. Available fields
2. Comparisons
3. Value

For example, if you want 
than one and whose code
steps
To change to ascending/descending ordering
Each item in the “Ordered by Fields” list has a small triangle to the right. If 
the triangle is pointing up, the ordering will be ascending. If pointing down, 
it will be descending.

To change the direction, click on the triangle.

To remove a field
Highlight the field in the left-hand column, then click the red left-pointing 
arrow between the two lists. The double left-pointing arrow will clear the 
“Ordered by Fields” list

Using formulae
If you wanting to order by a formula, click the Add formula button. In the 
following graphic the formul window is shown, and the formula 
“Length([items]code)” has been entered.

In the item list shown abo

This button shows a simp
item name or code.

Complex finds
The window shown abov
form a find using multipl
tor



Working with lists

1. Click on “default_pack_size” in the available fields list.
2. Click on “is greater than” in the Comparisons list
3. Enter “10” (no quotes) in the value field.

code starts with “a”

is very small. 

When a blank query window is first shown, you can re-use a previously saved 
query by clicking the Load... button and locating the query file.
34

If you wanted to find items that matched either one of the criteria we 
entered, we would click on the second line in the top list and then click on 
the “or” button at the bottom left of the window.

Saving and Using saved queries
If you think you will use a complex query again, click the Save... button. You 
will be asked to choose a name and location to save the query. The saved file 
4. Click the Add line button
5. Scroll down the available fields lists then click on “code” in the avail-

able fields list.
6. Click on “is equal to” in the Comparisons list
7. Enter “a@” (no quotes) in the value field.
8. Click the Query button to perform the query.

Before step 8, the window would look like this

The top area of the query editor shows a summary of the query that is about 
to be performed.

Note that we have used the wildcard character “@” to match all items whose 
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r
o

rer, choose Supplier > New manufacturer from the 
N

A
In
o
g

A
To

To
(M
 add a new supplier, choose Supplier > New supplier from the menu. 
akes sense really!)
ames: using, adding and editing

bout names
 mSupply a "name" can be a customer, a supplier, a manufacturer, plus all 
 none of the above. (Note that a "customer" can be anyone you supply 
ods to- e.g. another organization, or a ward in your hospital, or a patient)

dding a Customer, Supplier or Manufacturer
 add a new customer, choose Customer > new customer from the menu.

To add a new manufactu
menu:



Names: using, adding and editing

Items in the names entry window

Name: Code

• Note that if you do not wish to use different name codes and charge 
codes, check the "supplier name code and charge must match" and 

Name
The customer/supplier name. (Remember you can use the Tab key to move 
from field to field)

e 3 check boxes to mark each entry as a cus-
er.

t be used for receving or issuing goods.

 will fix a certain price for that Supplier or 
e is entered in File >Preferences > Prices. 
his customer, the selling price increased/
ified in the preferences for this price cate-

 B and in the prefernces category B is 
issued to customer XYZ that has a normal 
ce on this invoice will be $15.

we think....)

rate delivery and billing addresses.

 categories that you have assigned using 
tomer > Show categories.

gether certain types of customers or suppli-
lecting the group in the “Analysis“ field.

Postal address
ss if it is different to the physical address of 

icular customer as in the above “New cus-
 alphabetically sorted in printed customer 
l override the “Sort by line number” and 
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"customer name code and charge must match" check boxes in the 
mSupply preferences. If you do this, the charge code will be automati-
cally synchronized with the name code.

The "customer" or "supplier" check boxes will be checked as appropriate, 
depending on whether you have chosen "new supplier" or "new customer" 
from the menus to produce this window. However, you can still alter things 
here without upsetting mSupply. 

Here you can enter a postal addre
the supplier.

Print invoices alphabetically
If you check this button for a part
tomer window”, item lines will be
invoice for that customer. This wil
The unique code to identify this customer, supplier or manufacturer.

Charge to
mSupply is made to work in tandem with an accounting program (Although 
it will also function just fine by itself). The "charge to" is the code that is 
exported with each invoice. Generally you should make the charge code and 
name code the same (If you want, there is an option in the preferences to 
make sure this is the case). For example:

• If you have for example, 3 hospitals you supply, but you send the bills to 
the one place for payment, you may want to enter each hospital with 
its own name code, and all of them with the same charge code. In your 
accounting program you would just enter one debtor (customer) with a 
code the same as the charge code. eg

• In your accounting program you would enter "Blue Hospitals Assoc" 
with the code "bluehos"

• For a supplier, if you have entered a default currency and margin these 
will be entered, but you can override them. Every supplier should have 
a currency entered against it (The currency it uses for you invoice(s). If 
the currency isn’t yet in your system, close the name entry window and 
choose "currencies" from the "special" menu to add a currency.

Type:
In the main entry screen, there ar
tomer, a supplier or a manufactur

Restriction: Hold checkbox
If this is checked this name can no

Price Category
Selection of any of the categories
Customer.The price category valu
When goods are being issued to t
decreased by the percentage spec
gory. 

Eg: If customer XYZ is in category
assigned value of 50. If an item is 
selling price of $10, the selling pri

Address and contact details
These are fairly self-explanatory (

For customers, you can enter sepa

Category
This drop-down list shows a list of
Supplier > Show categories or Cus

Analysis
You can use this field to group to
ers. You can filter the report by se

Hosp name code charge code

Fred H Hosp fhhosp bluehos

Mary P Hosp mphosp bluehos

Sam Q Hosp sqhosp bluehos
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e field empty, youcan also click the OK button to 
ers. Note that the window has a series of radio but-
 the target of your search to customers, suppliers, 

es.

If the text you entered matches more than one customer, a list of matching 
names is shown.

 list window

s you to print address labels for the names in the 
played.

rint a list similar to the one displayed on screen.
Editing a Customer, Supplier or Manufacturer
For this example we will edit a customer. Editing a supplier is just the same, 
except that you can start by choosing Show supplier from the supplier menu.

Choose Customer > Show Customer.  You are presented with a window to 
enter as much of the Customer name or codeas you know:

Buttons in the names

Labels
Clicking this button allow
list. The label editor is dis

Print
Clicking this button will p
“Sort by shelf location“ set in Preferences > Printing. 

Extra information for customers only.

Shipping address
If the name is a customer, shipping address fields will be shown.

Extra information for suppliers only:

Supplier Details: Currency
Enter the currency code of the currency this supplier uses for invoicing you.

Margin
Enter the percentage margin to apply to items received from this supplier.

Freight factor
Enter the amount to add to quotations from this supplier to adjust quoted 
prices for freight. Note that if suppliers quote you "CIF" prices, then you 
should enter "0" here. An example: by looking back on invoices from IDA, we 
see that freight to Nepal generally amounts to about 15% of the net value of 
the invoice. There we enter "1.15" in this field for IDA.

About Manufacturers
When you are receiving goods, you can optionally specify the manufacturer 
of each item. Manufacturers can be chosen from a list that is made up of 
names who have the “manufacturer” checkbox checked.

For the manufacturer field to be shown, the option must be turned on by 
marking the “show manufacturer field on supplier invoices” option on the 
“invoices 1” page of the mSupply preferences.

If you leave the name/cod
get a full list of all custom
tons on the left to change
manufacturers or all nam
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Find
This button shows the same find window as choosing the menu item did so 
you can find a different group of names.

ce directly from this window. To do so, dou-
dit. A new window will open with the 
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Options for the invoices tab:
Order by
This button allows you to sort the displayed list by the criteria you choose. 
The Labels and Print buttons will use the order that is displayed. By default 
names are displayed alphabetically based on the name column.

Flags
This button allows you to mark certain names with a flag.

Firstly, highlight the names you wish to flag by holding down the control key 
(command on Mac) and clicking the names in the list you wish to use. Then 
click the Flags button to show a window where you can enter the flag you 
wish to add, and decide whether to replace any existing flags or append the 
new flag to the old one.

Editing or viewing a name
To edit/view a particular name, double-click the entry you want from the list. 
You will be shown a window where you can view the customer details. Dou-
ble-click a line to view details for that customer or supplier.Note the window 
displayed has "tabs" (buttons) along the top edge called "Invoices", "Backo-
rders", "Quotes" ;"notes";”contacts”;”Emails”;”Group”;”Purchase order” 
and “Website login”.

If you want a list of all customers or suppliers, click the find button without 
entering anything in the search field.

The Invoices tab
Here you can view the invoices for a customer or supplier.

You are now able to edit an invoi
ble-click the invoice you wish to e
invoice details displayed.
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nd edit the backorders for a customer name. mSup-
rders against suppliers as well, but we are not sure 
o this!

rders tab:

nts you with a window where you can add a backo-
r. 

ion of the item code or item name, then press the 

matically entered. You can change the date if you 

ntity owing.
• Type at least a port
tab key.

• Today's date is auto
like

• Enter the total qua
Print Range
Click this button to print a range of invoices for a customer. You will be asked 
to enter the first and last invoice numbers to be printed.

Aging
Clicking this button displays a list of aging categories and the outstanding 
unpaid balance for each invoice in each category.

Dates
Choose a date range from this menu to quickly show recent invoices, or to 
revert to showing all invoices

 The Backorders tab

Here you can view, add a
ply allows entry of backo
why you would want to d

Buttons on the backo

New backorder 
Clicking this button prese
rder line for this custome
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• Enter a comment (e.g. an expected arrival date)

• Click OK to save changes and exit the window.

The Quotes tab

 you have entered in mSupply for  this sup-

otes.

tes is shown.

,000 characters.
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Here you can view, add and edit n

A list of the first line of current no

The text of a note can be up to 32
Delete backorder
Click a backorder line to highlight it, then click this button to delete the line.

Copy
This command copies the backorder to the clipboard, allowing you to paste 
the report into an email message, word processor or spreadsheet document.

Print
The list of backordered items for the customer is printed.

Double-click a backorder line to edit the line. You will be shown the backo-
rder entry window, where you can change any details you wish.

Show:
This drop-down list allows you to choose which backorders to display.

• Backorders are normal items that have not been supplied to customers.

• Ad Hoc items are items that customers have ordered that you do not 
want to add to your stock list, but would rather make a special order 
just for that customer.

Here you can view the quotations
plier.

The Notes tab
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ree Palm Desktop (for Mac & Windows) can be 
w.palm.com

he right is a way of marking contacts. You can then 
-set of your contacts (e.g. those to whom you want 
sletter).

n the contact you wish to delete, then click the 

ails that have been associated with this name.

ail” button to compose a new email to this name. 

n its line to highlight it, then click the “Delete 
email” button.
Note: mSupply is not designed to function as your main source of all contact 
information- it is only designed to keep simple information about customers 
and suppliers, and people within those organizations. 
If you want more complete contact management there are many software 
To add a new note, click the "new note" button, enter the details, then click 
the OK button.

To edit or view a note, double-click on it.

To Delete a note, click on it, then click the "delete note" button.

The Contacts tab

To add a contact for this contact or supplier, first click once in the list of con-
tacts. The Add contact button will be highlighted. Click the button, then 
enter the details in the window that is shown.

programs available. The f
download from http://ww

The yes/no check box on t
use this field to find a sub
to send a price list or new

To delete a contact, click o
"delete contact" button.

The Email tab

This tab displays all the em

You can use the “New Em

To delete an email, click o
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The Group tab The Purchase Orders tab

 orders for the current name. If you are 
opefully) be empty!

ccess their order information using the 
ndow where you assign a logon name and 
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If you are allowing customers to a
mSupply web server, this is the wi
password to a customer. 
This tab displays the group information for the current customer. Groups are 
only relevant to customers, not suppliers.

Here you can select the group of which a customer is a member. When you 
choose a group, you will be shown a list of item departments which are 
linked to the chosen group. Once the group system is activated in the prefer-
ences, only items belonging to one of the listed departments (or items with 
no department) will be able to be supplied to that customer. 

This tab shows a view of purchase
viewing a customer the list will (h

The Website login tab
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o

iting or viewing just about any information about 

with a window asking you to enter either as much 
 as you know:

r press "return" when you want to proceed. If only 
will be taken straight to the item details, otherwise 
f matching choices. An item is considered to have 
 or item code starts with the characters entered.

 gives you access to a more powerful query editor 
 specific set of items. See the custom report section 

ter for a more detailed description of the query edi-

arch, enter an “@” sign before the text. E.g. enter-
ems with “250” anywhere in their name.

ms, click the find button without entering anything 
I

A
ev

M
co
ti

T

tems

n item in mSupply is usually a product that you purchase and supply. How-
er, there are also other types of items

• A service item has no stock, but can still be added to customer invoices 
and charged for. Examples of a service item might be a freight charge 
or a consultation fee.

• A cross reference item points to another item, so that when it is chosen 
in a list, it is substituted with the item it refers to. This allows you to 
have items in your system that are referred to by trade name, but are 
only issued according to their generic name.

anaging items is mostly done from the Item menu. This menu also contains 
mmands for managing lists related to items such as accounts, drug interac-
ns and units.

he Item Menu

Show items....
Use this command for ed
an item

Firstly you are presented 
of the item code or name

Click the “Find” button o
one item was found you 
you will be shown a list o
been matched if its name

The Complex find button
where you can find a very
of the Report menu chap
tor.

(Tip: to do a “contains” se
ing “@250” will find all it

If you want a list of all ite
in the search field.



Items

You will be shown a window like this:

We reccommend you use a single character (or two) as the flag.

If you choose “Append to existing flags, any items with existing flags will 
have the new flag added to the end of the flag. If you choose “Replace exist-

s will have their flags cleared. Note that you 
electing all items (control - A) then leaving 
king “Replace existing flags”, and then click-

the standard Order by window, where you 
ayed items by.

ntly displayed items in a list.

ind window, the same as if you had chosen 

or the first record that is highlighted. Click-
the item details window will jump to the 
ght multiple records, hold down the control 
 click on the records you wish to highlight.

indow where you can choose which fields 
 the list view. For further information see 

th a vertical list along the left side. Click on 
iled information about an item.

If you make changes that you don't want to save, you can click cancel. Note 
ade to quotes, notes and backorders will 
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however that changes you have m
be saved, even if you click Cancel.
Double-click the item in the list that you want to view. 

Other Buttons in the item list view 

Report
Click this button to open a report editor window where you can design a 
report. The report will use the currently displayed records (not the high-
lighted records).

Set flags
A flag is a quick way of identifying a group of items for use in a report.

You can set and remove flags for multiple items at the same time. To do so, 
hold down the control key (command key on Mac) and click on the lines you 
wish to flag. They will become highlighted. Then click the “set flags” button. 

ing flags”, then the selected item
can clear all flags for all items by s
the “Set flag to..” field blank, clic
ing the OK button.

Order by
Clicking this button will bring up 
can choose fields to sort the displ

Print
Click this button to print the curre

Find
Clicking this button displays the F
Items > Show items.

Modify
Click this button to show details f
ing the “OK and next” button in 
next highlighted record. To highli
key (command on Mac) while you

Customise list
Clicking this button will show a w
from the items table are shown in
Working with lists on page 31.

The Item Details WIndow
The item details are presented wi
the appropriate item to view deta
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This is the code assigned to the item. 

n be able to change the field contents. If not, you 
 user permissions for each user by choosing 

s

 to a department by choosing from the list of 
up departments, use the show departments... com-

 item will not be available to be issued on invoices. It 
t you will get a warning if you choose it when issu-
uired to choose a different item. Note that this 
he item; should you wish to hold selected batches 
tock from the options list on the left, and in the 
ox for the particular batch/batches to be held.

an that the item cannot be issued on customer 
sed in manufacturing. This is to stop someone acci-
terial on a customer invoice (for example, items 
old in an unprocessed state).

 be selected using the drop down list. Item catego-
il later in this chapter. For further information see 
n page 71.

interaction group for the item. We recommend you 
base interaction groups on ATC code groupings available from <www.dru-
gref.org>

 groups by choosing file > manage drug interaction 
ation see Manage Drug interaction groups on page 

n receiving
n you receive items the pack size will automatically 

 is primarily for use in dispensary mode, but may be 
too.

ive 50 x 100 boxes of Paracetamol, but you issue var-
To change an item code, you must click on the lock icon first, and then enter 
the new code in the field.

Units
Choose the unit you use for this item. It is useful to distinguish items you issue 
by pack (eg eye drops) from items you issue by volume (eg oral liquids)

What are those lock icons?
Before you can edit an item’s name, code or units, you need to click the small 
padlock icon to the left of the field. If you have sufficient user permissions to 

You can set up interaction
groups. For further inform
68.

Convert pack to one whe
If this box is checked, whe
be converted to “1”. This
useful in other situations 

For example: say you rece
Item Edit - General options

Item name
You cannot edit the item name directly. Rather, click on the lock icon next to 
the item name, and enter a new name in the window that appears. Note that 
you should never change the name of an item to a completely different item 
here. As of version 1.5 of mSupply, historical records will still record the cor-
rect name, but invoices in process will pick up the new name when you edit 
an invoice line.

Item code

edit the field, you will the
will be alerted. You assign
File>Edit users and group

Department
You can assign each item
departments here. To set 
mand in the item menu.

Hold: do not issue 
If this box is checked, the
will still appear in lists, bu
ing stock, and will be req
applies to all batches of t
only, you should choose S
Hold column, check the b

Issue in builds only
Checking this box will me
invoices- it may only be u
dentally issuing a raw ma
which by law can not be s

Category
The item category should
ries are explained in deta
Show item categories... o

Interaction group
Here you can choose the 
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iable amounts of paracetmol on invoices. If this option is checked, as you 
receive the stock on a supplier invoice, it will be converted to 5000 (quantity) 
x 1 (pack size). You will now be able to issue any quantity you like. The cost 

Volume per pack

enter a volume as millilitres (ml), litres (L) or cubic metres (m3)

sed to store bulk quantities of goods/items. 
20 characters) to identify the place where 

er of items present in one pack (outer).

 standard outer pack. This may be different 
e per pack you entered above, as outer 
g. (For example, vaccine packs may come in 

isplayed here; most users will be using a sin-
t relevant. For users managing more than 
e selected from the drop down menu. For 

nd wishing to work with the cumulative 
ill show “Supervisor mode”. Such users may 
ey so wish.

This is the margin that will be applied to this item on supplier invoices to cal-
 supplier margin is also set, there is a setting 
ces) that determines which margin will be 
lling price is set, this price will be used 

t a fixed selling price for this item. Enter 

You enter Value displayed mSupply stores

ml 0.00003 m3

5 m3 1.5 m3

0 L 0.6 m3

5 L 0.0015 m3
46

If you are using available volume tracking in your warehouse, then fill in the 
default volume for one pack of the item here.

Note that mSupply always stores volumes as m3 (cubic metres), but you can 

culate the sell price. Note that if a
in the preferences ( file | preferen
used. Note also that if a default se
rather than the margin.

default sell price
Only enter a price here if you wan
and sell price are automatically adjusted for the new quantity.

Shelf Location
Type as much of the location (ie the first few characters) or code as you know, 
then press the Tab key. If only one location code matches your entry it will be 
filled in automatically, otherwise you will be shown a standard choice list like 
this:

Select the location you want by double-clicking a line or by clicking once on 
the line and then clicking OK

Note that each batch of stock can have its own shelf location. When you 
receive items into stock, they will be given the shelf location you enter here 
unless a different location is chosen.

Bulk shelf location
Similar to shelf location but it is u
You can enter a code here (up to 
the item is stored.

Outer pack size
This field is for entering the numb

Outer pack volume
Here you can enter a volume for a
to an exact multiple of the volum
packs may have their own packin
an insulated container.)

Store
The store which you are using is d
gle store and this paragraph is no
one store, the desired store may b
users having access to all stores, a
data from them all, the display w
also access a single store should th

Pricing option: default margin

30ml 30

1500L 1.

600 L 60

1500 ml 1.
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the list, you will be returned to the list or the initial menus, depending on 
your starting point.

ns
s settings for cautionary warnings used when dis-
counts used when exporting transaction informa-

 a standard list. This list is set up using the Special > 

 add a warning for the item.

ble-click on its line then click the “Delete” button.

han one warning, the warning that has priority will 
on the label. You can add other warnings as part of 
uired.
Delete Item
If an item has no transactions, quotes, order lines or backorder lines, it can be 
deleted using this button.

In other words, once you have received stock for the item, you can’t delete it. 
You can delete an item immediately after you have created it or imported it. 
Note that if you have imported an item and stock, you can delete it, and it’s 
associated stock will be deleted too (but not once it has been used in a trans-
action such as an invoice or build).

To delete a warning, dou

When an item has more t
be automatically printed 
the label directions if req
the price for one unit (eg 1 capsule or 1 gm). A price entered here will over-
ride an margins you have specified for either the supplier or the item.

User fields 1, 2 and 3 & 4
You can use these fields for your own data. You can (query) search for items 
with a particular value or range of values in this field when producing a cus-
tom report

To set the names of the user fields, choose File > Preferences and click on the 
“Misc” option in the left hand list.

Catalogue code
Frequently organisations may apply a second code to an item - e.g. one for 
auditing purposes, in addition to one for general use. This field allows the 
entry of such a code.. Provided the Include catalogue code for each item box 
is checked under Preferences > Misc, a report on Catalogue codes may be pro-
duced.

Buttons in the item details window

Cancel
Exits the window without saving changes. (Note that changes to other infor-
mation you have made such as editing a backorder, adding a quote etc. will 
be saved).

OK
Saves changes then exits the window.

OK & Next
Saves changes, exits the window, then brings up the next item in the item list. 
If you did not have an item list open, or if you have reached the last item in 

Item Edit- Misc optio
This window currently ha
pensing medicines and ac
tion.

Warnings
Warnings are chosen from
Warnings menu.

Use the “New” button to
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To set a warning’s priority, double-click its line in the list

onth there is a popup menu to choose from 
value the average usage and the standard 
on will be shown.

 the usage with transactions that were 
ow (this applies to multi-user mode). It also 
h or without build transctions included in 
r or not the “include builds” checkbox is 
48

The Usage tab allows you to view the item usage per month for the previous 
24 months. This information is very useful for quickly spotting a trend in 
usage for a particular item.

Show Graph button
Clicking this button shows the same information in a graphical format.
Accounts
You can set the general ledger account to be used for exporting purchase and 
supply transactions involving this item here.

To set each account enter a portion of the account description or code and 
press the Tab key. You will be shown a standard choice list if more than one 
account matches what you typed.

Item Edit- "Usage" 

Below the list of usage for each m
1 to 24 months. After choosing a 
deviation for the period in questi

Refresh usage button
This button allows you to update
added since you opened the wind
allows you to show the usage wit
the totals, depending on whethe
checked or not.
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 of a stock line.It also gives you total and available 

 hold check-box. Once an item is held, it cannot be 
n the available stock window, but held lines will 
old column, and if a user attempts to issue the line 
t the line is on hold. Note that the Hold: do not 
al options takes precedence, and if that option is 
ay be issued, regardless of batch.

pplier and customer invoices for the item batch 
e this window to view immediately the list of cus-
pplied with this particular batch.

he lines that are still in your data file, but which 
 you can think of a use for this information, please 
ick the button the button title changes to "hide 
you to get back to the info you really wanted.

 the stock options page

ish to keep on hand. Note that you do not need to 
Show zero lines 
This button will show all t
have no stock on hand. If
let us know! When you cl
zero lines", which allows 

Other information on

Minimum stock
The minimum stock you w
Item Edit- Stock options

The "Stock" tab shows the lines of stock for this item.

Editing a stock line

To edit the cost price and selling price for an item line, double-click the line 
you wish to edit. Note that only users in the level 1 or level 2 access groups 
are permitted to edit stock lines.

The Stock tab 
This tab shows the details
quantity of a stock line.

Hold batches
To hold a batch check the
issued. It will still appear i
have a check box in the h
they will be informed tha
issue option in the Gener
checked, then no stock m

The Ledger tab 
This tab shows a list of su
being viewed. You can us
tomers who have been su
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enter a quantity here for mSupply's ordering system to work. In fact, it is bet-
ter in most cases to leave this number set to zero. This field should only be 
filled in if you absolutely must keep a minimum on hand. For example, if you 

Indicative price
The price for the item that will be used when you produce a price list

ll be used when you produce a price list

 transactions for the item in question.

You can use the "Show...." menu to show:

me (click on a transaction line for the name 

10 2

15 2
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Price List 

On Price list
If this box is checked, this item will be included when a price list is produced.

• Only supplier transactions

• Only customer transactions

• Transactions for just one na
you are interested in)

20 4
stock naloxone for narcotic over dosage reduction, and even if you only use 1 
vial every year, you have decided you need to keep five vials on hand, you 
would enter "5" as the minimum quantity for naloxone.

Stock on hand
The total stock of this item on hand.

Stock on order
The total quantity of stock of this item on order from suppliers

Analysis
This is the value of the last item ranking analysis. The figure represents the 
value of sales for the item for the last analysis period.

Qualifying quantity
The minimum quantity to be supplied before bonus stock is given.

Bonus quantity
The quantity of bonus stock to be given when the qualifying quantity is 
reached.

Bonus price 
If your bonus stock is totally free, leave this field as "0". If you charge a sur-
charge on bonus stock of (say) 5% of the original price, enter "5" here.

For example, if you enter a qualifying quantity of 10 and a bonus quantity of 
2 the following bonus stock will be given:

Report pack
The pack size for the item that wi

Item Edit - Ledger options

The item "Ledger" tab lists all the

Drop-down lists

Order quantity Bonus quantity

9 0
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ifferent suppliers, or even different prices from the 
 pack sizes.

are quotes, there are several factors that need to be 
tering the information in mSupply you are able to 
hese factors have been taken into account, and you 
ns from each supplier.

ack size in your local currency, taking into account 
 exchange rate.

for your "preferred pack size" you have entered for 
ce allows for a direct comparison between suppliers. 
he "preferred pack" for an item, all your quotes will 
 new pack size.

in the list of quotes to bring the cheapest quote to 

tton. The quotes input window will open
A quotation is a record of a price you have been given by a supplier. For each 
item you can have multiple quotes recorded, reflecting different prices you 
• Transactions for one particular item line. This will show the supplier 
invoice on which the item line was received, and all subsequent issues 
of that item line to customers. This can be useful for tracing a particular 
batch of medicines.

Tip: Clicking on the column headings of the transaction list will sort the list by 
the information in that column. The column header will be underlined to 
show by which column the list is sorted.

Note: If the cost price column is blank, this is because the current user does not 
have permission to view cost prices. (This option can be turned on or off for 
each user from the “File > edit users…” menu item).

If you want to view an invoice for one of the displayed lines, simply double-
click the line you are interested in. The invoice (or payment, as the case may 
be) will be shown in a new window.

Print 
Clicking this button will give you the choice of printing either the information 
currently displayed in the window or a complete ledger from the start of your 
year (along with the current stock and a running total of stock on hand)

Item Edit- Quotes options

have been quoted from d
one supplier for different

When you come to comp
taken into account. By en
find the best price once t
build a history of quotatio

Cost
Cost is the price for that p
the freight factor and the

Adjusted cost
Adjusted cost is the price 
that item. This second pri
Note that if you change t
be updated to reflect the

Comparing quotes:
Click "Adj cost" heading 
the top of the list.

Add a new quote
Click the "new quote" bu
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quoted price (i.e. prices are "CIF"), the freight factor for the supplier 
should be set to "1". If your supplier adds freight that amounts to 

Preferred 
This check box allows you to identify one (or more) suppliers as the preferred 
supplier for the item. One of the ordering methods uses the "preferred" 

 should be considered for ordering from a 
ng chapter for more details.

 transfer, you must use this field to record 
plier uses on their electronic invoices.

 identifier for this product.

 a price break along with the percentage 
quantity is reached.

pack (outer pack) and the freight for that 

ancel if you decide not to add a quote for 

 edit.

an change the date, the supplier, the price, 
x, or the "preferred" check box.

 wish to delete

utton.

• Confirm that you want to proceed.
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about 15% of the invoice price, set the freight factor to 1.15.

Strip pack
This check box allows easy identification of quotes that are for strip/blister 
packed items (as opposed to "loose" items). 
• Type as much of the supplier code as you know, then press the Tab key- 
you will be presented with a list of suppliers if there is more than one to 
choose from.

• Enter the price and the pack size in the currency you have been quoted. 

• Note that the currency and freight factor are filled in with the informa-
tion you have entered for the supplier. 

• If the supplier has quoted in a different currency to the supplier’s 
default currency, you can change the currency for this quotation from 
the drop-down list on the right.

• The freight factor is the factor you need to add to the supplier's prices 
to account for delivery costs. If your supplier includes these costs in the 

check box to indicate which items
particular supplier. See the Orderi

Supplier code
If you are using electronic invoice
the code for the item that this sup

Supplier bar code
Here you can record the bar code

Price Break
Enter the quantity that generates
discount that will apply once this 

Freight
Enter the value for the preferred 
pack provided by the supplier.

Click OK to accept the details, or c
this item.

To modify a quote:
Double-click the line you want to

In the window that appears you c
the pack size, the "strip" check bo

To delete a quote

• Click on the quote line you

• Click the "Delete quote" b
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es for an item here.

 to add a note. A note can be up to 32,000 charac-

k the note in the list you want to edit.

eft corner of the note editing window with “Dis-
p-down list:
• Enter part of the customer name, then press Tab to search for the cus-
tomer.

• Enter the order date, quantity and any comment, then click OK the save 
the new backorder entry.

To delete a backorder, click the line you wish to delete, then click the Delete 
backorder button.

The total stock on backorder is shown below the list.

To edit a note, double-clic

Notice that in the lower l
play” label, there is a dro
Item Edit- Backorders options

You can view the backorders for an item here. To edit a backorder, double-
click the line you wish to edit.

To add a new backorder for this item, click the New backorder button. This 
window will be shown:

Item Edit - "Notes" 

You can add and edit not

Click the new note button
ters.
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will allow you to incorporate transactions entered even if a power failure has 
occured. In normal use ,with a UPS, mSupply will automatically save data and 

Note too that if your user permissions do not allow you to add and edit Bills 
of Materials, this option may not be available.

erials for the item if it is a manufactured 
 have checked the “Use a Bill of Materials 
ox, when you enter a new build, it can be 
orrect materials (ingredients) and the cor-
manufactured.

s Options page:

cture this item 
e bill of materials (if one has been entered) 
ring builds.

This button allows you to add items to the bill of materials. 

this:
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you will not see an error here.

Item Edit - “Bill of Materials” options
(This option may not be showing if you do not have a registration for mSup-
ply that enables manufacturing, or the buttons may be dimmed so you can 
not make entries if your user permissions do not allow you to view Bills of 
Materials.)

You will be shown a window like 
Use this list to set the text of the note to display as an alert when this item is 
issued on a customer invoice, received on a supplier invoice, or choose “all” to 
have the message display for both customer and supplier invoices.

Item Edit - Reconcile options

Clicking the "reconcile" button will give a summary of usage.

It is useful for checking mSupply is working like we claim it does! If you get an 
error here it is most likely due to your using mSupply when a power failure 
occured. In multi-user versions we are able to provide you with a log file that 

Here you can specify a Bill of Mat
item. Once you have done so, and
to manufacture this item” check b
automatically filled out with the c
rect quantities for the total to be 

Items on the Bill of Material

Use a bill of materials to manufa
If this check box is not checked th
will not be used when manufactu

New ingredient
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ions

and then enter the same code when creating a new 
luate the items with that code for ordering. 

Never order this item 
If you have items that are "one-offs" or have been discontinued, use this 

ppearing in orders. 

d, you can not receive this item. This can be useful if 
g a different item, and you do not want people to 
dant item.
The dropdown list beside “Show” is used to display all the orders or sug-
gested orders or confirmed orders or finalised orders for the particular item.

check box to stop them a

Hold: do not receive
If this check-box is checke
you have changed to usin
accidentally use the redun
Enter the start of the item name or code then press the Tab key. If only one 
matching entry is found, you can then enter the quantity. Otherwise you will 
be shown a list of matching items. Double-click the item you wish to use.

Click the OK button when you have finished, and the item will be added to 
the bill of materials for the item you are editing.

Note: Be careful to enter quantities corresponding to the units you have speci-
fied for the item. 

Delete ingredient
To delete an ingredient, first click on the ingredient you wish to delete so 
that it is highlighted, then click this button.

Print 
This button allows you to print the bill of materials that is displayed.

Quantity of finished product this bill of materials is for
This is the total quantity of this item that will be produced by the bill of mate-
rials that is entered for the item. Be careful to set this quantity and the units 
correctly.

Item Edit- Order options

Item Edit - Order Opt

Ordering: Supplier ref
Enter a code in this field, 
supplier order only to eva



Items

Item edit - Dispensing options

• Update the default directions if you change any of the abbreviations.

Delete button
Click a line, then click this button to delete directions you no longer need, or 
if you have made an error.

han field
 have the user warned if they try to dis-

n the WHO Essential Drugs List.

em categorization system such as ATC codes

DDD value
y dose of the item. For example, doxycy-
 the DDD value for Amoxycillin is 1g. DDDs 

ntity of treatments of a drug or class of 

he number of units of the item that make 
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Add button
Click this button to show a window where you can add directions. You can 
enter any combination of directions and text. (Abbreviations are managed by 
choosing Speical > Abrreviations.)

The DDD value is the defined dail
cline’s DDD value is 100mg., while
give a way of calculating the qua
drugs given to a population.

DDD factor
Defined Daily Dose factor- this is t
Here you can set the default directions for an item that is being dispensed. 
The priority one direction will be entered for the item automatically when 
you dispense it. 

If there are directions with a priority of 2 or more, they will be available from 
a drop-down list when dispensing the item. Note that even if you set up 
default directions, you can override these at the time of dispensing, either 
with longhand text or by editing the abbreviation that has been entered.

Warning: If you choose to use this option be very careful to:

• Inform other users that default directions have been entered.

• Ensure the directions are appropriate.

• Check each prescription dispensed, and change the directions if the pre-
scription has different directions to the default set.

Warn if user tries to issue more t
You can enter a number here and
pense more than this quantity.

Item Edit- Reporting options

Reporting: Essential drug list 
If this box is checked, the item is o

Category 
This field should be used for an it
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codes in order to use mSupply).

 item will be included when you produce price lists.

size that you use for comparing quotes from suppli-

he list. 

 using the menu command Item > Show item cate-
ation see Show item categories... on page 71.

ion (ie the first few text characters) or code as you 
 key. If only one location code matches your entry it 
ally, otherwise you will be shown a standard choice 

ant by double-clicking a line or by clicking once on 
 OK

 is on your Essential Drugs List
• The "code" field should start with the first three letters of the item 
name 

• The item name should not be the trade name of the item, and should 
start with the most obvious and broadest description.

• eg a "brody forcep" should be entered as "forcep, brody". "aqueous 
iodine" should be entered as "iodine, aqueous"

If you think the item should appear in the published price list, then check the 
appropriate box. 

Select the location you w
the line and then clicking

Essential drug
Check this box if the item
up the DDD value. For example, for amoxycillin 250mg capsules the DDD fac-
tor is 4. For Doxycycline 100mg tablets it is 1

ABC category
This option allows you to mark items that are commonly used and then 
report on only those items. For further information see ABC analysis... on 
page 179.

New item.
Use this command to add new items. (It is not for adding actual stock- just 
details about an item)

You will be presented with a entry screen.

Here are some suggestions for making things systematic. (You are at liberty to 
ignore these suggestions, as you do not need to know or remember item 

Price list
If this box is checked, this

Reference pack
This is the standard pack 
ers. 

Category
Choose a category from t

Item categories are set up
gories... For further inform

Shelf location 
Type as much of the locat
know, then press the Tab
will be filled in automatic
list like this:
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ATC Category
Here you can enter category information. mSupply works best with the ATC 
classification system, but other systems can also be used.

ild by double-clicking on it.

s you have manufactured. That is, raw 
e used (taken out of stock), and a new stock 

ply version that allows use in manufactur-
. 

On choosing this menu item you are shown the build entry window:
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DDD value
The Defined Daily Dose for this item. This is a text field, so you can enter the 
units as well (eg "1g" or "250mg")

DDD factor
The DDD for this item divided by the strength (eg if the "DDD" is 1000mg, 
and the strength is "125mg", you would enter "8")

Pressing OK will accept the details and allow you to add another item.

If you don't want to add more items, press cancel. Items previously added are 
still saved- just the details showing on the screen are not saved.

Show builds...
You will be shown the standard find window to enter either the number of 
recent builds to display, or a particular build number.

You will then be shown a list as in the picture below.

Here you can view a particular bu

New build...
A build is a way of recording item
materials that are in your stock ar
item is created.

Note that you must have an mSup
ing for this feature to be enabled
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Note that ingredients can be added automatically from the bill of materials 

dient, click the New ingredient button. You will be 
d window for issuing goods from stock:

st as you would for entering a customer invoice.

shed entering ingredient lines, click OK to return to 

a line, double-click it, and change the details.

uble-click it, set it's quantity to zero, then click the 

e built.
 build, click “New item to build" button. You will be 
 below for receiving goods.

he item is automatically calculated for you. You may 
r the selling price as you prefer. 

ered the item to build, click OK to return to the main 

the item, simply double-click inside the “item to 
tab. If you regularly build the same item, you should enter a Bill of Materials 
for the item being built, and use the method outlined under the “Using a Bill 
of Materials” heading below.

Firstly, if you are entering a projected build (one that you expect to perform 
in the future), Check the This is a projected build check box. If this box is 
checked, all items added will be placeholder lines rather than actual stock. 
Doing this allows you to enter your manufacturing schedule in advance of 
ordering raw materials. The schedule will be taken into account when order-
ing to ensure that you will have enough materials in stock when it comes 
time to manufacture.

• The cost price for t
enter the margin o

• Once you have ent
window.

• If you wish to edit 
build” rectangle.
Note: if you have restricted access to builds, you will not be able to see cost 
prices or the profit summary window at the bottom of the window

*The build window has two parts: The top part of the window records the 
details of the item to be built and the lower part lists ingredients that are 
used in the manufacture of the product.

Adding ingredients manually

• To add a new ingre
shown the standar

• Enter ingredients ju

• Once you have fini
the main window. 

• If you wish to edit 

• To delete a line, do
OK button.

Adding the item to b
• To add the item to

shown the window
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• At the bottom right of the window in “summary” section is a summary 
of the cost, margin and selling prices for the build.

• When you click the OK button you may be asked if you want to enter 

Converting projected builds into an actual build.
• Once your manufacturing of a projected build is about to take place, 

… to locate the build you want to edit.

is equal to “none” (a placeholder line) you 
and choose an actual stock line from the 
y entering the line number or double-click-
). Once you have done this, the stock you 
d, and manufacturing can take place.

ber of items that will result from your build, 
 labels icon will print the correct number of 

 of as a “recipe” or “formula” for building 
, and the quantity of each required to make 

terials” tab in the build window you will be 
:
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the build into stock. You should only do so once the manufacturing and 
Quality Assurance (QA) process is complete. You will not be asked this 
question if there are any placeholder lines (those with a batch of 
“none”) entered as an ingredient. Such builds are presumed to be for 
projected manufacturing, and are kept with status “sg” automatically.

• To finalize builds, choose File > Finalize builds.... when the splash screen 
is showing.
• Once you are satisfied with the details, click OK to enter the build into 
the system. You will be asked if you want to enter the details into stock. 
If you say yes, the newly created item will immediately be available for 
issuing to customers. If you click later then the stock will not be avail-
able until you open the build window at a later date and enter it into 
stock.

• Note that the ingredients used in a build are considered to have been 
"sold" for re-ordering purposes, and will be counted in your usage.

Finishing build entry
• Understanding build status codes enables you to know what stage each 

build is at. The codes are the same as for other transactions.
• Each build transaction has a status code:

choose Item > Show builds

• For each line whose batch 
will have to double-click it 
item issue window (either b
ing the line you wish to use
have chosen will be reserve

• mSupply calculates the num
and by clicking on the Print
labels.

Using a Bill of Materials
A bill of materials can be thought
an item. It records the ingredients
the finished product.

When you click on the “Bill of ma
shown the following information

Code Meaning
nw A new build is being entered, but has not been saved.

sg "Suggested". A build has been entered, but has not yet 
been confirmed. If stock lines have been entered, raw 
material stock is reduced so that it is no longer available 
for other invoices, but the new item is not yet entered into 
stock. You should leave builds with this status while manu-
factured items are "in process" , or if it is a projected build 
for a future date.

cn "Confirmed." The item to build has been entered into 
stock.

fn "Finalized." The build can no longer be edited
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 actual batches of raw materials used, as opposed to 
 that are initially entered.

 actual quantities issued and the actual final quan-
e theoretical amounts that should have been used 

u to monitor production efficiency. Use the Print 
nt the yield information if required.

ems...
at you don’t keep in stock. When a customer orders 
ill be a “one-off” purchase, you can enter it as an 

tlines the work flow for Ad Hoc items
At this time (or later) you can adjust the amount issued to reflect actual 
Add Bill of Materials Button:
This button will add a Bill of Materials according to the formula entered for 
the item.

Before you click this button you should enter the item to be built including 
the quantity of finished product. 

Once you know the actual yeild of finished product you can adjust the final 
quantity manufactured by double-clicking the item to build.

Print options
It’s possible to print either a Pick list, detailing the ingredients and quantities, 
or a summary of the manufactured product. To achieve this, the box along-
side the print icon in the lower right corner must be checked, and the appro-
priate form selected from the Printing form drop down box

Choosing stock after adding a bill of materials
Each item added is also added to the “ingredients” tab, but no stock is 
attached to the item- it is a placeholder item. This is done as mSupply can not 
take into account all the factors that go into choosing an appropriate batch 
to use for each manufacturing run (The expiry, amount on hand, etc)

Actually to issue stock for use in the build you need to return to the ingredi-
ents Tab and double-click each line, then choose stock from the available 
stock list. Note that there is a button displayed Re-distribute all. Clicking this 
button will take the “total quantity issued” figure and re-distribute it over 
the available batches, making it easy to move from using a placeholder line 
to issuing actual stock.

issued quantities and the
the theoretical quantities

Calculate Yields button
This button compares the
tity manufactured with th
and made. This allows yo
yield report button to pri

Manage Ad Hoc it
Ad Hoc items are items th
an item that you decide w
Ad Hoc item. 

The following diagram ou
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When you choose Items>Ad Hoc items, the following window is displayed:

d Hoc items, add new items, delete items 

 view Ad Hoc items by their status. Ad Hoc 
us codes:

ier name in this field and press Tab to show 
g a supplier will show items assigned to that 
l show items supplied or to be supplied to 

Meaning

 has not yet been assigned to a sup-
k of this as your “to-do” list

 has been assigned to a supplier, 
ot been placed on a purchase 
ese items also need action.

 has been added to a purchase 
t the goods have not arrived.

fn
The item has arrived from a supplier and 

oiced to the customer
62

The “Name” field
Enter part of a customer or suppl
a list of matching names. Choosin
supplier. Choosing a customer wil
that customer.

been inv
From this window you can view A
and edit existing items.

The “Show” Drop-down list
This drop-down list allows you to
items can have the following stat

Status 
code

un
The item
plier- thin

as
The item
but has n
order. Th

po
The item
order, bu
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 purchase order
urchase order for a particular supplier, you can click 
b to view a list of Ad Hoc items you have assigned 
 you to add them to the purchase order. For further 
oc items tab on page 131.

ewed in the normal transaction list window. 

 with versions of mSupply prior to v1.4 will not 
t transactions" section of the window- you will have 
ctly.

y a window where you can re pack a particular item 
Note that repacks created
show up using the "recen
to enter the number dire

New repack...
This command will displa
into smaller packs.
Once you have chosen a name you can fine-tune the list displayed for that 
name. 

The “New” button
Clicking the “new” button displays a window like this:

From this window you can add an item name, the name of the customer, 
then name of the supplier, the quantity to order, and add a comment.

When the customer orders an item, you may not know who the supplier is. 
You can just leave the supplier name blank.

You can edit the default accounting codes for the item or just leave them set 
to the default values.

Editing an Ad Hoc item
To edit an item, double-click it in the list to display the item details:

Adding Ad Hoc items to a
When you are making a p
on the “Ad Hoc items” Ta
to that supplier, allowing
information see The Ad H

Show repacks...
Repacked items can be vi
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At [4.] click on Newline to bring up this window calling for the details of the 
repacks, and enter the details as appropriate.

s may be created at this stage - e.g. 5,000 
ked into 40x50 and 30x100. The Sell price, 
ocation are automatically completed, but all 
ired.

blets may be broken, for example, the total 
ill be less than the quantity selected for re-
curacy of your stock record, an inventory 
rmed - see below.

 transaction is suggested (sg), checking the 
uce a picking slip of the number and size of 
e status is finalised, the same operation will 

re-packs.

saction is created showing the original line 
ine(s) put into stock. The total value of the 

 edit a repack transaction after you have 
 right the first time! (You can always “re-
ke however!)

Deleting a repack
then the repack will be deleted. Only 
ested) or “nw” (new) repacks can be 

adjustments
entory adjustments allow you to increase or 
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if you click on the Delete button, 
repacks whose status is “sg” (sugg
deleted.

When to use inventory 
Items>Inventory adjustments. Inv
There are 4 steps for creating a repack. The window is numbered from top to 
bottom to help you follow the correct steps

1. Choose item to be repacked
At [1.] type the first characters or code of the item to be repacked, then press 
the Tab key. If only one item text or code matches your entry, it will be filled 
in automatically, otherwise you will be shown a standard choice list from 
where you can select the item.

2 Choose a batch
At [2.] double click a line to choose the batch; for repacking, batches cannot 
be mixed, and a single batch must be used.

3. Quantity to be repacked
At [3.] enter the quantity which is to be repacked; the pack size field is auto-
matically completed.

4 Details of new line(s) - i.e. the repacks

Note that repacks of different size
Paracetamol tablets may be repac
the Batch number and the New L
these fields may be edited as requ

Not infrequently, because some ta
quantity of the item re-packed w
packing at [2.]. To maintain the ac
stock adjustment should be perfo

Printing
While the status of the repacking
box beside the print icon will prod
packs of the original item; once th
produce a detailed record of the 

On clicking the OK button, a tran
taken out of stock, and the new l
transaction is always zero. 

Note: currently there is no way to
clicked the "OK" button, so get it
repack” an item to adjust a mista
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 supplier invoice will be created. Enter the details in 
uld as if you were receiving goods from a supplier, 

in the name field for you automatically, and does 

n be used to adjust any stock lines where the stock 
ss than the physical stock.

r the margin when starting this transaction. For a 
ent, set this to zero. If you are entering stock when 

or the first time, enter the percentage to apply here.

reduce stock
u have done a stock take and find that the physical 

is less thanthe amount recorded in mSupply.A trans-
stomer invoice will be created, except that you do 
 See the section on entering customer invoices for a 
rocedure.

nts are treated by mSuppy as a kind of Supplier 
 or edit an inventory adjustment, Choose the "Show 
tion from the "Item" menu.
Note: Inventory adjustme
invoice (or credit). To view
inventry adjustments" op
decrease the stock of an item that is recorded in mSupply. You will need to 
adjust the inventory if:

• Stock is discarded (due to damage or expiry)

• You do a stock take and find that physical stock is different to the stock 
recorded in mSupply. In this case the first thing to do is to see if you can 
find out where a mistake may have been made in issuing stock. For 
example, you may be able to retrieve extra stock mistakenly given to a 
client, or may need to ask a supplier for an order that has been entered 
but never actually received.

• Stock has been stolen.

• As a general rule, consider using a regular invoice to account for any 
transactions with a customer or supplier. Only use an inventory adjuste-
ment as a last resort.

Inventory adjust - add stock...
Use this function when you have done a stock take and find that the physical 
stock of an item or items exceeds the amount recorded in mSupply.

A transaction that is like a
just the same way you wo
except that mSupply fills 
not allow you to edit it.

After a stock take, this ca
recorded in mSupply is le

You will be asked to ente
normal inventory adjustm
starting to use mSupply f

Inventory adjust- 
Use this function when yo
stock of an item or items 
action that is just like a cu
not choose the customer.
description of the entry p
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Merge two items....

packinging materials, and quality control reagents.

You are shown a list of departments:

e New dept. button.

k the department you want to edit. You are 
 edit the department name:

oose what will happen when you attempt 
o is not a member of a linked group. Either 
e can be disallowed. This only applies if you 
ss by customer group turned on in the pref-
e this setting.

s that are members of the group you are 
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If an item has inadvertently been added twice, with slightly different descrip-
tions, here is your safety line! Enter the item to keep and the item to be 
merged. 

Important- if you merge two items that are in fact different, you will really 
mess things up. There is no un-do for this operation.
Note that merging items affects all historical records except for item names on 
finalized transactions, which will retain the original name for safety reasons.
Note: Items that either have a bill of materials or are used in a bill of materials 
can not be used for the item to delete/merge. If you try to do so, you will be 
warned.

Show  departments...
Items>Show departments. This item allows you to create and edit item 
departments. Once you have created departments, each item can be assigned 
to a department. 

For example, a manufacturer might create departments for raw materials, 

To add a new department, click th

To edit a department, double-clic
shown a window allowing you to

The radio buttons allow you to ch
to issue an item to a customer wh
the user can be warned or the issu
have Activate restricted item acce
erences - otherwise you can ignor

The Items tab displays a list of item
viewing:
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• Each group can have any number and combination of item groups in it.

ows the available departments

shows the customer groups that are members of the 
 is highlighted on the right hand side.

ht side allow you to add and remove groups from 
partment. Clicking the “Add a new relationship” 
 of groups you can add.

k and then click OK) to add a group to the current 
ill be given a warning if you try to add the same 
• When you attempt to issue stock to a customer whose group does not 
contain the department of the item you are issuing, either a warning 
will be displayed or mSupply will refuse to issue the stock, depending 
on the entry for that department in the “show departments” list.
To delete a department
Double-click it to display the entry window, then click the delete button. Note 
that you can not delete a department that has item members. You will be 
warned if you try to do this. To delete a department with Items, click the 
items tab and note the items that are members, then edit those items (using 
the Items > Show items… menu command) and set their departments to 
either none or a different department. You will then be able to delete the 
department. See the Manage Item Access entry below for more details

Manage Item Access...
This menu item allows you to create and edit item departments. 

Item departments are a bit complicated. Here’s what you need to remember

• Each customer is a member of one group

• Each item is a member of one department.

• The left hand list sh

• The right hand list 
department which

• The icons at the rig
the highlighted de
button shows a list

• Double-click (or clic
department. You w
group twice.
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• Depending on how the item department options are configured, 
attempting to issue an item to a customer whose group is not a mem-
ber of that department will either result in a warning message or in 

Steps in setting up interactions:

1. Choose a way of defining interaction groups. We recommend you use
the system being developed at <http://www.drugref.org> as in future,

 check automatically interactions with the
at is in development there.
 which groups.
 groups.

 turn

raction groups... You will be shown a list of 

d a new group, or double-click an entry to 
68

Manage Drug interaction groups
Items>Manage Drug Interaction. Drug interaction groups allow you to specify 
groups of items that interact with each other, and then specify a warning if 
these items from interacting groupsare issued to the same patient.

You can set up interactions in store mode, but warnings will only appear in 
dispensary mode.
mSupply refusing to issue the stock.

• Note that the option must be turned on in the preferences under the 
Invoices2 tab before this option will have any effect. 

• Here is a summary of how department groups affect whether an item 
can be issued.

mSupply will be able to
drug interaction server th

2. Define which items are in
3. Add interactions between

Let’s look at each of those steps in

Definining interaction groups
Choose Items> Manage Drug inte
groups:

Click the new group button to ad
edit it.
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like this:

t affects the current group, and then enter details 
choosing from the drop-down lists.

dence

• Quality of evidence
• Poor

to display when an interaction occurs, and any notes 
These fields are optional.

s in dispensary mode, you will get a warning like 
This tab has two buttons either to add or delete a drug interaction. (To delete 
an interaction click on the line you wish to delete before clicking the “delete 
interaction” button).

To edit an interaction double-click on the interaction you wish to edit. You 

• Fair
• Good
• Unknown

You can enter a message 
you may want to record. 

When you are issuing item
Here we have double-clicked on diazepam:

The window has two tabs.

The “items” tab shows a list of items that have been assigned to the group.

You assign an item to a group by viewing the item details (Choose Items > 
Show items), and setting interaction group from a drop-down list.

The “interactions” tab shows a list of groups that the current group interacts 
with.

will be shown a window 

You choose the group tha
about the interaction by 

The choices available are:

• Type of interaction
• Inhibits
• Augments
• No effect
• Conflicting evi

• Clinical Significane
• Minor
• Moderate
• Major
• Unkown
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this if the patient has been issued both the items in question:

Click the “New” button to add a new unit.

Note that you will need to have sufficient user permissions to use this func-
tion.

Warning: do not change the record for one unit into a different unit, as all 
ted.

w allows you to manage the range of 
items.

orting transaction data from mSupply to 
xternal accounting software. Double-click a 
n account code or description will affect all 
count.

new account. 
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Show units...
Items>Show units. Choosing this item shows a list of units:

items using that unit will be upda

Show Accounts...
Items>Show accounts. This windo
accounts that can be assigned to 

Account codes are used when exp
integrate your information with e
line to edit its details. Changing a
items that are assinged to that ac

Click the “New” button to add a 
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ppears initially inthe order in which the entries were 
 list is very straightforward. Simply select (by single 
e which you wish to reposition in the list and drag 
is example, the entry <CLINICAL EQUIPMENT> has 
fth place to second place.

ick the New button and the following window 
It is recommended that each item is placed in its appropriate category, but 
there is the option to select <NONE>

Selecting this item opens the Show Item Catgories window, showing the list 
of categories to which items may be allocated. Adding a new category

To add a new category, cl
appears:
Fill in the code, description field and select the account type. The field “items 
that use this account code” itemline(s) will be displayed for each account 
code. Account types are “Expense“, “Income“ and “Asset“.Click on OK but-
ton to add and Delete button to delete new account.

Show item categories...

Using item categories
When viewing an item’s details, a category can be assigned to that item, as 
shown in the following graphic:

Reordering the list
The Item Categories list a
made, but reordering the
clicking) the category nam
it to its new position. In th
been repositioned from fi
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Show Locations..

you to define the criteria for the various 
g. the permitted temperature range, 
tc.

at appears allows you to enter a name for 
ed conditions pertaining to that storage 

ype “Refrigerator” has been defined, the 
being 2° C - 8° C. 

s, the Show location types window might 
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Defining location type
Note that it is better to define the location type before the location. This sec-
tion discusses location types first, then returns to explaining locations.

Location types
Choose Item > Show location types to define or show a list of available loca-
tion types. 
The category name is entered in the “Item category” field, and the Items 
panel remains blank; only after items have been assigned to the newly 
defined category will they appear under “Items”; this is performed when 
adding a new item, Item> New item, or when editing an existing item.

You can report on the value of items issued according to their item category, 
and if you use dot notation you can even produce summary reports that 
group item categories together. For further information see The 2 period 
comparison by item category report on page 176.

Editing a category name
To edit the name of an existing category, in the Show Item Categories win-
dow, double-click on the name of the category to be edited; the New item 
category window appears with the selected category name already high-
lighted in the “Item category”field.

You can now change or edit the category name.

Note that all items in the selected category will now appear under the edited 
name; the previous name of that category will no longer appear in the list.

The window that appears allows 
types of location in your store - e.
whether location must be dark, e

Click on New, and the window th
the storage type, and the permitt
type.:

In the above example, a storage t
permitted range of temperature 

Having defined your storage type
look like this:



Show Locations..

73

brings up this window:

de, description and appropriate comments, as 

lume of the location you are defining. Volumes are 
3], but smaller volumes - e.g. 5l - may also be 
propriate unit (“litres” = “l” in the example) is 
Here you can enter the co
shown. 

Location volumes
You can also enter the vo
stored in cubic metres [m
defined, provided the ap
It is worth emphasising that the list does not show the actual store locations, 
but the types of locations.

Should you wish to edit the details of any storage type,double click on it; you 
can also add new location types when necessary.

Location - Defining locations
Before you can associate an item with a specific location (e.g. Shelf D4, Refrig-
erator 2, etc.), these locations must be defined and entered into mSupply.

From the menu, choose Item > Show locations, even if you have not yet 
defined any locations, as the window which appears has a New location but-
ton for this very purpose .

Clicking on New location 
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entered following the number. See also Volume per pack on page 46

This feature is important if, for example, you are replenishing your stock of 
vaccines, and you need to know if there is enough space available in the 

Editing a shelf location
Double clicking on a line allows you to view and/or edit location details.

When you double-click on a line, the following window is displayed.

tion descripion, comment, volume, location 

ing stock linesfor that particular location. 
s the following window.

 of interest to view further information.
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Clicking the Volume usage button will fill in the volume usage column with 
the volume used at each location provided that the volume of the location 
has been defined.

If you want to see a particular location, enter the first characters of the loca-
tion code or description into the Search location box and click the magnifying 
glass icon to show matching locations.

Double-click on a particular batch
refrigerator in which you store vaccines to accommodate a new order. (You 
would also need to know the volume of the vaccines that you are ordering).

The Location type field initially has the entry ‘None’’, and before using this 
feature, you must, as discussed earlier, define the various location types - e.g. 
Secure cabinet, refrigerator, etc.. [For further information see Defining loca-
tion type on page 72.]

Once the locations have been defined, you can associate each item in your 
store with its location, but do remember that a location has to be defined 
before an item can be associated with it.

To view the locations you have defined, choose Item > Show locations, and 
you will see a list of location codes and descriptions. In the example shown, 
two refrigerators are listed, one with a capacity of 25 litres, and one of 20 
litres - with their volumes expressed as millilitres. General tab

The General tab shows code, loca
type and summary. 

The Stock Tab
The Stock tab shows a list of exist
Clicking on the “Stock“ tab diplay
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Use extreme caution: This operation will affect all historical records of the 

rect...
ect.

sabled in Version 2 and later versions, as this opera-
 fly’.

 hand" figure which is kept up to date by mSupply.  
is command here in case you suspect your stock on 
f mSupply is doing it's job you should get an "all 
y correct" message when choosing this item. (Please 

 you need to order an item that is not on your stock 
o add it to your stock list. Such an item is considered 

 with non-stock items will be described.

ct New item, and enter the particularsas you nor-
eck the Non-stock item box. In the box immediately 
r from the list of customers held in mSupply. To 

stock item, a customer must be identified, and this 
fault customer for the item.

 the same item for a different customer at a later 
location you delete. They will be moved to the location you are keeping. The 
operation can only be undone by reverting to a backup copy of your data 
file.

In the window displayed enter the location to keep, and then the locationto 
merge. When you have checked that the information is correct, click the OK 
button. 

From the Item menu, sele
mally do, only this time ch
below, select the custome
place an order for a non-
customer becomes the de

Should you need to order
Merge two Locations...
If you want to remove a location from further use in mSupply (for example, 
you might have accidentally double-entered a location) this command can be 
used.

When you Choose Supplier > Merge two locations, this window is shown

Check stock is cor
Item > Check stock is corr

Note: This command is di
tion is performed ‘on the

Each item has a "stock on
However, we have left th
hand figures are wrong. I
stock records were alread
report to us if you don't!)

Non-stock items
There are occasions when
list, and you do not wish t
a ‘non-stock item’..

The procedure for dealing

Step 1
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date, the new customer is entered at the time the purchase order is being cre-
ated.

The example is for non-stock item Granuflex dressing.

In our example, we have ordered 2 items from Diamond Traders, one of 

ft corner) then click on OK, and an Alert 
 that ‘Customer invoices have been created 

 main menu, choosing Customer > Show 
ocess the invoice which has been created 
em for our customer, Western Infirmary
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which is our non-stock item.. 

The Goods Received must be finalised in order to create the Supplier invoice:
Step 2
Create the Purchase order which will include the non-stock item,

You will observe that the Customer box already contains the default cus-
tomer, in our example, Western Infirmary. You are able to edit this box, and 
select another customer - for example when a subsequent order for this item 
is placed for a different customer.

Step 3
On receiving the order, proceed as usual to the New Goods receipt form.

Uncheck the Hold box ( bottom le
message is displayed, advising you
for non stock items......’: From the
invoices allows us to select and pr
automatically for the non stock it



Non-stock items
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r

s

h

in the main window

ters of the supplier’s name, and then press the Tab 
e "supplier" check box checked can be used. If only 
try, the supplier name will be filled in. Otherwise, a 

ate entry, or click cancel to try again. You can also 
ws or the “d” and “u” keys on the keyboard to 

move the highlighted item down or up, and then use the"enter" key to 
em..

 serial number on the bill the supplier gave you.

ow you've run out of things to enter!

saction is created in File>Preferences>Invoices1 . 

n

mn

l
o

Resizable column

If the line you want is 
highlighted, click the 
“use” button or press 
the “Enter” key.
R

A
In
a 

En
la
o

Yo
u
th
su

C
Th

C
n

Ty
te
a

R
u

C
th
th
th

C
n

choose the highlighted it

Bill no.
Enter the bill number- the

Comment
Enter anything you like. N

Category
Category for supplier tran

lick to copy 
e details of 
e invoice to 
e clipboard.

ick to add a 
te.
eceiving Goods- a Supplier Invoice

ll goods you receive should be entered into mSupply by entering a "Supplier 
voice" or by using the purchase order system, which ends in the creation of 
supplier invoice. In some countries a supplier invoice is called a "bill"

tering a supplier invoice puts the goods into stock ready for issue. It calcu-
tes the selling price based on the margin you have chosen for that supplier 
 for that item, depending on how you have set your mSupply preferences.

u will notice there is a Prices tab in the supplier invoice window- this is for 
e with invoices received in foreign currencies, which will usually be done via 
e goods receipting system. For further information see Viewing and editing 
pplier invoices created via Goods Receipts on page 138.

oose Supplier > New invoice. The supplier invoice entry window will open. 
e cursor will be in the Name field.

Information to enter 

Name
Enter the first few charac
key. Any name that has th
one name matches the en
list will be displayed:

Double-click the appropri
use the up and down arro

lick to add 
ew supplier

pe initial let-
rs of the name 
d press tab

esizable col-

mSupply generates automatically both th e Invoice number and the Goods received ID, and if 
you click on this latter number, the Goods Received transaction will open. See “Tips” on p.82

Double-click a 
line to choose it.

Click the “New” 
button to add a 
new name.



Receiving Goods- a Supplier Invoice

The categories created are listed in this category field.

Buttons in the supplier invoice window 

If this check box is not checked and OK button is clicked, it will display a con-

be viewed and/or printed but it can not be edited.

If “Confirm supplier invoices without asking” is checked in the “Invoices 1” 
tab of the Preferences window, so all invoices will be finalized (whether you 

ails to the clipboard, allowing you to paste 
 message.

will leave no trace of your entry, and the 
eused.

us of “nw” if you have added lines to an 
 eachline using the “delete line” button 

s intentional, to save the “oops, I just 
 on it” feeling.  

ed by previously clicking OK, cancel will be 

OK
 and exits the window. You are given the 
o. If the invoice status is “sg” a packing slip 
ice will be printed. (Tip: you can bypass the 
the shift key as you click OK)

tion

oice has just been created- clicking 
will delete the invoice and automati-
lete each line

cel button will only delete the invoice 
ave first deleted all lines using the 
 line” button

s for status “sg”

nges or deletions can be made
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firm window with a message “Confirm invoice and enter into stock now?”If 
you click on “Later”, the invoice will have a status “nw”(new). If you click on 
“confirm”, the invoice will be confirmed.

If this check box is checked and if the invoice is not yet confirmed, it will dis-
play a confirm message.If you click on “Later”, the invoice will have a status 
“nw”(new) and will not be finalised.If you click on “confirm”, the invoice will 
be confirmed as well as finalized.So be very careful! A finalised invoice may 

Saves the changes you have made
opportunity to print if you want t
will be printed, otherwise an invo
print messages by holding down 
New line
Will add a line to the invoice. This command can be used on any invoice that 
is not finalized. Clicking the button will present you with the window for 
adding a line from stock.. See the Adding lines to an invoice section below for 
more details. To select a line to edit, simply double-click on it. Note that new 
line and edit line are disabled on finalized invoices

Delete line
Will delete a line whose batch is "none". To delete other lines, you must first 
edit the line and set it's quantity to zero.

The Hold Check Box
Checking this box means that the invoice can not have it’s status changed. If 
it’s status is “nw” it can not become “cn” (confirmed). If it is “cn”, it can not 
be changed to “fn” (finalized).

Note the “nw” status invoices do not have the stock entered into the system 
yet, so this allows you to enter a supplier invoice, but to make sure the stock 
is not available for issued until all the details have been checked.

The Finalize Check box
This check box allows you to finalize an invoice when you click the OK but-
ton. This will mean that it can no longer be edited, so be sure first that all the 
details are correct. Note that only users with “Can finalize individual invoices” 
checked in their user permissions can operate this check box. Other users will 
be warned if they try to turn it on, and the check box will automatically 
uncheck. 

like it or not!)

Copy button
This button copies the invoice det
them into a spreadsheet or email

Delete
Allows the deleting an invoice. 

When you press delete button, it 
invoice number assigned will be r

Note:Unless the invoice has a stat
invoice, you must manually delete
before deleting the invoice. This i
deleted my invoice with 100 lines

If the invoice has already been sav
disabled or not present.

Invoice status Descrip

nw The inv
cancel 
cally de

sg The can
if you h
“delete

cn Same a

fn No cha



Adding new lines to a Supplier invoice

81

with) “250mg” (for example), enter “@250mg” in the search field (without 
the quotes). 

pply a different margin to the whole invoice, click 
it the margin for that supplier by choosing Supplier 

e the margin. If you wish to apply a different margin 
 do this as you enter the lines, as long as editing 

 preferences.

you are entering, you can click new item to add the 

agree upon a standard form for entering items. For 
n "infant feeding tube" as:
 tube"

 infant"
eeding"

r be merged, but it is better to get it right in the first 

Now there are a series of fields to enter to fill in the basic information for the 

e?

as to be entered in this field.

lumn
Hint: you can use the "up" and "down" arrow keys to change the high-
lighted item (You can also press u to move up and d to move down!) . Press-
ing the enter key will choose the highlighted item.

line

Num units
How many did you receiv

Location
The location of the item h

Pack size
How many units in a pack
Adding new lines to a Supplier invoice
Click the new line button to add a line to the invoice. A window will appear 
like this:

The cursor will be in the field ready for you to enter the item name.

Item
Enter as much of the item name (or code) as you know, then press the tab  
key. As usual, if only one entry matches, it will be filled in. More than one 
matching entry will present you with a list from which to choose the item you 
want to issue by double-clicking it: The text you type will be matched against 
both the item name and the code. A match for either will display the item.

Note: To query for an item name or code that contains (rather than starts 

Note: If you did wish to a
the cancel button, and ed
| Edit supplier  and chang
to just some lines, you can
margins is enabled in the

If you can't find the item 
item.

Note: it is a good idea to 
example, will you enter a

• "infant feeding
• "feeding tube,
• "tube, infant f

Duplicated items can late
place!

Resizable co
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Note: Say you receive 50 packs of 100 amoxycillin caps, you should enter "50" 
in the quantity field  and "100" in the pack size field. However, if you issue the 
capsules in strips of 10 to customers (eg you allow them to order 20 or 30 cap-

You enter a manufacturer just the same as entering an item or supplier- type 

Editing lines on a supplier invoice
d at any time until the invoice is finalized.

on the line you wish to edit.

ssued
f this line to a customer, you will be warned 

show you a list of customer invoices that this 

em issue window, where certain fields will 
not be able to be edited. Also, you will not be able to reduce the quantity 
you received below the quantity already issued. 

ow where you can edit the line details in 
entering new details.
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the first few letters of the manufacturer’s name or code, and press the tab 
key. Choose the correct manufacturer from the list if more than one choice 
matches what you typed.

If the manufacturer you want to choose is not in the list, you can click the 
New button to add a new manufacturer.

The item issue window
You will be presented with a wind
much the same way as if you are 
sules), you should enter quantity " 500" and pack size "10"

Batch
The batch number or other identifying information. The batch appears on 
the invoice, so you can use this field to differentiate between brands if you 
need to (eg you operate using generic names, but occasionally want to give a 
specific brand- you can put an abbreviation for the brand name here as well 
as the batch).

Expiry
You can use "/" or "." to separate the day/month/year. Note: Use whichever 
date format you have set in your computer (dd/mm/yy or mm/dd/yy or yy/mm/
dd). You can enter the year as 2 digits, which will be understood as a date 
between 1961 and 2060. This should cover the expiry date on most things you 
receive in the next 56 years!

Cost Price
Enter your cost price for one pack of whatever size pack you entered above.

Margin and Sell price
If you have allowed editing of these fields in the preferences, you can adjust 
the margin (and the sell price will adjust automatically, or you can adjust the 
sell price (and the margin will adjust automatically).

Click OK if you are finished, or OK & next to add another line. (The invoice 
lines added will be displayed in Items Display Field.)Click cancel to exit to the 
main screen without saving any of the details.

Manufacturer
This field will only be shown if you have turned the option on in the prefer-
ences.

Supplier invoice lines can be edite

To edit a line, simply double-click 

Editing lines if stock has been i
If you have already issued stock o
with a window like this:

Clicking View issued invoices will 
particular line was issed to:

Clicking OK will take you to the it
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left or right.

d either in increasing order or decreasing order by 

d by clicking on the header and dragging it to the 

 a supplier invoice
f the following:

u wish to delete, then click on the delete line button 
 icon)

e to edit it (see above) and set it's quantity to zero.

will be asked if you really want to delete the line. 
Click OK to proceed.

Note: you can not delete a line from a supplier invoice that has been finalized.

s in mSupply
f pieces of information to calculate the selling price 
nfusing, but it also gives you a lot of power to have 
he way you like it.

uses:
Selling price calculation
mSupply uses a number o
of an item. This can be co
the price calculated just t

Here's the logic mSupply 

Mouse changes 
to divider sign
In the graphic above you will notice the “units issued: 100” text in blue to the 
right of the Quantity field. This will only be present if stock has already be 
issued to customers. You can click on that text to display a list of issued 
invoices as described above with the View issued invoices button.

Note that the OK & Next button is very useful for editing a whole invoice. 
Simply double-click the first line of the invoice, then use the OK & Next but-
ton to go from line to line.

Note also that many options for the window are set in the mSupply prefer-
ences. For example, whether or not line one is chosen automatically, and 
whether you can use placeholder lines.

Working with the list of invoice lines

Resizing Columns
These columns are resizable. If any of the column data is cut-off or remains 
hidden, the column width can be increased or decreased. It can be done by 
positioning the mouse at the borders of the column. The cursor changes to a 
cross with arrowheads on the horizontal bar. Click and drag the cursor to the 

Sorting Columns
Columns can also be sorte
clicking on the header.

The columns can be move
new position.

Deleting a line on
To delete a line, do one o

• Click on the line yo
(it’s got a trash can

• Double-click the lin

Click the OK button. You 

Increasing order

Decreasing order
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• Does the item have a selling price specified? If it does, this price will be 
used no matter what other information is available. Note that the price 
entered for the item is for one unit. The price will be multiplied by the 

Applying a Discount to the whole invoice
If a supplier gives a discount at the bottom of the invoice rather than adjust-

ach line will be reduced by 5%, and the 
It should then match the amount the sup-

d based on the new cost price, check the 
 The pricing rules as described above will still 

eceived note from Supplier invoice, 

r of the Goods Received transaction in the 
y clicking on the actual number, that partic-
ill be displayed. Similarly, the Edit goods 

o open Supplier inv ....... which will display 
84

ing the price of each invoice line, you can use the discount button. This win-
dow will be shown:
pack size to get the selling price for the line you are entering.

• Is either the margin specified for the supplier or the margin specified 
for the item zero? If so, the other (non-zero) value will be used?

• Is there a margin specified for both the supplier and the item? If so, the 
preference "item margin overides supplier margin" will be examined to 
see if it is on or off. If it is set, the item margin will be used, otherwise 
the supplier margin will be used.

For example:

Note that if you have turned on "allow editing margins and sell prices on sup-
plier invoices" in the preferences you will be able to over-ride the prices 
mSupply calculates.

If you enter “5” the cost price of e
invoice total will be recalculated. 
plier is actually charging you.

If you want the sell price calculate
“Recalculate sell price” checkbox.
apply.

Tip: Rapid access of Goods R
and vice versa
Supplier invoices show the numbe
upper right area of the window. B
ular Goods received transaction w
received list has a link Click here t
the required invoice.

cost 
price

pack 
size

Sup-
plier 
mar-
gin

item 
mar-
gin

preference 
set for  item 

margin  
overriding 
supplier  
margin

item 
price

price 
used

100 100 6 10 yes 1.15 115

100 100 6 10 no 1.15 115

100 100 6 10  yes 0 110

100 100 6 10 no 0 106

100 100 0 10 no 0 110

100 100 6 0 yes 0 106
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h

i

r number if there is one

u wish to record here

er invoice window 

ice. This command can be used on any invoice that 
he button will present you with the window for 
 See the Adding lines to an invoice section below for 
ne to edit, simply double-click on it. Note that new 
bled on finalized invoices

as been selected, and appears highlighted; multiple 
to be sequential, may also be selected and deleted 

d only if ‘We run a backorder system’ is checked in 
2 options. Clicking this button shows you a list of 

items that are on backorder for the customer you have chosen. If you click the 
button before choosing a name, you’ll be told so!. For viewing the backorder 

t confirm the transaction.

d, the status of the order changes from new (nw) to 
tions may still be made.
I

C
C

In

N
Ty
th
ca
O
yo
cl
formation to enter in the main window

ame
pe as much of a customer name here as you know and then press Tab. If 
ere is only one name that matches your choice, it will be entered automati-
lly for you, otherwise you will be presented with a list of available choices. 
nce you have entered a valid name, the New line button will be enabled. If 
u can not find the name you are looking for, you can add a new name by 
cking the icon to the left of ‘Name’.

list of items, you must firs

Confirm
When this button is clicke
confirmed (cn0); modifica
ssuing Goods to a Customer (Customer Invoices)

reating a new Invoice
oose new invoice from the customer menu. A window like this will open:

Their ref
Enter the customer's orde

Comment
Enter any information yo

Buttons in the custom

New line
Will add a line to the invo
is not finalized. Clicking t
adding a line from stock..
more details. To select a li
line and edit line are disa

Delete line(s)
Will delete a line which h
lines, which do not need 
using this button.

Backorders
Note: This icon is displaye
the Preferences>invoices 
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Note: The Backorders button will be hidden if you have backorders turned off 
in the Preferences.

There are a row of small icon buttons at the bottom left of the window. Hov-
ering the mouse over the button gives a description of what the button does.

bers to all lines on the invoice according to 
 lines around by dragging and dropping to 

ummary of the cost and selling price infor-

heck this checkbox rather than printing a 
e printed, allowing you to give a paying cli-
rges: 

g to this invoice.

Copy to clipboard
Copies the entire invoice to the clipboard

 window 
o be viewed in three different formats, but 
indow remains the same and is available for 
86

Confirm
This button is only available for invoices with status "sg" (suggested). For fur-
ther information see Confirming an invoice on page 92.

Small icon buttons in the Customer invoice window

Tabs in the customer invoice
The three tabs allow the invoice t
note that the lower area of the w
appropriate input in all views.
Delete backorder
You can delete an item line or multiple item lines by selecting the line(s) and 
clicking on Delete backorder button.

Modify line
This button is used to edit the item line. Select the desired line and click on 
Modify line button to display the following window.

Reorder lines
This button will re-assign line num
their current order (you can move
a new position.

Financial summary
Clicking this button shows you a s
mation for the invoice.

Print as Proforma invoice: If you c
pick slip, a proforma invoice will b
ent a form showing expected cha

Transaction note
Allows you to make a note relatin
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invoice above appears in the following format when the Summary tab is 
selected.

 the following window:
General
Once an invoice has been created, a detailed view of the items on it may be 
seen by selecting this tab; where the supply of a single item is made up of dif-
ferent batch numbers, they will be displayed as separate lines:

Summary
The Summary tab displays the items on the invoice, consolidating different 
batch numbers and displaying the total quantities for each item only; the 

Transport Details
Selecting this tab displays
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menu.

and may be attached to the appropriate box. An example of a printed label is 
shown:

l tab, allows you to finalize an invoice when 
rs with “Can finalize individual invoices” 
can check this box. Other users will be 
d the check box will automatically uncheck. 

, it will be confirmed as well as finalized 
 be very careful! A finalised invoice may be 
not be edited.

mmed out, it means that “Finalize customer 
 in the “Invoices 2” tab of the Preferences 
alized (whether you like it or not!)

Allows the deletion of an invoice. If the invoice has a status of “nw” you can 
delete the invoice even if has lines added. If the status is “cn”or “sg” you will 

 first. When an invoice has been deleted the 
eused.

 and exits the window. You are given the 
o. If the invoice status is “sg” a packing slip 
ice will be printed. (Tip: you can bypass the 
88

You can enter a box number (or other reference) for each line by clicking on a 
line in the list, and then clicking again in the “Box number” column. Once 
you have started entering box numbers, you can use the “Tab” key to 
advance to the next line.

If you are using the Box number feature, and having allocated a box number 
to every item in the order, you may then print labels for each box by clicking 
on the Print labels icon, when the requisite number of labels will be printed, 

have to delete the lines manually
invoice number assigned will be r

OK
Saves the changes you have made
opportunity to print if you want t
will be printed, otherwise an invo
Here you can add information about the method of transportation and 
related information related to shipping - e.g: Ship Date, Ship Method, 
Responsible officer, box number.

The choice list for Ship methods is set by choosing Customer > Show shipping 
methods.

The choice list for Responsible officers is a list of mSupply users for whom the 
“Can be responsible officer” check box has been checked. Choose File > Edit 
users and groups, then double-click a user name to set up each user as a 
responsible officer (or remove them from the responsible officer list)

If you enter information here, you can report on performance of your trans-
port operations in various ways using the “Transport Report” in the “Report” 

Finalise
This check box, under the Genera
you click the OK button. Only use
checked in their user permissions 
warned if they try to turn it on, an

If the invoice is not yet confirmed
when the OK button is clicked, so
viewed and/or printed, but it can 

If this check box is checked but di
invoices automatically” is checked
window, so all invoices will be fin

Delete
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he lines are numbered in the left hand column You 
ant in one of three ways:

umber into the line number field 

on the line in the list 

 the list to select the line you want, then clicking 
olumn to allow you to directly edit the issue amount 

ur line, the number available will show to the right 
 the pack size and batch will be filled in. You can 
r than zero and less than or equal to the number 
entered a quantity, the value will be entered in the 

main invoice screen, or OK & next to add another 
f situations that are more complicated

If the quantity ordered by the customer can not be totally filled, enter a place 
holder line for the balance outstanding. For further information see Place-

 lines
o issue can not be filled by the available quantity of 
 from multiple lines without leaving the window. 
 a manual way of doing this

om multiple lines
ply enter the total quantity you wish to issue into 
Double click on the one you want, or click cancel to try again.

If no entries match the request, the text will read try again. You can try as 
many times as you like! If you decide the line is not entered in the system, 
click New item to add the line.

If only one entry matches the request, it will be chosen automatically, other-
wise you are presented with a list of matching entries. 

Once you have the line you want, the list at the bottom of the window will 
display the available item lines (if any). Each item line may be a different pack 

holder lines on page 90.

Issuing from multiple
If the quantity you wish t
a single line, you can issue
There is an automatic and

Automatically issuing fr
To do so automatically, sim
print messages by holding down the shift key as you click OK)

Adding lines to an invoice
Clicking New line will bring up this window:

 
The first thing to enter is the item name or code. Enter as much of the item  
name as you know, then press tab. All items whose name or code starts with 
the text you have entered will be displayed.

size, batch, expiry, price. T
can choose the line you w

• By typing the line n

• By double-clicking 

• By clicking once on
again in the issue c
in the list

Once you have chosen yo
of the quantity field, and
enter any number greate
available. Once you have 
“issue” column in the list.

Click OK to return to the 
line.There are a number o

Double-click the 
line you want.

Or click on the line 
then click the 
“use” button
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the “Quan” field. Note that this should be the number of packs. The pack size 
of the currently selected line will be used to calculate the total quantity 
required. In the example below, the user has entered 70.

no lines available, or none of the lines are suitable (for example, this order 
needed strip packaged stock, and the available lines are all bulk packs), then 

ceholder lines in the preferences, and you 
ble stock, a placeholder line will be created 

ollowing actions will occur:

rders, a backorder line will be created for 

ces to delete placeholder lines when con-
d, otherwise they will remain on the invoice 
ir order was received, but the goods were 

batch
h an unusual avilable amount of a particular 
 rounds the available quantity, it may be 
 completely issue the batch. In such situa-
nt available by holding down the shift key 

 will issue the total amount available of that 
batch.

Bonus Stock
nus stock module in the preferences (on the 

ms with bonus rates set will automatically 
 bonus stock amount:
90

click the Placholder line button. You can now add a place holder line that will 
record the quantity and pack size until you either get stock, or you confirm 
the order, at which time the item will be moved to back order or deleted 
(depending on how you have set your preferences).

As in the window displayed below, placeholder lines are coloured in red so 
you can easilty identify them.

• If you have activated the bo
invoices 2 tab, then any ite
have a second line with the
When the tab key is pressed to leave the field, if the quantity entered is more 
than there is available for that line, this message is displayed.

If you accidentally entered more than you intended, click “Try again”, other-
wise click the “Distribute” button. In the example above, all 58 available of 
line 1 will be issued, and 12 will be issued from line 2.

Placeholder lines
If you have set “Allow placeholder lines” in the preferences, and if there are 

Note that if you have allowed pla
choose an item that has no availa
automatically.

When confirming an invoice the f

• If you have activated backo
each placeholder line.

• If you have set the preferen
firming, they will be delete
to show the client that the
not supplied.

Issuing all available stock of a 
Sometimes you might end up wit
batch. Due the fact that mSupply
hard to enter the exact amount to
tions you can issue the total amou
while you double-click a line. This
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e
le-click on it. You will be presented with the same 
ou add a new line, except that the item name is 
te that the quantity you have already chosen is 
ock- You are viewing the stock records as if the line 
rocessed.

other invoice lines for the same item are also taken 
he issue column is filled out with the the amount of 
sued on the invoice. In the window below, there are 
nvoice for different batches of amoxycillin, and all 
hen editing, irrespective of which of the three lines 
.

r the quantity, or choose a different item line (that 
ou can even click in the item name field, and select 

an entirely different item. Note that selecting a different item has the follow-
ing effects

sue the new item, all invoice lines for item you were 
ted, and invoice lines will be added for batches 
 new item.

 item for which there is already an invoice line(s) on 
ck to be issued on those lines will be shown in the 
ou proceed you are effectively editing the quantities 
e just selected, and you are deleting all invoices lines 
s originally on the invoice.
See the manual section on File > Show items... for a description of entering 
bonus amounts

• If you proceed to is
editing will be dele
being issued of the

• If you choose a new
the invoice, the sto
“issue” column. If y
of the item you hav
of the item that wa
• The bonus details will be shown when the item is chosen, and the 
bonus amount will be updated when the quantity  is entered.

• Each time the quantity exceeds a multiple of the bonus qualifying 
amount, the bonus amount will be increased by the amount specified 
for the item. For example, given the "2 free with 10 example above:

• The bonus amount for item item is set on the "stock" tab of the item 
details window:

Editing an invoice lin
• To edit a line, doub

window as when y
already chosen. No
added back into st
has not yet been p

• Note too that any 
into account, and t
each batch being is
three lines on the i
three are shown w
was double-clicked

At this stage you can alte
is, a different batch), or y

Quantity Bonus

8 0

10 2

14 2

18 2

20 4

28 4

30 6
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Changing the batch to be issued
If you want to choose a different batch for an existing invoice line:

Deleting a line from an invoice

 Note :you can not remove an item from an invoice that has been finalized.

s
drag-and-drop of a line to a new location. 
or the same item.

rted by line number the renumbering will 
wn an alert mesage. 

 when sorted by a different column, hold 
d-drop to override the message.

ndone, apart from you manually dragging 
n.

es automatically" set in the preferences, the 
den, and this option will not be applicable.

ld be done when the goods have left the 
 ready for dispatch).

available for invoices with status "sg" (sug-

 stock levels- the quantity is the total stock 
ble amount is what can be issued on an 
ow for a fuller explanation.

 bottles from Fred, and create an invoice for 
ill 10, but quantity available drops to 7, as 
e issued to someone else.
tch the order. At this point you confirm the 

order. The quantity and the available amounts are now both 7.

 button does the following:
y in stock redcuced by the amount issued on 

tus to "cn"
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• If the line is a placeholder line, you can simply click the line you wish to 
delete, then click the delete line button. 

• If the line is a normal invoice line (with stock associated with it), double-
click on the invoice line. In the line details window that appears, press 
Tab to advance to the quantity field, enter 0 (zero), then click OK. You 
will be asked to confirm that you really want to delete the line.

• In summary, the confirm
• Each line has its quantit

that line
• It changes the order sta
• double-click the invoice line

• set the quantity of the batch you don’t want to zero, 

• double-click the batch you do want, and enter the quantity you want to 
issue. 

• Note that if possible the new batch will be added to the invoice at the 
bottom of the other lines, and the former invoice line will be deleted. 
You can use drag and drop to reorder invoice lines if this is a problem.

Editing a placeholder line on an invoice
When you double-click a placeholder line, an extra button is displayed:

The Redistribute all button takes the quantity on placeholder lines and re-
assigns it to actual batches in stock.

When you are not editing a placeholder line, the button is not visible.

Reordering invoice line
Invoice lines can be reordered by 
This can be useful to group lines f

If the invoice lines are currently so
happen, otherwise you will be sho

If you really want to reorder lines
down the shift key as you drag-an

Note that reordering can not be u
lines back to their original locatio

Confirming an invoice
Note: if you have "confirm invoic
confirm invoice button will be hid

• Confirming an invoice shou
store (or have been packed

• The confirm button is only 
gested). 

•  Each item line records two
on the premises. the availa
invoice. See the section bel

• For example: 
• You get an order for 3

Fred. The quantity is st
these 3 bottles can't b

• You are about to dispa
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• If you are running a backorder system, it deletes any place holder 
lines (those with a batch entry of "none") and adds them to that 
customer's backorder file. Otherwise the line is simply deleted. 
Once an invoice is confirmed you will be asked if you now want to 
print an invoice.

Entering a service line on an invoice
All "normal" customer invoice lines represent the issue of stock lines to a cus-
tomer. (These lines appear in the large section in the middle of the "Customer 
invoice" window).

mSupply also allows you to charge a customer for "service" item(s) such as 
freight, or advice or a refundable deposit on a cool box.

Enter the description and amount at any time until the invoice is finalized.

Note that the "subtotal" amount on the invoice includes any service charges, 
and tax (if any) will be added to the amount you enter.

Editing tax on invoices
The tax rate on an invoice is determined by the "default tax rate" setting in 
the mSupply preferences.

To edit the tax rate on an invoice, click on the tax rate box at the bottom of 
the invoice entry window. You will be asked to enter a new percentage tax 
rate. Click the cancel button if you do not want to change the tax rate.

Note: you can not change the tax rate on finalized invoices.
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Transferring goods to another Store

h

 

 

i

s

 

This featu
store on t
you suppl

This proce
Customer
make sure

You must
tomer’, so
Name fiel
type the fi
the store 
under com
customer.

The proce
Goods to 

It is neces
items to b
appear on
Customer
re is available only to those users who are managing more than one 
eir systems - e.g. if you have a General store for holding stock, and 

y a Dispensary with their day to day needs.

dure follows closely the steps as described under ‘Issuing Goods to a 
(Customer Invoices)’, and to avoid unnecessary repetition, please 
 you are familiar with that procedure.

be logged in to the issuing store; the receiving store being the ‘cus-
 you create a new invoice from the customer menu, and in the 
d the name of the receiving store is selected in the normal way (i.e. 
rst few letters of the store’s name, press the TAB key, and *select 
n red colored text from the list displayed). “Stock transfer” label 
ment field defines that the issuing goods is for a store. not for a 

dure from this point is identical to that described under “Issuing 
a Customer” above. 

ary to finalise the transfer when you have finished entering the 
e transferred. Only after finalising the transfer will the new invoice 
 the system, as a Supplier Invoice in the receiving store, and as a 
invoice in the issuing store,
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a

chosen all invoices that have unpaid amounts will be 

 invoices are shown. If you receive a payment for an 
et finalized, your options are:

ount as an overpayment (see below)
ocies that are being paid and restart the payment 

customer is paying you it most likely means they 
 invoice and it is OK to finalize it!)

umber and a note if you want to.

unt of the payment into the lower right hand field.

ment to invoices:
 line in the list to be shown a box to enter the pay-

 or:
 shift key while double-clicking an invoice to allocate 
ding  amount of that invoice.
 "OK" button if you have allocated a greater 
t amount.

ould be entered as a negative amount. It is generally 
credits as soon as they show in the list.

mer might pay you more than the amount owing 
(not so likely, but it does happen to some nice organizations!), or the 

y you for an invoice that is not yet finalized. If this 
ny amount that relates to invoices in the list. When 
u will be warned there is an overpayment and you 
 want to continue. 
R

A
th

Th
"o
am

N
"i
p
st
am

W
w

• Enter the customer name or code into the first field and press Tab. You 
will be shown a list if there is more than one matching entry for what 
you have typed.

customer might pa
happens, allocate a
you click OK the yo
will be asked if you
eceiving payment from Customers

 payment from a customer is usually referred to as a Cash Receipt (whether 
e payment is by cash, cheque or transfer)

e system mSupply  uses to record payments is the accounting standard 
pen invoice" system, which means that the outstanding (that is, unpaid) 
ount of each invoice is tracked by mSupply.

ote that the "activate customer payment module" checkbox on the 
nvoices 2" tab of the preferences must be checked before you can use the 
yment module. Once this option is checked, new invoices will have the out-

anding amount recorded. If this option is not checked, the outstanding 
ount of invoices is set to zero.

hen you choose Customer > New cash receipt... you are presented with a 
indow like this:

• Once a customer is 
listed. 

• Note: only finalized
invoice that is not y
• Record the am
• Finalize the inv

process (If the 
agree with the

• Enter the cheque n

• Enter the total amo

• To allocate the pay
• Double-click an

ment amount,
• Hold down the

the full outstan
Note:you can not click the
amount than the paymen
Note: customer credits sh
good practice to allocate 

Overpayments

• Sometimes a custo
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• Click OK if you want to continue, or cancel if you want to allocate the 
extra amount to invoices.

• The next time you enter a payment for that customer you will be pre-
sented with a window asking you if you want to use the overpayment 
for this transaction:

• Click Use if you want to use the overpayment, or don't use if you want 
to enter another payment (Some customers just keep sending in the 
money...)
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s

the supplier details window.

t

e invoice to the customer (If the customer has an e-
red, the invoice can  be automatically attached to an
 produced can be attached to an e-mail using your
nt. Alternatively it may be transferred on removable

Zip, CD etc..)
s electronic invoice
s Supplier | import invoice to import the invoice.
the supplier invoice that is created against other doc-
against actual goods received. 

l be edited after import

 for calculating selling prices are used.

ppliers to send you electronic invoices, persuade 
ly! Alternatively, we can supply the mSupply invoice 

tware vendor for inclusion in their own software.

u perform a trial of the system on a backup data file 
roduction situation.
E

m
u

Po

S

Su

Cu

S

• For each quotation, enter the supplier code for that item. This means 
your own code for the item does not need to match the supplier code. 
(Note that you do not have to enter quotation prices for the electronic 
invoice system- just the item code).

eps to use electronic invoices
1. Supplier creates an invoice
2. Supplier chooses customer | export invoice to create an invoice
lectronic invoices

Supply has a system that allows users to send electronic invoices to other 
ers of mSupply.

ssible uses include:

• If you have a manufacturing unit and a separate warehouse, you can 
run two copies of mSupply and move stock from one location to 
another using electronic invoices. 

• If you have customers using mSupply, they can import a 100 line invoice 
in a few seconds, where entering manually might take thirty minutes to 
an hour.

etting up electronic invoices:

pplier:

• In the preferences of the copy of mSupply that is sending invoices, enter 
the supplier code that your customers will use for you.

• If your customer(s) have an email address and you want to send the 
electronic invoices via email, then enter their email address in the cus-
tomer details window.

stomer

• For each item that will be received from a particular supplier, enter a 
quotation for the item. This is most easily done from the quotes tab of 

3. Supplier sends th
mail address ente
email, or, the file
normal e-mail clie
medium (floppy, 

4. Customer receive
5. Customer choose
6. Customer checks 

umentation and 

Note: 

• The invoice can stil

• The standard rules

• If you want your su
them to buy mSupp
format to their sof

• We recommend yo
before using in a p
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Restricting User Access

r

i

i

 2" are the designer and administrator- 
verrides the grouping scheme. You cannot 

ys have level 1 access. If you only want one 
 administrator password to be the same as 

ave to enter exactly the same text into the 
stakenly enter something you didn’t realize 
e sure caps lock is not on when you type 
e sensitive.

n up to version 1.96 but has been removed 
e combination of access group and individ-

ual user permissions too confusing. Now all acess options are controlled by 
user.

hen that user has access to use the system . 
h the Access Group level.

f that user will appear in “Responsible 
98

Applyin
mSupply h
to manag
your syste

You are p

Double-cl
button to
sively- it is

Double-cl
entries are
Active : 
If “Active” checkbox is checked, t
But the access ability changes wit

Can be responsible officer : 
If this box is checked, the name o
g restrictions
as a comprehensive system of restricting user access, allowing you 

e who has access to which commands and what information within 
m. User access is managed by choosing file | edit users and groups . 

esented with a list of current users. 

ck a user to edit their details or delete them. Click the "new user" 
 add a new user. Note: it is best not to create and delete users exces-
 better to edit the users in the system. 

cking an entry gives you this window (same for a new user, but 
 blank):

Note also that "user 1" and "user
these two users have access that o
delete these users, and they alwa
person to have full access, set the
the designer password. 

When you enter a password you h
second field, so that you don’t mi
you had typed. Be careful to mak
your password. Passwords are cas

Note: ‘Access group’ was an optio
for version two, as users found th
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- you can use this table to record which user has-
 organisation.

sion User name

cing

Finalize purchase orders

rs

rs

r

Create purchse orders

Confirm purchase orde

Create & edit baclorde

Create new quotes

Edit & delete quotes

Duplicate purchse orde

Goods receiving

View goods received
Officer” in “Transport Details” section.

Language: 
Allows you to view mSupply according to the language selected. Curently, 
mSupply is available in English and French version onlyus.

User initials should be entered in the User initial field.

The Permissions tabs
Here you can set access for certain functions on a user-by-user basis. 

Let us know if there is a particular function in mSupply that you want 
restricted in this way and we shall consider adding it to the next version of 
mSupply.

Note that there are two tabs of permissions. Note also that newly created 
users do not have their permissions turned on- you have to turn each permis-
sion on manually.

Current user permissions:
which permissions in your

Permis
Ordering

View purchase orders

Delete purchase orders

Edit purchase orders

Edit purchase order pri

Manage tenders
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Add/edit goods received

Transfer goods between stores

Items

Add/edit abbreviations

Tenders

Create and edit tenders

Names

turer names

er names

ices.

invoice

Admin
100

Add/edit warnings

Add/edit prescribers

Add/edit transaction categories

Add/edit contacts

Merge prescribers

Show e-mails

Purge

View log

Set start of year stock

Preferences

Export & import
Create new items

Enter inventory adjustments

Edit inventory adjustments

View cost prices of stock

Create repacks

Edit item names, codes and units

Edit repacks

View DDD information for items

View pricing information for items

Manage item access

Edit item units list

Manage drug interaction groups

Merge two items

Manage locations

Add/edit departments

Goods receiving

View goods received

Add/edit goods received

Transfer goods between stores

Special

Add/edit users

Add/edit currencies

Add/edit reminders

Add/edit misc labels

Create customer, supplier & manufac

Edit customer, supplier & manufactur

Edit name codes

Edit name categories

Create and edit patient event

Edit patient details

Add/edit group

Reports

Manage reports

Revert reports to original

View all reports

Remote data

View remote data

Edit remote data

Invoices

Create customer invoices

Edit customer invoices

Create supplier invoices

Edit supplier invoices

Finalise invoices individually

Edit comments on finalised invo

Import supplier invoice

Duplicate supplier & customer 

Finalise multiple invoices



Applying restrictions

101

many users were confused by the mix of individual and group permissions..

d information about users.

ss book for you staff, but well hidden away!
The Log-on modes tab
mSupply now has two “modes” to allow its use in a store or a dispensary 
environment. For further information see Dispensary Mode on page 103.

At login, the window will reflect the settings checked under the “Log-on 
modes” tab; here the default store, and default mode may be set. The stores 
and the modes accessible to individual users must be set here. Think of it as a mini addre
* - only applicable to the mSupply web services module. Installations without 
this module can safely ignore these options.

Note that the user group settings on the first tab still apply. For a user to have 
access to a command they must 

a) be in an Access group of appropriate level, and 

b) have the appropriate permission check box checked.

Commands and actions restricted by user group 

As of version 2 all user permissions are set on a per user basis as we found 

The details tab
On this tab you can recor

Builds and bill of materials

View cost prices on builds

Finalise builds

View bill of materials

Edit bill of materials

Build items

Edit build items

Cash transaction

Make cash payment

Receive cash payment

Web Interface

Edit web passwords

Edit & create web messages

Printing

Print duplicate packing slips.

Print duplicate customer invoices



Restricting User Access

Restricting Customer access to items
102
mSupply has a system of restricting access to certain items. For further infor-
mation see Manage Item Access... on page 67..
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• Double-click on a user in the list

sers in the list
other is dimmed out, it is because your mSupply reg-
u to use those modes. Contact Sustainable Solutions 
ur registration.

rences > Invoices 2 then check the “show direction 
 mode“ box.

Once you have deactivated a mode for a user, it will not appear in the choices 
when they log on.

 be a customer, a supplier, both or neither. A "cus-
u supply goods to- e.g. another organisation, or a 
a patient.
D

A

St

St
ve

It

D

D
It

R
h

N
in
su

A
W
is

To
• Go to the “Log-on Modes” tab.

• Uncheck the boxes for the modes you do not want to make available 
for that user.

What is a “name”?
In mSupply a "name" can
tomer" can be anyone yo
ward in your hospital, or 
ispensary Mode 

bout Dispensary Mode

ore Mode

ore mode is the standard mSupply mode, and is the only mode available in 
rsions prior to 1.6.

assumes that customers are organisations, rather than individuals.

spensary Mode

ispensary mode allows you to use mSupply to supply medicines to patients. 
is more suited to use in pharmacies, clinics and hospital dispensaries.

gardless of mode, each user can only use those functions for which they 
ve permission, according to the permissions set for that user.

ote that in client-server versions of mSupply, different users can be logged in 
 different modes at the same time, allowing you to dispense to patients and 
pply wards, stores, clients or cost centres simultaneously.

ctivating Dispensary Mode
hen you create a new data file or upgrade to version 1.6, dispensary mode 
on by default. 

 turn dispensary mode off:

• Choose file > edit users and groups...

• Repeat for other u
Note: If one mode or the 
istration does not allow yo
if you wish to upgrade yo

• Choose File > Prefe
entry in dispensary



Dispensary Mode

What changes in dispensary mode?

name, mSupply will treat anything entered 
nd anything entered after a comma as a 

Items to be 
dispensed 
shown here

This is where any 
entered notes relating 
to this patient are 

When this box is 
checked, dispensary 
labels are printed

Use these buttons to 
elete a 
ote

See below for 
permitted methods of 
entering prescriber

Click here to edit 
the details of the 
current patient

t

If this box is checked, 
104

How to look up a patient
When you are entering a patient 
before a comma as a last name, a

add or d
patient n

receipts for patients are 
printed on labels.
Different menus
The menus in dispensary mode have different names. For example, the cus-
tomer menu becomes the patient menu.

In simple dispensary mode, there are a lot less choices in the menus. There 
should be enough options to allow a user to dispense medicines, but not to 
do much else.

Different windows

Prescription entry

In dispensary mode, we refer to entering a “prescription” for supply of items 
rather than an “invoice” The prescription entry window looks like this:

See below for permitted methods 
of looking up existing patients

Click here to add new patien
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• In the Prescription Entry window, click the New Patient icon to the left 
of the name entry area. This window will be shown (Shortcut: Ctl-Shift-

atient, you can click the small down-arrow to the 
 to display a window where the patient details can 

an type either their code, their last or first name in 
st comma first”. For example for the presciber Dr 
is 123) any of the following are accetptable

• bro,fe

king the entry to show a list of matching prescrib-
atches, the name will be entered directly without 

g on the “dipensing” page of the mSupply prefer-
r or not you can accept and print a prescription 
iber.

e notes tab will display each time you enter the 
Press the tab key after ma
ers. If only one presciber m
the list being shown.

Note that there is a settin
ences that affects whethe
without entering a prescr

Notes display
Any notes you enter in th
first name. 

For example, to find John Smith, enter “Smi,J” or “smith,joh”

If the patient’s name code is known, enter a “*” (no quotes) and then the 
name code or part of it. eg “*58298”

If there is more than one matching name, you are shown the name choices 
window

Entering a new patient
To enter a new patient, you have two options:

• In the name choices window (above) click the New button. (Shortcut: 
Ctl-Shift-P)

• IP) :

Editing patient details
Once you have chosen a p
right of the patient name
be edited.

Entering the prescriber
To enter a presciber, you c
full or abbreviated, or “la
Felix Brown (whose code 

• 123

• bro

• fel



Dispensary Mode

patient name in the Prescription entry window. These notes can be used to 
remind you of patient preferences for certain dosage forms, or drug sensitivi-
ties.

event from the list. If the patient event you have selected is numeric then a 
field where you can enter numeric value is displayed and if the patient event 
selected is boolean field then a check-box is displayed. 

ting the event you want to delete and click 

 selecting desired event type or patient 
 form. 

s
 click on New line , and Add item window 

 have been entered, provided that the 
y mode option has been selected in Prefer-
he medicine should be entered.

Entering directions
ems, there are default directions already 
e item being dispensed is FRUSEMIDE 40mg 
 are “Take ONEtablet in the morning”. 
y be displayed by clicking on the down 
ted direction field; directions not already 

her the Abbrev entry area, or the Expanded 
106

Enter first few letters of the patient event you are looking for and select an 

For many commonly prescribed it
present; in the example below, th
tablets, and the default directions
Alternative directions present ma
arrow to the right of the abbrevia
present may be typed in using eit
Before you add an event for a patient, you need to make sure that patient 
event s have been set up. To add patient event, choose Patient > Patient 
events , then click the “New” buton. By default “Note” patient event of type 
“Description” and code “NT” is provided. Youcan also have event of type 
numeric and boolean. 

Add and delete event
By clicking the “Add” button on the form you will be presented with the fol-
lowing window

You can delete the event by selec
the delete button.

Show
You can list events of a patient by
event from drop-down list on the

Entering prescribed item
On the Prescription entry window
appears.

Once the item name and quantity
Show direction entry in dispensar
ences, directions on how to take t
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can most likely used labels longer than 40mm with no problems.

 other printers if you want to use a different brand.

bels for an item again, choose Patient > Show Pre-
escription entry.

sed, click on the line you wish to reprint, and then 
g checkbox checked)

ls for all the items on the prescription, first click in 
 last item so that now one item is highlighted. Then 

 when you click OK

 that one label for an item, hold down the Alt key 
ick the OK button. You will be asked for the number 
abel is about to print.

ient stock of one batch?
cular batch of an item gets used up, you will need to 
n one batch to a patient. mSupply handles this 
 combines the totals for any item on a prescription 
rinted for the total quantity.

 with the first line number will be used, so enter 
ch you dispense, and leave the directions empty for 

 situation where you need to issue the same item to 
t directions you should either combine the direc-
or enter two prescriptions with the directions 
ch prescription (That is enter the line, then print the 
nt > New prescription and issue the item again with 

the second set of directions).

try window, once you have entered a patient name 
” button to view a patient’s history of what you 
• Label spcifications:

• 90mm x 40mm high

• White Matt Thermal Transfer Paper

• Wide Edge Leading

• 1 Across on a roll

• Perforation between each label

• Produced on 1" core to suit TLP2844

View history
In the new prescription en
you can click the “history
have dispensed.
entry area.

Note that you can mix abbreviations and text like this.

The drop-down list shows any standard abbreviations you have entered for 
the chosen item. If a stand abbreviation exists, the highest priority abbrevia-
tion will be entered when you choose the item.

If you have entered more than one standard abbreviation, you can choose 
one other than the default by choosing it from the drop-down list.

Note that mSupply stores the expanded text for each line, not the abbrevia-
tion. This means that there is a full audit trail of what was printed on the 
label (unless you edit the directions after printing).

Default directions
The set up of default directions is done on the dispensing tab when editing 
an item. For further information see Item edit - Dispensing options on 
page 56.

Printing Labels
mSupply currently is designed to work with the Zebra TLP 2844 label printer.

The Zebra is a very nice printer. It can use either thermal labels or a thermal 
ribbon which gives non-fading results. 

We currently support plain 90 x 40mm label stock as this is cheap and readily 
available. The Zebra printer is auto-sensing of the ending of a label, so you 

We are happy to support

Reprinting labels
If you need to print the la
scriptions to locate the pr

In the list of items dispen
click OK (with the printin

If you wish to reprint labe
the list of items below the
all labels will be preinted

Printing multiple labels
If you want to print more
(Option on Mac) as you cl
of labels required as the l

What if there is not suffic
As the quantity of a parti
issue stock from more tha
when printing labels, and
so that only one label is p

The directions for the item
directions for the first bat
subsequent batches.

Note: if you have the rare
one patient with differen
tions onto the one label, 
entered differently on ea
label(s), then choose Patie
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Viewing patient details
n-the-fly as you enter a prescription as 
w patients by choosing Patients > Show 

ch for and click Find

ng entries, or taken directly to the detail 
the values you entered.

o displaying a customer in store mode. How-
t shows each item dispensed. Double-click-
the transaction in a new window.
108

Patient history tab
The details displayed are similar t
ever there is also a history tab tha
ing an item in the list will display 
Duplicating a prescription
Once you have a history window open you can click to select a single entry or 
control-click to select multiple entries, then click the “duplicate” button to 
create new prescription line(s) with exactly the same details. Stock will be 
issued for these lines automatically.

Repeats
mSupply allows for the recording of repeat prescription. This is achieved 
when the prescription is first dispensed; in the Add item window, click on 
Total field in Repeats box in the top right corner of the window, and enter 
the number of repeats that the prescriber has authorised. The Repeat Dis-
pensing procedure is described a little later.

You can view a patient’s details o
described above. You can also vie
patients.

Enter the details you want to sear

You will be shown a list of matchi
view if only one patient matches 
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w below.

ser to alter the quantity of a particular repeat - e.g. 
k on a particular visit of the patient; the quantity 
on the quantity line, and again clicking on the quan-
dited. The arrow on the left bottom corner enables 
t quantity setting.

at and other details on the Add item window prop-
 save details .

n the left is contained in Prescription entry. You can 

icular patient. Click ing on the Repeats icon displays 
.

s items to be dispensed, quantity, total repeats, 
piry date for a particular repeat. Process repeats and 
below.

om the Repeats window
The number of repeats is assigned in Total field in Repeats box, and as the 
repeats are dispensed, the number remaining is displayed in the Left field. 

When you click on the blue arrows on the upper right side ,the total repeat 
number and total quantity for each repeat is shown. Clicking on the small 

The repeat window show
repeats remaining and ex
OK button are described 

OK
Click OK button to exit fr
Repeat Dispensing
The Repeats panel (upper right of the window shown below) allows details 
of repeat prescriptions to be recorded. Take the example of a patient present-
ing a precription for Frusemide 40mg tabs x 30 on 1st January 2007, with the 
prescriber requesting “Repeat monthly x5”; in the Total field you should 
enter “5”, and in the Expiry Date field you have the option of entering (a) the 
actual date on which the final repeat may be issued - in this example, “1 July 
2007” (allowing the patient one month’s grace) - or (b) “6m” for 6 months. 
Note that the characters “D”,”W” & “M” in upper or lower case are inter-
preted in this particular field as the specified number of days, weeks or 
months before the repeat instruction expires. mSupply defaults to an expiry 
date two months later than the current date, but this may be edited as 
appropriate. The system automatically updates the number of repeats 
remaining as the patient makes further visits to have the repeats dispensed. 
The window below is displayed when you click on the New line in “Prescrip-
tion window“

arrow displays the windo

This window allows the u
if there is insufficient stoc
can be edited by clicking 
tity, which may now be e
you to restore the defaul

Once you have filled repe
erly, click on OK button to

The Repeats icon shown o

issue the repeat to a part
the window shown below
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Process repeats
This button is used to issue the repeat for a particular patient and for a partic-
ular item line. For issuing the repeat, first select a desired item line and then 

the printer will, after printing the medicine labels, produce a patient receipt 
as shown below.

t printer for receipts, this option can easily 
 advise us of your requirements.
110
click on the Process repeats button. Now the system automatically manages 
the repeats internally.

Printing labels
Patient labels are printed when the Print labels option is checked in the Pre-
scription Entry window. Sample labels, produced by the Zebra TLP2844 
printer are reproduced below:

Printing receipts
When the Print Receipt option is checked in the Prescription Entry window, 

Should you wish to use a differen
be incorporated in mSupply if you
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can access mSupply data from any internet connected computer.

• It’s fast over low bandwith connections. The mSupply web server allows 

u
a

b server
, then click on “Web server” in the list.

e web server or have it start automatically when 

to use port 8080. This is because the default port 
0) on unix systems running mSupply can only be 

used by applications that have root privileges, and we don’t want you to have 
to run mSupply as root!

n supply you with an application that redirects traf-
0.

server licence, mSupply’s web server will only run for 
ill have to quit and start mSupply again to restore 

or better still, buy a licence for using the web server 

ctionality can easitly be extended from mSupply- 
ggestions !
T

A
W
fr

Se
ac
w
th
th

Th

C
n

W
ac
you to provide access to mSupply from locations that only have dial-up 
acccess

rrently the mSupply web server allows you to view information about 
mes, items and transactions from any web browser on your network.

e are able to extend the web serving functionality of mSupply significantly 
cording to client requirements.

If this is a problem, we ca
fic on port 80 to port 808

Note that without a web 
one hour. After this you w
web server functionality (
from us!)

Note: The web server fun
simply let us have your su
he mSupply Web Server

bout the mSupply Web Server 
hen mSupply’s web server is running, it allows you to access mSupply data 
om any networked computer that has a web browser.

curity warning: The current version of mSupply does not include restricted 
cess system. It is designed for use on small intranets only. Do not start the 
eb server on computers that are accessible from the internet. Note however 
at the current web interface provides read-only access to your data only, so 
ere is no danger of malicious editing or deleting of data.

e advantages of accessing mSupply in this way are:

• It’s easy. Most people are familiar with using a web browser.

• It’s low maintenance. You do not need to install any client software.

• It’s cost effective. Once you have purchased a web server licence an 
unlimited number of people can connect.

• It allows customer access to information. The web interface built into 
mSupply can easily be customized to allow clients, supplier or other 
interested parties to have restricted access to the mSupply information 
you wish to show them. We are also able to include order submission by 
customers, making it easy for them to place small orders, and have real 
time information on stock availability.

• You can access mSupply from anywhere on the internet. Once we sup-
ply you with a password protected version of the web interface, you 

Activating the we
Choose File > Preferences

You can choose to start th
mSupply starts.

By default mSupply is set 
number for http access (8



The mSupply Web Server

Connecting to mSupply from a web browser

 confirmed invoices, invoices in process, 
ders or view and create order. Click the 

Select “Show recent confirmed invoices” . It will display the invoices that have 
been confirmed.
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Once the mSupply web server is running, you can access it by typing http://
ip_address_of_machine_running_msupply:8080

The link can be bookmarked if you use it frequently to save you typing it each 
time.

Firstly you will be shown the mSupply introduction page.

The suppliers and the customers are given a unique code and password. Enter 
the code and password to login. The window as shown below is displayed.

Choose whether you want to view
invoices by number, items, backor
“OK” button

Show recent confirmed invoices
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l show the detail information about that particular 
Click on  to go back to home. 

Show invoices in process
It will display the list of invoices that have not been confirmed or finalised. 
The invoices displayed have their status of suggested(sg).

On clicking the link, it wil
invoice.
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y invoice number or you may give a period 
re entered. Click Find button.

 an invoice date. The results you get will 
sing! Here we will find invoices issued from 
114
Find an invoice by number
Select “Find an invoice by number“. Click OK button. You will be shown the 
invoice query page:

Here you can search for invoice b
when the invoice transactions we

Enter either an invoice number or
depend on the data file you are u
01/10/04 to 01/10/05.
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ersions of mSupply is done on an individualized 
inable Solutions for details.

earch of invoices on the basis of items. It will display 
low. 
Items
Select “Item“ to make a s
the window as shown be
By clicking on a link we are able to view the invoice details. Here we have 
selected the third invoice in the list for viewing.

Pricing
Pricing for web-enabled v
basis. Please contact Susta
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isplay information about the item in the 
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Enter the name of the item which you want to search or leave it empty to list 
all the items. Click Find button.

On double clicking a link, it will d
window as shown below.
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Select “Backorders“ to view the items on backorder. It will display a list of 
items on backorder, quantity, comment.

er“. It will display a list of orders that have been 
 a new order by clicking on “Create a new Order“ 
Backorders

View and create order
Select “View or create ord
created. A user can create
Button.
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m. Click on “Find/Add item” button. It will 
 the specification of query. Here, we typed 
t of items beginning with “amo” are dis-
118
Creating a new order

Click on “Create a new order“ button. It will display a window for placing 
your order. Enter the name or code of the ite

display a list of the items meeting
“amo” in item name field, so a lis
played.
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ill delete the order you have created. You can click 
e quantity.
To set all the quantity to zero, click on “Clear” button. The quantity of items 
to be ordered is entered in quantity field. After entering in the quantity field, 
click on “Add item(s) to order” button.It will display the status of the order.

“Delete Order“ button w
on the item link to edit th
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You can change the value and click OK. If you want to add some other items, 
then find and add the item as discussed above. After the order is complete, 
click “Finalise Order“ button.“Finalize Order” button will finalize the order 
that you have created.
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r

e

• You ask mSupply to calculate your average usage by looking back over 

st you order 145,000 capsules. If you want to change 
n edit it, and will have full sales information avail-

se "minimum" & "maximum" stock levels as its pri-
ng order quantities. They are not a very reliable, as 
 work to maintain. Be assured that the system that 
u much better inventory control! (Minimum stock 
 you to ensure a minimum quantity of rarely used 

gency supplies. They should not be used for most 

rchase order
r, Choose Supplier > New Purchase Order.

wing window will be displayed:

ervisor Mode, the window displayed will list all the 
access, and you can select multiple stores, in which 
der (PO) will cater for the stores you have selected, 
g

m
su
o
fe
tl

Lo
m
re

A

Le
the last 150 days. The result is that mSupply finds you have issued 
225,000 capsules to customers in that period:

• 225000/150 = 1500 capsules per day

• We want 120 days stock:

• 1500 x 120 = 180,000 capsules needed.

• We already have 35,000:

• 180,000 – 35,000 = 145,000 capsules to order.
However, if you are in Sup
stores to which you have 
case the new Purchase Or
Ordering Items From Suppliers

Supply provides a way for you to generate a purchase order to send to a 
pplier. Each organization tends to have unique requirements for their 
dering process, so we have tried to strike a balance between providing dif-
rent methods, and making the ordering module so complex that it is of lit-
 use to anyone.

gic used for calculating quantities
Supply attempts to calculate purchase order quantities based on your cur-
nt stock situation and hsitorical usage patterns.

 purchase order is generated using the following information:

• How much stock you wish to order (expressed as the number of days of 
average usage you wish to order)

• The current stock level

• The average usage over the last X days (you choose X yourself when 
you generate a purchase order). mSupply looks back at your actual sales 
transactions and calculates your average daily usage for each line.

• The amount of stock on backorder from customers (if any)

• The amount of stock already on order from Suppliers, but that has not 
yet arrived in your store.

t's take a simple example of Amoxycillin 250mg capsules:

• You want to order enough stock to last the next 3 months.

• Your current stock is 35,000 capsules

• mSupply will sugge
this quantity you ca
able at that time.

Note: mSupply does not u
mary means of determini
they take a lot of manual
mSupply uses will give yo
levels are present to allow
items. e.g. essential emer
items).

Creating a new pu
To Create a purchase orde

In most instances the follo
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and when received by the Supplier, the PO will list the goods which should be 
despatched to each store.

• how often you order from this supplier

• how much "buffer" stock you want on hand just before your next order 

 arrive. from IDA (International Dispensary 
*30=60

hs. (Ordering cycle - 4*30=120)

at least one month (30 days) when a pur-
re about to place a purchase order with IDA, 
stock to last until the following order arrives- 
r months time, and that order will take 2 
oes arrive, you will want a one month 
re, you want to order enough stock to last 

enter "210" into the "stock required (days)" 

 calculated using the report ‘Suggest order 
. The optional tender management module 
ulation functionality. Orders can also be cal-

 want to arrange for split deliveries - for 
e order for a year’s supply, and cash flow 
s mean you are unable to accept the order 
 certain items to be delivered in, say, four 
tervals. The order as generated lists the 

you need to modify this; what you are actu-
der line, and the procedure is described 

under that heading a little further on in this manual. For further information 
see Split Deliveries on page 135.
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You will need to take several factors into account when calculating how 
many days stock is needed:

• the lead time between ordering and delivery.
There are a number of choices available to generate the order in the way 
that best suits you.

Clicking on the Calculate button brings up a window allowing you to enter 
the necessary information from which mSupply will calculate the quantity to 
be ordered.

arrives.

• your cash flow situation

Here's an example: 

• Orders take two months to
Association) - (Lead time - 2

• You order every four mont

• We want a buffer stock of 
chase order arrives. If you a
you need to order enough 
you will order again in fou
months to arrive. When it d
buffer still in stock. Therefo
the next seven months, so 
field.

Note that order quantities can be
quantities’ from the Report menu
also includes automatic order calc
culated as discussed below.

Split Deliveries
There may be occasions when you
instance if you are placing a singl
reasons or storage space restraint
as a single delivery, and you want
consignments, at three monthly in
totalquantity to be ordered, and 
ally doing is editing a purchase or
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use 200 tubes of clotrimazole cream per month, and you enter "90" 
days, mSupply will order enough clotrimazole cream to build your stock 

ge to calculate average usage..
re is the number of days of usage history mSupply 
rage daily use. This figure is then used to calculate 
d. The bigger the number you enter here (maximum 
accurate mSupply is likely to be (although it will be 
ions). Entering a large number will slow down the 
ase order is created.

ata file that has less than 3 years of usage history, 
mber greater than the number of days since you 

 else your usage will not be accurately calculated.

w button to proceed. The order will be generated, 
 with a screen showing the order lines

 the order should you so wish.

s the defined periods, and you should select the 
ill normally be the current period.

g here is today’s date, but it cam be edited. Each 
an have a unique expected delivery date. The date 
igned to each line in the order as it is created. If you 
for a particular line or lines (for example you may 
will be able to do so when editing the purchase 

as no effect on the calculations of the required 
current order, but the expected delivery date of 

existing purchase order lines is taken into account.

Consider this example:

 of Paracetamol is 1,000 per day

0,000 in stock

ase order for 100,000 that is due in 60 days time.

erate an order for next 90 days, it will use the 
 the existing order, and calculate that you need to 
ver the period between 10 days into the future 
 run out) and 60 days into the future (when the 
ill arrive)
from its current level up to 600 tubes (that is, 3 months supply)

Other items in the create order window

Calculate button
The calculate button will automatically calculate “days stock required” for 
given lead time, ordering cycle and given buffer stock. 

your usage

you have 1

There is an existing purch

If you ask mSupply to gen
expected delivery date of
order 50,000 tablets to co
(when existing stocks will
pending purchase order w
Order types available from the popup menu

Order for all suppliers. 

• All items in the database will be evaluated to see if they need ordering. 
If you have a large number of items, this may take a few minutes. With 
this selection, you have the option to generate either a single order or a 
separate order for eacjh supplier by checking the Separate order for 
each supplier box.. In this case, mSupply will look at which quotation is 
marked as "preferred" for each item, and create a separate order for 
each supplier. Items without a "preferred"quotation will all be placed 
together in a single order.

Order for some items only

• Click on the Query items box, to bring up the Query Editor window, and 
enter the required parameters; use of the Query Editor is described in 
detail in the Reports chapter. For further information see Using the 
query (search) editor on page 161.

Order for one supplier

• This method is the best method to use for ordering from a particular 
supplier (you might have guessed that!)

• Enter the supplier code, and press the tab key. The supplier name will 
be filled in, or you will be given a list to choose from.

• Any items that have a quotation from that supplier that is marked as 
"preferred" will be evaluated to see if they need reordering. 

Days stock required 
• Enter the number of days stock you want on hand. For example, if you 

Use the last ..... days usa
The number you enter he
uses to calculate your ave
how much stock is neede
1095 - 3 years), the more 
less responsive to fluctuat
speed with which a purch

Note: if you are using a d
you should not enter a nu
started using mSupply, or

Click the Create order no
and you will be presented

Comment
Add a comment (note) to

Period
The drop down menu list
appropriate one, which w

Expected delivery date
The default date appearin
line on a purchase order c
you enter here will be ass
want to change the date 
want split deliveries) you 
order.

The date you enter here h
quantity to order for the 
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Exclude transfers from usage calculations
This option is only applicable if you are running multiple stores. If you have 
more than one store, this option controls whether inter-store transfers are 

you have entered 1.5 in the “times covered” box, at least 75,000 gm (minus 
the quantity already in stock and the quantity already on order) of Mag Stea-

Creating a blank purchase order
chase order. It will bring up a blank order 
. 

r
hoose Show Purchase order... from the Sup-

Choosing this menu item shows a window where you can enter enter either 
splay or the order number (this is printed on 
t). If you click OK without changing any 
list of the 15 most recent orders.
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rate will be ordered, whatever the usage calculation comes up with for an 
order quantity.

Once you have entered the details, click the Create order button. Order gen-
eration may take a couple of minutes, depending on how many items need 
to be evaluated. You will then be presented with the order editing window.

the number of recent orders to di
an order if you have printed it ou
information you will be shown a 
taken into account when calculating required quantities.

Take the following two examples.

1. You are in a hospital which has a store that does all the ordering for 
the hospital. The store supplies the pharmacy with goods. In this case you 
should leave the checkbox unchecked. That is, you want to include transfers, 
as this is valid usage from the perspective of the store.

2. You have two warehouses that both order directly from suppliers. 
Occasionally Warehouse A requests a transfer from Warehouse B if it urgently 
needs items. If you are generating a purchase order for Warehouse B, you 
would check the checkbox to exclude transfers, as they are "abnormal" 
usage, and if Warehouse A is using mSupply properly, they will be ordering 
more of that item from the supplier in the future!

Include items with suggested zero order quantity
If mSupply calculates that any of the lines from the supplier are not required, 
when this box is checked such lines will appear on the purchase order, the 
order quantity being 0.

Builds….
In this section you can make sure that any items that are going to be used in 
manufacturing will be taken into account when calculating required quanti-
ties.

Builds (i.e. manufactured items) can be entered with placeholder lines to 
reflect a projected manufacturing schedule. If the check box in the “new 
order” window is checked the proposed order quantity for each item will be 
compared to the amount of the item that is required to all projected builds, 
multiplied by the “times covered” value you have entered.

For example if there is 50,000 gm of Mag Stearate on projected builds, and 

Choose Supplier > New blank pur
form, to which you can add items

Editing a purchase orde
To view a recently created order c
plier menu.
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past usagae pattern. The above window “Purchase order list” shows the 
ordersfor the stockto the supplier

ill be deleted by clicking this button. You can delete 
by highlighting more than one line. To do so, con-
and-click) the lines you wish to highlight. If your 
 can not be deleted. If you attempt to delete a 
e alert message like the one below.

tton presents you with the quick report editor win-
 report can be constructed. This report can be 
rinted.

for quickly finding a group of purchase orders. 
d button, you will be presented with a window with 
 is you chose the Menu item Supplier > Show pur-

s you to sort the orders by multiple fields. Other-
 individual coulmn will also sort the order list by 
See the section Ordering items from Suppliers for a fuller description of creat-
ing and editing orders.

Buttons in the Purchase Order Window

New purchase order
When you clik the New purchase order button, a purchase order details win-
dow is displayed . See “New purchase order“ below.

Order by
The Order by button allow
wise simply clicking on an
that coulmn.
You will then be shown a window with a list of purchase orders. (If you 
entered a purchase order number you will be taken straight to the purchase 
order details window and not shown the list below).

Since mSupply provides a way for you to generate and to calculate a purchase 
order to send to a supplier on the basis of your current stock situation and 

Delete 
Any highlighted orders w
multiple purchase orders 
trol-click (on Mac:: comm
orders are finalised, those
finalized order, you receiv

Report
Clicking on the Report bu
dow, from which a simple
viewed, saved to disk or p

Find
This button is very useful 
when you click on the Fin
the same functionality as
chase orders (above).
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Print
When you click on the Print button, it shows two windows. The first window 
is the page setup for your printer, the second window allows you to specify 

 on the line you wish to edit.

ting window to show more lines, or to show 
 drag the handle in the lower right corner to 

When you double-click an order line you will be presented with a window 
allowing you to edit the item, quantity and pack size:

iscount 
 either 
en, or 
 dis-
the 
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how many copies to print .Whatever column sizes for fields are set in the Pur-
chase order list window, those sizes are reflected in the printed output.

E-mail order(s)
Any highlighted orders will be converted to queued emails. 

Customise list
This button activates the customize list window. For further information see 
Working with lists on page 31. 

Duplicate
If you wish to duplicate any orders, highlight desired orders from list and click 
the “Duplicate” button. 

Editing a purchase order
Double-click the order in the list you want to edit.

You will be presented with the Edit Purchase Order window:

Editing purchase order lines
To edit an order line,  double click

Note: you can resize the order edi
more of the item name. To do so,
a new position.

If the order qualifies for a d
applied to the entire order,
the percentage discount giv
the actual cash value of the
count should be entered in 
appropriate field
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Item

ered from the supplier. This information is not edit-
rmed an order.

pplier prefers.

 measured in.

item

e quantity ordered.

e the volume per packfor the pack size chosen. If 
ne the volume and pack size you have entered for 

 stores volumes as m3 (cubic metres), but you can 
es (ml), litres (L) or cubic metres (m3)

ers of location name or code as you know, then 
ne location code matches your entry, it will be filled 

se you will be shown a standard choice list.

w expect to receive from the supplier in all consign-
ments. You can adjust this figure so that the amount received is reduced or 
increased due to changes in what the supplier actually sends.

e right of Volume per pack), on clicking, dis-
of the selected item if it has been set previ-
 button next to Shelf location displays the default 

 “Pricing for this item” frame reloads the price data 
n. The price from the most recent quote is used if 
uotations. 
Here you can edit the item that is being supplied. To change the item, type as 
much of the item name as you know, then press the tab key. If only one item 
matches your entry, it will be filled in automatically, otherwise you will be 
presented with a list where you can double-click the item you wish to enter.

Comment
You can enter any information you wish to record about this order line here. 
Comments will be added to order lines when you email an order to a sup-
plier.

Refresh Buttons
The refresh button (to th
plays the default volume 
ously. Similarly the refresh
location.

The refresh button in the
from a preferred quotatio
ttthere are no preferred q
Information in the Edit Order Line window

Original quantity
The original quantity ord
able once you have confi

Pack size
This is the pack size the su

Units
The units that the pack is

Price
The quoted price for this 

Price extension
The price multiplied by th

Volume per pack
In this field, you can defin
you are entering a new li
the item will be used.

Note the mSupply always
enter a volume as millilitr

Shelf location
Type the first few charact
press the Tab key. If only o
in automatically, otherwi

Adjusted quantity
The total quantity you no

Shows supplier and 
customer transactions

Displays details of the 
delivery of this item

Details of original 
order

Should an individual line 
qualify for a discount, 
appropriate entries should 
be made in any two of 
these three fields
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If you have received an updated quotation after generating the original 
price, use this button to apply the updated details to this line.

View quotations for the item in question. You can double-click a quotation to 
edit its information. 

Note that the supplier of the quotation that is marked as "preferred" will be 
the "split" command to break a general 
r.

d a new quotation.

or the item being viewed.

es nothing. From version 1.93 (Aug 2006), if 
ted goods receipt transaction will open in a 
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The quotes tab
This tab shows quotes from suppliers for the item being viewed.

You can double-click a quote to view and/or edit details.
Other information in the Order line details window:

On hand
This is the quantity of stock on hand of the item

On order
This is the quantity of stock in other confirmed orders awaiting delivery.

On backorder
The quantity of stock you owe to customers on backorders

Quantity received
The total quantity of this line that has already been received on this order.

Tabs in the Order line details window

The usage tab
This tab shows the usage for the last 24 months of the item being viewed. 
This is useful for deciding if reported usage is consistent from month to 
month, or is due to one or two very large supplies to clients.

the supplier selected when using 
order into orders for each supplie

The New button allows you to ad

The receipt history tab
This tab shows all goods receipts f

Currently double-clicking a line do
you double-click a line the associa
new window. 
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 allows you to show only recent transactions....

er line, the associated invoice will be opened in a 

editing window

to the next order line, unless you have reached the 
hich case you will be taken back to the order editing 

ng changes to the current window.

ton, the order will be deleted and the order number 
t order.

Order status explained:
rst created it has status "sg" (for “suggested”)

been confirmed, it has status "cn" (for “confirmed”) 
ave the order amount added to the "on order" field 
at if another order is created for the same item, this 
 order will be taken into account.

een finalized have status "fn" (for “finalized”)
es finalized by clicking the Make supplier invoice 

s can no longer be edited.
You can display a sub-set of the transaction lines by choosing options from 
the drop-down lists.

The option Received ledger for this purchase order line shows all supplier 
invoice transactions for the current purchase order line. Goods receipts are 

• When an order is fi

• after an order has 
Confirmed orders h
for each item, so th
quantity already on

• Orders that have b
• An order becom

button,
• Finalized order
The ledger tab
This tab shows supplier and customer invoices for the item being viewed.

shown on a separate tab.

The Dates drop-down list

If you double-c lick a ledg
new window

Buttons in the Order 

OK & Next
This button will take you 
last line in the order, in w
window.

OK
Will exit the window savi

Delete

If you click the Delete but
will be reused for the nex
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• Should a supplier be unable to supply some or all of an item 
ordered, when the order is finalised, the ‘unsupplied’ amount is 
ignored in any of mSupply’s subsequent Stock on order calculations.

 was sent to the supplier. When you print a 
r to fill in this date for you, but you should 
xact date.

ent”, “Supplementary order for PO 183”) 
ss the top of the purchase order so your 
 notice the message.

er to arrive

Goods Received date
ve the date blank for purchase orders that 

 the invoice from the supplier

ave not had an invoice supplied by query-
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Fill in the actual delivery date. Lea
have not been delivered

Invoice received
Enter the date when you received

Hint: you can find all orders that h
ing on this field.
Estimated order costs explained
From version 1.7 onwards, mSupply displays a new column (Price Ext) in the 
order editing window that shows the cost of the order line. 

Other buttons in the Edit Order window.

Print purchase order for supplier
This button will print the complete purchase order form for sending to a sup-
plier. Note that you should fill in relevant details on the Details tab before 
printing the order.

Confirm 
See the section above on "order status" for an explanation. Orders should be 
confirmed once the order has been placed with the supplier. 

Auto calculate usage check box -
When this box is checked, each time you edit an item line, the usage for that 
line will be calculated. This is slower, but gives useful information uponwhich 
to base your ordering . Note that this option can also be turned on within the 
order line editing window.

The Details tab
This tab allows you to record a range of information that will be entered on 
the purchase order when it is sent to the supplier. 

PO sent date
Enter the date the Purchase order
purchase order mSupply will offe
edit it if necessary to reflect the e

Heading message
Any text you enter here (e.g. “Urg
will be printed in a large font acro
supplier will (or at least “should”)

Expected Delivery
Enter the date you expect the ord
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the “Add selected line to order” button to add a 
se order.

ine from a purchase order it will not have its status 
 is your job to do so using the Items > Manage Ad 

Here you can add an ad hoc item “on-the-fly”. This is useful if you want to 
process a purchase order for a single Ad Hoc item that has not yet been 

nage Ad Hoc items menu is the normal route to 
oc items.

ipt of the order, and, where multiple deliveries 
 each instance.
entered into mSupply.

Note that the Items > Ma
add, edit and delete Ad H

The Receipt tab
This is a record of the rece
have been made, records
Comment
You can enter any appropriate comments here.

Supplier’s agent
Enter the name of the intermediary party here - if there is one.

Delivery method
Enter a delivery method (eg “Air”, “Courier” ...)

Authorizing officers
Enter the names of the people who are required to sign off the purchase 
order. These names are printed on the purchase order.

Freight conditions
Enter the delivery address, shipping marks, etc. here.

Additional instructions
Enter any further information you wish to appear on the purchase order.

Commisions and charges fields
Fill in any relevant charges agreed between you and the supplier. Note that 
any charges that are zero will be skipped when printing the purchase order.

The Ad Hoc items tab
Here you can display a list of items that have been assigned to the supplier, 
but not yet added to a purchase order.

Click on a line, then click 
line to the current purcha

Warning: if you delete a l
updated automatically- it
Hoc items menu.

New Ad Hoc line button



gOrdering Items From Suppliers

t are created directly from purchase orders:

ted each time a consignment arrives.
ated when a supplier invoice is created that

elating to the particular order.
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The Invoices tab
This tab displays a list of invoices that have been created from this purchase 
order.

There are two types of invoice tha

1. Supplier invoices are crea
2. Customer invoices are cre

contains Ad Hoc items.

The Log tab
This gives information of events r
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indow is being shown, an extra menu is added to 

o the clipboard, so you can paste it into an email or 

 order which can be saved as a file in html format, 
ve Excel installed, the report will open in Excel. Note 
the Excel file, you should choose File > Save as.. in 
Copy order to clipboard
Copies the order details t
text document.

Export html ...
If you want to produce an
use this option. . If you ha
that if you want to keep 
The Location tab
This tab displays the locations of the items received, if this feature is used. 
Where details of the volume of available space in any location has been 
entered, and where details of the area/volume of item pack has also been 
entered, the remaining available space will be displayed. 

Lines will also be coloured red/orange/green to indicate greater than 100%, 
90 to 100% or less than 90% of space used. showing which lines are likely to 
cause space problems on receipt.

The Order Menu
When the order editing w
the menu bar:
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Excel and choose a location.

Print

To check the email before sending it, choose Special > list emails, then double-
click the email to edit it. Note that to make the columns line up properly, you 
will have to click the <|-|> button to view the text in a fixed-width font.

TML attachment, and attached to a new 
eue so that it is sent next time you send e-
ave not entered an e-mail address for the 
tored in the export folder you have nomi-
lti-user mSupply, the export folder is set as 
lient\Export” (on the assumption that you 
cation for mSupply).

pply to generate a PDF file, create an email 
ail.

Change PDF driver installed on the compu-
o work. The driver currently costs US$50, 
Solutions <info@ss.org.np>

 the mSupply data file, so you can create a 
r and send it from a different computer 

k that quotation data is up to date based on 

 and if a quotation does not exist, one will 
ist and the price you have paid in the order 
tation are different, you will be shown a 
ou can decide whether to keep the existing 
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Prints the order. You will be shown the standard printing dialog boxes. 

Note that if Show all lines is selected, the entire order is printed; if Show 
incomplete lines is selected, the printout lists only lines which have either not 
been supplied at all or require a balance to complete the order. 

Split
Splits the order into a number of smaller orders based on the preferred sup-
plier for each line. The preferred supplier is the quotation that is marked as 
"preferred" for that item. To view and edit quotations you can double-click 
the order line then chose "quotes" from the "show" menu. All items that do 
not have a quotation marked as "preferred" will be put into a separate order.

Email in body
The order will be turned into an e-mail and placed in the queue so that it is 
sent next time you send e-mails. You will be warned if you have not entered 
an e-mail address for the supplier.

The e-mail will be formatted as follows:

Email HTML attachment...  
The order will be turned into an H
email that is then placed in the qu
mails. You will be warned if you h
supplier. The attachment will be s
nated in the preferences. (For mu
the folder “C:\mSupply\mSupply c
have selected the default install lo

Email PDF
Choosing this item will cause mSu
and attach the PDF file to the em

Note that you must use the PDF x
ter generating the email for this t
and is available from Sustainable 

The PDF that is created is stored in
PDF attachment on one compute
without problems.

Update quotes using this order
This command allows you to chec
actual supplied prices.

Each order line will be evaluated,
be created. If a quotation does ex
and the price stored for your quo
window to compare prices, and y
quotation or update it.
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ted as follows:

nd add the item ‘Normal Saline’
acks field, enter 5,000
elivery date enter 1/1/08

acks field, enter 2,500
elivery date enter 1/4/08

acks field, enter 2,500In the Requested Delivery date 

, but enter 1/10/08 in the Requested Delivery date-
 in October.

delete the line calling for 12,500 units on 1/1/08.

ld now look like this:

t of allowing mSupply to take future deliveries into 
le, an additional order for Normal Saline was 

 delivery of 2,500 had already been arranged for 1 
The store does not have the storage capacity to hold 12,500 packs of Normal 
Saline, so the supply of this item needs to be made in multiple deliveries; it is 
decided that 5,000 be requested for delivery at the beginning of January, fol-
lowed by 2,500 at the beginning of each of the months of April, July and 
October - i.e. at three monthly intervals.

This feature has the effec
its reckoning if, for examp
placed in mid June, and a
July.’ 
Note that you need to have your user permissions “Can add quotations” and/
or “Can edit quotations” set before this command is available.

Split Deliveries
Creating split or multiple deliveries will now be described using the following 
example. 

It is important to note that the Purccchase Order should not be finalised 
before this procedure is performed, as a finalised order may not be edited or 
altered in any way.

A store is placing an order for a year’s supply of IV fluids and, having followed 
the normal procedures, mSupply has created the purchase order displayed: 
below. 

The Purchase Order is edi

• Click on New line, a
• In the Number of p
• In the Requested D
• Click OK & Next
• In the Number of p
• In the Requested D
• Click OK & Next
• In the Number of p

enter 1/7/08
• Click OK & Next

Repeat the last two steps
field for the final delivery

To complete the process, 

The Purchase Order shou
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Receiving goods using the Goods Receipt function

the order has been received; to display all purchase orders awaited, enter @ 
in the Supplier field. (This has been done in the example shown below):

hich matches the order you have received 
ntry, or by highlighting the entry and click-

reappears with the supplier field and some 
on the Add from purchase order icon brings 
dow, which displays the goods on the pur-
elect each item separately, or - when the 
ordered match the delivery exactly - select 
ils of the items received .

ed which were not ordered; when this 
ered item icon and complete all relevant 
136

Occasionally goods may be receiv
occurs, click on the Add an un-ord
Receiving multiple consignments (partial deliveries) for the one purchase order

mSupply version 1.9 and later allows you to receive multiple consignments 
based on the original purchase order. This makes goods receipt process a little 
more complicated, but quite a bit more flexible. It also allows you to monitor 
supplier performance by comparing the amount received against the amount 
you actually ordered.

Entering goods received in the computer
Choose Supplier > New goods received, and this window appears:

In the Supplier field (which displays Search purchase order when it first 
opens), enter the first few characters of the name of the supplier from whom 

From this screen select the entry w
either by double clicking on the e
ing on the Use button.

The New Goods Receipt window 
other details completed. Clicking 
up the Choose order lines ..... win
chase order, and you may either s
items ordered and the quantities 
the entire order to enter the deta



Location management when receiving goods.

137

e or space required for a particular item. The small 
serts the default location for the items.

 for each item, you can click on OK & next to pro-
tem.:

ived
n the Goods Received list has been received, a Sup-
d, but in order to do this the Goods Received list 

cking the Finalise box in the bottom left hand cor-

ent when receiving goods.
ing have had a location and volume entered when 
eated, these will be transferred to the goods 
it these details you can do so by double-clicking a 
the volume or the location.

The Check Space button provides a means of quickly seeing if the incoming 
stock will fit in the space you have allocated: After clicking the button lines 

s

ough space at the chosen location to fit the stock.

iving stock the location will be more than 90% full.

ing this line the location will be less than 90% full.

ds Receipts
oods received...

window is shown:
All the items you’ve selected are added to the goods receipt The quantity is 
set to the total remaining to be received for that item.

Double click on each item in turn and the window allowing you to enter 
quantities, pack, batch numbers, expiry dates.

The right hand side of the window shows you the shelf location, total capac-
ity and available space for a particular item in a particular shelf location. You 

will be coloured as follow

• Red: there is not en

• Orange: After rece

• Green: After receiv

Viewing existing Goo
Choose Supplier > Show g

A standard mSupply find 
details. Select the item before proceeding.

In both instances, when the items have been selected, click on the Use but-
ton. 

You are now presented with the Edit goods received window .

are also shown the volum
“refresh” icon the right in

After entering the details
ceed to editing the next i

Finalising Goods Rece
When all available stock o
plier invoice will be create
must be foinalised by che
ner of the window.

Location managem
If the items you are receiv
the purchase order was cr
receipt. If you want to ed
line and either changing 
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r invoices created via Goods Receipts

s receipts differ slightly from standard sup-
rices. Here, you can add in any extra 
138

Supplier invoices created via good
plier invoices on the second tab: P
Click the OK button to view the last 15 goods receipts, or enter a value to 
find in the lower field, and choose the field you are searching for in the left-
hand drop-down list.

Viewing and editing supplie
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:I
Similarly, if you click on the link Click here to open Supplier ... , the relevant 
charges from the supply side (jn the supplier’s currency) and from your side (in 
your local currency) and mSupply will calculate an updated price for you.

Currency and Currency rate
Select the supplier currency from this drop-down box. The rate will be auto-
matically entered below.

Extra supplier charge
Here, in the supplier’s currency, enter any extra charges from, the supplier.

Local charge to distribute
Here, enter any local charges, in your local currency.

Calculcate
Click this button to have the extra supplier charge and the local charge to dis-
tribute automatically assigned to the lines below. The changes will be 
reflected in the total, also..

Goods Received: viewing relevant Purchase Order and Supplier 
invoice
Accessing the relevant Purchase Order when the Edit goods received window 
is open is achieved by clicking on the Purchase order number (upper right) ; in 
the example shown, by positioning the cursor over 19 .............:

..........and clicking, Purchase order no.19 is displayed:

Supplier invoice will open
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h

efore changing your organization name. 

d

ded with the two pieces of information you need to 

ion name
 id.

utton will copy these two pieces of information to 
u can paste them into an email and send them to us. 
eld is not showing 12 characters &/or numbers, you 
ard installed on your computer. Please consult us for 
uch cards can be purchased for $10 to $20.

• Once we have received your registration information we will generate 
a registration code for you. The code is entered by clicking the enter 

 window. You will then be shown another window 
er the registration details you have been supplied. 
structions supplied with the registration number will 
rmation to put in each field.
P

C
w
su

G

O
th
to
b

A
en
ap

Th
Th
te
dress line 1 & 2
ter the address information about your organization that you wish to 
pear on invoices.

e Register button
is button will be dimmed once you have registered. If you have not regis-
red, clicking this button will display the registration details window:

code button in this
where you can ent
Your registration in
describe what info
references...

oosing the preferences menu item from the file menu opens a window 
ith a side bar. Clicking on a subject in the side bar shows the options for that 
bject:

eneral 

rganization name-
is will print on the top of invoices. Note that your organization name is tied 
 your registration code. Please contact info@msupply.org.nz for a new code 

• Here you are provi
register:
• Your organizat
• Your hardware

• Clicking the copy b
the clipboard, so yo

Note: if the hardware id fi
do not have an ethernet c
installation instructions. S
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The percentage margin that will be filled in when you enter a new supplier. 
This value can be edited for each supplier at any time. Enter "0" if you do not 

name of the folder by clicking the choose button:

ou wish to use, click the “OK” button.

esktop folder" to have exported files 
 users choose desktop.

ts automatically go the "exports" folder in 
pplication. This is because many networks 
lder on the server computer)

ber at any time, but there is no real need to 
a new year with the numbers moved up to 
d. 

voice number below the highest number 

Note too that supplier invoices and customer invoices use separate sets of 
numbers- a supplier invoice and a customer invoice can have the same 

 "confused". This might confuse you 
ease the invoice number for one series (eg 
"50000" (or some such number) so the two 

r dates into here. 
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apply a mark-up to items you sell (For example, if you are issuing stock to hos-
pital wards at cost) default tax rate will be applied to customer and supplier 
invoices. Note that this amount can be edited when you are entering an 
invoice by clicking on the tax rate at the bottom of the invoice entry window. 

Export destination
If you want your exported files to go to a particular destination, choose the 

number without mSupply getting
though, and if this is the case incr
next supplier invoice number) to 
series are very different.

Period Closing
There are two fields you can ente
• Note: mSupply registration codes are specific for the computer and 
organization name and the expiry date of your licence (if it is time-lim-
ited). If you change either your organization name or the computer on 
which you are running mSupply you will have to contact us for a new 
code. (We may require evidence of the changes you have made before 
issuing a new number). 

Default customer
Leave this field blank for normal operation. If you usually (or always) only 
issue to one customer, enter that customer's code here. You must set the 
value to the name code of an existing customer. Doing so will mean that this 
customer's details are automatically filled in when you create a new customer 
invoice.

Default currency
This is the currency you use yourselves. You can choose from a pop-up menu 
of currencies you have entered into mSupply. 

Default margin

Once you have found the folder y

(Note: Macintosh users: choose "d
appear on the desktop. Windows

Note: in client/server mode, expor
the same folder as the 4D client a
will not allow clients access to a fo

Next invoice numbers  
You may increase the invoice num
do this. Some people like to start 
the next thousand or ten thousan

Note that you can't decrease an in
already used. 
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d amount on invoices
te can be changed when entering an invoice. Other-
 is always used. (On supplier invoices the actual tax 
ited if this option is checked. This allows perfect 

 with amounts charged by a supplier).

ices
 in with the date the invoice is created. If you need 

to enter your own dates, check this option. Note that you will not be able to 
ized invoices. 

tained by mSupply. You can only edit the confirm 

efault
he printing check box on supplier and customer 
On all invoices you can choose to print or not print- 
lt setting.
modify the dates on final

The entry date is still main
date.

OK button will print by d
If this option is checked, t
invoices is on by default. 
this merely sets the defau
[The closed date is the date before which no transactions can be entered. Set-
ting the close date means that all transactions up to that date are finalized 
and no more transactions with an earlier date will be able to be entered in 
the future . The close date can not be moved backwards- only forwards.

The locked date is the earliest date that can be entered for a transaction. The 
lock date can be moved forwards as far as the oldest non-finalized transac-
tion, and backwards as far as the close date

If you try to set an invalid lock or close date you will be warned.

Be very careful setting the close date. Changes to the close date can not be 
undone.

Invoices 1 

All Invoices....

Allow editing tax rate an
When checked the tax ra
wise, the default tax rate
amount can be directly ed
matching of tax amounts

Allow date entry on invo
Normally the date is filled

2000 20012002 2003

Close Date

Lock Date can be moved 
anywhere in this range Earliest non-finalized 

transaction date



Preferences...

Export invoices to a file when finalizing
If this box is checked, each time you finalize customer or supplier invoices, a 
tab-delimited text file of the finalized invoices will be created. This allows you 

Supplier Invoices....

hide batch number & expiry date entry
Some people use mSupply for inventory control of all sorts of general goods. 
Hiding these fields will speed up entering information if you do not use those 

tically
ly to put goods into stock when you auto-
 supplier invoice. Usually, you will want 

oon as it is entered. If for some reason you 
 invoices without having the stock immedi-
nchecked. You will then be prompted when 
lier invoice whether to confirm the invoice 

supplier invoices
n by the new line button on supplier 
om that displays recent purchases of the 

argin on supplier invoices
ere is a margin set for both the supplier and 
 the item margin will be used. If unchecked, 

le 
ly to record the outstanding amount to be 
is system is not activated, supplier invoices 

nding. (If you use a separate accounting sys-
lities, there is no need to use the inbuilt 

en receiving items
cturer field when receiving each item on a 

supplier invoice. Manufacturers are set up using ‘Show manufacturers’ and 
ier menu.
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Allow editing margins on supplier invoice lines
If this option is chosen, you can edit the margin for individual supplier invoice 
lines. Otherwise the margin will be locked at the margin set for that supplier 
in the window for editing supplier details (reached from the supplier | edit 
supplier menu..)

‘New manufacturer’ on the Suppl
to import the data into an accounting application. 

After deleting lines redo the numbering
If this box is checked, deleting invoice lines will result in all invoice line num-
bers being updated so there is no gap in the numbering.

Invoice line display
there are three possible ways for invoice lines to be sorted when they are dis-
played. Choose the one that suits your needs:

Activate budget module
In order to use the Budget feature, this box must be checked. For further 
information see Budget Overview on page 224.. This feature is applicable to 
store mode only.

Activate Ad Hoc items
Ad Hoc items allow you to receive and issue items that you will only use once. 
That is, you have ordered the item for a particular customer, and do not want 
to hold it in stock. For further information see Manage Ad Hoc items... on 
page 61.

fields.

confirm supplier invoices automa
Check this box if you want mSupp
matically click the OK button on a
stock to be available for issue as s
want to be able to enter supplier
ately available, leave this option u
you click the OK button on a supp
then and there or later. 

show comparative purchases for 
When checked, the window show
invoices will have a list at the bott
item you enter.

Item margin overrides supplier m
When receiving an item where th
the item, if this option is checked
the supplier margin is used.

Activate supplier payment modu
Check this box if you want mSupp
paid on each supplier invoice. If th
will display a zero amount outsta
tem, and us mSupply's export faci
payment system).

Able to specify manufacturer wh
Check this box to show a manufa

no particular sort order is slightly quicker at displaying the lines, 
especially if you have invoices with a lot of 
lines (eg more than 100)

by line number maintains the order in which you entered the 
items. This option is the one most commonly 
chosen by mSupply users.

alphabetically sorts alphabetically by the item name
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have any stock associated with it. Place holder lines can have an item name, a 
quantity, and a pack size, but the batch number is set to "none". 

s automatically
ot wish to run a 2-step issuing process for customer 
g process means that when an invoice is initially cre-
of "sg" ("suggested"). When you print a suggested 
l be printed. Stock on "sg" invoices has been taken 
y, but not from the "total stock" entry for each item 
rm" button is checked, then the customer invoice 

ger have a "confirm" button. The first time you click 
ing a new invoice, the invoice will immediately be 

s automatically
t to disallow editing of an invoice as soon as it is 
tton is clicked, on the main invoice form, the invoice 
urther editing allowed. Until the OK button is 
 lines can be edited.

, “confirm customer invoices automatically” will also 
n already. That is, if invoices are automatically 
utomatically be confirmed.

e on customer invoice lines
 price of lines on a customer invoice can be edited 

de or edited.

er lines on customer invoices
ecked, all lines on an invoice will have to be actual 
der system you must check this box.

tore mode
 window for issuing stock will be enlarged to show 

the area to enter abbreviations and customer directions or notes under store 
n invoices after each invoice line.

ispensary mode
 window for issuing stock will be enlarged to show 
ations and customer directions or notes under dis-
es print on invoices after each invoice line.

ts module
t mSupply to record the outstanding amount to be 
voice. If this system is not activated, supplier invoices 
When you confirm an invoice, if you are using a backorder system, place 
holder lines will be transferred to make backorders. If you are not using a 
backorder system, place holder lines will be deleted if the option below is 
turned on. 

Show transport details
If this box is checked, then a transport details button will be shown on cus-
tomer invoices, allowing editing of transport details (arrival dates, etc) and 
box numbers.

mode. These notes print o

Show direction entry in d
If this box is checked, the
the area to enter abbrevi
pensary mode. These not

Activate customer receip
Check this box if you wan
paid on each customer in
Invoices 2 

These options apply to customer invoices only.

We run a backorder system
Check this item if you want to record backorders for customers for supply at a 
later date (For suppliers, backorders are recorded in the ordering system as 
partially supplied orders). 

Note that if you use a backorder system it will affect the way "place holder" 
lines are handled. 

A place holder line is a line entered on a customer invoice which does not 

Confirm customer invoice
Check this box if you do n
invoices. A two step issuin
ated, it will have a status 
invoice, a packing slip wil
from the "available" entr
line. If the "one step confi
entry window will no lon
the OK button after creat
confirmed. 

Finalise customer invoice
Check this box if you wan
entered. Once the OK bu
will be finalised, and no f
clicked, individual invoice

If you turn this option on
be turned on if it is not o
finalis4ed, they will also a

Allow editing selling pric
When checked, the selling
as the invoice is being ma

Allow entering placehold
If you leave this box unch
stock. If you run a backor

Show direction entry in s
If this box is checked, the
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will display a zero amount outstanding. (If you use a separate accounting sys-
tem, and us mSupply's export facilities, there is no need to use the inbuilt 
payment system).

Delete placeholder lines when confirming invoices

box, allowing you to select a line.

Print the following message for placeholder lines
ssage typed in this field will be printed in 
 lines. For example, you might enter “backo-
ackordered. If you check the box and leave 
ill be empty. 

er invoices
tering customer invoices the user will be 
lable transaction categories. Transaction cat-
al > Show transaction categories menu item. 
stomer invoices have been set up, this 

a mono-spaced font, which tends to do a 
atrix printers. 
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When checked, placeholder lines are deleted when the invoice is confimed.

Select first batch when multiple batches present
When this box is checked the first batch (the one with the shortest expiry) will 
automatically be selected when issuing items. The cursor will then be posi-
tioned for you to enter the quantity.

If the box is not checked, the cursor will be positioned in the “line number” 

Form to use for packing slips
. Choose the appropriate form.

• "simple...."- this form uses 
better job with some dot-m
Show item category while issuing goods
If you are making use of the item category facility, checking this box will 
allow you to see the category of the item you are issuing as it is being issued.

Warn me if expiry is less than (days)
Entering a numver in this box causes mSupply to alert the user when any item 
selected is due to expire before this number of days has passed.

Disallow issue of goods with short expiry
If this option is checked, mSupply will not allow issue (customer invoices, pre-
scriptions) of goods with an expiry date less than the number of days speci-
fied here. Goods with no expiry date will not be affected. Note that once this 
preference is checked, there is no way for the user to override it- the rule is 
enforced until the preference is turned off. 

Enter zero in the field to disallow entry of goods that have expired.

Note that inventory adjustments and supplier credits can still be issued to 
remove goods from stock or return goods to a supplier.

Activate restricted item access by customer group
When this check box is checked, any item that is assigned to a department 
may only be supplied to customers who are members of groups linked to that 
item’s department.

See the section in the Item Menu chapter on the Manage item access… for 
more information on how to set up item departments, customer groups, and 
how to link groups to departments.

Warning: Checking this item may mean that some items can not be issued. 
Make sure you have set up the item access system properly before proceed-
ing.

When this box is checked, the me
the batch column for placeholder
rder” to show these lines will be b
this field blank , the batch field w

Require category entry on custom
If this option is checked, when en
required to select one of the avai
egories are set up using the Speci
If no transaction categories for cu
option will have no effect.

Printing 
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ing narcotics, and have the following message: 

• I have received the above Narcotics.

............

 that will be shown when you print a special invoice. 
lly used as narcotic receipt forms.

rsion 1.62. It allows the choosing of a particular 
ing invoices. More printer models will be added 

o choose, leave this option set to “None- show page 

f a printer, when you print an invoice the page 
 will not be shown. Instead, the invoice will be 
 print setting stored for that printer.

t balance on invoice.
 you are using the mSupply  cash receipts system, 
r balance will be printed at the bottom of each 

 invoices:
, GST or Sales tax) to your invoices, check this option 
x amount

s
ill appear on the top left header for most reports. A 
 is to include your organisation name.

s
Text you enter here will appear on the bottom centre space of each page of 

is space to include a confidentiality clause on your 

• Signed:.........................

• Position:........................

• Date:.............................

A message on a packing slip might be as follows: 

• Packed by:..................

• Date/time:..........................

reports. You might use th
reports.
• "nicer- for inkjet/laser"- This form is the recommended form. 

• "shop receipt" is a simple receipt for printing onto A5 size paper. Infor-
mation about batch and expiry is not shown.

Form to use for invoices. 
Choose the appropriate form to use when you print customer invoices.

Dont’t print placeholder lines in pick slips
Place holder lines will not be printed in pick slips if you have checked the 
“Don’t print placeholder lines in pick slips“ box in the preferences.

When printing a packing slip. 
Packing slips can be sorted by line number (the order they were entered), or 
by shelf location (which will enable a "logical" order for picking goods from 
the shelves). 

Print separate packing slips for these locations
By default mSupply will print a single pick slip for all locations. If, for instance, 
you need separate pick slips printed for cool store items (whose locations in 
your store start with “CS”), and for Dangerous drugs (whose locations in your 
store all start with “DD”), you would enter “CS,DD” (no quotes, each location 
separated by a comma) in this field. If a pick slip being printed contains CS 
items, they will be printed separaterly, and the same for items with a“DD” 
location.

Edit messages on printed forms.
Choose the appropriate form from the drop-down list (menu), and then click 
the "edit" button to edit the message that will appear on the bottom of 
every form of that type. For example, you may use the special invoice for issu-

• Checked by:............

Title on special invoices
Here you can enter a title
Special invoices are typica

Printer choices
This is a new option in ve
printer model when print
over time.

If you are not sure what t
setup”

If you choose the name o
setup and print windows
printed directly using the

Print customer statemen
If this item is checked and
the outstanding custome
invoice.

Print subtotal and tax on
If you are adding tax (VAT
to show a subtotal and ta

Default Header on report
If you enter text here, it w
common use of this space

Default Footer on report



Preferences...

Misc 

import the invoice into their system automatically.

Use a lock file if data already open
If this box is checked, mSupply will maintain a record of when it is open out-
side of the database. This option only applies to the single-user version of 

nd user attempts to open your data file 

 for example, you have a power failure and 
nly, mSupply will not be able to delete the 
ge when you attempt to restart mSupply 
 the data file. If you are sure this is not the 
 Mac Finder to locate the folder that con-

he file that has the same name as your data 
 will now be able to start mSupply. 

his option on unless you understand the 
 administrator who authorizes your use of 

this option might be useful is when you 
 server, and allow multiple single-user copies 
ta file. In such a situation to have 2 users 
aneously would be disastrous.

t in client-server mode- mSupply will prop-
 one data file in this situiation.

ly will ensure that each new item entered 

earch
roduced where the item’s catalogue code is 

stom fields that you can use to record your 
own data for each item. The first three fields hold text or numbers, the 

), and the fifth field is a numeric field. Here 
) for each field. Note that field one is also 
te also that when using the search editor to 
n producing a custom report), the fields are 

t with the labels you might have assigned. 
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This is an old copy- warn me at startup.
You may want to save an old copy of your data (for example the data as it 
stood on the last day of the financial year). If you check this box, you will be 
warned at startup if the database is an old copy, to reduce the risk of acciden-
tally entering current transactions into an old file rather than your current 
file. 

fourth field is yes/no (or true/false
you can specify the label(or name
displayed when you list items. No
search for items (for example whe
labeled "user field 1" etc. and no
Window Position
Here you can set the number of pixels from the top of the screen and from 
the left side of the screen (on Windows: the top/left of the application win-
dow) that new windows will open. 

Orders
Enter the number of days to "look back" when evaluating each item's usage 
to calculate the amount of stock needed. Entering a higher number will give 
a better long term average, but will mean that orders take longer to create. 

Own code for electronic invoices 
The code that customers must have for your organization in their copy of 
mSupply. This code is added to invoices you export, and allows customers to 

mSupply. This means that if a seco
while

What if your machine crashes? If,
your computer shuts down sudde
lock file, and you will get a messa
that another user is already using
case, use Windows Explorer or the
tains your mSupply data. Delete t
file but ends in “_locked.txt”. You

We recommend you do not turn t
above paragraph or have a system
this option.

An example of where turning on 
store your mSupply data on a file
of mSupply to access the same da
attempt to access the data simult

Note that this option has no effec
erly handle multiple user access to

Item codes must be unique
When this box is checked, mSupp
has a unique code.

Include catalogue code for item s
When checked, a report can be p
one of the search parameters.

Labels for custom item fields
mSupply provides you with five cu



Log

149

eed more detailed logging than is proved here. It is 
 future version- the trade-off is that it leaves the 

What is recorded
 log will record each new invoice created

invoice is considered to have been edited if it's 
l value has changed. The old value and the new 

ue are recorded in the log

enever a new customer or supplier is created, 
ir name and code will be recorded in the log.

Modifying an 
item's sup-

The supplier field for each ittem can be used to 
determine to whom orders for goods are placed 

pending on the type of order you generate). If 
 use this method, you may want to know if 
upply users change the preferred supplier for an 

h time a user logs in or logs out of mSupply
Log 
mSupply logs some significant events automatically, but other events are only 
logged if you select the appropriate check boxes on this tab. 

Please contact us if you n
easy to incorporate into a

plier field (de
you
mS
item

User log in 
and log out

Eac
Service items
Service items are items that do not have any stock associated with them. For 
example, a fee for special handling of goods, or for reprinting an old invoice, 
or a consulting charge.

These preferences determine whether new items are allowed to be service 
items or not. Note that changing this preference will not affect existing items.

Customer code and charge code must match
Customer code and charge code must match - If checked, when entering or 
editing a Customer, you will have to enter the same code for both the "code" 
and the "charge code" fields. (It is a good idea to leave this checked unless 
you have several customers that are invoiced separately, but whose invoices 
are collated onto a single statement at the end of the month) 

Supplier code and charge code must match 
If checked, when entering or edit a Supplier, you will have to enter the same 
code for both the "code" and the "charge code" fields. (It is a good idea to 
leave this checked unless you have several suppliers that are invoiced sepa-
rately, but whose invoices are collated onto a single statement at the end of 
the month) 

Currency formats
This option specifies the format in which currencies will be displayed in mSup-
ply. We provide two preset formats for currencies with 2 decimal places and 
currencies with none. If ou want to enter a custom format you can change 
the field below the drop-down list. For example you may want to use a dif-
ferent separator than a comma. Note that if you type illogical values into the 
field you can cause numbers to not display at all, or display erroneous data. 
Contact Sustianable Solutions if you need more information.

Item
Invoice cre-
ation

The

Invoice edit-
ing

An 
tota
val

Creating a 
new cus-
tomer or sup-
plier 

Wh
the
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potential open to create very large log files, which may be a problem for 
some users. E-mail 

ver. eg "mail.mac.com". You only need to 
 inbuilt email functionality.

ort servers that require authentication. We 
sk us nicely.

u only need to do this if you are using 
lity.

ded at the end to all e-mails you send. You 
might want to put your organization contact details here. It is generally poor 
etiquette to make your signature too long.

er" or "monaco" is better for viewing text 
 the automatic order generation in mSup-
ye appeal.
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You can choose from available fonts on your system, the text size and the text 
style. Click the OK button to save your changes, or cancel to exit the window 
without saving.

Use mono-space font by default
A mono-space font such as "couri
in columns, such as is produced by
ply . However, visually it has less e
Font 

You can edit the text styles used for items on customer and supplier invoices. 
Double-click an item to be shown the styles window:

Mail server name
The name of your mail (SMTP) ser
do this if you are using mSupply's

Currently mSupply does not supp
can add this functionality if you a

Return email address
Enter your own email address. Yo
mSupply's inbuilt email functiona

Signature
The text you enter here will be ad
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n to specify the destination of the backup files. We 
 backup to a different physical volume from the one 
 is stored.

mSupply server as a Windows service. This allows 
ntrol of the starting and stopping of the server from 
can be run when a UPS is shutting down. Please con-
ion.

 should be compressed or not from this drop-down 
 smallest backup size, but it will take longer for 
ompromise of speed and size.

le to-do list built into mSupply. 

ny reminders that are not completed and whose 
d will be displayed in a window when a user logs 

ee Reminders... on page 223.
If you are going to use this function, contact Sustainable Solutions. For more 
information on this function For further information see Backup...... on 
page 193.

The settings in this window are to be used only for single-user mode. In cli-
ent-server user mode you must set the backup preferences on the server 
machine.

Reminders provide a simp

If this option is checked, a
due date has been reache
on.

For further information s
Default subject line when creating orders
When mSupply  automatically turns an order for a supplier into an email, the 
text entered here will be put in the subject line. For example you might want 
to put "Acme Hospital order" to advise the supplier of its contents. Note that 
you can edit the subject line of automatically generated emails before you 
send them.

Sort order lines for email and HTML export by item name
This option allows emails generated automatically to be sorted alphabetically 
by item name before the email is created. If this option is left unchecked, 
emails will use the creation order of the order lines to create the email.

Backup 

Choose backup folder
Click the “Choose” butto
strongly recommend you
where your mSupply data

We recommend running 
automatic log on, and co
command line tools that 
tact us for more informat

Compression ration
Choose whether backups
list. Compact will give the
backups to run. Fast is a c

Reminders 
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Web server Moneyworks 

s accounting software, you can have mSup-
neyworks.

re information on these options.

.np for more information on Moneyworks, 
rsion.

neyworks. Don’t turn it on if you don’t 
 haven’t set up Moneyworks as described 

I.P. address of machine using Moneyworks
You only need to fill in the I.P. address here if:

ote machine across a network.

onnecting to a local instance of Money-
ty.
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• You are on Macintosh and

• You are connecting to a rem

If you are on Windows or a Mac c
works, make sure this field is emp
mSupply includes a built-in web server

Here you can set it to start, or to start automatically when mSupply is started.. If you use the superb Moneywork
ply directly input invoices into Mo

Contact <info@ss.org.np> for mo

Visit http://www.moneyworks.com
including a free demonstration ve

Link to Moneyworks.. check box
This option turns on linking to Mo
know what you’re doing, or if you
below.
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invoices that are about to be imported.
• If you still have no success, turn off the “Link to Moneyworks...” 

act <info@ss.org.np> if this is of interest to you.

 options

sary mode, you can choose have mSupply alert you 
nsary mode is explained further in Dispensary Mode 

tient history.... field determines how far back from 
 should look for drugs that interact with the drug 

re activated, you will be shown a warning message 
when you enter a drug on a patient invoice that interacts with other medi-
cines dispensed to that patient.
checkbox, and produce a file. Then manually import the records 
into Moneyworks using the File > Import > Transactions command 
(making sure you load the correct import map using the “Load” 
button). The file has errors, Moneyworks will give a more complete 
error report.

• Note that if export to Moneyworks is not successful, the transactions 
will not be finalized in mSupply, so you will not get invoices that are 
missed in Moneyworks.

We are also able to provide a similar option to link with Quickbooks account-
Notes on setting up Moneyworks:

• The import into Moneyworks relies on using an import map. The map 
for supplier invoices must be named “si_import.impo” and the map for 
customer invoices “ci_import.impo”. These map files must be stored in 
the “Import Maps” folder inside the “Moneyworks Customer Plug-Ins” 
which is next to your data file.

• The advantage of using import maps is that it gives you flexibility in 
deciding which accounts will be designated for sales and purchases, and 
the way the fields exported from mSupply are used inside Moneyworks.

• If you would like sample import maps from Sustainable Solutions, 
please email us at <info@ss.org.np>.

• Once you have set up the import maps and turned on the “Link to 
Moneyworks accounting software” checkbox, mSupply will attempt to 
send invoices to Moneyworks that are finalized using the “Finalize cus-
tomer invoices” and “Finalize supplier invoices” commands.

• Note that the “Export invoices when finalizing” option must also be 
checked. (This is found on the “Invoices 1” page of the preferences.)

• If you get an error when exporting, usually you will get a message tell-
ing you what the problem is. Things to check include
• Obviously, Moneyworks must be running
• Make sure the correct i.p. address is specified if connecting to a 

remote machine on Macintosh.
• Make sure any charge codes used are actually present in the Mon-

eyworks data file you are using. We can supply a version of mSup-
ply that automatically adds names to the Moneyworks data file if 
they aren’t found when exporting, but this costs extra!

• Make sure that Moneyworks has open periods for the dates of the 

ing software. Please cont

Drug interactions

When operating in dispen
to drug interactions.Dispe
on page 103

The number of days of pa
the current date mSupply
you have just entered.

When drug interactions a
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Customization Options Dispensary mode 

played on medicine labels on its own line.

f the dispensed item, e.g. In-Patient Dispen-
eate an identification code, and enter it in 
e last item printed on the the right of the 

 printed onlabels, check the box in Print pre-
scriber full name.

eparate line
ation address 1 as separate line, you can 
parate line. You have to set the text in Pref-
. The text which you type here will be dis-
wn line.
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Print organization address 1 as s
By checking the box Print organiz
print organization address 1 as se
erences: General >>address 1 field
played on medicine labels on its o
On request from client, we may make a changes to mSupply that are only visi-
ble to that client.This pane allows you to enter in a customization code to 
activate those changes

Message on labels
The text you type here will be dis

Custom identification code
If you wish to identify the origin o
sary or Out- Patient Dispensary, cr
this field. It will then appear as th
third line of each label.

Print prescriber full name 
To have the prescriber’s full name
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not been entered when they click the OK button for accept and print a pre-

t the default account codes that will be used when 
her manually or automatically.
scription.
Print a receipt on labels by default
mSupply allows you to print a patient receipt on a label; to enable this func-
tion by default, check the box Print a receipt on labels by default in Prefer-
ences:Dispensary mode as shown above. This has the effect of enabling the 
“Print receipt” check box in the Prescription entry window. Note that if the 
Print a receipt on labels by default is not checked, the function may still be 
turned on in the Prescription entry window. For further information see Print-
ing receipts on page 110.

Print patient category 
Once you check the box of Print patient category, you are able to print the 
patient category on medicine label on patient name line.For this, you have to 
set the patient category in Preferences: Dispensary mode.

Default Patient category
The text you enter into this field will be assigned to the category field for 
new patients.

Assign Patient codes automatically
If this box is checked each new patient created will have a serial number 
assigned to them. The assigned code can be overriden by the user.

Prefix codes with
The text you enter in this field will be used as a prefix for automatically gen-
erated patient codes. e.g. if you enter “t” codes will be assigned “t1”, “t2” 
etc.

Warn if no prescriber entered
If this checkbox is checked, then the user will be warned if a prescriber has 

Item 

In this window you can se
new items are created eit
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Purchase Order Defaults Purchase Order Printing

se Orders
n will be printed on purchase orders that 
nd includes a space for signatures. This is 
rders and post them to suppliers, but should 
nd purchase orders via email.

ing tenders and purchase orders as attache-
 an attachment being created in your cho-
hunderbird, Eudora, etc. (Windows only at 
t checked, emails will be created in the 

Note: this option requires that the Win2PDF driver be installed on Windows. 
Contact us to purchase. (On Mac the inbuildt PDF driver is used)

tomer price categories”, it will activate the 
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Prices
On checking the box for “Use cus
price categories.
This window allows you to enter text that will be printed on purchase orders.

The easiest way to see how these fields will look on a purchase order is to fill 
in the fields and then print a sample purchase order. Note that we are willing 
to design custom purchase order forms to meet individual needs.

Print signature scetion on Purcha
When this box is checked a sectio
shows the authorizing officer(s) a
applicable if you print purchase o
most likely be turned off if you se

Use system emailer....
When this option is checked send
ments will result in an email with
sen email client such as Outlook, T
this stage). When this option is no
mSupply email queue.
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s identified by it’s network card, so if you change the 
ve to re-enter the settings displayed here.

the location of your Spreadsheet application. Once 
ion, it won’t ask you again. Clicking the button 
ing common locations for Excel. If it finds them it 
. If it doesn’t it shows an open/save window where 
on yourself.

cel you want to use and then click OK. 

n-standard location you can use the “add another” 
d that location to the list.
This computer
The settings in this window apply to the computer you are currently con-
nected from. That means that if you are using mSupply in client-server mode 
you will see different values depending on which computer you are currently 
using.

Click on the version of Ex

If Excel is installed in a no
button to locate it and ad
By default all customers are assigned a price category of “A”

To assign a different category to a customer, choose Customers > Show cus-
tomers... and find the customer entry. Then set the price category field to a 
different value

Here in the preferences, you specify what percentage change to the default 
price will be made for each category.

For example, you might have a group of customers to whom you charge com-
mercial prices, which are 20% above your normal price. Enter “20” in the “B” 
category field, then assign your private customers a price category of “B”

Note that the computer i
network card you may ha

Excel location
Here you can set or reset 
mSupply knows this locat
results in mSupply search
shows the window below
you can choose the locati
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In client/server mode the location of Excel on each machine is stored sepa-
rately.

Staroffice and Openoffice are also supported- if you use these applications 

Here you can paste in a logo you have copied to the clipboard; it must be in 
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the form of a Bitmap (yourlogo.bmp) or a Tagged image format (yourl-
ogo.tif). 

If you want the logo to be printed on invoices, mark the checkbox.

Currently the logo will only print on purchase orders and invoices that print in 
landscape format (Choose the invoice format from the “Printing” pane of the 
preferences).
just choose the “Soffice.exe” file instead of “Excel.exe”

OK and Print

Checking these boxes means that the printing checkbox will be checked by 
default when the corresponding window is opened.

Note that you can still manually turned the option on or off in a window- 
these settings just affect the default value.

Logo
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lternatively, many reports are available from the Reports page of the Navi-
a

tions...
w present you with a window like this before print-
R

A
g
 tor, as shown below:
eport Menu

Report printing op
Many of the reports belo
ing the report:



Report Menu

This window allows you to set various options:

Report destinations

Header and footer

Preview on screen before printing
. Note that you can also turn on print pre-

 is displayed after you click the OK button.

layed and this allows you to create a report 
nts using the quick report editor; once cre-
e report in the custom reports folder for 

e three choices:

A list of tables on the left to choose which table (which type of records) you 
ms, etc. 

tions for transaction lines. The “Transaction 
allows you to search much faster on a large 
xample, if you are wanting to get the quan-
rs in a specific month, you would use this 
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You can choose what information will be displayed at the top and bottom of 
each page. The default report heading is set according to the report you are 
printing. By default, the date will print on the left and the page number on 
the top right of each page.

If you have filled in a default header and footer in the preferences, these will 
be displayed at the top left (for the header) and the bottom centre (for the 
footer)

want to report on, e.g. Names, Ite

As of version 1.6 there are two op
lines (Transaction query)” option 
number of transaction lines. For e
tity of each item given to custome
option.
Printer
On selection of this option, the print window will be displayed. The preview 
of the report can be displayed by turning on the print preview.

Open in Excel
If the ‘Open in Excel’ box is checked, mSupply will immediately open the 
report as a spreadsheet in MS Excel, provided MS Excel is installed on your 
computer; this feature also opens the report as a spreadsheet in Staroffice/
Openoffice. [We’ve included special code to make sure they open using the 
“Calc” module of these applications.]

When this box is checked, you will first be asked to save the report. Once you 
have given it a name, the report will be saved, and then automatically 
opened in spreadsheet form.

The first time you use this option, mSupply may ask you for the location of 
your spreadsheet program, which it will then store for future reference.

The location can also be set by choosing File > Preferences and clicking on the 
“This Computer” tab.

Save to HTML file
If this option is selected, your report will be saved with extension “.html”. 
Hence, it can be opened by any web-browser or spreadsheet application on 
any platform or operating system.

Save as Text file 
Your report will be saved to a file as a tab-delimited text file. (That is, a tab 
character between each column and a return character at the end of each 
row). After saving, you can open the file in a spreadsheet or word processing 
program.

This option turns on print preview
view from the print window that

Custom Report... 

The custom report window is disp
according to your own requireme
ated you may save the form of th
future use

The window requires you to mak

Report table
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your hard disk, and retrieve them next time you run the report.

ith the label editor, where you can design and save 
hese are useful for use with names for addressing 
 with Items for making tags for labeling shelves in 
e. 
is option the "Order by" window will appear after a 

ws you to sort the records into a particular order 
 labels. (In a nutshell: Drag fields from the list on the 
n the right to use them for sorting)

the menu
ed any reports in the custom reports folder which is 
der as the mSupply application, they will be listed 

ach table, and what each field contains, see the 
 in this manual.

yout
 you have used previously, and saved, may be 
e >Open on the menu bar, and selecting the 

ch) editor
 bit daunting, but is also very powerful and once 
apabilities, your competence to access the precise 
uire from within the mSupply database will signifi-
ples will later be described, but here we look at a 

med on the items table:
• If you save the report you have created in the Custom reports folder 
it will show up in the report form. drop-down menu on future occa-
sions when you choose custom report

• Note: Do not save any reports in the reports folder - these reports 
are reserved for special use, and modifying them could create prob-
lems! 

• New label layout
Which records
A series of radio buttons to choose which records to examine 

• All records

• New search (query), if you want to report on records meeting specific 
criteria. If chosen, you will be presented with the Query (search) editor, 
where you can build search statements to your heart's content! A short 
description of using the query editor is given below, and two example 
searches are later described. For a more comprehensive description, a 
range of books is available either in electronic or hard copy versions. 
Please email info@msupply.org.nz for more information.

• The "Current selection" is the group of records that were last displayed. 
For example, you can use the Item | View or edit item command quickly 
to find all items starting with "a". When you click the OK button, the 
items in the list are the "current selection". If you are not sure which 
records represent the current selection, you should click the "new 
search" radio button. 

Report form

• New report 
• After clicking the OK button you will be presented with the report 

editor where you can design a report. The report editor is some-
what complex, but time spent in learning how to use it is time well 
spent. It is a powerful and invaluable feature. A brief introduction 
together with designing two simple reports are given in Designing 
a Report below, and more details are available in training courses 
on using mSupply, and in publications available from Sustainable 
Solutions. 

• If you want to save a report or search (query), you can save them on 

• presents you w
label layouts. T
envelopes, and
your warehous

• If you choose th
query. This allo
before printing
left to the list o

• other items in 
• if you have sav

in the same fol
here.

For a list of the fields in e
Field Descriptions chapter

Using previously saved la
Any report layouts which
accessed by clicking on Fil
required layout.

Using the query (sear
The query editor can be a
you are familiar with its c
information you may req
cantly increase. Two exam
query about to be perfor



Report Menu

"Comparisons" on the right by clicking on the comparator you wish to 
use.

• The Conjunction. This does not apply to the first line of a query, but the 
second and any further lines need to start with a conjunction. Set the 
conjunction for the selected line by clicking the appropriate button in 

 window ("And", "Or" or  "Except")

Add Line" button.

complex query that you might wish to use 
 it to your hard disk and select it again using 
 the window.

ered, click the "Query" or "Query selection" 

ing of two custom reports, [1] listing in 
f all items presently in stock, and [2] listing 
tribution (customers) of a particular batch 
anufacturer recalls a particular batch of an 

 both examples, as features described in the 
 in the second.

om the Reports page in the Navigator, you 

e Items table, and to perform a New Search, 
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• The Query value. Is entered in the bottom area (above the buttons). In 
the example above, the field chosen is an alphanumeric field (the item 
code), so an entry area is displayed where you can enter text or a 
numeric value - in this instance the item code "gri250t" has been 
entered. Note that you can also use the "@" symbol as a wildcard in 
your query value to perform "contains" queries.

Our report requires us to select th
When you open the Custom Report editor, it is ready to take input values for 
a simple single line query. Each line of a query needs 4 items of information:

• The field to query. Choose this by clicking on the field in the middle-left 
list of fields. Just above the list of fields is a drop-down list that allows 
you to also choose fields from related tables. If you want to perform 
related queries, you need to know a little about the internal structure 
of mSupply data. Please contact us if you would like a diagram of the 
table layouts. A simple example of a related table is that each transac-
tion line is related to a transaction (many to one relationship). The 
means that you can use the information stored in the transactions table 
(eg invoice date, number, status, etc.) to query transaction lines.

• The Comparator. Choose the comparator from the list of fields under 

the bottom-left area of the

To add lines to a query, click the "

If you have spent time creating a 
on future occasions, you can save
the "save" and "load" buttons in

Once your completed query is ent
buttons to proceed.

Designing a Report
We shall now describe the design
alphabetical order the quantity o
the sources (suppliers) and the dis
number of an item - useful if a m
item. 

It is recommended that you study
first example will not be repeated

Report 1.
Having selected Custom Report fr
are presented with this window:
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 appears; this is where you can design the layout of 
w you want the records to be sorted:

ser look at the Quick Report features; there are two 
e which generate two specific types of reports: List 
ples are limited to the List mode, and the Cross 

table mode will not be described.

ypically display records as a list with break rows 
rformed.

report, you can specify the following:

y fields or formulas, either from the current table or 
.

er. 

ns.

2. Click on the comparison
In the List mode, reports t
where calculations are pe

When you create a quick 

• Columns that displa
from related tables

• Sort levels and ord

• Summary calculatio

• Display format.
using a new report form, so with these options selected, the window now 
looks like this:

Click OK, and the Query Editor window appears, as shown in the upper figure 
below; this is where you specify the criteria on which you wish to create your 
report - in our simple example, the single criterion is that there should be 
stock on hand of the item. In the lower window, we have specified this by [1] 
clicking on stock_on_hand in the Available Fields panel on the left, [2] clicking 
on is greater than in the Comparisons panel on the right, and [3] entering 0 
(zero) in the Value panel below. You will see that the conditions we specified 
now appear in the upper panel - it’s always a good idea to check here to con-
firm that the report will conform to your specified criteria.

Now click on the Query button in the lower right corner.

The Quick Reportwindow
the report, and specify ho

We'll start by taking a clo
operation modes availabl
and Cross table. Our exam

1. Click on the field to query
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e used as a basis for generating the report. 
ed in the Fields list and the related fields 
s table.

 be inserted into the report by double-click-
ose the type of display in the Field selection 

list located just above the area. Indexed fields appear in bold. You can also 
display and select the fields of related tables. 

etween columns of the report. They can be 
uce the size of each column. Manual resiz-

h option if it has been activated for the col-

Menu bar and
Tool bars

Title and Detail rows

Break rows

Sort list

Column divider 

Cell

Quick Report area

croll bars
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Column dividers: 
These lines show the boundaries b
moved manually to enlarge or red
ing deselects the Automatic Widt
umn concerned.
• Text for labels.

• Formats for numeric and Boolean data.

• Font, font size, style, and justification for labels, summary calculations, 
and data.

• Background colours on a cell column or row basis.

• Borders,Page headers and footers.

• Presentation style from a wide range of templates.

Master Table: 
This is the master table that will b
The fields of this table are display
will be displayed in relation to thi

Fields list: 
This list lets you select the fields to
ing or by drag and drop. You cho

Master table Field selection list S
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the report. It is repeated for each page of the report. The Quick Report editor 
inserts field names by default, but you can modify the contents.

ource of the data for each column.

as contextual menus that make it easy to access cer-
l operations. Instead of making menu selections or 
Column properties areas, you can perform certain 
a Quick Report contextual menu.

tual menus for row, column, and cell operations.

:

ter in a cell, a row title, or a column heading and
ht mouse button (on Windows) or press the Control
 in the report area (MacOS).

nu appears. The commands in the contextual menu
 your pointer is (i.e., a row label, column heading, or
commands that are inappropriate for the particular
ell are disabled..
d menu command:

, and Cells
Report, you need to select rows, columns, and cells 
A cell is the intersection of a row and a column.

lick on the Title, Detail, Subtotal, or Grand total cells 
a.

 - Click the Header row of a column.
Detail row: 
This row contains information drawn from each record and is repeated in the 
report for each record. You can associate a display format with it, depending 
on the type of data represented.

Subtotal rows: 
These rows display intermediate calculations as well as the wording that is 
associated with them. A row is created for each sort order.

Selecting Rows, Columns
When designing a Quick 
in the quick report form. 

• To select a row: - C
in the row label are

• To select a column:
Cells: 
A cell is the intersection of a row and a column.

Scroll bars: 
You use the scroll bars to view parts of the quick report design that extend 
beyond the area of the quick report form.

Sort list/Sort order display area:  
This list displays the fields of the report on which the sort will be carried out, 
as well as the sort order and whether it will be ascending or descending. Each 
field inserted into this list causes a sub-total row to be added in the Quick 
Report area.

Quick Report area: 
This area lets you build your report by inserting fields using drag and drop, 
double-clicking or via the contextual menu; you can also adjust the width of 
the columns added, or delete breaks or formulas, define the colors and bor-
ders of cells, etc.

Title row: 
This row displays the names of fields or formulas that have been inserted into 

Column data sources: 
These titles indicate the s

Contextual menus 
The Quick Report editor h
tain row, column, and cel
working with the Cell or 
operations by displaying 

There are separate contex

To use a contextual menu

1. Position the poin
hold down the rig
key while clicking
A contextual me
depend on where
cell). Also, menu 
row, column, or c

2. Choose the desire
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• To select a cell: - Click the cell.

Adding and Modifying Text

ently out of stock will not appear in the report.

The Quick Report window should now look like this:

d as appropriate by positioning the cursor 
column headings, clicking and dragging to 
olumn width is obtained:

f the columns indicates the right hand edge 
o to keep the report to single page width, 
the left of this line.

s it will be printed, click on File on the menu 
can scroll through the pages of the report, 
dea of how it will appear:
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The second column in our report will show the present stock of each item, 
and the same procedure is followed; select the stock_on_hand entry in the 
list, and double-click on it. You should be aware that items which are pres-
You can add or modify text in the quick report form to label parts of the 
report. For example, if you requested summary calculations, you can label 
them by adding text to other cells in the Subtotal and Grand total rows.

You can add and modify text as follows:

• Edit the text that automatically appears in the Title row of the report,

• Insert text in empty cells of the Subtotal and Totals rows,

• Insert the value of a Subtotal field in the Subtotal rows,

• Specify the font, font size, justification, and style for any text that 
appears in the report.

For our first report, we want two columns only, the first listing the items in 
alphabetical order, and the second showing the quantity presently in stock. 
This is achieved by double clicking on item name in the list, and then to have 
the list sorted alphabetically, make sure item name remains highlighted, and 
click on the green arrow in the centre:

The column widths can be adjuste
on the dividing line between the 
the left or right until the desired c

The vertical red line to the right o
of the page as it will be printed, s
columns should be positioned to 

To preview on screen the report a
bar, and select Print Preview; you 
and the diagram below gives an i
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his appearance:

r report a title to appear at the head of each page; 
 on File, then Header and Footer; a window 
 create and/or edit such a header You will most 
r to appear in the centre of the line, and in this case, 
enter panel in the Text Settings area; here you can 
r choice, and features such as bold, underlined, etc.; 
ader, not to the body of the report.

n File on the menu bar, and select Generate and - 
r is connected, online and loaded with paper - your 
For our report, pale yellow has been selected for the alternate row colour, 
The printed report may benefit from shading or colouring of alternate rows, 
and this is achieved while the report format is being set. In the Quick Report 
editor, click on Detail to highlight the row, then click on the Alt.background 
colour icon, and a chart appears from which you can select the colour(s) of 
your choice.

and the report now has t

Adding report title
You may want to give you
this is achieved by clicking
appears in which you can
probably want the heade
type your entry into the C
also select the font of you
these apply only to the he

To print the report, click o
provided that your printe
report will be printed.

Select your choice ofcolur 
from this chart

Alt background colour icon



Report Menu

will show the present stock of each item, 
ed; select the stock_on_hand entry in the 
ould be aware that items which are pres-
 in the report.

 now look like this:
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For our first report, we want two columns only, the first listing the items in 
alphabetical order, and the second showing the quantity presently in stock. 
This is achieved by double clicking on item name in the list, and then to have 
the list sorted alphabetically, make sure item name remains highlighted, and 
click on the green arrow in the centre:

The second column in our report 
and the same procedure is follow
list, and double-click on it. You sh
ently out of stock will not appear

The Quick Report window should
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type your entry into the Center panel in the Text Settings area; here you can 
also select the font of your choice, and features such as bold, underlined, etc.; 

om report window, this report requires us to select 
, and to perform a New Search, using a new report 

indow appears, expand the Item Key table, and 
wn the list until code appears, and select it by click-
 now shows [items]code, the default comparator is 
te the line, move the cursor to the Value entry 

f the window and enter 'gri250t'. Click on Add Line 
njunction And; In the Available Fields panel, shrink 
 batch, accept the is equal to comparator, and enter 
 panel. You have now defined the criteria for the 

o click on the Query button.

window appears, with the Master Table - in this 
 lines' table - expanded for selection of the fields 
e'll be using four fields from the master table, 
, pack and quantity; double-click on each of these in 
port design window should appear as shown:
these apply only to the header, not to the body of the report.

To print the report, click on File on the menu bar, and select Generate and - 
provided that your printer is connected, online and loaded with paper - your 
report will be printed.

Report 2.
The second report lists the sources (suppliers) and the distribution (customers) 
of a particular batch number of an item - useful if a manufacturer recalls a 
particular batch. The item chosen for our example is Griseofulvin 250mg tab-
lets, the code for which is gri250t, and the batch no.is D1174

The Quick Report design 
example the 'Transaction
required by our report;  w
namely item name, batch
the list, and the Quick Re
Adding report title
You may want to give your report a title to appear at the head of each page; 
this is achieved by clicking on File, then Header and Footer; a window 
appears in which you can create and/or edit such a header You will most 
probably want the header to appear in the centre of the line, and in this case, 

Having displayed the cust
the Transaction lines table
form,

When the Query Editor w
once expanded, move do
ing on it;the upper panel
equalto,and  so to comple
panel in the lower part o
and accept the default co
the Item Key table, select
'D1174' in the Value entry
report, so you are ready t

You can drag the divider between columns to 
adjust the width of any column
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D
th
se
Ta
d

The table to access is the Transactions table, and the fields we require are 
In
th

eport are now selected, and we can arrange them in 
is is easily performed by selecting the column to be 
the item name to be the first column, so we select it 
n heading, and move it by clicking on the 'Move Left' 

umns using the 'Move Left' icon and the 'Move Right' 
der from the left is:

ter in landscape rather than portrait form, so click on 
elect landscape. Once you have done this, you can 
en by clicking on the 'Print preview' icon; this is how 
0

voice number, type, and confirm date. Double-click on each, then expand 
e Names table, and double-click on name. 
on't be concerned at the order in which these fields appear in the report for 
e moment - we'll rearrange the order once all the fields have been 
lected. The fields we now need to add are in other tables; presently 'Master 
ble' is selected ,and we need 'Related Tables', which is selected from the 

rop-down menu.

All eight fields for the r
their required order. Th
repositioned - we want 
by clicking on the colum
icon.

Select and move the col
icon until the column or

• Item_name
• Batch
• Name
• Type
• Invoice_num
• Confirm_date
• Pack_size
• Quantity

The report will look bet
File > Page Setup, and s
view your report on scre
it should look: 
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count the number of transactions, and display the totals involved. Observe 
the two rows added to the report annotated with the sort parameters fol-

 adjusted as described earlier, and having a look at 
ble appropriate widths to be defined.

pear something like this:

's not necessary to display the Invoice type, so this 
ight click on the column heading, and from the con-
de'; move the Count icon in the type column to the 

s the field name in the displayed column heading, 
lumn headings by double clicking on the cell in the 
tion point cursor appears and the current entry is 
ace the default text with whatever you consider 

ection of presentation styles available, any of which 
port. On the menu bar, click on Style > Presentation. 
ning a header for the report, we have opted for 
 the appearance you see below.

e, you may wish to run your reports again. You 
copy of each report in the Custom Reports folder; 
ng on File on the menu bar, and selecting Save or 
 a name, and saving it in the Custom Reports folder, 
location of your choice. Then when you’re ready to 
lowed by 'change'; these are the break points in the report, and the results of 
any calculations are displayed in these rows ..... here's how; a hash, '', is 
entered in the appropriate row - in our example, the '[Transactions]type 
change' row; we need to know how many customers have been supplied 
with this batch, so the Count icon is inserted in the row - note that it does not 
matter which column has the Count icon - for the time being it is entered in 
the 'type' column; also required is the total quantity ordered, and the total 
quantity distributed, so the 'Sum icon' is entered on the same row, but in the 
'quantity' column.

At some time in the futur
should, therefore, save a 
this is performed by clicki
Save as, giving the report
or any other appropriate 
The next steps are :

[1]to sort the report

[2] to perform some simple calculations

[3] to display this information.

[4] to adjust the column widths  All these are simple to perform on the 
Custom Report window:

[1] Sorting the report. Drag and drop in the 'Sort order' panel the parameters 
required - in this example [Transactions]type and [Transactions] confirm_date.

[2] Performing calculations and [3] Displaying the information.  We need to 

[4] Column widths can be
the Print preview will ena

The report should now ap

Only two tasks remain! It
column may be hidden - r
textual menu, click on 'Hi
name column.

mSupply by default enter
but you can edit these co
'Title' row, when an inser
highlighted; you can repl
appropriate.

Finally, there is a large sel
can be applied to your re
In our example, after defi
Classic 2 giving our report
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run the report next time, having specified your criteria in the Query Editor, 
when the Quick Report window first appears, click on File on the menu bar, 
select Open, and retrieve the desired report from its saved location, preview it 

ple), it is suggested that you record it in one of the available user fields. The 
DDD value should not be recorded in mSupply’s DDD factor field

 some simple criteria are entered in the 
te reports giving, for example:

or all items supplied to a specific hospital 

or all items in ATC category “J” supplied to 
s “h” (for hospital) for a particular month.

 for all essential drugs supplied to all custom-

number of DDDs supplied for each category 
 you have "DDD factor" values entered cor-
egory are shown (not each individual trans-
d, or exported for use in another 

tions in the window... summary level...- 
gory field is then evaluated based on the 
 code is "broken down" as follows 

feine" is N06BC01. "N" is the level 1 code, 
el three code, "C" the level four code, and 

position 

character 1 (A-Z) 

2 characters 2 & 3 (01-99)

character 4 (A-Z) 

character 5 (A-Z) 

characters 6 & 7 (01-99)
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The category analysis report is designed to be used in conjunction with the 
"category" field and the "DDD factor" field for each item. 

 So, for example the code for "caf
"06" the level 2 code, "B" the lev

3

4

5

and print it.

Category Analysis...

ATCs and DDDs
“ATC” stands for “Anatomical, Therapeutic, Chemical”, and is a method of 
classifying chemical entities, and identifying them by category.

“DDD” stands for “Defined Daily Dose”, and provides a means of comparing 
the utilisation of different drugs in a meaningful way. - e.g. if a dispensary has 
issued 10,000 x doxycycline 100mg and 20,000 x amoxycillin 250mg, a greater 
number of amoxycillin capsules has been used; but according to the DDD 
method, a greater number of patients have been received doxyxcycline.

Thanks to the help of the WHO Collaborating Centre on Drug Statistics and 
Methodology, we are able to offer a starting drugs file with their codes; we 
have plans (not yet implemented) to maintain on our website an up-to-date 
list of ATC and DDD codes for essential drugs.

Reports using ATC and DDD codes
mSupply is designed for the ATC code to be entered in the Category field for 
each item, and is then able to report on supply transactions, giving a break-
down according to the different levels of the ATC code.

The DDD Factor field is intended to store the item’s number of dose units in 
its DDD; for example, if an item’s DDD is 1,000mg, and the supply is made 
using 250mg units, the DDD factor is 4. When designing a report, the total 
quantity of this item used should be divided by the DDD factor to obtain the 
number of DDDs supplied.

Should you wish to store an item’s DDD value (1,000mg in the above exam-

When you produce a report, only
form. It is a simple matter to crea

• A level one ATC summary f
during a 12 month period

• A level two ATC summary f
customers who are coded a

• A level three ATC summary
ers for a particular quarter.

The report provides you with the 
at the level requested, presuming
rectly. Only the totals for each cat
action). The report may be printe
application. 

Let's run through the different op
enter the summary level. The cate
ATC coding system. Note that the

level

1
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the second popup menu. For example, if you want to report on a certain 
group of hospitals, you could enter those hospitals as having a category "h", 

ats for displaying the transaction information by 
the list

What it does
 name The report will sort each invoice in the 

date range according to the name (Sup-
plier or Customer) and give totals for 
each name.

 date As above, but totals given for each day.

Each invoice line by item This report lists each item supplied or 
received, and lists the transactions for 
that item. This report can be very long

fit The cost and selling price totals for each 
invoice are displayed.

d by 
m

The invoices will be grouped by the item 
department assigned to each item. Each 
item department is further sorted by 
items in alphabetical order.
and then report on "names whose category starts with 'h'"

Transactions.... 
This report summarises supplier or customer transactions in a number of for-
mats.

Each invoice showing pro

Each invoice line groupe
item department then ite
"01" the level 5 code.

Note that if you choose "level 3", you will also be shown the summary values 
for "level 1" and "level 2" as well.

Which type of item? 
You can report on all items, or you can report on just a certain category. For 
example, you can enter "J" here to report only on items whose ATC code 
starts with "J". Note that you need to set the summary level to "level 2" or 
your report will only report the total for category "J" without any further 
breakdown of data. 

only report on essential drugs 
Check this if you only want to analyze items whose essential drug check box is 
checked. 

Transaction type? 
- Normally we will be interested in supply to customers. However, we might 
also be interested in "what percentage of purchases from IDA (a supplier) are 
aniti-infectives?", in which case we would click on the "items received from 
suppliers"

Date range... 
Enter a starting date and an ending date. Only transactions whose confirm 
date was within the range will be analyzed. The default range is the last 90 
days. Note that the dates you enter are included in the range (that is the 
"from" date is "on or after" and the "to" date is "on or before") 

Which customers/suppliers...
Leave this value blank to report for all customers. Otherwise, choose "code" 
or "category" from the popup menu, and the appropriate comparison from 

Type of report 
Choose from several form
clicking on the format in 

Report name
Each invoice grouped by

Each invoice grouped by
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Totals for each category As above, but only the totals for each 
category will be displayed- each transac-
tion will not be shown.

section below.

Prescriber report This report allows you to view the total 

Cross tab: items in rows, names 
in columns, value in cells

These reports are like Excel pivot tables. 
Warning: they can be slow to produce if 
you have a lot of data. Start with small 
date ranges until you are comfortable 
your machine can handle the load. Note 
that reports that produce a lot of col-
umns won’t print well- it is better to 
export them to a spreadsheet and print 
from there.

See above

See above

See above

First the report is grouped by item name 
and then by the pack size issued. It dis-
plays the total quantity and total count for 
each item.

The report is grouped by each item’s 
transaction category first and then by 
each item.The report shows the total 
count, total quantity and total value for 
each item. Lastly it also calculates a 
grand total of the items count, quantity 
and value columns.

The invoices are firstly sorted by the 
address1 field, and then by the name 
they were supplied to. This groups 
invoices together by whatever you 
entered in the “Address1” field for each 
name - e.g. you might enter the region or 
province.

As above, but the first sort is by the entry 
in “Address2” field.
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value, mean item value and item count 
for prescriptions dispensed for each pre-
scriber

Each invoice sorted by Address2 
and name
Totals for each item Each item that has been received (or 
issued) will be shown with the total quan-
tity and value received/issued

Totals grouped by item and 
names

Firstly the totals are broken down by 
item, and within each item, totals are 
shown for each name that has supplied/
received that item.

Totals grouped by name and 
items

As above, but firstly sorted by name, and 
then broken down by item within each 
name.

Totals for each name The total value of items received/sup-
plied to each name

Totals for each item department The total value supplied/received for 
each item department is shown

Totals for each item grouped by 
day

The total quantity and value of each item 
is shown for each day.

Totals for each item grouped by 
month.

The total quantity and value of each item 
is shown for each month.

Totals for each item grouped by 
item description.

First the report is sorted by item then the 
total quantity and price of each item is 
shown. It also provides a grand total for 
the item quantity and price columns.

2 period comparison by item cat-
egory

The user selects two periods, and the 
transactions for each period form a col-
umn. The rows are determined by the 
item category. This is a special report 
that has different input options. See the 

Cross tab: items in rows, names 
in columns, quantity in cells

Cross tab: items in rows, days in 
columns, value in cells

Cross tab: items in rows, days in 
columns, quantity in cells

Distribution of quantities issued

Totals for each item grouped by 
transaction category then item

Each invoice sorted by Address1 
and name
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Enter the date range of transactions to report on. Note that the date used is 
the date the invoice was confirmed, which may differ from the original entry 

 year” refers to the year before the current year 
urrent year is 2005, choosing “last year” will set the 
Jan 2004 to 31st Dec 2004.

r customer code or category of transactions to be 

m either "equals" for an exact match or "starts 
 all names whose code or category starts with the 

tegory that can be used to group certain kinds of 

rt on transactions for a single name, you can find 
ng up their details using Supplier > Show suppliers or 
ustomers.

Item filter
Here you can specify the items to include in the report.

item choice options will be hidden because the cho-
 transactions, not on transaction lines:
date, depending on how your system is configured in the preferences.

• Note the popup menu to the right of the date entry fields that allows 
you to quickly choose from a list of common date ranges:

Note that sometimes the 
sen report is reporting on
Transaction type 
you can choose to report on:

• sales to customers (customer invoices: type “ci”)

• sales to and credits from customers (customer invoices & credits: type 
“ci” & "cc")

• purchases from suppliers (supplier invoices: type "si")

• purchases from and credits to suppliers (supplier invoices & credits: type 
“si” & "sc")

• Inventory adjustment - add stoc k (Refer to pag e no. 65)

• Inventoru adjustment - Reduce stock (Refer to page no. 65)

Date range -  

• Note that “last
(That is, if the c
dates from 1st 

Name filter
You can enter a particula
displayed. 

• You can choose fro
with" to search for
entered text.

• Each name has a ca
names together.

• If you want to repo
their code by looki
Customer > Show c

Customer ordered short fall 
report

 Where there has been a short fall, this 
report shows the short fall of each item 
and of each item category by quantity 
and percentage. It shows what demand 
from customers has been met or unmet. 
It applies only for issues to customers.

Each invoice line grouped by 
name

The invoice lines for the chosen date 
range are groupted together for each 
name. This report allows you to quickly 
see what has been issued to a client or 
clients.
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Which mode?
If you are using mSupply in both store and dispensary mode, you might want 
to report only on transactions in store mode or in dispensary mode. You can 

To set up item categories, choose Items > Show item categories

Take the following simple example of categories that have been set up as fol-

 hierarchy with a period (dot).

 as many characters as you like

 as long as you don’t use a period or a space. 
urgical gloves small” is a valid entry. (Level 
 is “gloves” etc.).

 the category name is finished enter a space 
er a description for that level of the hierar-

ary level of “none” each category is shown

vel one chosen, only the first level of the 
egories 1.1 and 1.2 and 1.1.1 have all been 
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lows:
If we run the same report with le
hierarchy is shown. Items with cat
summarised under “1 Antibiotics”
do this by checking Store mode or Dispensary mode radio button depending 
on your requirements.

The 2 period comparison by item category report
This report allows you quickly to compare sales or purchases for 2 periods of 
your choice based on item categories.

When you choose this report a different set of options is shown.

Set the date range for each of the columns and then choose a summary level.

Dot notation and summary levels
The summary level is based on the item category field. If you have set up item 
categories using dot notation, then you can summarise categories. 

The rules for dot notation are

• Separate each level of your

• Within a level you can have

• You can use any characters,
e.g. “surgical.gloves.small S
one is “surgical”, level two

• When the hierarchy part of
character. You can then ent
chy.

If we run the report with a summ
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The check-box “Exclude Ad Hoc item” is displayed accordng to the type of 
report selected. By default, it is checked.

nfirming invoices” must be un-checked.

 select the desired parameters and click OK. An 
below.
When checked, the transaction report generated will not include any Ad Hoc 
items (items you don’t normally keep in stock).

Customer Ordered Shortfall Report
When you choose Report> transactions and then select “Customer ordered 
short fall report“, the transaction report like the one below will be produced. 
This report is used only for sales to customers.

Note that for this report to make sense the preference”Allow placeholder 
lines on customer invoices” must be checked, and the preference “Delete 
And with level two chosen, items with category 1.1.1 and 1.1.2 are summa-
rised under the heading “1.1 Penicillins”

Note that if you have items to which no category has bbeen assigned, they 
are shown under the heading ‘none” at the top of the report.

The categories are printed in the order that you have specified by drag-and-
dropping in the window shown by choosing Item > Show item categories....

Transaction filter
Filters the report for given category

Prescriber filter
Displays reports for gven prescriber only, depending upon the selection made 
(equals, starts with, contains, is not equal to).

Exclude Ad Hoc item

placeholder lines when co

From the report window,
example report is shown 
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Purchase Orders...
• The Outstanding Purchase Order Lines report, which will display all Pur-

chase Order lines for Purchase Orders provided that (1.) delivery is 
incomplete, and (2.) the Purchase Order has a Confirmed (“cn”) status. 

whose status is Finalised (“fn”) will be 
is particular report.

ed; options are:

ween two specified dates entered in the 
pdown list on the right affords ten preset 
, “yesterday”, “this week”, “last week”, 

ppliers meeting specific criteria by selecting 
code” in the left dropdown list, “equals”/ 
entre dropdown list and making an appro-
ht. If this field is left blank, the report will 
uppliers within the chosen date range.

ed to items meeting specific criteria; here, 
e” / “Item name” / “ABC category” / “Shelf 
down list repeats the options in the para-
 entry is made in the field on the right. 
l produce a report on all items within the 

chosen date range.

You can also report on items that have a certain category. By default this 
h means the item category will be ignored.

t on invoice lines will produce meaningful 
eria. Reports that report on whole transac-
 by name” or “Each invoice grouped by 
ul data, as any one invoice can contain mul-
port on invoice lines (e.g. “Each invoice line 
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Note that the number of lines received may not match the number 
ordered as a single Purchase order line may be supplied in split deliver-
ies, as in example shown, or an ordered line may not be supplied at all.

option is set to “Don’t care”, whic

Note that only reports that repor
results when you choose item crit
tions (e.g. “Each invoice grouped
date”) will not produce meaningf
tiple items. Choose reports that re
Types of report
There are three reports currently available:

• The Ordered ItemReport will list items that are on purchase orders 
according to criteria specified.

• The Goods Received data vs Order date report lists each Goods Receipt 
for a particular purchase order and the number of lines received, then 
follows with details of the number of lines and date of the original pur-
chase order, as in the example below. This is useful for tracking supplier 
delivery performance.

Note that Purchase Orders 
ignored when producing th

Date range and date type
A date type option must be select

• creation date

• sent date

• expected delivery

• actual delivery

The report may be generated bet
From and To fields, while the dro
date range options, from “today”
“this month”, etc. 

Report on names .....
The report may be confined to su
“name code” / “analysis” / “Price 
“starts with” / “contains” in the c
priate entry in the field on the rig
include purchase orders from all s

Report on items .......
Similarly the report may be confin
the left dropdown list is “Item cod
location”/ “Flag”, the centre drop
graph above, and an appropriate
Again, leaving this field blank wil
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•  Enter the value of a transaction line above which to report on. 

tems based on the value sold in the period specified. 
is referred to as an "ABC" analysis or a "pareto" 
ved that 20% of the items an organisation supplies 
of the value. Therefore, it is useful (and wise!) to 
 20% of items that are most important. This report 
at. 

lowing information: 

de in report
s to be included in the report.

The default date is for the last 90 days, but you can enter any date you wish 
 its "analysis" field updated with the total value of 
ecify to the current date.

..
eport on all names. You can enter a name code or 
duce the report for just one name, or for a group of 

re ordispensary mode or both modes of transactions 
It may be good for your organization to have a purchasing policy that stipu-
lates that transactions over a certain value must be authorized by a second 
party (that is, someone other than the purchaser). This report allows you eas-
ily to monitor such a policy. 

The report will be printed, or you can use the "print preview" check box in 
the "print" window to view the report onthe screen before printing. 

here. Each item will have
sales from the date you sp

Report on names whose.
Leave this field blank to r
analysis field value to pro
names.

Which mode...
You can choose either sto
by item” or “Totals for each item grouped by month”)

Order status
The default order status is “All”, but the dropdown list allows the report to 
be confined to orders Suggested, Confirmed, Finalised, or Confirmed and 
Finalised.

Purchases... 

This report finds all purchasing transactions with a specified time period that 
are over a certain value.

 There are two items of information to enter: 

•  Enter the date range of transactions to report on

ABC analysis... 

This report will rank the i
Sometimes such a report 
analysis. It has been obser
usually accounts for 80% 
concentrate firstly on the
makes it easy to do just th

You need to enter the fol

Number of items to inclu
Enter the number of item

Date range
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to be included in the report.

Exclude Ad Hoc items

range chosen.

• The cumulative liability for expiring items for each of the next 12 
months.

• The 12 most valuable expiring items (or at least batches of particu-

g
o view your report on screen first.

eport directly in your chosen Spreadsheet 

..

l stock value either for a particular depart-
 also report on the stock value of items with 
 by entering appropriate search criteria.
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• The 10 suppliers from whom you have purchased the most in the date 
range chosen.

• The 10 customers to whom you have supplied the most in the date 
range chosen.

• If you check the “Include section on expiring items” checkbox, a section 
will be included that lists:
f you check this box then Ad Hoc items will not be included in the report. 

The report lists items starting with the one with the highest value of sales. 
The value of sales and the percentage of the total value are also shown. Note 
that the total value is the total for the items in the report, not the total sales 
for all items. If you want to report on the total for all items, set the "number 
of items to report on" to a number greater than the number of items in your 
data file (Note that this may make the report very long, but you can choose 
just to print the first few pages if you wish).

Management summary...
This report is designed with line managers in mind, or other people who 
want to “keep their finger on the pulse” of their organisation but are not 
interested in the fine detail!

You’ll be shown a window where you can choose a date range for the report:

The report provides the following information:

• The total value of stock on hand

• The 10 items with the largest stock value

• The 10 items with the largest value of supply to customers in the date 

lar items)

Preview on screen before printin
Check this checkbox if you want t

Open report in Excel
Check this checkbox to view the r
program.

Show total stock value.

This report is used to find the tota
ment or all departments. You can
a particular name or shelf location
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have created.

 separately” will also give you a column on the right 
e a physical stock take, you can enter the quantity 
ock, allowing any corrections to be made in mSup-

h item” will not show individual batches, but the 
and of each item.

h batch in stock, with a total at the end of the 

habetically either by item name or shelf location, 
ave chosen in the “Sort report by” options

 that lists the stock at the start of the year. 

produce a report for the stock in your store on a 
particular date. You are shown a window like this:
Should you wish the report to give information a particular location, then 
that location should be specified , selecting the appropriate operator of the 
three available in the drop down box alongside the Filter by actual stock loca-
tion option.

Report format
You can choose from three formats:
Current Stock... 

A report will be produced that lists each item line that is currently showing 
stock greater than zero. 

Type of report
A “Find” report allows you to enter the normal item find criteria to choose 
which items to include.

A random report allows you to enter a number only. That number of items 
will be randomly chosen, and stock take sheets for those items printed. This 
facilitates spot checking of your actual stock situation.

Additional options
Should you wish the report to be department specific, then that department 
should be selected from the drop down list of the departments which you 

• “Each batch shown
where, having don
that is actually in st
ply.

• “Total stock for eac
total quantity on h

• List the price of eac
report.

The lines are reported alp
depending on what you h

Opening Stock... 

A report will be produced

Stock on date...
This report allows you to 
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The graphical stock history report allows you to view the value of your stock 

are then able to enter the dates for any period you would like to view:

istory report showing stock value will be dis-

item or items showing the quantity of stock 
ed period.

ting of confirm dates on transactions this 
to accurately calculate the information used 
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over a desired period of time. When you choose graphical stock history, you 

Graphical daily stock
This report shows a graph for an 
on hand for each day over a defin

Note that if you have allowed edi
may affect the ability of mSupply 
Enter the date for which you wish to show the stock.

Type of report
You have 3 options:

1. Show items only: each item in your system will have a single entry
with the total quantity on that date.

2. Show items with batches: each batch, its expiry and batch number
along with the quantity of stock will be shown.

3. Each batch - for spreadsheet: as 2., but every row has an entry, to facil-
itate sorting, etc. on a spreadsheet.

In the right hand box you choose whether to include transactions for the day 
you are reporting on or not.

The Report on items whose.... box allows you to restrict the report to certain 
items only, and/or to items with a certain category.

Open report in Excel
Check this checkbox to directly open the report in Excel rather than printing.

Graphical stock history

Select OK and a graphical stock h
played
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s out-of-stock of key items from one year to the 

ntities
 your current stock and, based upon a required 
er which you enter, to suggest how much of each 
hould consider ordering. You’ll see this window:

ll items, leave the item name field blank, otherwise 
de. For example, to report on amoxycillin stocks, 
nto the field.

 graphic, after the item name and code choices, 
luding the names given to custom item fields in the 

tegories, then use the item category list to choose 
rt on.

n list to find Items with a particular code, or to use 
ed into one of the custom user fields. If this isn’t 
 complex find button to display the full query edi-
This window also displays a list of items that were found. To display the graph 
for a different item, choose it from the list.

This report can be used as one of a set of key indicators for performance of a 

If you wish to use item ca
the item category to repo

You can use the drop-dow
the values you have enter
powerful enough, use the
tor.
in this report.

Choosing this item from the menu show this window:

Enter the date range, and the items on which you wish to report on. Remem-
ber you can use the item flag field to select an ad hoc list of items to include 
in your report.

Clicking OK displays a window where you are shown a graph of the quantity 
in stock on each day for the first item that matched the criteria you entered. 

facility by comparing day
next.

Suggest order qua
Use this report to analyse
number of days stock cov
included stock item you s

If you want to report on a
enter an item name or co
you could enter “amox” i

As shown in the following
other fields are listed, inc
preferences.
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Click on the refresh button (double blue arrows) to calculate the number of 
items these basic parameters will find.

Only include items whose stock cover is less than....

Item list...

 on-screen or printed list of items.

ted in the window, but please tell us what 
r adding it.

ata” as an option unless you purchase a 
Supply, in which case you can view reports 
Supply. Contact us for more information.

n of item usage for the last few months, 
rs, It also includes stock on hand and stock 
 report.

l for forecasting or for seeing a list of items 

 you are shown a window like this:
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If you want to report only on items whose stock is low, enter the threshold 
for days of stock on hand into the second field. For example, entering 90 into 
this field will only include items in the report whose stock is not sufficient to 
cover average usage for the next 90 days.

Enter “0” (zero) for this field to report on items with any amount of stock 
remaining.

Include items with no usage in the last 12 months
If this box is checked, items with no usage over the last year will be included. 
This check box will have no effect if the previous “days cover” field is filled in, 
as an item with no usage will have “infinite” cover- any stock you do have is 
going to last you forever!

Include usage for build ingredients
If you manufacture items, you can choose whether the use of ingredient lines 
in manufacturing is included in the report or not.

Order quantity for X days stock cover
In this field, enter the number of days stock cover you want to have available. 
The report will automatically take into account any stock you already have, so 
all you need to do is enter how many days cover you want, starting from 
right now, in this box.

Open report in Excel
Checking this box opens Excel (or any installed spreadsheet) and displays the 
report directly. If you want to save the report, choose File > Save as... in your 
spreadsheet program.

This report allows you to view an

There is only one report layout lis
you would like, and we’ll conside

Local/Remote Report
This option will only show “local d
web services enabled version of m
from remote locations running m

Item usage...
This report gives you a breakdow
with summaries for the last 2 yea
on backorder for each item in the

The report produced is very usefu
that need to be ordered.

When you choose the menu item
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If you wish to use item categories, then select the item category list to choose 
the item category to report on.

 items in the report whose stock is not sufficient to 
he next 90 days.

eld to report on items with any amount of stock 

ge in the last 12 months
s with no usage over the last year will be included. 
o effect if the previous “days cover” field is filled in, 

 will have “infinite” cover- any stock you do have is 

gredients
, you can choose whether the use of ingredient lines 
ed in the report or not.

xcel (or any installed spreadsheet) and displays the 
t to save the report, choose File > Save as... in your 

...
ow to enter the item details:

in the top section. 

t for all items, leave this field blank. Otherwise enter 
e the report to just a few items (e.g. entering “am” 
rt of just the items whose name starts with “am” 
oxycillin, etc.…)
You can use the drop-down list to find Items with a particular code, or to use 
the values you have entered into one of the custom user fields. If this isn’t 
powerful enough, use the complex find button to display the full query edi-
tor.

Click on the refresh button (double blue arrows) to calculate the number of 
items these basic parameters will find.

Only include items whose stock cover is less than....
If you want only to report on items whose stock is low, enter the threshold 
for days of stock on hand into the second field. For example, entering 90 into 

Enter your search criteria 

Item name field

• If you want a repor
some text to reduc
will produce a repo
(Amitriptylline, Am
You can choose whether to carry out an item usage report, a suggested 
ordering amount report, or to auto generate a tender from the drop-down 
list at the top. This form is used for all 3 functions. For now, leave this as it is.

If you want to report on all items, leave the item name field blank, otherwise 
enter an item name or code. For example, to report on amoxycillin stocks, 
you could enter “amox” into the field.

As shown in the following graphic, after the item name and code choices, 
other fields are listed, including the names given to custom item fields in the 
preferences.

this field will only include
cover average usage for t

Enter “0” (zero) for this fi
remaining.

Include items with no usa
If this box is checked, item
This check box will have n
as an item with no usage
going to last you forever!

Include usage for build in
If you manufacture items
in manufacturing is includ

Open report in Excel
Checking this box opens E
report directly. If you wan
spreadsheet program.

Item slow movers
You will be shown a wind
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Months stock

• Enter the number of months stock to report on. Items with more than 
this number of months stock on hand will be included in the list. The 

For example, entering 31/8/11 will display all items with expiry dates before 
31st August 2011 (Enter the date in short format in the way your computer is 

Quotation Summary...

n section, namely: All quotations and Pre-
options in Group together by section. They 

ns in which “Preferred” is set to true or 

hose quotations in which “Preferred’ is set 

ation report on the basis of supplier.The 
o a particular supplier are listed along with 

n report with the items arranged in alpha-
sponding supplier’s name.

g you to narrow your search further by lim-
ing your specified criteria - e.g. the supplier’s 
he resulting report will display only quota-
.

This report allows you to print information about the transport details for a 

ere you can select a date range and choose 
d by a particular method, by a particular 
lar name or names.
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set to handle dates (DD/MM/YY or MM/DD/YY or YY/MM/DD). Three report 
type options are offered; select as appropriate. You may refine the search by 
using the Name filter.

range of invoices.

First you are shown a window wh
to report on only invoices supplie
responsible officer, or to a particu
correct figure to enter here depends upon your desired stock turn. In 
general, if you are turning over your stock 3 or 4 times a year, you 
would want to know about items which have more than 8 months 
stock on hand.

• The report is calculated using the last 12 months usage as a guide to the 
average monthly usage.

You can check the Open report in Excel box to open the report in Excel, or 
any installed spreadsheet.

The report produced is very useful for managing under-performing inventory. 
It allows you quickly to obtain a list of items where a reduction in stock is 
desirable.

Expiring items... 

This report will ask you to enter a date, and will then give a report of all item 
lines in stock whose expiry date is before the date you have entered.

There are two options in Report o
ferred quotations. There are two 
are Supplier and Item

All quotations shows the quotatio
false. 

Preferred quotations shows only t
to true.

Supplier option displays the quot
quotations for the items related t
that supplier.

Item option displays the quotatio
betical order along with the corre

In addition there is a filter allowin
iting the report to suppliers meet
name code may be entered, and t
tions from that particular supplier

Transport Report
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ns window is shown, where you can choose the des-
nd footers.

otals
ade for use in dispensing situations where you want 
ber of prescriptions and items issued in a day. How-

ever, it is also useful for getting a quick view of workload for a month or a 
year in store mode.

 shows a window like this (but without any user 
Choosing this menu item
names and totals)
Click “OK” to run the report.
Note that transport details can only be entered on customer invoices if you 
have checked the “We use box numbers” option in the Preferences

Prescriber report
This report (v1.93 onwards only) allows you to view the total value, mean 
item value and item count for prescriptions dispensed for each prescriber.

You will be shown a window with the normal date range options, and the 
option to only report on prescibers whose type field is set to a certain type....

Click OK to proceed. 
As usual, the report optio
tination and set headers a

User transaction t
This report was initially m
a quick count of the num
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Debtors... 

payment... and enter the name of the customer with an overpayment. You 
will be asked if you want to use the overpayment amount for this payment. 
Choose use, then allocated the overpayment to outstanding invoices.

 
ow to find customers.

ers, leave the entry field blank. Click OK 
 any customers who match the criteria 
h no amount outstanding will not have a 

at are not available or insufficient stock is 
s of the order placed by the customer. Infor-
 name, current stock, customer code, b/ord 

stem this gives you a quick way to check if 
ck so they can be supplied to customers.

Suggest price list additions... 
Note: the price list menu items are for those organizations that produce a 

eful to call your publication a "price indica-
rice is a guide, and not a fixed price). You 
ftransactions and the number of months 
onths) that would make an item eligible for 
 is performed using the criteria you enter, 
eet the criteria but are marked as not being 
188

This report will produce a list of all debtors. mSupply uses an open-invoice sys-
tem of accounting for debtors, so the outstanding amount for each invoice is 
displayed. 

Not e that the total outstanding on invoices is not reduced for any previous 
overpayment by a customer, but this is listed in a separate column in the 
report.

To remove overpayment amounts from the system, choose customer | new 

price list or price indicator. (It is us
tor", as it implies the published p
are asked to specify the number o
(e.g. 2 transactions in the last 3 m
inclusion in the price list. A search
and a list of items is shown that m
Date range
You can either enter dates manually or choose from the drop-down list to the 
right of the date fields.

Time range
Enter times here in 24 hour format (e.g.. 9:00 in the “from” field and 17:00 in 
the “to” field. Leaving these fields on 00:00:00 will calculate for the whole 
day.

To calculate totals, click the Show button. If there are a lot of transactions to 
evaluate, a progress bar will be shown.

Click the OK button to close the window when you are finished.

Customer statements...
You will be presented with a wind

If you want a report for all custom
and a report will be produced for
entered. Note that customers wit
statement printed for them.

Backorder report
This report shows a list of Items th
present to meet the requirement
mation about the item code, item
quantity is displayed.

If you are running a backorder sy
backordered items are now in sto
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If you wish to include different information, you can create a custom report 
to do this.

range

 see the item ledger between the two dates you 
ther filtered by using the normal search section 

oblems... 
ith a list of items whose ledger balances (total in 

 equal the difference between the opening stock 
and.

report to investigate further.

 created as a check that the ledger was being accu-
e different transactions in mSupply. It has been left 
lso useful to pinpoint unauthorized adjustment of 

.. 
 a full item ledger at the end of the financial year.

arting letter. If you are printing a ledger for the end 
most likely good to type "a" and print, then choose 
 type "b"- this way the report will be divided into 
inting of a particular section again.
Print item ledger.
This report is for printing

You will be asked for a st
of the financial year, it is 
the menu item again and
sections, allowing easy pr
in your price list. You can double-click on items in the list and click their "price 
list" check box to add them to the price list. 

Update price list... 
 This item updates the prices of items from the item line on hand that has the 
most stock.

 Only items whose "price list" check box is checked are updated. 

Each line of stock is evaluated to determine which stock line you have the 
most of. That line is used as the indicator price for its item.

 Note that if an item has no stock, then the price for that item will not be 
altered. 

 It is a good idea to run the "suggest price list additions" report first.

Price list...
 All items that are marked as included in the price list are placed in a report. If 
you wish to export to a text file, choose "save to disk" in the report options 
dialog that is shown. Note: items that are in stock, but that are marked as not 
in price list will not be included.

 The exported file has fields separated by tabs and records separated by 
returns. The field order is: 

• Item 

• pack size

• price.

Item Ledger date 

This report can be used to
set. The ledger can be fur
underneath.

Look for ledger pr
This report presents you w
minus total out) does not
and the actual stock on h

Double-click a line in the 

The report was originally
rately updated with all th
as a menu option as it is a
stock values. 
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Location report...

ated locations.

Manage Reports...
 built-in reports:

ually need editing. If you know what you 
rt and then click the “Edit report button” to 

Using the report editor is complex, but it has the potential to produce a lot of 
inable Solutions for a link to download a 

on, changes you make to a report will affect 
 without some forethought....

o save face by undoing the damage they 
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Check the “open in Excel” checkbox if you wish to directly open the saved 
report in Excel (or any installed spreadsheet).

Click the OK button to run the report.

useful information. Contact Susta
separate manual on the subject.

Note that in a multi-user installati
all users, so don’t change a report

Revert report
This button allows intrepid souls t
This report is available in version 1.96 and later.

This report lists the location description, type, capacity, used volume and per-
centage available. Choosing this menu item shows you the location report fil-
ter options widnow as below:

The report may be restricted to certain locations by using specific search crite-
ria. Choose either “Code” or “Volume“ from left drop-down list is . The cen-
tre drop-down list allows you to choose a comparitor.

You have to make an appropriate entry on the right-hand field. Leaving the 
field blank means no filter will be applied.

Location type
It allows you to choose a location type. You can select the one from the drop-
down list on the right side. The graphic of location type is shown below.

For example, you can specify the location type“COOL” to show only refriger-

Choosing this item shows a list of

The built-in reports should not us
are doing, you can click on a repo
be shown the report editor.
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have done to a particular report. The report that was installed with mSupply 
will be reloaded from the disk, and any changes you have made to the ver-
sion stored with the data will be discarded. 

Revert All button
This button returns all reports to their original state when you installed 
mSupply. Use it with caution.
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File menu...

n

 

ta file will contain no items, names or transactions. You can either 
 

le currently in use (saving any changes 
en the new data file.

re than one data file, use the “About mSup-
enu (mSupply menu on Macintosh), where 

played.

 same data file from 2 or more single user 
e. You will corrupt your data. If you require 

r licence!

nge to a different user without quitting 

our computer, choose this item before you 
xt user will have to log in with their user 
 access. 

 the option of quitting mSupply or re-
sword. This stops a new user canceling the 
Supply under your login details. 
Note that if
menus will 

New dat
This comma
you can cho

If you click t
(saving any

The new da
enter these
to import it

This comma
you can sele

If you click t
manually or use the import commands (see later in this chapter) 
ems, names and stock.

Open data fileFinalising…

nd will present you with a standard open/save window where 
ct an existing data file to open. 

he OK button after successfully selecting a valid mSupply data 

If more than one user is sharing y
leave the computer so that the ne
name & password before gaining

Clicking the Quit button gives you
entering your user name and pas
window and continuing to use m
 you are running mSupply in Finalisingdispensary mode, the 
ot match the descriptions here. 

a file…
nd will present you with a standard open/save window where 
ose the name and location of a new data file:

he OK button, mSupply will close the data file currently in use 
changes made automatically), and then open the new data file.

file, mSupply will close the data fi
made automatically), and then op

Note that if you regularly use mo
ply…”. Command from the help m
the data file currently in use is dis

Warning:: Do not try to open the
copies of mSupply at the same tim
multi-user access, buy a multi-use

Change user
This menu item allows you to cha
mSupply. 
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computer where someone else is already logged in to mSupply, or else your 
work (and mistakes!) will be attributed to the person who was logged in.

kup of your datafile to be made to the specified 
.The backup path can be set from File> Prefer-
backup manually as well as automatically. It is not 
base before performing a backup.

 both in single user as well as multi-user mode. 
his command performs a backup of the server data. 
ow how the backup is proceeding.

 , you can’t run “Backup“ and “Restore“ function-
ld always be run from the server computer.

up configuration“ for more details on page 246.

 you to choose a backup data file,;uncompress it 
and start using it as your main data file.

In client/server usage this command will have no effect.

oring. We suggest you consult Sustainable Solutions 
re.

 invoices....
us "cn" (i.e. confirmed invoices) may be finalized. If 
n turned on in the Preferences, finalized invoices 

llow import into an accounting program. They can 
Be very careful about rest
before attempting a resto

Finalise customer
All invoices that have stat
you have the export optio
will also be exported to a
Change Password
You can change your password using this command. You must know your old 
password to do this.

 
You are required to enter the new password twice to ensure you have typed 
it correctly. 

Note: passwords are case sensitive- make sure you don't have Caps Lock on. If 
you forget your password you must ask the user who is either first or second 
in the password list  to change your password for you. 

Edit users and groups... 
For further information see Restricting User Access on page 98.

Show current user...
A small window appears to show the current user (in case you've forgotten 
your name!). Actually, it is important to ensure that you do not start to use a 

Backup......
This function allows a bac
locationin your computer
ences.You can perform a 
necessary to quit the data

“Backup” function works
Under multi-user mode, t
A progress window will sh

Note:- In multi-user mode
from the client . This shou

See “mSupply Server back

Restore...
Choosing this item allows
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also just be "exported" to a printed list.

Once an export is done, invoices can no longer be edited. (They have status 
"fn" for finalized). 

• Hold down the control key (Windows) or command key (Mac) while 
clicking on the lines you wish to finalize. The lines you have selected will 

• Once you are satisfied with the records you've selected, click the OK 
button. (In fact, don't just be satisfied, be extra sure- you can't reverse a 
finalization. It really is final). 

rked as "finalized" (status "fn"), and they 

 to print the list of finalized invoices.

 the Preferences, a text file called 
ated on the disk (& in the folder) you have 

 invoices, they are given an export batchFi-
 number that allows you to recall those 

ccounting software, you can export invoices 

 in the Preferences, rather than exporting a 
mpt to connect to Moneyworks, and 
oneyworks, where a debtor invoice is cre-

You can then use Moneyworks superb state-
l over the form design) along with it’s open 
itor payments to take over the handling of 
info@sussol.net> if you would like more 

ices when finalizing” is turned on in the 
en finalized but not yet given an export 
list. If any such invoices exist you will be 
d "supplier_invoice_expt.txt" will be cre-

cified in the Preferences.

 Client/Server mode, exports will be sent to 
the "export" folder located in the same folder as the 4D client application.

s... .
ces.... section above, but for supplier invoices

upp_invoice_expt.txt”
194

be highlighted. 

• To reverse a choice click on the line again. 

• If you want to choose all the transactions displayed, type control "a" 
(Windows)/ command "a" (Mac) 

Finalise supplier invoice
As for the Finalize customer invoi

The export file created is called “s
Each time a group of invoices is exported, they are all assigned a common 
"batch" number. You can use this batch number to export an invoice again, 
should your export file become lost or damaged.

On choosing File | Finalize customer invoices... you will be shown a window 
displaying all the customer invoices that have not been finalized. 

Note that if “export invoices when finalizing” is turned on in the Preferences, 
invoices that have been finalized but not yet given an export batch will also 
be included in the list. If any such invoices exist you will be alerted to the fact.

Follow these steps: 

• The transactions will be ma
may no longer be edited. 

You will be given the opportunity

If you have specified the option in
"cust_invoice_expt.txt" will be cre
specified in the Preferences. 

Each time you finalize a group of
nalisingFinalising. This is a unique
invoices

Moneyworks exports
If you are using “Moneyworks” a
directly to Moneyworks.

If you have turned this option on
text file to disk, mSupply will atte
directly send the invoice data to M
ated for each invoice in mSupply. 
ment production (with full contro
item handling of debtor and cred
payments and receipts. Contact <
information.

FinalisingNote that if “export invo
Preferences, invoices that have be
batch will also be included in the 
alerted to the fact. A text file calle
ated at the location you have spe

Note: if you are using mSupply in
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cial year until all builds are finalized.

e shown on the right hand side of the invoice list.

mited text file of items with this command. 

mand only imports items and not the stock. If you 
, see the next heading: “Import items & stock”.

mand you are first shown an open/save window 
e text file to import. Once you have chosen the file 

 headers
line of your import file for column headers, check 
ill ignore the first row in the file, and start import 
See the sections above for the details of how to finalize transactions. The 
process is just the same for builds.

Export a batch again...
Choosing this item presents you with a window where you can choose a 
batch number to export again:

First line contains column
If you have used the first 
this box. Then mSupply w
from the second row.
Finalise inventory adjustments...
You need to finalize inventory adjustments so that they can be purged from 
mSupply at a later date. Also, you will not be able to set the start of year 
stock at the beginning of the next financial year until all inventory adjust-
ments have been finalized.

On choosing item | finalize inventory adjustments... you will be shown a win-
dow displaying all the inventory adjustments that have not been finalized. 
Follow these steps:

• Hold down the control key (Windows) or command key (Macs) while 
clicking on the lines you wish to finalize. The lines you have selected will 
be highlighted.

• To reverse a choice click on the line again.

• If you want to choose all the transactions displayed, type control "a" 
(Windows)/ command "a" (Macs)

• Once you are happy with the records you've selected, click the OK but-
ton. (In fact, don't just be happy, be extra sure - you can't reverse a 
finalization. It really is final).

The transactions will be marked as "finalized" (status "fn"), and they will no 
longer be able to be edited.

Finalise builds...
You need to finalize builds so that they can be purged from mSupply at a 
later date, or to disallow any further editing of particular builds. Also, you will 
not be able to set the start of year stock at the beginning of the next finan-

Invoice batch numbers ar

Import items....
You can import a tab-deli

Please note that this com
would like to import both

When you choose the com
where you can choose th
this window is displayed
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Remove quote characters on import
Note that if you do not check this box , mSupply will strip out quotation char-
acters as MS Excel inserts quotes around fields when it shouldn’t. If you have 

mSupply) in a spreadsheet program such as MS Excel or Appleworks to view 
what the file should look like. The "edl_tab.txt" file is available on the down-

Column Column Field Description

e 8 alphanumeric characters (must be 
a unique value) 

e 30 alphanumeric characters 

3 alphanumeric characters(ea, ml or 
mg). Entries in the units list will be 
created if you import a unit that does 
not already exist in the data file.

e 
e 

integer 

l: you don’t have to include them:

a- 20 alphanumeric characters 

d 30 alphanumeric characters 

d 30 alphanumeric characters 

d 30 alphanumeric characters 

d “true" or "false" 

“true" or "false" 

e- 30 alphanumeric characters 

e 30 alphanumeric characters- the ddd 
and its units 

13 M ddd factor number greater than zero (default=1) 

14 N item The long description for the item. Do 
not include carriage returns (new 
lines made with the return or enter 
key) in your text file.

The name of the department that the 
item belongs to. If the department 
does not exist, mSupply will create it.
196

load page of the mSupply web site 

Field order for the text file: 
descrip-
tion

15 O item 
depart-
ment
put the quotes character into a field as an abbreviation for an “inch” it will 
be removed.. (Consider using the metric system! )

FinalisingDuplicate items in mSupply
mSupply can allow you to import items into a data file that already contains 
item, depending on which radio button you have chosen for the duplicate 
codes section. 

Create new duplicate and continue
Even if the code is a duplicate a new item will be created. Note that you can 
not use this option unles the preference “Allow duplicate item code” is 
selected in the mSupply Preferences

Ask each time
mSupply will warn you if it detects an item with the same code as an existing 
item. Having two or more items with the same code will not affect how 
mSupply works

You can open the "edl_tab.txt" file (A sample file containing a representative 
selection from the WHO Essential drugs list already formatted for import into 

Number Letter

1 A item cod

2 B item nam

3 C units 

4 D referenc
pack siz

The following fields are optiona

5 E shelf loc
tion 

6 F user fiel
1 

7 G user fiel
2 

8 H user fiel
3 

9 I user fiel
4 "

10 J edl 

11 K ATC cat
gory 

12 L ddd valu
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rows unless you know what pack size you want to use as the “standard” 
(Don’t worry about this. The reference pack is used for comparing quotations. 

new data file and chose the import command. 
g box to the text file and click “OK” to import the 

ant to remove quotation mark characters. If you 
icrosoft Excel, it adds quotation marks around fields 
m (even though it shouldn’t). If this is an issue, 
ove the quotation marks.

ock
 item only imports item codes and descriptions, 
 the task of entering quantities for all items (usually 
adjustment). 

ck command lets you import item codes, names and 
m. 

You can now import items and stock into an existing data file; however, this is 
a somewhat risky procedure, and we do not recommend it. If mSupply 

ort with the same code as an existing item, the 
 existing item.

oceeding with this command.

n item
rious batches of an item separately. For example, if 
two batches of “ace250t” on separate rows. mSup-
 description and code and then enter in the stock 
You can receive and issue any pack size you like).

Save a spreadsheet file as shown above as a tab-delimited text file. 

detects an item in the imp
stock will be added to the

You have been warned!

Make a backup before pr

More than one batch of a
It is possible to enter in va
your import file contains 
ply will first fill in the item
The chances are that you already have a set of codes that you use internally. 
In this case open up Excel or a similar spreadsheet program, fill in the item 
description in the order shown above. For a quick solution, you only need to 
take account of the first four column, the rest can be ignored.

The third column representing “Units”, can be left blank, however, it is better 
to fill this in. The fourth column “reference pack size” can be set to “1” for all 

Open up mSupply with a 
Direct the open/save dialo
file.

You will be asked if you w
have created the file in M
that have a comma in the
choose the option to rem

Import items & st
The Import items… menu
which still leaves you with
by entering an inventory 

The Import items and sto
the initial stock of that ite

16 P account 
code for 
stock

The account code used for stock 
purchases . Note that these 
accounts will be created if they don’t 
exist. 

17 Q account 
code for 
cost of 
goods 
sold

18 R income 
account 
code

19 S category The item category is actually stored 
in a separate table. As each item 
category is imported, a new record 
is created in the “item_category” 
table if one does not already exist. 
We strongly recommend you use the 
WHO EDL categories for this field

Column
Number

Column
Letter

Field Description
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for the first batch the item. For the next line of data, mSupply carries out a 
search for the code, and adds another batch as the same item already exists, 
and then updates the total quantity. 

Field order for import file

porting purposes, firstly you need to enter 
eet (e.g. Microsoft Excel). The first row 
scriptions or left blank as the import func-

tion will ignore this row.

You can omit the batch number and expiry date columns as in the example 

 item code assigned: any lines without an 

Column Field Note

Upto 20 characters

Upto 50 characters

Up to 3 characters

Integer

The number of packs (not the total quan-
tity. Although if the pack size is “1” then 
this will be the same as the total quan-
tity).

The price of one pack

The selling price of one pack (Set to the 
same as the cost price if you do not sell 
stock you issue)

Up to 20 characters

In short format (dd/mm/yy or dd/mm/yy 
depending on the format set in your 
computer’s operating system)

Up to 32000 characters (Be careful not 
to have any carriage return characters in 
the text though, or the import file will not 
be valid)

Text
198

below.

Note: make sure every line has an
It is not necessary to group the same batches together, but making sure that 
various batches of the same item have the same identical code is important, 
otherwise extra items will be created. The actual full name of the product is 
taken from the first batch the program encounters; subsequent batches that 
have the same code as an item that already exists in the data file will use the 
item name of the exisiting item. (You can even leave the item name blank for 
subsequent lines if you want to).

Note on pack sizes
The “pack size” and “quantity” field should be entered taking into account 
the way you will issue stock (For example, say you are importing Amoxycillin 
stock of 3000 capsules that are in boxes of 100. If you are going to issue stock 
of Amoxycillin individually (28 to this patient, 21 to another patient), then 
enter a pack size of “1” and a quantity of “3000”. If you will only issue whole 
boxes, use a pack size of “100” and a quantity of “30”. If you enter a pack 
size and quantity that does not fit, you will still have the option of repacking 
the items (using the “repack” function from the “item” menu) to meet your 
supply needs.

In order to create a text file for im
your stock details into a spreadsh
should be taken up by column de

1 Item code

2 Item name

3 Units

4 Pack size

5 Quantity

6 Cost price

7 Sell price

8 Batch

9 Expiry

10 Description

11 Shelf Loca-
tion
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s whether the name being imported is a customer or 

lesser number of columns, and mSupply will only 
tion you have provided.

-delimited text (rows end with a carriage return and 
ted with a tab character). Note that MS Excel tends 
ters (line feeds and quotes), but mSupply will grace-

 without complaining!

 this menu item will show a window where you can 
 not to ignore the first line (you will want to if you 
 row for column headings), and whether or not you 
e feeds and quote characters (which you’ll want to 
xcel to save the text file.

nu item “Import abbreviations...” and “Import pre-
wn the standard mSupply import window. For fur-

ort items & stock on page 197.

nt names, leave column B (the full name) blank. 
ame and First name columns, and mSupply will 

automatically generate the name field for you. Below is an example of 
importing patients, customer and supplier name that demonstrate how to fill 

o import type.

J Customer group. If the group name does not exist, it 
will be created by mSupply on the fly.

Meaning
Customer or Patient

Supplier

Both a customer and a supplier
in the field with respect t
K Last name (make sure this field is blank if you are 

importing a supplier or if you are importing a cus-
tomer who is not a person [that is, an organisation])

L First name (applies only to people)

M Date of birth

N Gender (enter “F” or “True” for females. All other val-
ues taken as male)
item code with be skipped when importing.

Once you have completed the spreadsheet list, save the file as a tab-delimited 
text file. Open up mSupply with a newly created data file and choose File > 
Import items & stock. A window will appear allowing the import file to be 
located. Choose the text file that you have created and click “OK”. If the file 
has been successfully imported, an “All done” message will appear.  

Import customers and suppliers
The Import customers and suppliers… menu item allows you to import cus-
tomers and suppliers into an mSupply data file.

The required field order is

• Column C describe
supplier:

• You can provide a 
import the informa

• Save the file as tab
columns are separa
to add extra charac
fully remove these

• Note that choosing
choose whether or
have used the first
wish to strip out lin
do if you’ve used E

When you choose the me
scribers...” you will be sho
ther information see Imp

Importing patients
If you are importing patie
Make entries in the Last n

Column Field

A Code

B Name

C Type

D Address1

E Address2

F Country

G Email

H Phone

I Category. The customer or supplier category will be 
created if it doesn’t already exist. If the name is a 
customer and a supplier, a customer category will be 
created.

Value
C

S

(blank)
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s by checking the New search check box, 
r you to specify your search criteria, or else 

.

t repeatedly, you can save an export format 
d it will be available for re-use later. Saved 

 menu in the export options window.

tions window will appear.

 will be exported by double-clicking records 
t few records is shown in the lower pane.

 re-use, click the  button (arrowed) to save 

To import Patients, column B [Names] needs to be left blank but 
Last name & First name must be completed
200

Here you can choose which fields
from the list. A preview of the firs

If you want to save the export for
If you have a lot of patients there will be a short delay once you have chosen 
the import file while mSupply counts how many records there are to import, 
then a progress window will be shown to inform you what proportion of the 
import process has completed.

Export....
This command will display the export window, allowing you to export records 
from mSupply to a file.

You can search for a set of record
which displays the Query editor fo
use the currently selected records

If you use the same export forma
in the "export_projects" folder an
projects will appear in the popup

When you click OK the export op

For Supplier, columns B 
[Names] , K, L, M & N 
should be completed..

If ‘Type’ column is left blank, 
this represents both customer 
& supplier.

For Customer, columns B 
[Names] , K, L, M & N 
should be completed..
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Exit/Quit

nts can be retieved if the document has not been 

 selected text and places it on the clipboard

y selected text and places it on the clipboard

ed text (if there is any) with the contents of the clip-
ted text, the clipboard contents are inserted at the 
ng cursor)

e particular field.

s are dimmed out,  it is because you are not cur-
. 
This command will exit mSupply. 

There is no need to save your work. mSupply does this automatically.

The Edit Menu 
The commands in the Edit Menu can be used when you are entering text, just 
the same as in a word processor. 
the settings to disk. Locate the "export_projects" folder in the same folder as 
the mSupply application, and save it in that folder. It will then be available 
from the popup menu next time you do an export.

Export items...
This option allows you to export all of the stock items in your data file to a 
text file, in a format recognisable by mSupply so that you can later import 
them to another data file. When you select this option you will see this dialog 
box:

Click continue to carry on. The standard file dialog window for your operat-
ing system will appear, allowing you to select a file name and location to save 
the text file.

Export names...
This option exports all the names (suppliers, patients and customers etc) in 
your data file in exactly the same way as for Export items... above.

Preferences
For further information see Preferences... on page 141.

Undo: The previous conte
saved.

Cut: Deletes the currently

Copy: Copies the currentl

Paste: Replaces the select
board. If there is no selec
insertion point (the blinki

Clear: Clears the text in th

If the copy/cut/paste item
rently in a text entry field
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f the Show customers menu item, which works in exactly the same way.

e
e

r

 this item.

ave invoices entered against it and you are export-
ounting program, a new "creditor" must be made in 
 with the same code, or you will get an error when 
ally make the code when you get the error in your 
n you try to import!)

editing a supplier contains basic information. Fields 
that especially relate to suppliers include:

s, enter the currency used by this supplier. This value 
alue set in the "default currency" option of the 

age) that will be added to the cost price to calculate 
ter an invoice. For example, if you enter "10", items 
 bought for 30 dollars will have their value 
S

S
Yo

N

Fo
o

N
R
b

Se
p

ew Supplier invoice...
cord the receipt of goods here. Each invoice provided by a supplier should 
 entered using this command.

e the Section entering supplier invoices for a detailed description of the 
ocess.

Currency
If you are using currencie
will be filled in with the v
preferences.

Margin
The amount (as a percent
the sell price when you en
from this supplier that are
upplier Menu

how invoices....
u can view or edit supplier invoices using this command.

ote that finalized invoices can no longer be edited.

r further information see Show invoices.. on page 216. for a full description 

New Supplier...
To add a supplier, choose

Note- if this supplier will h
ing invoice data to an acc
your accounting software
you import! (You can usu
accounting software whe

The window for viewing/
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increased by 10% (i.e. 3 dollars) and will be sold for 33 dollars.

Freight factor

Note that the transaction uses the cost price of the goods to calculate the 

access" group can perform this action.)

rt an invoice generated by one of your sup-
 will be presented with an open/save win-
 invoice file to be imported.

mporting invoices:

 generated by the "export invoice" com-
Supply.

y of mSupply must have your supplier codes 
pply attempts to import a code that it does 
ss will stop.

mported, you are still free to edit it. You 
ainst a paper copy when it arrives.

ed so that if you attempt to import an 
e able to. This prevents accidental double-
ice. 

m a supplier, you must perform the follow-

 item you receive from the supplier. This is 
f the item details window, or from the 
etails window.

 the item in the supplier code field of the 
 to enter other details for the quotation if 

ture to mSupply. Versions 184 and 186 
f tender management: this version (v190) 
eate and edit a tender, or have mSupply cre-
y based on your stock usage data. 

ns, Tender management activation requires 
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invoice value. If you have set the mSupply preferences to allow editing sell 
prices, you will also be able to edit the price at which you return goods on a 
supplier credit.

You can also adjust the cost price of an item line manually. To change an item 
line's cost price, choose Items | View or edit item... Locate the item concerned, 
then click on the "stock" tab to display the item lines. Click the item line you 
wish to change, then click the "edit line" button. (Only users in the "high 

Show tenders...
Tender management is a new fea
included beta implementations o
includes the ability to manually cr
ate a tender for you automaticall

Note that for multi-user installatio
The amount to multiply supplier quotations by to account for freight charges. 
(If their quotations are "CIF" you should set this to zero).

Show suppliers...
This item allows... you guessed it- to view suppliers. A window like this is dis-
played.

In the field, type as much of the supplier name or code as you want to. If 
there is only one item, the details will be displayed, otherwise a list will be dis-
played from which you can choose the name you want by doubling clicking 
it.

Note that if a supplier has invoices entered against it, you will not be able to 
uncheck the "supplier" check box, and you will not be able to delete the sup-
plier.

New Supplier credit....
Entering a supplier credit is exactly the same as entering a customer invoice, 
except that you enter a supplier code rather than a customer code.

Import invoice....
This command allows you to impo
pliers who also uses mSupply. You
dow where you should locate the

Note the following points about i

• The invoice must have been
mand in another copy of m

• The item codes in your cop
entered (see below). If mSu
not know, the import proce

• Once an invoice has been i
should check the invoice ag

• After import the file is edit
invoice again you will not b
importing of the same invo

Entering Supplier Codes
- If you are importing invoices fro
ing steps:

• enter a quotation for each
done from the quotes tab o
quotes tab of the supplier d

• enter the supplier code for
quotation. There is no need
you do not want to.
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lick the New button. A window like this is shown:

nformation about the tender. 

created. This is set to today’s date by default.

s sent to suppliers. By default, this is also set to 
hanged.

ust respond to the tender by. By default, this is set 
to one month from the creation date, but can be changed.

 of sg/cn/fn (suggested, confirmed and finalized). 

 that is still being built.

nfirmed status, no new tender items should be 
 been confirmed, suppliers can be added (see 
tes. Responses from the suppliers can be entered 

d, and a decision made as to which quote is pre-
m.

 as a basis for purchasing once it has been finalised. 
To edit an existing Tender, double-click the tender line in the list.

To auto-generate a tender, click the Auto generate button. We’ll get to auto-
generation later.

Status
Tenders can have a status

A suggested tender is one

Once a tender is set to co
added. After a tender has
below) to contact for quo
into the tender, compare
ferred for each tender ite

A tender can only be used
payment of a fee. Please contact Sustainable Solutions for more information.

To start, select ‘Show tenders’ from the supplier menu (see below), or select 
‘Show tenders’ from the navigator’s Suppliers page.

Choosing this menu item shows a window with a list of current tenders (if 
any) and some options.

To create a new tender, c

Here you can fill in basic i

Creation date
The date the tender was 

Issue date
The date the tender is/wa
today’s date, but can be c

Response by date
The date that suppliers m
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If you set a tender’s status to “fn” you will be given a warning when you click 
the OK button. Finalized tenders cannot be edited in any way.

Future versions of mSupply will have expanded user permissions, so you can 

elds will be added here as we receive client 

g of the tender to suppliers, and entering 
w.

he New line button on the Tender lines tab.

this:
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determine which users have authority to edit tenders based on the tender 
status.

Our ref
This field should be used to enter a short reference code to appear in tender-
related correspondence. It is strongly recommended that this not be left 
blank.

Comment
The comment field is for your internal use. It is not printed on any tender 
documents.

Tender lines Tab
This tab displays be default when you open a tender for editing. It displays 
the items currently included in the tender, and by selecting ‘All’, ‘Filled’ or 
‘Unfilled’ from the drop-down list above and to the right of the list, you can 
select which items are displayed. There are buttons for adding an item, 
removing an item, printing a report on the tender, and, once the tender is 
finalised, accepting the preferred quotes and creating purchase orders. 
Details of use are blow.

Conditions Tab
Clicking this tab shows a field where you can add condtions which apply to 
the tender as a whole and are NOT specific to certain items. To start a new 
line (as with any text box), press Shift+Enter (although any long lnes will 
wrap). See below for an example:

Note that a more complex set of fi
feedback.

Suppliers tab
This tab is used to manage sendin
responses. Its use is discussed belo

Adding items to a tender
To add an item to a tender, click t

You will be shown a window like 
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same was as entering a new tender item, above. Note: you cannot edit or 
delete lines on finalized tenders.

ist of suppliers to whom the tender is to be (or has 

t, click the Add Suppliers button.

wn:
n the graphic below, we see what the tenders window looks like after four 
items have been added. Note that the item ‘Paracetamol 100mg Tab’ has 
been added twice - once in a pack size of 12 and again in a pack size of 24:

To add suppliers to the lis

A list of all suppliers is sho
Type as much of the item name or code as you know, then press the Tab key. 
If only one item matches your entry, it will be filled in. If multiple items 
match, you will be shown the standard item choice list to choose the item you 
want. The panel on the right displays the description of the item, assuming 
that the Full description details have been completed in the Item details 
under the General tab.

Fill in the number of packs you wish to purchase, and the pack size. The total 
quantity of individual units will be calculated.

Choose the units you wish to use.

Entries in the comment field are for your internal use, and won’t be printed 
on the tender documents you give to suppliers.

In the tender conditions field, enter any conditions which are specific to this 
tender item, but NOT applicable to the tender as a whole. These conditions 
will be printed on the tender letter with the item details.

The second tab ‘Compare supplier responses’, is for use after suppliers have 
responded to the tender. This will be covered later.

Note: it is possible to add the same item more than once to a tender. Each 
entry will be treated separately. This allows for the same item to be added in 
differing pack sizes.

Deleting tender items
Click the line you wish to delete so that it is highlighted, then click the Delete 
line button. If a supplier has already quoted on a tender item, you will be 
warned before deletion.

Editing tender items
From the Tender lines tab, double-click the tender line you wish to edit. The 
‘Edit tender item’ window will open, allowing you to edit the details in the 

Suppliers Tab
Clicking this tab shows a l
been) sent:
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purposes, and we will customize the printed layout to meet the requirements 

you have entered email address for the chosen suppliers.

Note that the Win2PDF PDF driver must be installed for this command to 
work. Please contact us if you wish to purchase this driver.

ou will be given the option for the ‘Date 
d with today’s date.

uppliers in response to a tender
to receive ad hoc quotations from suppliers. 
ntegrates with this existing functionality, 
s against a particular tender.

plier, double-click the supplier name from 
e ‘Edit quote’ form will appear:

note that this will usually be filled already 
er responded, the reference that the sup-
s (to be quoted in future correspondence), 
which the supplier has responded. If you 

have previously set a default currency for this supplier, this drop-down list will 
already be set to that currency. Otherwise, your own default currency will 

 provided a quote for, click the New line(s) 
ms for this tender. 
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of each client.

Email Selected button
Clicking this button produces email documents for each of the highlighted 
suppliers. A PDF document (the same as the printed document) is produced, 
attached to an email and stored in the email queue. To send emails, use the 
Special > Send queued emails... command. This option will only be effective if 

appear. 

Adding quote lines
To add items that the supplier has
button. You are shown a list of ite
You can add multiple suppliers by holding down the control key (command 
key on Mac) and clicking on suppliers you wish to add. Once you have 
selected a supplier or suppliers, click the Use button to add them to the list. 
To create a new supplier, click the New button.

Once suppliers are added, they will appear in the list. Double clicking a sup-
plier will open a window for adding and editing quotes - see below.

Deleting a supplier
Highlight the supplier you wish to remove from the tender, then click the 
Delete supplier button. This will remove the supplier from the tender - it will 
NOT delete the supplier from mSupply. Note: you cannot remove a supplier 
from a finalized tender, or if the supplier has quoted on one or more tender 
items.

Print Selected button
Clicking this button prints a tender document for the highlighted suppliers, 
including all the items you specified.

Note that the tender document printed, while usable, is purely for illustrative 

Whichever method you choose, y
sent’ field to ne automatically fille

Receiving Quotations from s
mSupply has always allowed you 
The tender management system i
allowing you to receive quotation

To receive a quotation from a sup
the suppliers tab of the tender. Th

Here, you can edit the date sent (
by this stage), the date the suppli
plier is using for their own record
and, importantly, the currency in 
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supplier
ote, click on the line to highlight it, then click the 

uote line
 items, double-click quote lines to be shown this 

m is very similar to the form for ad-hoc quotes - the 
at the currency cannot be changed, and the related 
p. Enter the price and other details the supplier has 

 and supplier fields are filled in automatically).
You will note that this for
main differences being th
tender is shown at the to
returned to you. (The item
Hold down the control key and click the items you wish to add, then click the 
Use button to add the items as quotations from the supplier. You can use the 
Control-A shortcut to select all items as well.

To add the same item twice to a quote from supplier, click the Add lines(s) 
button and choose the item a second time. You will be shown a warning that 
the item already exists, and be asked if you want to add it again. You might 
need to do this if the supplier has supplied two prices for the same item 
based on differences in packaging or other specifications. Note that if you 
entered an item twice in a single tender to account for such differences, it will 
appear twice here and you won’t need to carry out two selections.

In the graphic below, the four lines in the tender have been added to the 
quote for this supplier. As the lines have not been edited yet, the price 
appears as 0 and the tender pack size has been used.

Deleting a quote from a 
If you wish to delete a qu
Delete line button.

Entering prices for each q
Once you have added the
window:
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Note that the price you enter is the price for one pack.

To cycle through all the items, click OK & Next. To edit this quote only, click 
OK.

In the example above, we see that Roadrunner has responded with a quote 

There are two important checkboxes for each quote.

 is the one chosen to win the tender.

t compulsory criteria you have specified, you 
x. Obviously, if this checkbox is checked, you 
e as “preferred”

ata of all stored quotes for an item, includ-
this is available by choosing the menu item 
item, then viewing the Quotes tab.

fferences in exchange rate, pack size etc to 
local currency. The supplier with the lowest 
 be the price winner. You need to evaluate 
ally a good guide.

 supplier, their name will appear on the 
 line page (see below).

d supplier for all the items in the tender (or 
- tenders do not have to be completed - you 
rable market conditions, for example), 
w. You should see something like the 
osen as the preferred supplier for three out 
refore be providing the remaining item:
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of 56 rupees per pack of 24, and Coyote has reponded with quote of 35 cents 
per pack of 20. The Net cost and Adj. cost columns show the comparative 
prices in local currency. Even though the tender specification was for packs of 
24 and Coyote has quoted based on a pack of 20, the user here has chosen 
Coyote, as the Adj. Cost is so much less.
Comparing quotations from different suppliers
Once you have received all quotations for an item and entered the informa-
tion, or once the due date has arrived, you are ready to compare prices. We 
suggest that at this point you change the status of the tender from suggested 
(sg) to confirmed (cn). 

To compare prices, open the window for the tender, and on the Tender lines 
tab, double-click the item. If you have changed the tender status to CN, a list 
of all received quotes for that item will be shown, with comparitive prices 
(Net Cost and Adj. Cost) in your home currency. (If the tender is still at SG sta-
tus, you will need to select the ‘Compare Supplier Responses’ tab:

To view detailed information about a quote, double-click it. The window for 
editing quote lines from a supplier is shown. You can make on-the-fly 
changes to the quote line in this way (if, for example, you phone your sup-
plier for an updated quote).

Preferred checkbox
The quote with this item checked

Disqualified checkbox
If the supplied quote fails to mee
may choose to check this checkbo
will not be able to mark this quot

Note that if you want historical d
ing those from previous tenders, 
Items > Show items, locating the 

Adjusted cost
This column takes into account di
show a comparitive price in your 
price displayed in this column will
other features too, but this is usu

After you have chosen a preferred
main tenders form on the tender

Accepting tenders
When you have chosen a preferre
as many as you wish to purc hase 
may want to wait for more favou
return to the main tenders windo
below, where Coyote has been ch
of four items. Roadrunner will the
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supplier. If you have previously generated purchase orders for the same 
item(s), you will be warned. For further information see Editing a purchase 

appear in the log.

 cannot be updated from other quotes in the usual 
specific tender.

t when you print a purchase order which is part of 
red the choice of printing an acceptance letter to go 
lies to emailing purchase orders. The acceptance 
ble, is intended only as a sample. As with tender 
at is very basic and intended only as an illustration 
 are happy to customise the layout for clients.

on
 manually create a tender, but you may wish instead 
tically create a suggested tender for you based upon 
o do this, click the ‘Auto generate’ button from the 
s shown below:

ill appear. You may recognise it from the Item usage 
er report - it uses much of the same functionality:
order on page 124..

Purchase orders from tenders
In general, the resulting purchase orders are no different to a normal pur-
chase order generated by mSupply. However, the orders will have some dif-
ferences:

- Something like ‘Generated automatically on 15/3/06 at 16:31:27 from tender 
Test Tender, our ref: ACME001.’ will appear in the purchase order comment 
field to let you know this is part of a tender.

The following window w
report and suggested ord
At this point, the tender’s status should be set to Finalised (FN), thus prevent-
ing any further editing.

Printing an internal report
At any time during the tender process, click to Print internal report button to 
print a report showing the current progress of the tender. A variety of infor-
mation is shown on this A4 landscape report.

Accepting the quotes
Quotes for tender items can be accepted singly or en masse by simply select-
ing the lines on the form you wish to accept and clicking the Accept selected 
button. mSupply will generate purchase orders for the selected tender items 
with the preferred suppliers. mSupply will generate one purchase order per 

- Similar information will 

- The purchase order lines
way, as they are tied to a 

Acceptance letters
The main difference is tha
a tender, you will be offe
with it. The same also app
letter provided, while usa
invitation letters, the form
of the tender module. We

Tender auto-generati
The above details how to
to have mSupply automa
your projected demand. T
‘Show tenders’ window, a



Supplier Menu

 here. First, several default values have been 
 and ref fields that you’re going to want to 
s chosen for any of the tender items, and 
en entered into each item’s comment. Third, 
ms is 1. 

 the default pack size and default unit for 
(these values are set when editing items - 
s not find a default unit, it leaves units 
warning into the comments. The same goes 
’t tell it otherwise, mSupply assumes a 
-generation will therefore be most useful if 
ms.

e tender process is, from this point on, 
ormal tenders.

Future changes
The tender management module is relatively new to mSupply, and therefore 

ts feel are necessary, and may possess fea-
e value feedback from our clients, particu-

 and the evolution of mSupply is largely 
ontact Sustainable Solutions with any com-
ender management module - or indeed any 
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As you can see from the example above, auto-generated tenders may be 
rather large, so you may wish to process ten tenders with more specific crite-
ria rather than one huge one at once. In our example, if we restrain our 
search to all items beginning with ‘A’, we get 48 tender items instead. 

You can choose to immediately look at your tender, or return to it later. If you 
click ‘Yes’, you’ll get something like the below example:

may not have features which clien
tures which clients do not need. W
larly regarding new functionality,
driven in this way. So, please do c
ments or requests regarding the t
aspect of mSupply.
You can tailor your search by item in the usual way. Clicking the refresh but-
ton (double-blue arrows) shows an estimate of how many items will be proc-
essed. Further refinements can be added. Be sure to enter the number of 
days stock cover you want to order for in the last text box - in the example 
above, all items are to be processed, including those which have not been 
used in the last 12 months, and 500 days of stock is to be ordered (if it’s 
needed).

Processing all this data may take a few minutes if you have a lot of stock 
items recorded in your system, so mSupply will ask you if you’ve got the time 
to spare. If you do, click ‘Yes’. A progress indicator will appear to show you 
how much work is left to be done. When mSupply has finished processing 
everything, it will let you know:

There are several things to notice
entered for the description, dates
change. Second, there are no unit
the message ‘Check units!’ has be
the pack size for most of these ite

This is because mSupply looks for
each itemas it creates the tender 
see the section on Items). If it doe
blank, but enters a ‘Check units!’ 
for pack size - although if you don
default pack size of 1. Tender auto
these default values are set for ite

Reviewing and continuing with th
done in exactly the same way as n
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vated the payment module in the preferences (tab 
e system is activated, each supplier invoice will record 
nding (The amount left to pay to the supplier). Any 
fore activation of the system will have their out-

et to zero, so will not show for payment.

ices will appear in the list. Use the file | finalize sup-
and to finalize invoices once all the details are cor-

upplier more than the total outstanding (as if you'd 
fferent to a cash receipt, where you can accept an 

overpayment from a customer.

ame or code. Once you have chosen the supplier, a 
 you have not fully paid will be shown.

unt you wish to pay. Alternatively, if you want to 
ft-double-click each invoice and then the amount to 
in the "allocated" amount at the bottom of the win-
Show cash payments..
You will be presented with the standard transaction find window, where you 
can view a list of recent payments, or find a particular payment number.

New cash payment...
This command presents you with the new cash payment window.

Entry steps

• Enter the supplier n
list of invoices that

• Enter the total amo
pay all invoices, shi
pay will be shown 
dow.
Show purchase Orders....
Choosing this menu item shows the Find window for purchase orders. For fur-
ther information see Editing a purchase order on page 124.

New Purchase Order....
This item allows creation of a new order from a supplier. When you Choose 
Supplier > New purchase order, a new purchase order window is displayed.

For further information see Creating a new purchase order on page 121.

New Blank Purchase Order...
Choosing this menu item creates a purchase order with no lines to which you 
can add order lines. For further information see Creating a new purchase 
order on page 121.

Show Goods Received
For further information see Viewing existing Goods Receipts on page 137.

New Goods Received
For further information see Receiving goods using the Goods Receipt func-
tion on page 136.

Note that:

• You must have acti
invoices 1) Once th
the amount outsta
invoices entered be
standing amount s

• Only finalized invo
plier invoices comm
rect.

• You can not pay a s
want to!). This is di
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• To fully pay an invoice hold down shift and double-click it's line. (If the 
invoice is already marked as fully paid, the payment amount will be 
reset to zero)

ries for your suppliers. To add a new cate-
 an existing category name, double-click-
tion brings up this window:

 category name. A list of suppliers to whom 
 shown underneath. If there are no 
 delete the category.

nd edit manufacturers in the same way as 
her information see Show invoices.. on 
cription of the equivalent command for 
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Show categories
Selecting this option brings up this window:

Show manufacturers
Select this option to show, view a
you would edit suppliers. For furt
page 216. which gives a fuller des
showing customers.
• To partially pay an invoice, double-click it's line and enter the amount 
you wish to pay.

• Once you are happy with the details, click the OK button. If you want to 
print the information, make sure the print checkbox is checked.

Merge two names....
If you accidentally enter two names into mSupply that identify the same 
organization, you can use this command to combine them.

Use extreme caution: This operation will move all historical records from the 
name you delete to the name you are keeping. The operation can only be 
undone by reverting to a backup copy of your data file.

In the window displayed enter the name to keep, and then the name to 
delete. When you have checked then checked again that the information is 
correct, click the OK button. You will be given one last chance, and then.....

Here you can add and edit catego
gory, click ‘New category’. To edit
double-click it in the list. Either ac

In category name, add or edit the
this category has been assigned in
assigned suppliers, click ‘Delete’ to
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New manufacturer
Select this option to add a new manufacturer in the same way as you would 
add a new supplier. See the Names- entering, adding and using  section for a 
fuller description of this command.
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Customer Menu

r

n

 this:

ow to show more of the customer name.

he bottom of the window:

This button is very useful. It will bring up the find transactions window as dis-
cussed above:

Invoice number 123 will be dis-
played. 

n The query editor will be dis-
played, where you can enter a 
more detailed query.
216

This menu
tions to o

Show i
This comm

The Find T
You will b

1

25 
If you enter: Transaction(s) Displayed
You will be taken directly to the 
most recent invoice entered

A list of the 25 most recent 
invoices
 contains commands related to managing customers and transac-
 from customers.

voices..
and is for viewing or editing any customer invoice

ransactions window
e presented with a window where you can enter a number. 

The list invoices window lookslike

Note that you can resize the wind

The following buttons are along t

Find

123 in the  lower box

Click the complex find butto
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h a window where you can enter as much of the 
ow.

r name matches the entry you have typed, you are 
atching customers. Double-click the customer you 

 Customers and Suppliers chapter for full details.

tomer.

 a Customer and a Supplier chapter for full details.

it is exactly the same as entering a Supplier invoice, 

ustomer name rather than the supplier name

ed with zero margin. This is because mSupply uses 
the cost price entered to calculate the amount to credit the customer, so 

 amount you charged them as the cost price for each 
me you want to sell the item again for the same 

iginally, hence the cost and selling price must be the 

 enter negative values in mSupply. Even when you 
ods from customers, or returned goods to suppliers, 
pply automatically converts the invoice total to a 
New Invoice...
This is the standard way to issue stock to a customer.

You will be presented with the invoice entry screen

See the Issue Goods (Customer invoice) chapter for a fuller description.

Show customers...
For viewing or editing any customer.

you must enter the
line. We then presu
price you sold it or
same

Note: there is no need to
are entering returned go
enter positive values. mSu
negative amount.
Click on the drop down list to determine which field to query

Choose the comparison from the next drop down list (equals, starts with, etc) 

Note: the comparison popup menu will change depending on the type of 
field you have chosen in the first list.

This window is very useful for quickly finding a group of invoices.

If you want to query on multiple criteria, do your first query, then click find 
again, but this time make sure the selection radio button is selected. The sec-
ond query will now search only the results of the first query.

Print
Prints the list of invoices displayed. (Does not print the actual invoice- just a 
list)

Order by
Displays the "order by" window, where you can drag fields from the list on 
the left to the right-hand pane to sort the list by the fields you have chosen.

Sum
Displays the total value of the highlighted invoices. Highlight more than one 
invoice by control-clicking (Mac: command-clicking) invoices. Highlight a 
block of invoices by clicking on the first invoice of the series, then shift-click-
ing on the last invoice in the series.

You will be presented wit
customer name as you kn

If more than one custome
presented with a list of m
wish to view or edit.

See the Adding or Editing

New customer...
Allows entry of a new cus

See the Adding or Editing

New credit...
Entering a customer cred
except that:

• You will enter the c

• Items will be enter

Use the drop down lists to 
select which field to query
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Cash Receipts....
customer_code is the code you have assigned to the customer, and number is 
the invoice number.

The exported file will be saved to the destination you specify in the mSupply 

 will be asked if you want to attach the file 
then mSupply will create an email to the 
d to it.

 customer does not have an email address 

nvoice is the same as a regular invoice, 
text to appear at the bottom of the invoice. 
ces with areas for signing for the receipt of 

at the bottom of a special invoice from the 
 window.

ice numbers. You will be asked for the first 

roup customers (or suppliers) together for 
t up an item restrictions scheme, allowing 
rtain customers.

See the explanation of how to set up a restriction scheme under the “man-
age permissions…” heading under the “item menu” chapter above.

 set up group names:
218

Export HTML invoice...
This command exports any customer invoice to a file that can be emailed to a 
customer and easily read or printed by them using a web browser.

When you use this command you will be asked to enter an invoice number. 
The default choice is the last invoice created.

The file will be named "customer_code_invoice_number.html", where 

The groups window allows you to
For viewing or editing any customer payment. The procedure is outlined 
above in the "Show invoices..." section of the manual. 

New cash receipt....
See the chapter above Receiving payment from customers for an explanation 
of the payment receiving system.

Export invoice...
This command exports any customer invoice to a file. The file created is in a 
special format that can be imported into another copy of mSupply using the 
Supplier | Import invoice... menu command. Do not use this command for 
sending invoices to customers for them to view or print- use the export HTML 
invoice…command for that purpose.

When you use this command you will be asked to enter an invoice number. 
The default choice is the last invoice created. The invoice will exported to the 
export folder you have set in the preferences, and will be labeled with the 
invoice number.

Before you can export, you must set your "own code" in the preferences. This 
is the supplier code that your customers will use to identify you when import-
ing the invoice.

Once the invoice is exported, you will be asked if you want to attach the file 
to an email. If you click attach then mSupply will create an email to the cus-
tomer with the invoice attached to it.

Note: you will not be asked if the customer does not have an email address 
entered for them.

preferences.

Once the invoice is exported, you
to an email. If you answer attach 
customer with the invoice attache

Note: you will not be asked if the
entered for them.

Print special invoice
Prints a special invoice. A special i
except that you can set different 
One common use is to print invoi
narcotic goods.

You can set the text that appears 
"printing" tab of the preferences

Print invoice series.
Allows printing of a range of invo
and last numbers to print.

Show groups...
Customer groups can be used to g
reporting purposes, and also to se
some items to be issued only to ce
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• You can enter or edit the group name in the top field.

lier invoice
 to take a supplier invoice and directly make a cus-

 are delivered directly from a supplier to a client, but 
r organisation.

r the supplier invoice number and the customer 
 created, so have this information ready.

r invoice with suggested status is created. 

lier invoice have been issued already, you will be 
lable balance will be added to the customer invoice.

....
.” on page 1214.for a description of this commandd. 
ced in both the supplier and customer menus for 

gs up this window:

it categories for your customers. To add a new cate-
. To edit an existing category name, double-click it in 
• The list displays all names which are members of this group.
• Click the delete button to delete a group. You can only delete 

groups that have no names as members. You can remove group 
members from the groups tab of the name viewing window 
(Choose Customer | Show Customers…

• Click OK to leave the window.

Here you can add and ed
gory, click ‘New category’
• Click the new group button to add a new group.

• Double-click an entry to edit its name:

Invoice from supp
This command allows you
tomer invoice.

It is useful for goods that
are charged through you

You will be asked to ente
code for the invoice to be

When finished, a custome

If any lines from the supp
alerted and only the avai

Merge two names
See “Merge two names...
The same command is pla
ease of use.

Show Categories
Selecting this option brin
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the list. Either action brings up this window:
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To enter a new method, click the New button.

To edit an existing method, double-click the item in the list. A window to 
enter or edit the name is shown.
In category name, add or edit the category name. A list of customers to 
whom this category has been assigned in shown underneath. If there are no 
assigned customers, your can click Delete to delete the category.

Show shipping methods
Choosing this menu item shows a window with a list of shipping methods.
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 for any reason the mSupply Navigator is not visible, choose this option to 
ow it again. 

h

printing method for printing labels. For label print-
u use EPL printing rather than using the Windows 
 more reliable.

etwork print servers, allowing multiple mSupply cli-
to a single labe printer.

s
e you to use EPL printing?

indows printer driver, be aware you will need 
n the machine you are using, and will need to set 
r the printer. Contact us for details.

 right margin in millimetres.

 printing” from the drop-down list, you are shown 
ose between serial and TCP connections:
T

S
If
sh

P
C

rinting preferences
oosing this menu item shows the printing preferences window. 

EPL printing options
If you choose “Direct EPL
this window. You can cho
he Special menu

how Navigator

Here you can choose the 
ing we strongly advise yo
printer driver as it is much

We now support Zebra N
ent machines to connect 

Windows printing option
Did we mention we advis

If you insist on using the W
administrative privileges o
up a custom paper size fo

You set the label left and
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• Serial requires a standard serial port on your computer. Set the “port 
number” field to “1” if your serial port is COM1. Set it to “2” if it’s 
COM2.

Show connected users

ow with a list of currently entered curren-
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Note: Not applicable when running mSupply in single user mode

To display a list of users currently logged on to mSupply, select this option.The 
window below is displayed, and by selecting one or more users, a message 
typed into the Message box will immediately appear on the selected user(s) 
desktop when you click on the Send button. Such messages are not stored on 
the system.
• TCP requires you have a Zebra print server installed. Enter the i.p. 
address of the printer in 1.2.3.4 form.

For both methods, you set the width and height of the labels you are using in 
millimetres.

Default system printer
This drop-down list provides a quick way of changing the system printer 
(Windows only). It is simply a shortcut to the same functionality available by 
choosing Start > Control panels > printers and faxes and then right-clicking 
the printer you want to set as default, and choosing “set as default” - phew!

Check for updates...
Choosing this item will connect to the mSupply web site and compare your 
current mSupply version with the version you are now using.

If an update is available, you will be shown a window where you can click to 
download the latest version.

Currencies...
Choosing Currencies opens a wind
cies.
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quotations, so you can not delete it..

lick the “new reminder...” button at the bottom of 

e-click it in the list.

 on the reminder to delete, then click the “delete” 

cking on the column headers. Click a second time to 
ion.

ders displayed according to the status and whether 
 complete or was created by you.

r in-complete reminders, choose from the status 

 window
Cancel
Click to exit the window without saving changes.

OK
Click this button when you are finished editing currencies.

Reminders...
The Reminders command shows reminders that are not yet completed.
Buttons in the currency list window :

New
To add a new currency.

OK
When you are finished editing currencies.

Editing a currency entry:
Double click a currency to edit it. Note that your "home" currency should be 
entered with a value of "1", and all other currencies should be entered with a 
rate relative to your home currency. A window with the currency code and 
the current rate will appear. 

You can edit the rate. Note that doing so will automatically update quotes 
that use that currency.

Buttons in the currency editing window :

Delete
Click to delete the currency. If the button is dimmed, the currency is in use by 

To add a new reminder, c
the list.

To edit a reminder, doubl

To delete a reminder, click
button.

You can sort the list by cli
sort in the opposite direct

Filtering the list
You can change the remin
the reminder is for you to

To show only complete o
drop-down list.

The Reminder details
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Date
The due date of the task

length you choose - months, quarters, years or whatever. 

Once budget periods are set up, you can allocate each transaction to a 

To use the budget feature, these are the steps to be taken:

 presents you withthe window as shown; 
 at the top of the list, with the oldest entry 

d list window : 

ys the window for entering details for the 
224

budget period. The items on that transaction will have been assigned 
accounts, and you can then view budget reports based on expenditure or 
sales broken down by the accounts you have assigned to items.

At the end of a budget period, that budget period may be locked so that no 
further entries may be made. 
Reminder for User
By default you create reminders for yourself, but you can also create them for 
other users. If you’re the micro-managing type, you could put everyone else’s 
work plans in for each day or week!

Note
The text of the reminder message

Completed
Check this box if the reminder is completed (but note that it won’t usually 
show in the list once is is checked)

Repeats automatically
Once this box is checked, you will be shown options for the reminder to 
repeat daily, weekly or monthly.

Show budgets...

Activating the budget module
To use this feature, the Activate budget module on the Invoices 1 tab in Pref-
erences must be checked.

Budget Overview
You can define budget periods here. The periods you define can be any 

Entering budget details 
Choosing Special > Show budgets
note that the latest entry appears
at the bottom. 

Buttons in the budget perio

New
Clicking on the New button displa
new budget period. 



Show stores

225

Should you wish to edit a figure allocated to an account, double clicking on 
the appropriate line on the Budget period list brings up the Budget edit win-

propriate line on the Budget period list brings up 
indow, then by clicking on the Show actuals icon, a 
pears:

 with details of actual performance against budget, 
 time how much of the budget for each account has 
ch remains.

de on the Budget period list are saved when you 
click on OK. 

physical area where stock is held. When a user logs 
oose a particular store (hereafter “the current 
 then operate as if the stock in that store is the only 
 from the current store will be available for dispens-

e to stock in that store, and issues from and receipts 
dow; follow the procedure described in the previous paragraph, and edit or 
delete the amount, setting it to the revised figure or zero. The entire budget 
may be deleted from the Budget period list, but only when the amounts allo-
cated to all accounts are zero. To delete a budget, select it on Budget period 
list, then click on Delete button. 

Show stores

What is a “Store”?
In mSupply a “store” is a 
into mSupply, they can ch
store”), and mSupply will
stock available. Only stock
ing, and reports will relat
In the Description field, enter the name of the budget period - for example 
FY 2008. The first time you use this feature, the Start date field is set to 00/00/
00, and you should enter the End date. On subsequent occasions, the Start 
date field will show the date one day later than the End date entered on the 
previous occasion; note that the Start date is non enterable. Enter the end 
date in the End date field.

In Account Description column, a list of account names and code(s) will be dis-
played. To set budget figures, select the Account to which the budget applies 
by clicking on the line. Once selected, click on the figure in the Budget col-
umn of that line, and enter the budget figure.

Editing & Deleting budgets

Budget Report
Double clicking on the ap
the Edit Budget period w
more detailed window ap

This window presents you
and lets you know at any
been spent, and how mu

OK
Any changes that you ma
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to that store. 

Most users of mSupply will only have a single store, and so will have no need 
of this functionality.

m the Special menu , on first use the above 
store having the default description ‘Gen-
or more than one store require to create the 
k on New store to show the window below, 
tails of the new store being created:.

s), the Stores list window will display all 
n entry to edit that store’s details.

o a particular store from this window; its 
ore, to display the created stores, and to 
 a store being possible only when that store 
e been no transactions recorded.
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After having created a new store(
stores, and you may double click a

Note: You are not able to log on t
purposes are these:- to create a st
edit or delete a store , deletion of
contains zero stock and there hav
The following examples illustrate situations where you might want to run 
more than one store.

• A hospital pharmacy where you have two dispensing locations: an inpa-
tient pharmacy and an outpatient pharmacy.

• A hospital pharmacy where the pharmacy store stock is treated sepa-
rately to the dispensary stock. You would set up mSupply with a store 
called “Pharmacy store” and a store called “Dispensary”. You would use 
the “transfer stock” function to move stock from pharmacy store to dis-
pensary.

• A pharmaceutical warehouse where you have 2 or more actual ware-
houses. These may be adjacent or several hundred kilometres apart. (Of 
course you need network connectivity between sites to run mSupply at 
each site).

Note: In the above examples, when you log on, you would select the appropri-
ate mode - see table:

When ‘Show Stores’ is selected fro
window appears, with the single 
eral’. Users having responsibility f
additional store(s), and should clic
which allows entry of required deExamples Stores Log on mode

Hospital Pharmacy In-patient Dispensary Dispensary

Out-patient Dispensary Dispensary

Hospital Pharmacy Pharmacy store Store

Dispensary Dispensary

Warehouse Adjacent Store Store

Remote store Store
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he label in roughly the position that they are on the 
nter a very long left and right footer they may over-
bel. Print a single test label to check first.

 print to plain 90mm x 40mm (w x h) labels from a 
 contact us if you require support of other printers 

rint the number of labels specified in the quantity 
l printer. If the print preview button is checked, you 
n preview of the label. Note that if you enter a 
the preview option, you will be shown a preview of 

the window without saving any changes you have 

elete the currently displayed format and return you 
mats.

changes you have made and close the window. 
 print is not saved- it is reset to 1 each time you 

Abbreviations...
Abbreviations allow you to enter directions quickly and accurately when dis-
Label name
This field will not print on the label- it is for you to identify the label. It is 
shown in the list of available formats when the Misc labels menu item is cho-
sen.

pensing medicines.
Misc labels
Choosing this item shows a list of previously saved label formats.

Double-click an item in the list to edit/print that format, or click the New but-
ton to add a new format. The format details window looks like this:

Heading, Body, Footers
These fields will print on t
screen. Note that if you e
lap in the middle of the la

The labels are designed to
Zebra label printer. Please
and other label formats.

Print button
Clicking this button will p
to print field to your labe
will be shown an on-scree
large quantity and check 
each label!

Cancel button
Clicking Cancel will close 
made

Delete button
Clicking this button will d
to the list of available for

OK button
Clicking OK will save any 
(Note that the quantity to
open the window).
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to add common directions quickly.

Do not use actual words as your abbreviation, or else attempting to type the 

One this list is formed, you can apply one or more warnings to each item, and 
choose which warning will be automatically printed on labels.

to edit its details.

new warning.

 set of warnings as specified by the pharma-
y.

n “Managing Prescibers” but we all know 

, issuing items to a patient allows you to 
add a prescriber. This menu item allows you to set up your list of prescribers.
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word will result in the expanded text appearing on your lablel!

Warnings...
This menu item allows you to view and edit the standard list of warnings. 
Double-click an abbreviation to edit it.

As usual, you can sort the list by clicking on the column headers

Click the “New” button to add a new abbreviation.

Click the report button to construct a simple report. on all abbrviations. This 
report can be previewed or printed.

Type an abbreviation and the text that it will expand to.

When you are issuing an item you can mix abbreviations and your own text 

Double-click a warning in the list 

Click the “New” button to add a 

We suggest you use the standard
ceutical authorities in your countr

Prescribers...
We were going to title this sectio
that’s not possible ;-)

When you are in dispensary mode
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scriber when dispensing.

Other fields are fairly self-explanatory. Note that the code, first name and last 

nt to add a “Miscellanous Prescribers” item to the 
ve a lot of prescribers whose prescriptions you only 

roup prescribers together, and can then be used to 
oducing a transaction report.

o merge two prescribers, where the same prescriber 
ered twice. You are shown a window like this:

ames by entering the start of their surname or their 
ab. The top prescriber is the one who will be kept. 
be deleted.

e two names, check the details are correct, and 
 warned one last time, and then the operation will 

be completed.

ded the deleted prescriber will now show the name 
 kept.

ories
ay of grouping transactions together. Each type of 
wn list of categories. For example customer invoices 
ormal” and “urgent”. Inventory adjustements 
xpired”, “damaged” and “stock take”
name can all be used for looking up prescribers when dispensing.

Initials
The text you put in the “Initials” field will print on dispensary labels.

Active status
If you have a prescriber that is no longer used, you can change their status to 
“inactive” and the prescriber will not show in the choice list when dispensing. 
Inactive prescribers will still show when you choose Special > Show Prescib-
ers...

All transactions that recor
of the prescriber that was

Transaction categ
Categories allow you a w
transaction can have its o
might have a category “n
might have categories “e
To add a new prescriber, click the “New” button.

Add a code for the presciber. You can use the code quickly to look upthe pre-

We suggest you might wa
list, and use this if you ha
dispense infrequently.

Category
This field can be used to g
filter prescribers when pr

Merge prescribers
This menu item is used to
has accidentally been ent

Enter the two prescriber n
code, and then pressing T
The lower prescriber will 

Once you have entered th
then click OK. You will be
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and there were only categories for supplier and customer invoices).

ith a name (a customer or supplier), and it is 
the "show suppliers…" or "show custom-

a name, you can edit details for that contact 

indow:

 to report on or wish to produce a set of 

presents the Quick report editor window. See the using the report editor 
chapter for more instructions.

u with a dialog with two choices:

rinted of the records in the window.
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Contacts...
This command displays a window where you can edit contacts.

Order by
sort the contacts

Print
clicking this button will present yo

• If you click list a list will be p
Click on “New” button to create a new category.

The categories can be added to customer, customer credit, supplier, supplier 
credit, repack, build, inventory adjustment while creating or editing transac-
tions.

Once you have assigned categories they will show as a drop-down list when 
you enter a new invoice or transaction.

(In versions of mSupply prior to v1.8 categories were set in the preferences, 

Contacts are usually associated w
easier to edit such contacts using 
ers…" command.

If a contact is not associated with 
using this command.

Buttons in the contact list w

Query
Use to find the contacts you wish
address labels for.

Report
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Choosing this command results in you being shown a window like this: 

 you to compose and then send an email from 

 functions of mSupply allow you to:

stomers that they can print (using the "export HTML 
)

pliers (using either the "Email" or “Email pdf” menu 
 an order)

oices to customers that they can automatically 
import into their copies of mSupply.

• Send an email as you would using another email application. If you use 
tage is that the email can be linked to the name, 

rom the Email tab of the name details window.

 email address in the to field. If you have email 
for names in mSupply, type the start of the name, 
utton to automatically insert the address. To enter 
ress, separate the addresses with commas.

he subject field
mSupply, the advan
and easily viewed f

To compose an email 

• Enter the recipient
addresses entered 
and click the find b
more than one add

• Enter a subject in t
• If you choose labels, you will be shown the label editor, allowing you to 
print a set of address labels for the current list of contacts. Note that 
you can save a particular label layout and then use the "load" com-
mand in the label editor to restore your layout.

New
To edit a contact, double-click on the line you want to edit. You will be shown 
the contact details:

New e-mail...

The email window allows
directly within mSupply. 

The inbuilt email sending

• Send invoices to cu
invoice" command

• Send orders to sup
item when editing

• Send electronic inv
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• If you want to enter addresses in the "CC" or "BCC" fields, or want to 
attach a document to the email, then click the small "plus" icon on the 
left to show those fields. (See below for how to attach documents). To 

default will display all mail for the last week.

ouble-click it.

se the name of mailbox from the list 

e of the following:

ccessfully sent. Once a message has been 
 it. To send the same message again, use the 
opy of the e-mail.

 and will be sent next time e-mail is sent

 and will not be sent.

You can click on the "status" and "date" column headers to sort messages by 

, and it will open in the message composi-

op-down list to show a list of mailboxes:
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those columns.

To view a message, double-click it
tion window.

Managing mailboxes
Click the edit button beside the dr
enter more than one address in the "CC" or "BCC" fields, separate the 
addresses with commas. 

• Type the text of your message.

• Click the OK button to queue your message. 

• To send your message, click the send button in the message list window, 
or choose Send queued mail... from the special menu.

Notes:

• Make sure you have set a return address and a mail server in the prefer-
ences.

• If you are using a dial-up connection, you must close the connection 
when you have finished sending.

Attachments 

• mSupply allows you to attach documents to an email. 

• To attach a document, simply click the "attach" button. You will be pre-
sented with the standard window to find a file.

• There is no limit to the number of attachments you can add to a email. 
(Well, actually it's a few thousand. Let us know if this isn't enough.)

• To delete an attachment, click the attachment in the list you want to 
delete, then click the delete button.

Show e-mails...
You will be requested to enter the number of days of mail to display. The 

Viewing a messages
To view a message from the list, d

To view a different mailbox, choo

Status 
The status of a message will be on

• S - the message has been su
sent you can no longer edit
duplicate button to make a c

• Q - the message is queued,

• H - the message is on hold,
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the "connect to..." window to initiate a connection. 

Note that if it takes a long time to establish a connection, mSupply may give 

e end of the year, the item ledger will print the 
ions for the year, and your ending stock quantities.

 not change any stock-on-hand values or archive 

se this command, but if you do not, you will not be 
ns, and you will get very long item ledger printouts!

ges
ply web server, web messages give you a way of giv-
lients. For example, you might want to let them 
packaging, a drug recall or that you will be closed 
ing.

ll be shown in the customer’s web browser after 
ged in.

 shows a list of messages
an error. If you are experiencing problems, first establish the connection to 
your ISP, then choose Special | send queued e-mail.

Set start of year stock...
This command sets the start of year quantity for each item, and records the 
start date. The starting stock date and stock quantity are used when printing 
a ledger.

The idea is that you reset your starting stock on the first day of each new 

Choosing this menu item
Buttons in the message list window:

Delete
To delete a message, click on it to highlight it (control-click (Mac: command-
click) to select mulitple messages). You will be given a warning allowing you 
to change your mind!

Duplicate
A copy of the message you have highlighted will be made, and will open in 
the message composition window to allow you to edit it.

New
A new message will be created, and the message composition window will 
open, allowing you to edit it.

Find
The find window will open, allowing you to find messages. The results will be 
displayed in the list.

Print
The displayed list of messages will be printed.

Send queued e-mails...
Any queued e-mailed messages will be sent. If you have a dedicated network 
connection, the messages will be sent straight away. If you have a dial-up con-
nection and you are not already connected to the internet, you will be shown 

financial year. Then, at th
starting value, all transact

Using this command does
any transactions.

You are not required to u
able to archive transactio

Show Web messa
If you are using the mSup
ing information to your c
know about a change in 
next Tuesday for stock tak

The messages you add wi
they have successfully log
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adio button checked will be displayed.

. Messages are sorted by priority before they 
 priority of “1” will display at the top of the 

s on, they will see the headline message 
 will display the full message text.

 in the message headline and body.

appear in bold, write it like this:

• <strong>Urgent request for assistance</strong>

re very annoying</blink>

ke complex newsletters with columns and 
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To make a message blink:

• <blink>Blinking messages a

You can also use this facility to ma
links to other web pages etc. 
Double-click a message to edit it.

Delete button
Click on a message in the list, then click this button to delete it.

Click the New button to add a new message. The window to add or edit a 
message will be shown

Only messages with the “active” r

Priority
Choose a priorty from one to five
are displayed, so messages with a
list.

When a customer successfully log
only, with a “more....” link, which

Note that you can put HTML tags

For example, to make a message 
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Buttons in the window:

• OK- exit the window

 displays a report of the list of names of the users, 
status, number of logins, last login date and last 

nu item a dialog is displayed allowing archiving of 
s, Log, Items, Item lines (Stock).

 to refer to removing information from the main 
d to purge anything in order to keep mSupply run-
ish to do so in order to keep the data file to a more 
in a small speed advantage on older hardware.

ore data into the system, the speed of the system 
ially when doing procedures that require searching 
nd backing up files will take longer.

ply is 16 million records in each table (16 million 
tions, etc). Once a data file approaches 2Gb in size it 
ct Sustainable Solutions for more information if your 
 large.

e old information, the best thing to do is to do a 
e you do the archive. You can then use the File > 
ss this backup copy at any time.
• Order by- sort the log

• Search- find particular records in the log.

• Export- allows you to export the log for use in another application

For further information see Log on page 149. for a complete description of 
which events are recorded in the log.

Note that double-clicking a log entry will bring up a small window with the 
full item details. You can not edit this information.
View log
When you choose view log you will be asked how many days history to view 
(the default is 7 days)

This menu item can only be used by users in the "high access" group.

It displays a list of significant events, along with the date, the time and the 
user.

User’s report
Choosing this menu item
their access group, active 
login time.

Purge...
When you choose this me
certain tables- Transaction

We use the term “purge”
database. There is no nee
ning, however you may w
manageable size, or to ga

As you enter more and m
will become slower, espec
through lots of records, a

The current limit in mSup
names, 16 million transac
will need splitting. Conta
data file is becoming very

If you want a record of th
backup of mSupply befor
Restore command to acce
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***

 are able to create new store where you 
“Name”.

isplays the wndow like the one below.

***
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Show stores...
This window displays the list of available stores in the mSupply. 

When you choose “Show stores...“ you will be presented with the following 
window. 
Purging transactions will also archive the transaction lines associated with 
that transaction.

You cannot purge any transaction:

• whose confirmation date is after the date the stock was last set.

• has a confirmation date within the last three months.

• status is not "fn" (finalized).

You cannot archive Items that have transactions or stock related to them.

You cannot archive item lines whose stock is not zero or that have transac-
tions related to them, unless the transaction is finalized.

Buttons on the Store list ... window

New Store : Using this button, you
need to fill the “Store code” and 

Clicking on “New store“ button d
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h

ll you whether or not your version is up-to-date).

u

i

s PDF help file is a thing of beauty and you ought to 
T

A
C
m

Yo
th
te

A
Th
fo
cl
au

W
W

thorisation
e Authorisation button is provided largely for developer’s use, and is there-
re not something you will need to worry about. It is there to help us solve 
ent’s problems. It is not recommended that you click it and start trying out 
thorisation codes!

hy is there no help option?
e haven’t included a help file in mSupply to keep download sizes small, and 
he Help Menu

bout mSupply...
oosing this item shows a window with information about the current 

Supply version, and about the location and size of your data file.

u can click the little arrow icon to retrieve the current version number from 
e internet if you want to. (This will not download a new version- it will only 

because we think that thi
use it! 
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r

 
 delete records or perform special operations for the end of the financial 
ar. If you want to, you can just carry on using mSupply as usual. 

g invoices. Use the Finalize Customer invoices... and Finalize 
mmands to do this. (Note that any customer invoices with a 
sted") must be confirmed before they can be exported.)

ustments. Use the Finalize inventory adjustments command 

of mSupply as it stands at year-end. It is a good idea to keep 
e place for long term storage.

 item. Choose "print item ledger" from the "report" menu. 
up copy of mSupply to print this ledger at a later date.

ear stock" from the "special" menu. This simply records the 
tion number, and records the total opening stock quantity 
 a ledger calculation for the coming year.

 begin entering transactions for the next year.

Repair
 file regularly, it is a good idea occasionally to check 
veloped. Problems can develop due, for example, to 
r reasons outside our control.

t users or professional IT staff
rdware failure, the first option should always be to 
ood backup of your data.

st repair a damaged data file, please contact Sus-
tainable Solutions for advice.

To check your data, download a product called 4D Tools. (4D Tools and a 
 CD) from ftp://ftp.4d.com.

 your data file for errors, or repair your file. Please 
ions if you believe your data file has a problem, 

 backup copy of your data first.

pair your data, Sustainable Solutions is able to use 
 your data, and even export your data and re-

le. We have not had to do this for a customer yet, 
 as a near-last resort.
M

E
W
m
p

Ta

H

E
It
to
ye

H
an
owever, there are certain procedures that will improve operation, and make 
 audit of your operation easier.

• Perform a stock take.

• Print out stock take sheets to record differences easily between actual stock and 
stock according to mSupply. See the  stock take sheets section of the "Report 
menu" chapter.

• Use inventory adjustment transactions to correct errors. See the Inventory adjust-
ment- add stock and the Inventory adjustment- reduce stock sections of the "Item 
menu" chapter.

manual is included on the

4D Tools can simply check
contact Sustainable Solut
before repairing it.

Always use 4D Tools on a

If 4D Tools is unable to re
specialist tools to examine
import into a new data fi
but the option is available
iscellaneous Topics

nd of Month tasks 
e are presuming that you will finalize and export your invoice data once a 
onth. If you choose a different frequency, you should still follow the same 
ocedure.

sks to perform:

• Check your invoices are correct. Once you have finalized an invoice, it can not be 
edited.

• Finalize and export supplier invoices. See the file menu chapter.

• Finalize and export customer invoices. See the file menu chapter.

• Record the stock on hand value (this is only necessary if your accounting system 
requires the information). See the special menu chapter.

ints:

• Each month, take your finalized invoices and file them. We suggest you file 
invoices in order of their invoice number (a separate file for supplier and customer 
invoices).

• Keep a file with the summary printout from each month produced when you 
finalize invoices.

nd of Year Tasks
is usual to run according to a financial year. mSupply does not require you 

• Finalize all outstandin
Supplier invoices... co
status of "sg" ("sugge

• Finalize inventory adj
to do this.

• Make a backup copy 
this backup in a secur

• Print a ledger for each
You can use your back

• Choose "set start of y
date and next transac
for each item to allow

• You are now ready to

Maintenance and 
If you are using your data
that no problems have de
faulty hardware and othe

For technically competen
In the case of a serious ha
revert to the last known g

If for some reason you mu
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How do I move a window whose title bar has been 

•  Zoom - Magnify the view, or see the whole page (if the view is already mag-

Security of your data
word system carefully, your data is fairly 

s access to the original copy of mSupply, 
e data file, as the "user 1" password is 
ry screen until it is overwritten the first time 

bility to keep copies of your mSupply soft-

d in the data file are encrypted with strong 
 is little danger of someone finding your 

 maintain data relating to a single store in 
, this is how mSupply continues to be used. 

he requirements of organisations/institu-
ne store. Normally you will log into a partic-
 and only see stock and transactions relating 
ers may login in Supervisor mode. For fur-
e 15. In this mode, users may now access 

ore - either selectively or cumulatively.

reate Purchase Orders that will be based on 
 delivery destinations for different lines 

ating to stock will display an additional 
f an organisation having four stores - Gen-
Medical and Island Medical.

report should be selected in the normal way 
by clicking with the mouse; to select more than one store, hold down Ctrl 

clicking on the desired store(s).
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nified).
Note that once you have set the print preview to "on", the "print preview" 
check box will remain checked until you uncheck it or you quit mSupply.

(Windows) or CMND (Mac) while 
hidden?
On Windows:

• Method 1: Press Ctrl and both mouse buttons, and drag the window to the new 
location.

• Method 2: Press Alt-Ctrl-right mouse button, while dragging the window to the 
new location.

On Mac OS 

• Press Control-Command-mouse button, and drag the window to the new location 

Printing notes
When printing you are usually presented with two dialog boxes (Windows). 
The first box is the "page setup" window. What this window looks like will 
depend on which printer you have chosen. The second box is the "print" win-
dow.

The "print" window has a check box that allows you to preview each page 
before printing. Buttons in the print preview window:

•   Print - Prints the current page

•   Stop - Stops the print preview. Useful to view a report without printing it.

•   Previous page (left arrow icon)- Move to the previous page of the print job

•   Next page - Move to the next page of the print job

If you maintain the mSupply pass
secure.

Note, however, that if a person ha
they will easily be able to open th
clearly shown in the password ent
you click "OK". It is your responsi
ware and data in a safe place. 

As of version 1.4, passwords store
(512 bit) RSA encryption, so there
password.

Supervisor mode
mSupply was initially designed to
each data file, and for many users

Version 2 (and later) now meets t
tions operating with more than o
ular store when starting mSupply,
to that store. However, Level 1 us
ther information see Store on pag
data relating to more than one st

In Supervisor mode you can also c
data for all stores, and can specify
within the order.

In this mode, all of the reports rel
panel, as shown in the example o
eral, Northern Medical, Southern 

The store(s) to be included in the 
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e

g

her that “C” depending on how your sys-

alls the following files and folders:
ng mSupply reports and plug-ins in the 

ime
 double-click the “Start mSupply Server” 

oosing Start > mSupply Server > mSupply 

dow where you should choose the “I would 
dio button.
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mSupp
If you are
a CD with
install the
mSupply_
computer
at any on

To run the
and doub

Installin

Run the in

What is in
We strong
ries, which

mSupply S

mSupply C
stalled where:
ly recommend you do not change the default installation directo-
 are as follows:

erver: c:\Program files\mSupply\mSupply Server

lient: c:\Program files\mSupply\mSupply Client

You will be shown a welcome win
like to activate 4th Dimension” ra

Then click “Next”
ly Client/Server installation
using the client/server version of mSupply you will be supplied with 
 2 installers. One installer, mSupply_server_installer.exe is used to 
 server software on a single server computer. The installer 
client_installer.exe is used to install the client software on as many 
s as you wish. You will be limited in how many clients can connect 
 time by the server licence you have purchased.

 installers, simply insert the mSupply CD, open Windows Explorer 
le-click the installer file on the CD that you wish to run.

 mSupply server

staller

(The volume may have a name ot
tem is configured)

mSupply server installer also inst
A folder called “Plugins” containi
same folder as 4D server.exe

Starting the Server for the first t
The first time you start the server,
icon on the desktop

You can also start the server by ch
Server
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he window to generate a file.

 here- just click the “Next” button.
Then the activation mode window is shown.

Choose “Offline activation” then click “Next”
In the next window you should read the agreement.Click on the “I agree” 
check box, and then on the “Next” button”

You will then be shown t

Do not enter information
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ow with the following message:

ing window with the “Open a database” 

ill be shown an open/save window where 
located in C:\Program Files\mSupply\mSup-
244

Click the “Choose File” button and choose the file sent to you by Sustainable 
Solutions.

Once you have chosen the file, it will show in the box in the window:
Click the “Browse” button. You w
you choose the program file. It is 
You will then be shown a window instructing you to send the generated file. 
Just click the “Next” button.

Then you will be shown a window where you are asked to integrate the file 
received.

Then click the “Next” button.

You should then be shown a wind

You will then be shown the follow
tab selected.
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shown where you can choose the location and name of your new data file.

folder called “mSupply data” inside your “My Docu-
eate the data file anywhere you like, but make sure 
s to the directory or there will be problems.

 “save” button you will be shown a message stat-
s been updated with new preferences. 

with the client software to configure the prefer-
 enter the mSupply registration number. You will 
ver admin interface:
You will have to connect 
ences for mSupply and to
then be shown the 4D ser
ply server\Progam\mSupply.4Dc

Click the “Open” button.

You will be shown a window where you can choose or create a new data file.

Click the “New” button to create a new data file. Another window will be 

We suggest you create a 
ments” folder. You can cr
you have read/write acces

Once you have clicked the
ing that your data file ha
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About the backup scheduler window
The new version based on 4D 2004 server has an integrated backup scheduler. 
Please request detailed documentation from Sustainable Solutions regarding 

vice
tart automatically when the machine is 
ed by setting the server to run as a service. 
tabase as Service

y clicking the close box on the top right (or 
s). You will then be shown a disconnect win-

OK”. The server will quit.

tive interface by choosing Start > (Settings) 
Tools > Services. 

and choose Send to > Desktop (as shortcut). 
area in the future.

list. You will be shown this window.
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Make sure you click the “Unblock” button or the server will not function 
properly.
Congratulations!

If you get a Windows Security alert
If you are running WIndows XP with SP2 or later installed you may get this 
alert:

its use.

Setting the server to run as a ser
The server should now be set to s
turned on. This can be accomplish
Choose File > Register Current Da

Quit the Sertver admin window b
choose File > Quit from the menu
dow:

Type “0” into the box, and click “

Now open the services administra
> Control Panel > Administrative 

Right-click on the “Services” icon 
This will provide quick access this 

Double-click on “Services” in the 



mSupply Client/Server installation

247

” is set to “local system account”

vice to interact with desktop” is checked.

indow.

vice by clicking the little “play” button (right facing 
ith the 4D service highlighted.

er will start automatically when the machine is 
ed to log-on to the machine.

est you delete the “start mSupply server” shortcut, 
D server as a service, and should not be used.

ally stop and start the server in future:

the “Services” shortcut you made on the desktop, highlight 
the 4D server service, and click the “start” button (looks like a “Play” button on a 
VCR )

ke sure clients are not connected, then choose File > Quit on 

y client then register mSupply.

umbers
server the licence allowed 2 concurrent connections. 
ra connections, you should enter the serial 

ence. This window is shown:
On the “Log On” tab, the settings should be shown below:

• To stop the server, ma
the server.

Next steps: install mSuppl

Entering Extra 4D serial n
When you registered 4D 
If you have purchased ext
number(s) now.

Choose Help > Update lic
Double-click on 4DServer:mSupply - fortunately it is usually the first item in 
the list!

You will be shown the 4D service properties window. Change the “startup 
type” in the drop-down list to “automatic”.

• Make sure “Log on as

• Make sure “Allow ser

Click “OK” to close the w

You can now start the ser
triangle) on the toolbar w

From now on the 4D serv
turned on. There is no ne

On the desktop, we sugg
as this will not start the 4

Should you need to manu

• To start, double-click 
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To create a new data file, click the “New” button. 

To select an existing data file, navigate to the file’s location then click the 
“Open” button.

may want to change are the memory set-
.

indow is shown:

 in the left-hand list. Provided you have 
d, set the “Maximum cache” setting to half 

you have 768Mb, set it to 384000 Kb). This 
tegrated with the data stored in the data 

file, but provides much faster access times, significantly speeding up non-
ures. The cache settings will have more 
e system has a larger number of records to 

hs the performance differences will be neg-

 setting determines how often the data on 
 the data in the cache. We recommend you 
 version based on the 4D 2004 engine we 
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indexed queries and other proced
effect in subsequent years once th
manipulate. In the first few mont
ligible.

The “Flush Data Buffers every ....”
the hard disk is synchronized with
set this to “2” minutes. (From the
Click the “Add” button to enter additional licences.

Creating a new data file or choosing a different data file
From this point there should be no need to revisit any of the about proce-
dures to operate mSupply. However, if you are testing, or starting a data file 
for a second organisation, you may wish either to change the data file mSup-
ply is using or to create a new file.

The mSupply program (the files named “mSupply.4DC” and “mSupply.RSR”) 
store the path to the last data file used, and the next time mSupply is started, 
the previous data file that was open is opened again unless there is user 
intervention or the “old” data file has been moved to a new location. 

To intervene, hold down the “alt” key as the 4D server starts up. 

You will be shown the standard open/save window:

Setting server memory settings
The most important settings you 
tings and the cache flush interval

Choose Edit > Preferences. This w

Click on the “Application” section
more than 256Mb of RAM installe
the physical RAM installed (eg. if 
cache memory is automatically in
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Click on the first user, then enter the password and click “OK”

mation see The Register button on page 141.

one or email the information to Sustainable Solu-
ion code.

ed to your organisation name and the MAC address 
ither of these will require a new code, which we 

 want sytematically to go through the mSupply 
ppropriate setttings.

ave a “clean” data file that is registered and is set 
 not have other data in it.

lso installs the following files and folders:
ork” in the Windows folder on the startup volume, 
omponent files that need to be present for 4D to 
(and othe types of) network(s).

installed on 4D client. Each time 4D client connects 
 have been added or modified on the server are 

he client.

ve been set up to overwrite existing files, so rein-
restore any potentially corrupted files to their origi-
l not overwrite your data files, unless you have been 
r data file “example data” and put it in the “exam-

 the event of a power failure
Your mSupply server should be attached to a UPS. The UPS should be fited 
with a control cable (serial, USB or network cable) that allows control soft-

er situation and shut down the server.

re set the shutdown to start at least two minutes 
l.

t that point. The file should contain the single line 
here the service name is the name displayed in the 

ble-click the service name in the services window. In 
rvice name is “4DS mSupply.4DC” (not to be con-

me)
Firewalls and the like
To make it easy for you to connect, mSupply publishes details about available 
servers on a specific port. It is quite possible that products such as “Zone 
Alarm” and “Norton Personal Firewall” will block access to this port and stop 
discovery of the servers. Contact your system administrator if the list of availa-
ble servers is blank.

Registering mSupply
The procedure is described earlier in “Preferences” chapter of the mSupply 

ware to detect a low pow

In the UPS control softwa
before the power will fai

Set it to run a batch file a
“net stop Service name” w
properties when you dou
the example below the se
fused with the display na
intend to use the ability to run a log file that records all unsaved changes and 
allows automatic integration of the unsaved changes should there ever be a 
crash - e.g. in the event of a hardware failure or a sudden power outage)

Installing mSupply Client
To run the installer, insert the mSupply CD, open Windows Explorer and dou-
ble-click the mSupply_client_installer.exe file on the CD. Once the installation 
is completed, double-click the “start mSupply Client” shortcut on your destop. 
The following window will appear:

The window lists available mSupply servers on your network. Click on the 
server you wish to connect to. Once you have connected successfully, the 
“Recent” tab will be shown first, and you can choose the server there. If for 
some reason network settings have been changed, and you cannot connect 
from the “Recent” tab, remember to look at the “TCP/IP” tab as well.

Clicking the “OK” button will take you to the mSupply password entry win-
dow. For new data files, the password is “user1” for the first user in the list. 

manual. For further infor

You will either have to ph
tions to obtain a registrat

Note that the code is key
of the server. Changing e
shall willingly provide.

mSupply preferences
Once registered, you may
preferences and choose a

Saving your data file
At this point you should h
up ready to use, but does

mSupply client installer a
A folder called “\4D\Netw
which contains network c
communicate over a TCP 

Note that no reports are 
to the Server, reports that
automatically copied to t

Note that the installers ha
stalling the software will 
nal state. The installer wil
wise enough to name you
ple data” folder.

Graceful shutdown in
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Positive amounts reflect a customer invoice for stock supplied by you.

Negative amounts reflect a credit to a customer.

 configuration
rver. If you are using mSupply in Single-user 
e set using the menu File > Preferences.

 functions are available, and it is not neces-
erforming a backup.

kup are set in the application Preferences.

e performed automatically at regular inter-

tomatic backup, the required parameters 
rences, then click on “Backup” in the left-
adings in the Backup preferences section.

les to be backed up ....... it is recommended 
ked.
250

Positive amounts reflect a supplier bill for stock supplied to you.

Negative amounts reflect a credit to the supplier.

Customer invoice export file name is "cust_invoice_expt"

The field order is: customer code, transaction number, comment, date, subto-
tal, tax, total.
You may wish to test your typing skills by opening a command prompt:

Export file formats
Export produces a tab-delimited text file (tabs between fields, returns 
between records).

Supplier invoice export file name is "supp_invoice_expt"

The field order is: 

mSupply Server backup
This information applies to 4D Se
mode, the backup preferences ar

Full database backup and restore
sary to exit the database before p

The files to be included in the bac

It is recommended that backups b
vals without user intervention.

Before performing a scheduled au
should be set. Choose Edit > Prefe
hand pane. There are four sub-he

Configuration options
Check the boxes adjacent to the fi
that only the Data File box is chec

supplier code

transaction 
number 

bill number 

comment 

date

sub-total

tax

total
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ng been made since the previous backup (you can 

30 backups. 

ns are self explanatory, and the ones appropriate to 
ould be selected.

 restore option for mSupply- if you should need to 
ct Sustainable Solutions for help.

nsions and types
r reference and to help your understanding. 

indows OS - five files.

 suffix)

file (.rsr suffix)

xe suffix)

x)
Backup options
The Backup options window (shown below) allows the user to specify the 
number of backup files to be kept, and whether to create a backup in the 

mSupply file exte
This information is just fo

On both Macintosh and W

•  A structure file (.4DC

•  A structure resource 

• An executable file (.e

•  A data file (.4DD suffi
The Backup File Destination Folder should be on a different volume from the 
one containing your database, and not on a different partition of the same 
drive.

It is possible to use a log file to provide complete roll-back functionality in the 
event of a system problem. Please consult Sustainable Solutions before turn-
ing this option on.

Scheduler Options
The Scheduler option allows the frequency of the backups to be set - in the 
above example, backups are made daily except Saturdays at 20:00 . Note that 
if Saturdays had been included, the “Every day(s)” option would have been 
selected, and the figure “1” entered in the box.. Sustainable Solutions recom-
mends daily backups.

event of no changes havi
leave this unchecked).

We reccomend you keep 

The other available optio
the user’s requirements sh

Restore options
Do not set the automatic
do a restore please conta
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•  A data resource file (.4DR suffix)

double-click the copy of the structure file, mSupply may still open using the 
252

data file from the original if it can find it. 

To choose the data file manually do this: hold down the option key (Mac) or 
Alt key (Windows) as you click the OK button in the password window. You 
will then be given an open/save box to choose the correct data file.

If you are not sure which structure and data file you are currently using, 
choose about mSupply... from the help menu (Windows) or the apple menu 
(Mac)
File arrangementLocation
It is easiest to keep all relevant files in the same folder, in a reasonably accessi-
ble place on your hard drive. (For example, directly on your "C" drive.)

If you make copies, don't leave them in the same folder, or you'll just get con-
fused!

There are several folders to store reports and queries that need to be in the 
same folder as your structure file. Note that these folders are automatically 
created when you unzip the program files the first time. They are mentioned 
here so those of you with an inquisitive streak won't unknowingly do dam-
age!

•  A reports folder. This stores reports that are used by the program. Leave this 
folder alone- store your own reports in the custom reports folder.

•  A custom reports  folder. Store the reports you create here.

•  A custom queries folder. Store the queries (searches) you create here.

•  A custom labels folder. Store any label templates you create here.

Note that on Windows or Macintosh the run time application (that is, the 
database engine- "4Drun.exe" file on windows) can reside anywhere on your 
hard disk, and does not need to be regularly backed up (although you should 
have one backup copy somewhere!)

Getting the right data file when you open mSupply
Important! If you open mSupply by double-clicking the "start mSupply" icon 
on the desktop (Mac users- by double-clicking the structure file), mSupply will 
try to open the same data file that was last opened. It will open the same file 
each time if you repeat the same procedure. If you make a copy, and then 
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invoices issued)

eaning 

ew invoice 

uggested 

onfirmed 

nalized 

he order has been created, but the "stock 
n order" value for each item has not yet 
een updated. If another order for the same 
em is processed, mSupply will not take 
ccount of suggested orders. Suggested 
rders can be deleted.

he "stock on order value" for each item has 
een updated. Confirmed orders can also be 
unconfirmed" if you cancel an order. Items 
nd quantities can still be edited.

he order has been received, a price calcu-
tion done, and the order has been turned 

into a "supplier invoice". The order is now fin-
ished with, and can be deleted.
T

T
m
tr

T

Tr
m
tr
ransaction Status Codes 

ansaction status
Supply uses a set of two letter codes to keep track of the status of each 
ansaction:

ps payment (cash payment) to a 
supplier
ransaction Codes

ransaction type codes
Supply uses a series of two letter codes to denote the different types of 
ansactions it can handle.

For orders:

 Code Meaning 

ci customer invoice (goods sup-
plied to a customer)

sg customer credit (goods returned 
by a customer) 

si supplier invoice (goods received 
from a supplier) 

sc supplier credit (goods returned 
by you to a supplier)

rp repack (A stock line is broken 
down into smaller pack sizes)

bu build- an internal transaction 
where you manufacture (build) 
items from raw 
materials in stock. 

rc receipt (cash receipt) from a 
customer (a customer pays for 

Code M

nw n

sg s

cn c

fn fi

sg T
o
b
it
a
o

cn T
b
"
a

fn T
la
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For Supplier invoices
.

 tables in mSupply (There are some others, 
ose!). This information will help you if you 

ing information (querying) using that field 

has been chosen, but the OK or "confirm" 

sg The invoice has been created. An order from 
a customer has been received, and the items 
put against the invoice are still in your store, 

o longer "available" to issue to other 
rs. (i.e., the "available" amount for 
 line has been reduced, but the 

" amount has not). Note that if "one 
firm" is checked in the preferences, 
tomer invoices move straight from 
tus “nw” to status “cn”

ice has been confirmed by clicking 
rm" button, which is done when the 
ves the store. Lines that couldn’t be 
 are added to the "backorder" file. 
ice can still be edited.

ice has been finalized, and can no 
 edited

 build is being entered for the first 

ed" - the raw materials are taken out 
 but the finished product (the item to 
not yet entered into stock.

d" - the raw materials are taken out 
and the finished product is entered 
k. 

" - the build can no longer be editied
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Field formats
The following tables list the main
but we're not telling you about th
are building your own reports. 

Note that if a field is indexed, find
will be very quick.

button has not yet been pressed.
For Customer invoices

For Builds

nw . The "new supplier invoice"  menu item has 
been chosen, but the OK button on the 
invoice has not yet been pressed, or confirm-
ing the invoice has been postponed. (This 
option is only available if "confirm supplier 
invoices automatically" is unchecked in the 
preferences). 
Note: quitting mSupply by choosing the 
"quit" command from the file menu or 
click the application close box  (Win-
dows only) while you are entering a new 
supplier invoice will result in the invoice 
being saved with status "nw". To con-
firm the invoice, open it then click the 
OK button

sg This status is not used for supplier invoices- 
invoices of status "nw" become status "cn" 
when the OK button on the form is pressed

cn The invoice has been entered, but can still 
be edited.

fn The invoice has been finalized , and can no 
longer be edited.

nw The "customer | new invoice..." menu item 

but are n
custome
each item
"quantity
step con
then cus
being sta

cn The invo
the "confi
stock lea
supplied
The invo

fn The invo
longer be

nw "new" the
time.

sg "suggest
of stock,
build) is 

cn "confirme
of stock 
into stoc

fn "finalized
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name_key_ Alpha 8 *

Long Integer    

Real    

Alpha 20  

Long Integer    

Long Integer    

Long Integer    

Long integer

Bill of Materials
cription Type Length Indexed

Long Integer   *

Long Integer    

Alpha 20  

Alpha 50  

Alpha 60  

Long Integer    

Real    

Real    

Real    

unit_key Long Integer    

Bom Master
ription Type Length Indexed

Alpha 8 *

Alpha 8 *

Real    
supplier 

customer_tr
ansaction_k
ey_order

Long Integer    

status Alpha 3 *

customer_tr
ansaction_k
ey 

Long Integer    

Field Name Desc

item_key 

ingredient_it
em_key 

quantity 
Abbreviation
Field Name Description Type Length Indexed

abbreviation Alpha 20 *

expansion Text   

Account Code
Field Name Description Type Length Indexed

key ß Long Integer    

code Alpha 20  

description Alpha 80  

account_type Alpha

Backorders
Field Name Description Type Length Indexed

item_key Alpha 8 *

quantity Real    

key Long Integer    

comment Text    

name_key_
customer 

Alpha 8 *

order date Date    

type Alpha 3 *

item_name Alpha 80  

order_line_k
ey 

price 

units 

account_sto
ck_key 

account_pur
chases_key 

account_inc
ome_key 

store_key

Field Name Des

key 

transaction_
key 

item_key 

item_name 

spare_units
_v180 

line_number 

quantity 

yeild 

total_used 
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units_key Long Integer    

spare_units
_v180 

Alpha 60  
Drug Interaction

Field Name Description Type Leng
th

Inde
xed

Long Integer    

Long Integer    

Long Integer   *

Text    

Text    

Alpha 2  

Alpha 2  

Alpha 2  

Long Integer    

Alpha 20  

Date    

nteraction Group
n Type Length Indexed

Long Integer   *

Alpha 50  
256
key Long Integer   *

line_number Long Integer    

Contacts 
Field Name Description Type Length Indexe

d

name_key Alpha 8 * 

first Alpha 20  

position Alpha 30  

user1 boolean   

comment Alpha 20  

last Alpha 20 * 

Currencies
Field Name Description Type Length Indexed

key Alpha 20 *

rate Real    

currency Alpha 3 

is_home_currency Bool-
ean

key 

affected_group_key 

affecting_group_key 

notes 

alert_message 

action 

clinical_significance 

quality_of_evidence 

source_key 

author 

date_modified 

Drug I
Field Name Descriptio

key 

name 
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e_list 

e total stock on 
nd

Real    

eld you can use for 
fining groups of 

s to appear on 
rchase orders

Alpha 8  

ed for quickly mark-
 items for reporting 
rposes

Alpha 8

e defined daily dose 
 the item

Alpha 8  

 item code Alpha 18 *

e opening stock on 
 previous time the 
ck was set (usually 
 end of the finan-
l year)

Real    

” = general, “sv” = 
vice, “cr” = cross 

erence

Alpha 3  

 the price be edited 
issue time?

boolean    

 default margin for 
 item

Real    

 selling price for the Real    

rs 
rue, this item will 

never be added to an 
order automatically

Boolean    

Long 
Integer 

   

Long 
Integer 

   

Long 
Integer 

   

 key of the depart-
nt this item belongs 
(internal)

Long 
Integer 

  *
opening_stock_t
his_year 

Real    

default_pack_si
ze 

The size used for com-
paring quotes

Real    

minimum_stock The least stock that 
must be maintained

Long 
Integer 

   

atc_category Alpha 30  

report_quantity Real    

bonus_qualifyin
g_amount 

bonus_quantity 

bonus_price_pe
rcentage 

department_key the
me
to 
E-Mail
Field Name Description Type Leng

th
Inde
xed

key Long Integer    

status Alpha 2  

to Text    

subject Text    

body Text    

date Date    

name_key Alpha 8 *

attachments BLOB    

date_sent Date    

time_sent Time    

cc Text    

bcc Text    

mail_box_key Long Integer   *

Items
Field Name Description Type Leng

th
Inde
xed

key Internal reference Alpha 8 *

item_name The name of the item Alpha 80 *

include_on_pric Boolean    

stock_on_hand Th
ha

supplier A fi
de
item
pu

flag Us
ing
pu

ddd_value Th
for

code the

prev_open_stoc
k 

Th
the
sto
the
cia

item_type “gn
ser
ref

price_editable can
at 

margin the
this

default_price the
item

ignore_for_orde If t
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stock_on_order The quantity of stock 
on confirmed purchase 
orders

Real    

p_key Integer 

user field 4 boolean    

backorder_quan Real    

analysis Real    

Alpha 30  

Alpha 30  

Real    

Long 
Integer 

   

Long 
Integer 

   

Long 
Integer 

   

l key of the 
is item

Long 
Integer 

  *

Long 
Integer 

   

Long 
Integer 

  *

Alpha

Long 
Integer

Real

Boolean
258

pack_to_one_o
n_recieve 

Boolean    

cross_ref_item_
key 

Alpha 8  

shelf_location_b
ulk 

Alpha 20  
essential_drug_l
ist 

True if the item is on 
your essential drug list

Boolean    

spare_shelf_loc
ation 

Alpha 20  

indic price Real    

user field 1 Alpha 30  

hold_for_issue If true, this item can 
not be added to cus-
tomer invoices

Boolean    

builds_only Only issue this item on 
builds

Boolean    

reference_bom_
quantity 

The quantity that the 
entered bill of materi-
als will produce

Long 
Integer 

   

use_bill_of_mat
erials 

If true, automatically 
enter build lines based 
on the bill of materials

Boolean    

description Long description of the 
item

Text    

hold_for_receive If true, this item can 
not be received on 
supplier invoices

Boolean    

Message Text that will be dis-
played in a win-
dowhen this item is 
issued or received.

Text    

interaction_grou Long   *

user field 2 

user field 3 

ddd factor 

account_stock_
key 

account_purcha
ses_key 

account_income
_key 

unit_key The interna
units for th

outer_pack_size 

category_key 

ABC_category

warning_quantit
y

user field 5

print_units_in_di
s_labels
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item_directions

Item Lines
scription Type Leng

th
Inde
xed

 physical loca-
 for this batch

Alpha 10  

 item key of the 
ck line

Alpha 8 *

Real    

 expiry date of 
 line

Date    

 batch number 
he line

Alpha 14  

 number of 
ks available for 
e

Real    

Real    

Real    

Real    

Boolean    

Real    

Long Integer   *

al number of 
ks on hand

Real   *

Alpha 8 *
Field Name Description Field Properties

directions Text

item_key Alpha Indexed

key Long Integer

priority Long Integer
 

Items to Update
Field Name Description Type Leng

th
Inde
xed

item_key Alpha 8  

spare Long Integer 

Item Category
Field Name Description Type Leng

th
Inde
xed

key Long Integer   *

Description Alpha 60  

spare Alpha 3  

summary_only Boolean

Item Department
Field Name Description Type Leng

th
Inde
xed

key Long Integer   *

department Alpha 30  

issue Boolean    

Field Name De

location The
tion

item_key The
sto

pack_size 

expiry_date The
the

batch The
of t

available The
pac
issu

start_year_quan 

cost price 

sell price 

hold 

initial_quan 

key 

quantity Tot
pac

name_key 
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Item Note label
tion Field Properties

Text

Alpha

Text

Text

Text

Text

Text

Long Integer

Log
Type Leng

th
Inde
xed

Date   *

Alpha 10  

Alpha 80  

Alpha 60  

Time    

Long Inte-
ger 

  *

Alpha 2 *

Mailbox
Field Name Description Type Leng

th
Inde
xed

Long Integer   *

Alpha 50  
260

key 

name 
Field Name Description Type Leng
th

Inde
xed

item_key Alpha 8 *

date Date    

note Text    

WhenToDisplay Alpha 2  

Item Warning Link
Field Name Description Type Leng

th
Inde
xed

key Long Inte-
ger 

   

item_key The item key for this 
warning

Alpha 8 *

warning_key The key of the warn-
ing to be displayed

Long Inte-
ger 

  *

priority True or False 
depending on the 
warning’s priority

Boolean   

Field Name Descrip

body

description

footer_left_1

footer_left_2

footer_right_1

footer_right_2

heading

key

Field Name Description

entry_date 

user 

event 

event type 

time 

source_key 

source_type 
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female Boolean    

Alpha 50  

Alpha 50  

Long Integer   *

BLOB    

Alpha 60 *

Alpha 2  

Name Category
scription Type Leng

th
Inde
xed

Long Integer   *

Alpha 50  

Alpha 2  

Name Group
scription Type Leng

th
Inde
xed

Long Integer   *

Alpha 40  

Name Note
scription Type Leng

th
Inde
xed

Alpha 3  

Date    

Text    

Alpha 8 *

Long Integer    

Alpha 2  
date_of_birth Date    

overpayment Rreal    

group_key Long Integer   *

hold Boolean    

ship_address1 Alpha 50  

ship_address2 Alpha 50  

url Alpha 80  

barcode Alpha 22  

Field Name De

note_type 

entry_date 

note 

name_key 

key 

later_use3 
Names
Field Name Description Type Leng

th
Inde
xed

key Alpha 8 *

name Alpha 80  

fax Alpha 20  

phone Alpha 22  

customer Boolean   *

bill_address1 Alpha 50  

bill_address2 Alpha 50  

supplier Boolean   *

charge code Alpha 20  

margin Real    

comment Text    

currency_key Alpha 20  

country Alpha 20  

freightfac Real    

email Alpha 30  

Analysis Alpha 30  

code Alpha 20  

last Alpha 30 *

first Alpha 30 *

title Alpha 5  

postal_address1 

postal_address2 

category_key 

sacho 

web_id 

price_category 

Field Name De

key 

name 

type 

Field Name De

key 

name 
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leteruse3 Alpha 2  

spare8 Alpha 2  

spare9 Alpha 2  

permissions
Field Name Description Field Properties

Perchase_Orders
- Type Leng

th
Inde
xed

Alpha 8 *

Long Integer   *

Date    

Long Integer    

Alpha 5  

Text    

Alpha 20  

Real    

Real    

Real    

Real    

Alpha 50  

Long Integer    

Date    

Boolean    

Date    

Long Integer    

Long Integer    

Real    

Date    

supplier_agent Text    

Text    

Text    

Text    
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item_dept_key Long Integer

name_group_ke
y

Long Integer 
Indexed

delivery_method 

authorizing_offic
er_1 

authorizing_offic
er_2 
spare10 Alpha 2  

spare11 Alpha 2  

spare12 Alpha 2  

Numbers
Field Name Description Type Leng

th
Inde
xed

name Alpha 30 *

value Long Integer    

Number Re-use
Field Name Description Type Leng

th
Inde
xed

name Stores deleted 
serial numbers for 
reuse- not rele-
vant to users

Alpha 30  

number_to_use Long Integer    

Field Name Descrip
tion

name_key 

key 

creation_date 

target days 

status 

comment 

currency_key 

inv total 

freight 

local charges 

curr rate 

reference 

lines 

requested_delvi
ery_date 

locked 

actual_delivery_
date 

created_by 

last_edited_by 

Order_total 

invoice_receive
d_date 
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Quote
e Field Proper-

ties

Long Integer 
Indexed 
Unique

y Alpha (8) 
Indexed

_date Date

Date

Alpha (30)

y Long Integer 
Indexed

Purchase_Order_Lines
cription Type Leng

th
Inde
xed

Long Inte-
ger 

  *

Alpha 8 *

real    

real   

ce 
real    

cost_local real    

Alpha 50  

Alpha 10  

Date    

real    

real    
comment 

batch 

expiry 

quan_original_o
rder 

quan_adjusted_
order 
freight_condition
s 

Text    

additional_instru
ctions 

Text    

total_foreign_cu
rrency_expecte
d 

Real    

total_local_curre
ncy_expected 

Real    

agent_commissi
on 

Real    

document_char
ge 

Real    

communications
_charge 

Real    

insurance_char
ge 

real    

freight_charge real    

po_sent_date Date    

spare1 Long Integer    

spare2 Long Integer    

spare3 Long Integer    

Field Nam

key

names_ke

responded

sent_date

spare_field

tender_ke

Field Name Des

order_key 

item_key 

quan_this_order 

packsize_ordere
d 

cost_from_invoi
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quan_rec_to_da
te 

real    

pack_size_recei real    

item Alpha 20 *

value Alpha 60  

item Alpha 40 *

type Alpha 2  

blob BLOB    

Long Integer    

Alpha 80  

Prescriber
Type Leng

th
Inde
x

Long Integer   *

Alpha 20 *

Alpha 80  

Alpha 10  
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Pref Blob
Field Name Description Type Leng

th
Inde
xed
ved 

estmated_cost real    

item_name Alpha 80  

key Long Inte-
ger 

   

pack_units Alpha 5  

price_expected real    

price_extension
_expected 

real    

supplier_code Alpha 20  

Permissions
Field Name Description Type Leng

th
Inde
xed

name_group_ke
y 

Long Integer   *

item_dept_key Long Integer    

Prefs
Field Name Description Type Leng

th
Inde
xed

user_key 

network_id 

Field Name Description

key 

code 

name 

initials 
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Freight_comme
nt 

Text    

Reminder
scription Type Leng

th
Inde
xed

Long Integer    

Date    

Boolean    

Text    

Boolean    

Boolean    

Long Integer    

Long Integer    

Long Integer   *

Long Integer    

Report
scription Type Leng

th
Inde
xed

Alpha 80  

BLOB    

Long Integer    

Long Integer    

last_updated Date    

Ship Method
scription Type Leng

th
Inde
xed

Long Integer   *

Alpha 80  

Tender
Freight_per_pref
erred_pack 

Real    

lead_time_days Long Integer    Field Name De

key 

method 
Quote_lines
Field Name Description Type Leng

th
Inde
x

edit_date Date    

name_key Alpha 8 *

price Real    

preferred Boolean    

pack_size Real    

currency_key Alpha 20 *

comment Text    

net_cost Real    

adj cost Real    

item_key Alpha 8 *

strip pack Boolean    

supplier_code Alpha 20  

supplier_bar_co
de 

Alpha 50  

price_break_co
mment 

Text    

price_break_qu
anity 

Real    

price_break_dis
count 

Real    

supplier_preferr
ed_pack_size 

Real    

Field Name De

key 

due_date 

repeat_has_bee
n_generated 

message_text 

done 

repeats_automa
tically 

repeat_type 

repeat_interval 

user_key 

repeat_day 

Field Name De

report_name 

report_blob 

owner_key 

key 
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Field Name Descrip-
tion

Field Properties

comment Text

Indexed

units_key Long Integer 

Field Name Description Type Len
gth

Inde
xed

name_key The internal reference 
ame (cus-
lier) associ-
e 
 (if any)

Alpha 8 *

l reference 
y mSupply 
 visible to 

Long Inte-
ger 

  *

 number 
Supply

Long Inte-
ger 

  *

Real    

ent text 
 the user

Alpha 80  

e transac-
eated

Date    

ction type. 
nsaction 
ter pg ) 

Alpha 3 *

ode denot-
us of the 
 (See the  
 )

Alpha 3 *

al plus the 
 (see 

Real    

number 
supplied by mSupply 
when the invoice was 

Long Inte-
ger 

   

Alpha 30  

ce supplied 
r party for 
tion

Alpha 10  
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Indexed

Transactions

finalized.

spare_category 

their_ref The referen
by the othe
the transac
conditions Text

created_by_use
r_key

Long Integer 
Indexed

creation_date Date

desc Alpha (80)

due_date Date

issue_date Date

key Long Integer 
Indexed Unique

status Alpha (3)

Tender_lines
Field Name Descrip-

tion
Field Proper-
ties

comment Text

conditions Text

items_key Alpha (8) 
Indexed

item_name Alpha (80)

key Long Integer 
Indexed 
Unique

pack_size Real

quantity Real

tender_key Long Integer 

key of the n
tomer/supp
ated with th
transaction

key The interna
key given b
(not usually
the user)

invoice_num The invoice
given by m

amount_outstan
ding 

comment The comm
entered by

entry date The date th
tion was cr

type The transa
See the tra
codes chap

status A 2 letter c
ing the stat
transaction
chapter pg

total The subtot
tax amount
below)

export batch The batch 
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y ger 

ship_method_co Alpha 80  

Long Inte-
ger 

   

Long Inte-
ger 

   

e key of the cate-
y chosen for this 
oice 

Long Inte-
ger 

  *

Transaction Category
escrip-
on

Type Length Indexed

Long Integer   *

Alpha 80  

Alpha 3  

Transaction Lines
scription Type Len

gth
Inde
xed

y of the transaction to 
ich it belongs

Long 
Integer 

  *

y of the item to which 
elongs

Alpha 8 *

batch Alpha 20  

price_extension Real    

te or directions if a 
pensary line

Text    

Real    

e expiry date of this 
 on the invoice

Date    

Real    

Real    
mment 

waybill_number Alpha 50  

number_of_cart
ons 

Long Inte-
ger 

   

arrival_date_esti
mated 

Date    

arrival_date_act
ual 

Date    

note No
dis

sell_price 

expiry_date Th
line

cost_price 

pack_size 
confirm_date The date the invoice 
was confirmed

Date   *

service descrip Description of any ser-
vice items on the 
invoice

Alpha 60  

service price The amount of any 
extra charges added to 
the invoice (or dis-
count)

Real    

subtotal Total of all price exten-
sions plus the service 
price

Real    

tax The tax amount of the 
invoice

Real    

user_key The user id number of 
the user who created 
the invoice

Long Inte-
ger 

  *

pickslip_printed
_date 

Date    

prescriber_key Long Inte-
ger 

  *

order_key Long Inte-
ger 

  *

invoice_printed_
date 

Date    

ship_date Date    

ship_method_ke Long Inte-   *

responsible_offi
cer_key 

mode_key 

category_key Th
gor
inv

Field Name D
ti

key 

category 

type 

Field Name De

transaction_key Ke
wh

item_key Ke
it b
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quantity Quantity issued (in num-
ber of packs)

Real    

box_number Alpha 10  
Users

Type Length Indexed

Long Integer   *

Alpha 50  

Alpha 50  

Alpha 30  

Long Integer    

Date    

Integer    

Alpha 8  

BLOB    

Boolean    

BLOB    

Time    

Alpha 4  

Alpha 50  

Alpha 50  

Date    

Alpha 50  

Alpha 50  

Alpha 50  

Alpha 50  

Alpha 50  

Date    

date_left Date    

Alpha 50  

Boolean    

Warning
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Units
Field Name Descrip-

tion
Type Length Indexed

key Long Integer   *

units Alpha 60  

comment Text    

job_title 

responsible_offi
cer 
item_line_key The key of the item line 
(stock line) that the 
transaction line belongs 
to

Long 
Integer 

  *

line_number The sequential line num-
ber on the invoice

Long 
Integer 

   

item_name The item name (stored 
to give data integrity for 
historical transactions 
even if the related item 
name is later changed)

Alpha 50  

key Long 
Integer 

  *

supp_trans_key
_ns 

Long 
Integer 

  *

order_line_key Long 
Integer 

   

Transaction Notes
Field Name Descrip-

tion
Type Length Indexed

key Long Integer   *

note Text    

Field Name Descrip-
tionß

key 

name 

startup_method 

spare_must_be
_field 

nblogins 

lastlogin 

group 

mode 

qdump_offset_b 

active 

permissions 

lasttime 

initials 

first_name 

last_name 

date_of_birth 

address_1 

address_2 

e_mail 

phone1 

phone2 

date_created 
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v.195 (5th February 2007)

ll have significant abilities to report on volumes used 
n..

lay uses the great new list view- you can set col-
orders and it is remembered next time you open the 

s to Andy):
over shows you how likely it is that lines in stock will 
 expiry.
tfall report shows how much of customer demand is 

w be split into multiple sheets by shelf location. (See 
pter for more details).

tals report can now be produced for a time range 
ny prescriptions were processed for a particular 

ting now sorts correctly by line number.

 form could cause a client crash if you shose “simple- 
x” for the customer invoice form in the preference

 not working correctly for Report > Purchases

antity for number of items to report on in ABC anal-

ber 2006)

• Purchase Orders can be opened in directly in Excel.

 supports Zebranet II print servers.

andles different long text in item names and direc-

displays prescriber category

n reports by prescriber name or category

w be split into multiple sheets by shelf location. (See 
pter for more details).
New Features

• French translation of the interface elements complete (except for 
changes in this version)..

• Location management:
• You can specify locations from a list, and define location volumes
• You can define location types
• Command to merge locations
• Can set default volume for each item.

• Label printing now

• Printing of labels h
tions much better.

• Prescriber list now 

• Can filter transactio

• Packing slips can no
the Preferences cha
Changes in Earlier Versions

• version 1.96 wi
at each locatio

• Purchase order disp
umns, widths, sort 
window.

• New reports (thank
• Expiry date vs c

be used before
• Customer shor

being met.

• Packing slips can no
the Preferences cha

• User transaction to
(e.g to see how ma
shift).

• Goods receipt prin

Bug fixes

• A corrupted invoice
good for dot matri

• The date filter was

• Can now enter a qu
ysis report.

v.194r3 (13th Decem

New Features

Field Name Descrip-
tion

Type Length Indexed

key Long Integer   *

code Alpha 20 *

warning_text Text    

Web Message
Field Name Descrip-

tion
Type Length Indexed

key Long Integer   *

active Boolean   *

show_until_date Date    

headline Text    

message Text    

Web Favourites
Field Name Descrip-

tion
Type Length Indexed

name_key Alpha 8  

Item_key Alpha 8  

type Alpha 3  
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• User transaction totals report can now be produced for a time range 
(e.g to see how many prescriptions were processed for a particular 
shift).

v1.94r1 (28th September 2006)

• First stab at a French translation of the interface (just the menus and the 
item details window)

tachment now opens the attachement

n from the “other” mode to which it was 
etails window is used

no longer be selected by the code in dispen-

er menu is now working.

)

ow supports EPL printing, which bypasses 
driver and allows the user to keep a “nor-
 Windows printer for reports and the like, 
 labels to the label printer. 

eous labels. 

neous labels

bels of a dispensed item “on-the-fly”

an Excell Pivot-table)

rts:
ction category
ress field (e.g. for getting regional distribu-

New features

• Anew Prescriber report

tegories for prescriptions separately to cus-
e.

oice of a category for customer invoices in 

 fly in dispensary mode
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New Features

• You can open a transaction from dispensary mode by double-clicking a 
line in the history tab when viewing patient details.

• Ability to specify an external email client on Windows for email pur-
chase orders and tender documents (as opposed to using mSupply’s 
internal email client)

• Can now set transaction ca
tomer invoices in store mod

• New preference to force ch
store mode.

• Can edit prescribers on the
Bug fixes

• Item details stock view displays correctly after doing a “split” on a 
batch.

• Prescriber report now shows mean price correctly (was showing std 
deviation).

v.194r2 (1st November 2006)

New Features

• The item list view is much improved.
• Users can choose which columns are viewed.
• Users can add their own columns
• The columns and their widths (as set by the user) are remembered 

when the window is closed, and restored when the window is 
opened.

• The above settings are stored on a per-user basis, so each user get 
their own custom view.

• You can import item categories when importing items

Bug fixes

• The menus and user guide have been edited to clarify the difference 
between Item category and ATC category.

• The ATC category report now excludes items whose DDD factor is zero, 
runs much faster, and formats numbers consistently.

• Import of items now includes the ability to import Item category

Bug fixes

• Double-clicking an email at

• When viewing a transactio
entered, the right type of d

• Store mode cusotmers can 
sary mode

• Order details window: Ord

v1.94 (10th September 2006

New Features

• Printing to Zebra printers n
the poxy Windows printer 
mal” printer as the default
and at the same time print

• More settings for miscellan

• Ability to duplicate miscella

• Abilitty to print multiple la

• New cross-tab reports (like 

• Other new transaction repo
• Report items by transa
• Report invoices by Add

tion totals)

v1.92 (4th July 2006)
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stock list.

• Copy/Paste was disabled for File>Preferences.

nal features apply to Dispensary Mode only

e Customised identification codes and print them on 
ed.

ay the item category as the goods are being issued is 

e printed on every label, on selected labels, or not at 
e option chosen.

for items has been added that can store a numerical 

w stay at the front (Windows only)

g was starting from zero, causing the first line to be 

lations for supplier credits.

 enable our French translator to localize text for 
bels.

6)

s giving wrong suggested quantity.

• Added compression to backup options

led as no-one was using it!

rders now make use of the any quotations present 
en if they are not marked as preferred.
• Copy/Paste was disabled for Tenders window.

Changes

• Item slow movers Report uses days rather than months.

Price tab now does not show on Inventory Adjustment window.v1.91 (12th 
June 2006)

• Bonus system disab

• Manual purchase o
for that suppleir, ev

v1.90 (9th Mar 2006)
• Patient details update as soon as edited

• Support for any size dispensary label width and height.

• More user choices for handling duplicates when importing items

• Prescriber gender field now showing

• Any transaction report can now be run for dispensary mode, store 
mode or both.

v1.92 (4th July 2006)

New features

• The option to print purchase orders alphabetically has been added.

• Prescribers can be assigned active or inactive status.

• A purchase order printing section has been added to File > Preferences. 
Here, you can turn on/off the printing of signatures and other sections 
of Purchase orders.

• You can copy a supplier invoice to the clipboard, from where it can be 
pasted in Excel.

• Sell price categories have been made applicable to patients in Dispen-
sary Mode.

• By double-clicking a purchase order line, then clicking the receipts tab, 
you can view the receipt transactions for that item by choosing an 
option from the drop-down list.

Bug fixes

• Item detail view: the Stock tab was not showing the supplier in the 

New features
Note: These three additio

• The option to creat
labels has been add

• The option to displ
now available.

• Units of issue may b
all, according to th

• An extra user field 
value.

Bug fixes

• Modal windows no

• Build line numberin
hidden.

• Disabled price calcu

Changes

• Internal changes to
menus and field la

v1.90r2 (9th May 200

Bug fixes

• Reorder report wa

New features



Transaction Codes

Bug fixes

• Under certain circumstances and with certain printer drivers, printing 
purchase orders could cause a PC to hang or restart. This issue has been 

generation and purchase order creation. Internal tender report also 
added.

• ABC analysis report and Transactions report have been improved.

• Management summary now prints in portrait not landscape.

ven added query options.

s been updated. You can now preview the 
ms to be included before running the full 

w gives more information.

 now been consolidated into two pages 

as been consolidated and reduced in size.

ck for the reports folder on startup. Reports 

pire after 1800 transaction lines rather than 
on is expired, menu bars will no longer show 

w be opened in MS Excel or OpenOffice 

els in dispensary mode

 is now printing rather than creating PDF 

w versions of mSupply.

s the data file you are connecting to.

• Manufacturers can now be defined as a separate category from suppli-
 have a manufacturer defined.

n added “open in Excel” option

ow remembers the Excel (Or Staroffice Calc) 
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Changes

• Dispensary express mode has been removed. Dispensary full mode is 
now simply Dispensary mode.

• Reports Item ledger and Item ledger date range have been consoli-
dated into a single report Item ledger.

ers, and each incoming item

• Several reports now have a

• In multi-user use, mSupply n
location for each user.
fixed.

• Deleting purchase order lines. Under certain circumstances, a high-
lighted purchase order line could not be deleted. This issue has been 
fixed.

• Searching for suppliers via purchase orders. This search showed all sup-
pliers. This issue has been fixed.

• Creating supplier invoices from goods receipts. Under certain circum-
stances, a placeholder line was mistakenly created. This issue has been 
fixed.

• On startup, mSupply now clears out it’s temporary folder.

• Many other minor bug fixes.

New Features

• mSupply Navigator added. This window allows easy access to all the 
common mSupply functions and options, and takes the place of the 
splash screen.

• New goods receipting functionality added. This provides a more precise 
method of receiving goods and automatically creates supplier invoices. 
Multiple batches from one purchase order line can now be received 
separately, and excess goods can be received.

• mSupply can now import and export all names (suppliers, customers 
and manufacturers) and all stock items to and from text files.

• New report ‘Suggest order quantities’ added. This report analyses your 
stock levels and suggests which items need ordering and how much.

• Tender management module improved to include automatic tender 

• Item list report has been gi

• Item usage reports form ha
approximate number of ite
report.

• Goods received printing no

• Purchase order forms have
rather than three.

• Purchase order line form h

• mSupply will not longer che
are now saved internally.

• Unregistered copies now ex
a flat 3 months. If registrati
up.

• Many more reports can no
Calc..

v.186 (2nd Feb 2006)

Bug fixes

• Fixed bug with printing lab

• Printing tender documents
files.

New Features

• Automatic checking for ne

• Log-in window nows show
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were added.

re now centred on the screen rather than offset 

lder lines recalculate subtotals (not immediately rel-
inking of the future ;-) )

2006)

now works for adding new customers and suppliers.

 customer invoices now show new lines immediately 
ng an open/close of the invoice window.

dscape report, some portrait reports were also being 
e.

 bill of materials renumbers the line

ngement report was fixed (date_chooser_manage 

e window better on startup.

owing properly when viewed from the supplier 

er also updates the prescriber list immediately.

t working as the mSupply installer was putting the 
rong location.

r 2005)

Bug fixes

 Quotes were not showing. New quotes were not 
. This was a major problem. All users of v184 should 

Tender lines produced an error if no units were 

ows could be hidden behind other windows.
• Adding of Ad Hoc items to a backorder is now more robust (done in a 
new process)

• When editing a transaction line, and changing it to a totally different 
line, stock totals were sometimes not updated correctly.

• Set start of year stock was wrongly rounding to integers rather than 
leaving as a real number. 

• Previously entered
properly enterable
upgrade.

• Selecting units for 
defined.

• Some tender wind
• Opening reports in Excel creates a temporary file and opens the report 
without any further user intervention. (Remember to save the report to 
the location of your choice before closing Excel if you want to keep it!)

• New names can be added directly from the names list window.

• Reminders now record the user who created each reminder. You can 
view and edit reminders created by you that others should action as 
well as reminders for you to action. The reminders list is now sortable 
and has resizable columns

Changes

• We now use the Win2PDF PDF creator on Windows. This results in faster 
and more reliable PDF creation. Please contact us for purchase of the 
driver.

• Macintosh PDF generation is now working reliably.

• Tenders: print all and email all buttons removed- you can get the same 
functionality by selecting all rows and click the Print selected or Email 
selected buttons.

v1.85r2 (13th January 2006)

Bug fixes

• When an invoice line created with a previous version of mSupply was 
edited, and there was another invoice with the same batch, the edited 
line did not correctly reflect the total of the two lines.

• When a placeholder line was deleted on confirmation of an invoice, the 
display was not being updated.

• The price extension was not always set to zero when placeholder lines 

Changes

• Item list windows a
from the corner.

• Changes to placeho
evant, but we're th

v1.85r1 (3rd January 

Bug fixes

• OK & Next button 

• Transport details on
rather than requiri

• After printing a lan
printed in landscap

• Deleting a line on a

• An error in the Ma
method)

• Splash screen fits th

• Quotes were not sh
details windows.

• Deleting a prescrib

• Web server was no
HTML files in the w

v1.85 (29th Decembe
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New features

• 2 Period transaction comparison report added. This report shows 2 user 
selected periods in columns, and uses item categories for the rows. 

• Placeholder lines are coloured in red.

• Drag-and-drop renumbering of invoice lines

• Dispensary mode: there is now an option to set default directions for 
 direction is applied automatically. Other 
osen when dispensing an item.

ued for each user.

ames as well as items.

n totals.

der to names import.

nts rows first, and shows a progress dialog 

formation

refixed with a custom character(s).

mproved.

f transactions is now recorded. You can use 
y nicely graphs of hourly transaction loads. 
 you want to know how.

s address & date of birth to help distinguish 

nt and Prescriber names.

f names to handle languages with apostro-
i.e. Tongan!)

rates on both name and code, and can 
st name comma first name”. “U” and “D” 
 up and down the prescriber choice list as 
s.

g of miscellaneous labels to Zebra label 

• Can now merge prescribers.

n now be set for each transaction type.

d to Names > Find patient window.

 decimal places to enable more accurate 
 years old.
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• Ad Hoc item lines are coloured blue.

• Service lines are coloured purple.

• Item categories can reordered by drag-and-drop, and the order is 
remembered when choosing a category for an item. Item categories 
can now be chosen when adding new items.

• Default printing options ca

• Complex find button adde

• Patient ages now show two
ages for children less than 2
Using dot notation for item categories allows the report to produced 
for different levels in a hierarchy.

• Item categories can now be defined as summary categories, which 
means they are for reporting only, and can’t be assigned to an item.

v1.84 (13th December 2005)

Bug fixes

• Supplier margins were not being shown when liners where edited on a 
supplier invoice.

• Ad Hoc item can’t be deleted

• First row was being ignored on names import even if boxed not 
checked on options

• Importing items and stock was no importing item name if “remove 
quotes” option was checked (oops!). and cancel button now being 
respected on warning dialogs, and setting of opening stock was ingnor-
ing pack sizes other than 1.

• Packing slip print dates were not being saved.

• Fixed potential issue with repacks.

• When importing electronic invoices, the item name was not being 
saved in the transaction, although the import happened successfully.

New features

• Automatic distribution of quantity to be issued over multiple batches

• Editing of multiple batches to be issued can be done in the one win-
dow.

each item. The first default
default directions can be ch

• New report shows items iss

• Flag field now added for N

• New report: User transactio

• Added first, last, dob & gen

• Import_cust_supp now cou

• More fields for prescriber in

• Patient codes can now be p

• Repacking of transactions i

• The time of confirmation o
this field to draw some ver
Ask Sustainable Solutions if

• Patient choice list now show
patients.

• Auto-capitalization of Patie

• Improvements to lookup o
phes as the first character (

• Prescriber lookup now ope
search prescribers using “la
keys now work for moving
they do for names and item

• Entering, saving and printin
printers.
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• Label printers can be set for each computer, and mSupply will automatically switch 

er invoices is now rounded to 2 decimal places for display.

sh receipts now working.

and stock from the item details window now working again.

s were not being remembered when set by the user (broke 

of mSupply now correctly show they are registered.

egory" for items.

and is now enabled.

ended to 80 characters. Various windows expanded to show 

ate) field for quotes from suppliers.

ugust 2005)

r the ABC category has been added.

s been improved, and the preferred location of the backup 
ted from within mSupply.

unctional in 4D.2004.2

osly being disabled.

ly 2005)

• Able to add supplier discount on individual order lines as well as on the entire 

 deleted if unused; this feature is available to group 1 and 2 

 currency calculation under the “Prices” tab on the order.

n supplier invoices now being updated. This error appeared 

r form, when an item line is deleted, subtotals and discount 
This error appeared in ver.1.81 
to the correct printer when printing labels.

• New report- graphical item history- shows a chart of stock on hand for each item, 
and calculates the number of days in the period of the report that the item was 
out of stock.

v.182r2 (30th August 2005)

Bug fixes

• Automatic backup for Mac & Windows can now be set.

• In preferences the buttons to choose files and folders were wrongly disabled.

invoice.

• Item category may be
users only.

• Improvement in local

Bug fixes

• Sub totals and totals o
in ver.1.81

• On the purchase orde
are now recalculated.
• Dispensary mode transactions warn if trying to save an invoice with no 
lines.

• Entry of dates when issuing and receiving stock is more flexible. e.g. 
entering “3/4” will work. This change also resolves an issue with the 
alert for invalid date formats not being modal on WIndows.

• New item warning if user tries to issue more than a certain quantity (set 
per item). This is helpful where people get confused between items 
whose pack size is whole units and items whose pack size is ml or gm.

• The method day_number_to_text can be used in custom reports to 
show the day as text (“Monday”, “Tuesday” etc) in reports. Contact us if 
you want to know how to do this

• Many more user permissions.

Changes you’re unlikely to care about

• The reporting options for items are now on their own tab.

• When deleting a confirmed order, the user is given the choice of re-
using the order number.

v1.83 (13th September 2005)

Bug fixes

• Some report query options were not being applied.

New features

• Added a "flag" field to quickly mark multiple items for reporting.

• Backorders can be added and edited from the items tab

• The margin on suppli

• Cash payments and ca

• Printing item ledgers 

• Some preference item
in v181, now fixed)

• Client-server versions 

New features

• Added field "ABC cat

• Restore backup comm

• Item name length ext
longer item names.

• Add a "valid until" (d

Version 1.82 r1 (1st A

New features

• Under Item, a field fo

• The backup facility ha
file may now be selec

• File > restore is now f

Bug fixes
Two buttons were errone

Version 1.82 (27th Ju

New features
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• In Supplier>transactions, totals were not being recalculated when the cost price of 
an item line was changed. This error appeared in ver.1.81

• In Supplier>transactions, editing an item line failed to update stock or prices, lead-

• Logo can be saved and printed on invoices and purchase orders.

New features

• There is a new type of item - Ad Hoc items. These items can not be added directly 
to a customer invoice - but can be added to purchase orders. When a purchase 

e is automatically generated for the item.

her type of item that do not have any stock, but 
em. When you choose a cross-reference item the 
uted.

ly be changed by users who have permission to do 

ames.

lds can now hold 50 characters.

tegory drop-down list. You can set name categories 
arately.

’s “accounts” as is accounting codes). You can man-
ems > Show accounts. Each item can have accounts 
ense account and an income account.

can be imported for items and for names.

rmat.

rmat.

e (landscape mode)

 item code (landscape mode)

a tab with purchase orders for that supplier

table. Choose Item > Show units to view and add 

item name at the time of the order.

 by user permissions into those who can receive 
e invoices and enter/edit prices

voices created from that order in a separate tab.

he purchase order they were created from (or zero 
if they were not created from a purchase order).

information including supplier outer pack, supplier 
ight details.

an expected price and units recorded for each item.

s record the date they were printed. They give a 
voice that has already been printed.

 can now be saved to a file on disk. 
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• Purchase Orders can be e-mailed as PDF attachments.

• Log printing of purchase orders.

• User permissions to control printing of duplicate pick slips and invoices.

Version 1.70 (3rd December 2004)
• This version only available in client server versions.

• Supplier quotes can now store 
bar codes, price breaks and fre

• Purchase orders can now have 

• Customer pick slips and invoice
warning if you try to print an in

• Reports in the report manager
ing to ledger errors.
When entering items received, the first item line was not saved, although all sub-
sequent lines were. This error appeared in ver.1.81

• In Manufacturing mode, the Build transaction ingredient costs were not being 
updated. This error appeared in ver.1.81

Version 1.81 (21st June 2005)

New features

• Using the web interface, customers can now: 

• View their own orders/invoices in progress

• Place new orders that immediately show in mSupply for processing.

• Most lists now display in a new format where each column is resizable and sort-
able. Columns can also be moved to new locations.

• New robust automated backup procedures and backup scheduler

• HTML export of reports.

• Automatic opening of reports in Excel.

• Restoration of data from a backup.

• Improved transaction categories.

• Ability to place news and messages on the web interface.

• Improvements to Dispensary mode.

• Patient history view

• Edit patient details on the fly.

Version 1.70r1 (4th Feb 2005)

New features

order arrives, a customer invoic

• Cross-reference items are anot
rather “point” to a different it
item to which it pointsis substit

• Names and name codes can on
so.

• Postal address fields added to n

• All name fields and address fie

• Names now have a separate ca
for suppliers and customers sep

• Added accounts for items (that
age accounts using the menu It
set for an asset account, an exp

• Expanded range of fields that 

• New purchase order printing fo

• New goods received printing fo

• Pick slips now include item cod

• Customer invoices now include

• Viewing a supplier now shows 

• Item units are now stored in a 
units.

• Purchase orders now store the 

• Purchase order access is divided
goods and those who can mak

• Purchase orders now display in

• Supplier invoices now display t
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checked

• Fixed a bug with display of order lines

o stock are now handled properly

previously saved it was possible the totals could be incorrect.

find button on the item list window - wasn't loading record 
 only one record was found..

004)
rder lines, especially when doing price calculations.

etter care of bill of materials

ence option to allow mSupply to maintain a file that indi-
 currently in use by a single-user copy of mSupply.

report was added to give a quick overview of the state of 
sation.

ore robust in their implementation (you won’t see much 
)

ated order costs to orders.

omatically update quotations from an order. The user has 
 either only new lines or existing lines as well.

oices can now be set in the preferences.

 be generated for a date range, and for either one cusotmer 
rs (as well as the default setting which is for all customers).

 is now functional when editing lines on builds.

on reports (including transactions by month, and sales totals 

if they have no associated transactions or quotes.

f items and names.

Version 1.61r2 (April 2004)

ed import of items and stock. Changed item import meth-
s (long description and department)

o store standard header & footer on reports

store customization code. This is used for making special ver-
pecial clients ;-)

y label to simply "category" for items

elds  in item"input" form if bonus system not activated in 
• When clicking on "new line" for orders, the item name field now gets the focus.

• Tab order on users "input" was naff.

• Fixed a bug when a new user edits an original order, the "Edited by" was not 
changed to the current one.

• The estimated costs in the orders was not updated properly

• Repacks weren't filling in the item name stored with transaction lines/

• Title was missing for most recent invoices display.

• Improved and expand
ods to take extra field

• Added a preference t

• Added preference to 
sions of mSupply for s

• Changed ATC categor

• We now hide bonus fi
preferences. 
Bug fixes

• Fixed a potential bug in issuing items that are part of a restrcted group.

• Sometimes suppliers could show in lists that should only have displayed customers.

• Placeholder button when issuing items on invoices was not moving correctly for 
smallest window size.

Version 1.63 (22nd August 2004)
• Currently only available for multi-user clients

• Delete pref "default_currency"  on update if it exists

• Printing of dispensary labels to Zebra label printers.

• Item warning have been added for cautionary & advisory labels.

• Presciber records have been added.

• Now compiled with 4D 2003.

• New reports editor.

• Reports are now stored with the data.

Version 1.62r1 (17 Aug 2004)
• Fixed a bug in display after opening single item selection

• Added a preference first batch even if multiple batches present

• Added "order by" button to items list

• Items list"- now grows to right of item name. 

• Fixed "delete reminders" button reminders list.

• Fixed sort columns on reminders

• Fixed bug with items import- it was not working unless "strip" quotes was 

• Supplier credits with n

• If a customer invoice 

• Fixed a bug with the 
to allow editing when

Version 1.62 (9 June 2
• Improved display of o

• Merging items takes b

• There is now a prefer
cates if the data file is

• A new management 
affairs of your organi

• Currencies are now m
change on the surface

• Added display of estim

• New command to aut
the option to update

• The title of special inv

• ABC analysis can now
or a range of custome

• The OK & Next button

• Several new transacti
for each name).

• Items can be deleted 

• Improved importing o
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• Add user permissions:
• Can view pricing fields for items
• Can view DDD fields for items

• Fixed a bug where a supplier invoice could be finalized using the check box on the 

• Added way to add all available quantity of an item line as the quantity used when 
issuing stock (hold down shift while double-clicking the line). This is especially use-
ful for issuing manufacturing stock with amounts that run to several decimal 

report option wasn’t working.

how all lines or only incomplete lines

ered_by" and "last_edited_by".

report window.

tion when doing a transaction report.

 now still be able to unlock it.

ions
justments
finalized invoices
des and units

utton method) - was printing even if print turned 

 new item to build on bn_add_edit_item_to_build 

 the item to be built, improving safety should the 
er date.

h possibilities for items on the current stock report.

hen first view the orders tab for an item

nt length to 50 characters.

 copied to the comment when adding a build item 
 means the item displays in the list of builds

rder” menu is displayed. There is a new menu 
made”, which lists supplier invoices created from 

r field 1 or 2 when selecting items to include in the 
item usage report.

• Importing items and stock- you can now import batches, expiries, and the item’s 
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invoice entry window, but then the user could choose “later” for entering the 
stock into mSupply. Du-oh!

• Updated method "table_set_titles" to include more item fields in query editor

• The cursor is now correctly positioned when opening a build input window (was 
on page 0, so not automatically selected

• Cosmetic fixes to many windows to improve compatibility with OS X 10.3

long description

Version 1.61 (March 2004)
• Added several new report formats to the transaction report:
• Total by name report
• Added report for item by month
• Added report for item totals by category
• Transaction reports using categories updated
• Added reports for item by date

• Enabled fields for choosing a name & item for all reports on transactions report 
options window

• Fixed a bug that could allow the total item stock to get out of sync with actual 
stock when editing lines on a customer invoice.

• A couple of reports were updated so the quantity column was showing 
[trans_lines]quan rather than (quan * pack size)

• Added “this year”, “this quarter and last quarter” as options for transactions 
report.

• Transaction_report now remembers last report done

• Added organisation name to order print out

• When using the item usage reportcan choose item or code

• Fixed a bug where item units were enterable when entering invoice item lines.

• When importing names the freight factor is set to 1

• Fixed delete button on the list editor - it would return an error if no line was 
selected.

• Shipping address is now hidden if a supplier.

• More options are available for choosing which items to generate an order for

Version 1.61r1 (March 2004)

places

• ABC analysis - include items in 

• When editing orders you can s

• Added fields to orders for "ent

• Fixed spellings on transactions 

• Added "last year" as a date op

• When an order is finalized, are

• Added three new user permiss
• can enter inventory ad
• can edit comments on 
• can edit item names, co

• Fixed printing of repacks (OK b
off

• Now go to page 2 after adding
on [transactions]"build"

• Builds now display the units of
item’s units be changed at a lat

• Added user fields 1 & 2 as searc

• Fixed order lines not showing w

• Increased [transactions] comme

• The name of item to be built is
(only if comment is blank). This

• When editing an order and “o
choice “show invoices already 
the order.

• Added the option to query use
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• HTML context-sensitive help. mSupply now has help that will display in a web 
browser and take you to the right place in the manual when you open it when 

customer invoice directly from a supplier invoice. This is use-
h” invoices, where the supplier has supplied the goods 

e option to leave quotes in when importing items, as some 
rt “inch” signs!

 has been increased to display the full name for long item 

em for use on an invoice, it’s tool tip now shows the text of 
on.

 real numbers (as opposed to integers)

 or include manufactured (built) lines from item usage calcu-

h batch is shown when issuing goods and in the item details 

atient notes are shown when issuing medicines, and notes 
 and deleted “on the fly”.

 of materials has been made more user friendly.

t can now be used to report on all items with less than a cer-
tock on hand. This allows it to be used as a simple order tem-

 been added that allows automatically generated email 
 item name.

click an transaction line in the ledger tab when viewing an 
shown the invoice that the line belongs to in a new window.

ays properly (fixed 1.5r9 and later)

Changes in Version 1.5.0

materials when building items.

permissions system. Many more access priveleges can be set 

argin and gross profit for invoices.

 stores the item name, so that historical information is 
em name is edited after an invoice has been finalized.
using a particular part of mSupply. (The help is not included in the download ver-
sion to keep the download to a reasonable size. You can download the PDF man-
ual separately).

• Web services (client-server only). Not in demo version or single-user- the ability to 
query mSupply data from a range of web services aware applications (including 
SQL server, Oracle, Sybase, etc....).

• XML export (client-server only. Not in demo version or single-user). XML export 
allows extremely easy import of required data into other applications.

• New report editor (client-server only. Not in demo version or single-user). The new 
report editor includes the ability to do cross-tab reports, export reports to HTML, 
colour alternate rows, and lots more!

Major Features

• Can now use a bill of 

• Much expanded user 
on a per-user basis.

• Optional display of m

• Each invoice line now
retained, even if an it
• Fixed a bug where new data files did not have inventory adjustment and repack 
names created (not a data issue- just helps display of these transaction types in 
lists). (1.61- all others below 1.6r1)

• Allow import of items to existing data files.

• Added more menu choices to dispensary full mode.

• Report > Stock on date- fixed a bug in the report generation.

• Report > Item usage- clarified the reporting options

• Order editing: the expected and actual delivery dates are now enterable by the 
user (thanks Andrea!)

• Order lines respect the font settings in the preferences.

• Fixed a potential issue with merging names (fortunately before anyone was 
injured!)

Version 1.6

Major Features

• A dispensary mode has been added, where you can issue to patients rather than 
organisations.

• Built in web server- you can access mSupply data from your web browser.

• Drug interactions. Be alerted to drug interactions with already dispensed medi-
cines. Drug interaction information includes the affected group, and severity and 
clinical significance of the interaction and the quality of evidence. In a furture ver-
sion of mSupply we hope to be able to automatically download up to date drug 
intereaction information from drugref.org’s RPC server once it is complete. (See 
http://www.drugref.org)

• Reminders- a separate to-do list for each user which can automatically remind you 
of due tasks when you log on to mSupply. Reminders can be set to automatically 
repeat at certain intervals.

Other Features

• You can now make a 
ful for “charge throug
directly to the client.

• You are now given th
people want to impo

• Field length for items
names

• When you select an it
the full item descripti

• Pack sizes can now be

• You can now exclude
lations

• Shelf location for eac
stock tab.

• In dispensary mode, p
can be added, edited

• Adding items to a bill

• The item usage repor
tain number of days s
plate.

• A new preference has
orders to be sorted by

• You can now double-
item, and you will be 

Bug fixes

• Item usage now displ
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• Each batch of an item can have it’s own shelf location specified when goods are 
being received.

• Can now lock orders to stop them being deleted.

• Backorder list now displays available stock

• Improved support for certain dot matrix printers that require line advance before 
printing.

• Shelf locations can be editied for each batch (if the user has permission to do so)

hether or not placeholder lines are deleted when 

y now attempts to guess the price of the new pack 

 item notes.

ccurately show progress for long operations.

nsaction reports: “total value for each item” to 
eived of each item over a date range.

saction reports: “item usage broken down by cost 
 for each cost centre under each major item head-
 just a single item or group of items)

cription field.

 the orders for the item (both historical and cur-

arate shipping and billing address

eir access level, last log-on time and date, and the 
.

 of placeholder lines when confirming an invoice 
have their stock updated

 where comment was not editable on supplier 
 & supplier ref were.

batch numbers could be skipped if the user can-

 advesely affect ledger reports

ractional quantities would report an discrepancy 
when there was none.

roperly in client-server mode.

ne with a query on the “hold” fields for items

gures for items (not the actual stock on hand of 
er with actual stock when items were deleted on 
 zero quanitity) or on customer invoices (using the 
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• A new button on invoices shows the profit (value and markup/margin) for a cus-
tomer invoice.

• Printed transaction lists now display the total value of the transactions at the bot-
tom.

• New Report type to print an item ledger between any two given dates. This allows 
a ledger to be printed for any historical period.

• Deleting orders did not work p

• Custom reports can now be do

• The calculated stock on hand fi
item lines) could get out of kilt
supplier invoices (by entering a
“delete line” button)
• Can now resize order windows correctly.

• Orders can now be partially received, and receved in multiple consignments. More 
information is stored about the original order quantity etc, allowing reporting on 
supplier performance.

• Finding orders in mSupply is now easier.

• Orders now show the total quantity required rather than the quantity for a spe-
cific pack size. This allows multiple pack sizes to be received for the same order 
line.

• Names can now be put on hold, so they are not able to be used in a transaction.

Other Features

• Improved graphics for buttons on invoice forms (thanks to Cognito Software for 
the ideas and graphics!)

• OK & Next button now works when editing an invoice, so one can edit multiple 
lines on an invoice without returning to the invoice list.

• The main invoice list window now updates in the background when an item is 
being added or edited.

• The font can be chosen for invoice lists.

• Item notes can now be set to display when issuing or receiving the item.

• Automated backup while mSupply is running, along with a scheduler to specify 
when backups should run.

• Built items can now report the production yeild in relation to theoretical quantity 
on the bill of materials

• Expiring items report can now be sorted by value, name or expiry date.

• Total stock value report can now be generated for all items or just one depart-
ment

• Preference to automatically renumber lines when a line is deleted.

• New preference to determine w
an invoice is confirmed.

• When repacking items mSuppl
size.

• Can now do custom reports on

• New progress windows more a

• Added a new report to the tra
show the value supplied or rec

• Added a new report to the tran
centre” which shows the totals
ing. (This report can be run for

• Items can now have a long des

• A new tab for each item shows
rent).

• Customers can now have a sep

• A new report lists each user, th
number of log-ons for the user

Bug fixes

• In Client/Server mode, deletion
could cause some items to not 

• Fixed bug (also fixed in 1.43r5)
invoices, but service item fields

• Fixed a problem where export 
celled the export.

• Certain build transactions could

• Ledger reports for items with f
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• Fixed a bug where finalizing a invoice might not record the amount as outstand-
ing if one-step finalize was turned on in the preferences.

red in mailboxes, as well as being attached to suppliers or 

Customer invoice windows now grow when the corner is 
e lines. They also “remember” their position when a win-
on the same session.

n included: “Item slow movers”. This report lists items with 
 number of months stock on hand, which is very useful for 
 by allowing action to be taken to dispose of under-per-

ustomer credit could have a margin added to it if a default 
ered for that customer (Don’t ask us why someone would 
ustomer!)

s with the wrong alerts being displayed when a user can-
emails

dering for one supplier was using the non-preferred quotes 
r than the preferred quotes.

own list to the invoices tab of the name viewing window so 
r a name can quickly be shown rather than having to scroll 
ry long list.

oducts from ingredients. This is useful for pharmaceutical 
y other organization that buys raw materials and sells a fin-

 have their own transaction number

ys up to date (Or almost always- If another user is editing an 
r receive stock for that item, the transaction will proceed, 

ck every 60 seconds for the item to become available, and 
tock). Note that the stock for each item line is always correct.

• The find transaction window has been redesigned, as some users found the old 
window unclear (although it did allow for very fast entry. There is now a separate 
field to enter the number of recent invoices or the invoice number. If there is 

elds, the invoice number field will be given priority. (This 
rching for an invoice number, you don't need to clear the 
nsactions" field first.

t" command in the file menu. You can export information 
. You can save export projects which define the fields you 
uickly recall the projects from a popup menu.

he supplier invoice margin item-by-item, rather than only for 
 a new setting in the preferences to determine which value 
 both an item and a supplier margin specified.
• Data file warns if there are no items in the file when you try to view items.

• New menu commands to open a different data file or to create a new data file.

Version 1.4.2
• A long standing bug where occasionally the selling price and invoice total were 

not calculated for lines on supplier invoices has been fixed.

• Supplier invoices and customer invoices now have a delete line button that will 
delete any line from an invoice (except finalized invoices, of course)

information in both fi
means that when sea
"number of recent tra

• The is now an "expor
from almost any table
want to export, and q

• You can now specify t
each supplier. There is
will be used if there is
Version 1.4.3
• Windows XP certified.

• Each customer or supplier can now be assigned to a group. There is no limit to the 
number of groups that can be created.

• Customer groups can be used as a way of creating a restricted access scheme for 
medicines. For example, you can specify that items whose department is “nar-
cotic” can only be supplied to customers whose group is “central hospital” or 
“remote hospital”

• Transaction totals are now kept up to date in the background, so that even if a 
user quits by using the Windows close box, the correct transaction total is avail-
able. Without reopening the invoice.

• Dot matrix printers can be driven directly from mSupply, either to 10c m roll paper 
or A4 paper.

• Item stock import can now include batch numbers and expiry dates when setting 
up a new data file. 

• Item name import is now more flexible, and handles nasty extra characters that 
Excel inserts more gracefully.

• Names can now be imported.

• Changing a user password from the user list now requires entering the password 
twice to save errors

• The password entry window has been redesigned. It now alerts the user if caps 
lock is on.

• User access to certain functions can now be set on a per-user basis.

• Invoices can be finalized as they are entered on a “per-invoice” basis if the user 
has permission to do so.

• Fixed a bug where processing a previous customer overpayment on a cash receipt 
would not remove the overpayment amount from the customer’s record.

• Emails can now be sto
customers.

• Supplier invoices and 
dragged to show mor
dow is opened again 

• A new report has bee
more than a specified
managing inventories
forming stock.

• Fixed a bug where a c
margin had been ent
enter a margin for a c

• Fixed some small bug
celled attachment of 

• Fixed a bug where or
for that supplier rathe

• Added a dates drop-d
that recent invoices fo
to the bottom of a ve

version 1.4
• The ability to build pr

manufacturing, or an
ished product.

• Supplier repacks now

• Item stock is now alwa
item while you issue o
and mSupply will che
will then update the s
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• Each transaction can have it's own category. The list of categories can be defined 
in the preferences. Supplier transactions and customer transactions have their 
own categories.

• Passwords are now stored in the data file using 512 bit RSA encryption for added 

• Items lines (that is, batches) can now be held (quarantined) on a per-batch basis

• Invoice windows now remember their position, and open in the position they 
were closed in.

 HTML format that can be viewed by any web 
 and Spreadsheets.

ices to e-mails, either as an electronic invoice or as 

ents, CC and BCC addresses.

.

 the invoice layout, and some extra safety checks 
es.

ow fully client-server capable. We expect mSupply 
 concurrent users with no problems. If anybody has 
y can lend, we'll be able to report on larger net-

 For users, the most significant change is that the 
 all windows. Now you simply double-click the line 

opened at the same time. To do so, click on the 
ly man), and the menu will reappear, allowing you 

u
on report window now lets you choose from 
of report
pplier or item
ear (or closing stock for previous year- same 

- previously mSupply only reported the total. 
t as well

• Report headers, footers and borders can now be set by the user

nt purchases for an item when entering a supplier 

can have a note attached to it with up to 32,000 
ll print on the bottom of the invoice.

e in any currency- not just the default currency for 

n invoices for your information to be added.
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security.

• Export of finalized invoices is now optional. It is turned on or off on the "invoices 
1" tab of the preferences.

• Each item can now be assigned to a department, allowing you to group items, 
and produce reports based on those groups. 

• Items can now be held so they are only issued on builds, or they are not issued at 
all.

• There is an option to show rece
invoice

• Transaction notes- any invoice 
characters of text. The note wi

• Supplier quotations can now b
the supplier.

• There is a second address line o
• Abbreviations: When entering directions for an item, any abbreviations entered 
will be expanded to the full text. The list of abbreviations and their expansion can 
be edited by the user.

• Custom labels can be sorted before printing.

• Item usage now also shows standard deviation as well as the mean for the months 
usage chosen

• A new "item usage" report enables a concise print out of usage history.

• Displaying item usage is now much faster.

• Generating orders has been sped up dramatically.

• Items can now be excluded from orders permanently.

• Forecasting support is improved by :

• A new report to show usage statistics for selected items.

• Orders can now use the last three years usage data to evaluate required 
quantities.

• Standard deviation as well as monthly usage mean is available for each item.

• A customer receipts module has been added. This uses an "open-item" system of 
accounting to record the exact amount outstanding on each invoice. (This module 
does not affect the functioning of mSupply if you do not turn it on in the prefer-
ences)

• New reports based on the account status of each customer: 

• Debtors report lists all customers with outstanding balances

• Customer Statements prints a statement for each customer with an outstand-
ing balance.

• A bonus stock system has been added. This allows issuing bonus stock to custom-
ers automatically, based on the bonus formula entered for each item.(This module 
does not affect the functioning of mSupply if you do not turn it on in the prefer-
ences)

• Export of invoices and orders in
browser, most Word Processors

• Automatic attachment of invo
an HTML invoice.

• E-mails can now have attachm

Version 1.3
• Version 1.3.2 & 1.3.3: bug fixes

• Version 1.3.1: minor changes to
added when calculating tax rat

• Most significantly, mSupply is n
will be able to handle 20 or 30
a spare 70 or 80 computers the
works.

• Many interface improvements.
edit line buttons are gone from
you want to edit.

• Multiple windows can now be 
splash screen picture (the supp
to start a new task.

• Greatly expanded reports men
• a menu in the transacti

several different styles 
• quotation reports by su
• opening stock for the y

thing!)
• current stock valuation

Now you can print a lis
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• A new preference allows turning on or off the logging of new name creation.

• The previous year's item ledger can be printed. This means that new transactions 
can be entered without the need to save an end of year copy of mSupply just for 
printing the ledger.

• Each transaction no longer stores the name code and the charge code- the charge 
code is taken from the name at the time of export. This way you can edit charge 
codes and re-export if there is a problem.

• In the ledger tab of the item viewing window, there are two extra options- 
• to view all the transactions for a particular name (click on a transac-

tion then choose this item to view all transactions from/to the same 
name as the one you clicked.

• to view all the transactions associated with a particular batch of stock.

• Holding down the shift key while clicking on a blue column header now sorts the 
column in the reverse (descending- 9>1, z>a) order.

• Email from within mSupply. We have added quick email functionality. This is just 
the start- watch this space...

• It is now possible to set the minimum stock level for each item (although there is 
no requirement to do so. See the manual for a fuller explantion). When generat-
ing an order, mSupply's own calculation method is used first, and if the result is 
still less than the minimum, the order quantity is increased.
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